Composer Pro User Guide

Control4 Disclaimer
Control4® makes no representations or warranties with respect to this publication, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Control4 reserves the right to make changes to any and all parts of this publication at any time, without any obligation to notify any person or entity of such changes.

Trademarks
Control4 and the Control4 logo are registered trademarks of Control4 Corporation. Other product and company names mentioned in this document may be the trademarks or registered trademarks of their respective owners.

Legal Notice

GNU
GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION (Section 3.b.)
You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:
Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 on a medium customarily used for software interchange.
The complete text for this license is available on the Control4 web site at: http://www.control4.com.

Gracenote
Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either a registered trademark or a trademark of Gracenote, Inc. in the United States and/or other countries.
Music and DVD recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. For more information visit www.gracenote.com.

MPEG
Fraunhofer IIS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. Supply of this product does not convey a license nor imply any right to distribute content created with this product in revenue-generating broadcast systems (terrestrial, satellite, cable, and/or other distribution channels), streaming applications (via Internet, intranets, and/or other networks), other content distribution systems (pay-audio or audio-on-demand applications, and the like) or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards, and the like). An independent license for such use is required. For details, visit http://mp3licensing.com. Radio Locator is the service provider of AM/FM channel list.

© 2005-2008 All Media Guide, LLC provides music and video recognition technology that provides cover art and related text that enriches the Control4 user Navigators.

Copyright
© 2010 Control4. All rights reserved. Control4 and the Control4 logo are registered trademarks or trademarks of Control4 Corporation in the United States and/or other countries. All other brands or names may be claimed as property by their respective owners. Pricing and specifications subject to change without notice.

No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

Contact Information
Control4 Corporation
11734 S. Election Road
Salt Lake City, UT 84020 USA
http://www.control4.com

Part Number: 200-00005
Contents

1. Introduction ............................................................................................................................. 7
   1.1 Purpose .......................................................................................................................... 7
   1.2 Scope ............................................................................................................................. 7
   1.3 Related Documents and Resources .................................................................................. 8
2. Composer Pro Basics .............................................................................................................. 8
   2.1 Installing Devices ............................................................................................................. 9
      2.1.1 Procedure ................................................................................................................ 9
   2.2 Rebooting the Control4 System ........................................................................................ 9
      2.2.1 Procedure ................................................................................................................ 9
   2.3Resetting the Control4 System ......................................................................................... 9
      2.3.1 Procedure ................................................................................................................ 10
   2.4 What’s New in this Release? .......................................................................................... 10
      2.4.1 OS 2.0.5 ................................................................................................................ 10
      2.4.2 OS 2.0.1 ................................................................................................................ 10
      2.4.3 OS 2.0 .................................................................................................................... 11
   2.5 Configuring Properties ................................................................................................... 16
      2.5.1 Procedure ................................................................................................................ 16
      2.5.2 Example of Device Properties Configurations .......................................................... 17
   2.6 Configuring Devices ....................................................................................................... 20
      2.6.1 Guidelines for Configuring Devices ......................................................................... 20
      2.6.2 Configuring Third-Party Devices ............................................................................. 20
      2.6.3 Using My Drivers or Search Tabs .......................................................................... 21
      2.6.4 Using the Online Database to Search for Drivers ..................................................... 22
      2.6.5 Configuring Controllers .......................................................................................... 22
      2.6.6 Configuring AV Devices .......................................................................................... 30
      2.6.7 Configuring Lighting and Keypads .......................................................................... 51
      2.6.8 Configuring Navigators ............................................................................................ 75
      2.6.9 Configuring Contacts and Relays ............................................................................. 96
      2.6.10 Configuring HVAC Systems ................................................................................... 101
      2.6.11 Configuring and IP Camera or Web Image ............................................................. 110
      2.6.12 Configuring Black & Decker Locks ....................................................................... 110
   2.7 Customizing the Navigators .......................................................................................... 113
      2.7.1 Setting Up the Photo Screen Saver Option ............................................................... 114

Copyright © 2010 Control4. All Rights Reserved.

3.1 Setting Up a Network Configuration ................................................................. 191
  3.1.1 Procedure .................................................................................................. 191

3.2 Creating Device Drivers .................................................................................... 193
  3.2.1 Procedure .................................................................................................. 193
  3.2.2 Why Create a Device Driver? ...................................................................... 194
  3.2.3 Overview of Creating Device Drivers ............................................................ 195
  3.2.4 Guidelines for Creating Device Drivers ......................................................... 195
  3.2.5 Driver Wizard ............................................................................................. 196
  3.2.6 Power Management ..................................................................................... 198
  3.2.7 IR-Controller Drivers ................................................................................... 201
  3.2.8 Serial-Controlled Device Drivers .................................................................. 219
  3.2.9 2-Way Serial or TCP/IP-Controlled Driver Using DriverWorks ....................... 225
  3.2.10 Related Tasks ............................................................................................ 225

3.3 Connecting and Verifying Devices .................................................................... 226
  3.3.1 Why You Need Connections ........................................................................ 226
  3.3.2 Connect and Verify Devices ......................................................................... 227
  3.3.3 Connecting Rooms ....................................................................................... 231
  3.3.4 Connecting Devices to the Network ............................................................... 236
  3.3.5 Testing Device Connections ......................................................................... 243

3.4 Setting Up the Media .......................................................................................... 250
  3.4.1 Overview of Media Management .................................................................... 251
  3.4.2 Configure Video Scanning of Network File Storage Devices ......................... 253
  3.4.3 Setting Up Media Auto-Scan ......................................................................... 255
  3.4.4 Setting Up Media Stored on a Controller ..................................................... 256
  3.4.5 Setting Up Media Stored on a Disc Changer .................................................. 258
  3.4.6 Setting Up Videos for a Media Player ........................................................... 265
  3.4.7 Setting Up Media for Radio Stations ............................................................ 265
  3.4.8 Setting Up Media for Television Stations ..................................................... 266
  3.4.9 Importing a DVD List from a File .................................................................. 268
  3.4.10 Using External Storage Devices ................................................................. 268
  3.4.11 Adding an Audio or Audio/Video Switch ...................................................... 271
  3.4.12 Creating a Playlist ...................................................................................... 272
  3.4.13 Testing the Media Connection ..................................................................... 274
  3.4.14 Editing Media Information .......................................................................... 274

3.5 Programming the System .................................................................................. 280
  3.5.1 Programming Basics for Control4 Systems .................................................... 281
  3.5.2 Programming with Commands ....................................................................... 287
3.5.3 Programming with Conditionals ................................................................. 298
3.5.4 Programming Using Digital Audio and Rooms ........................................... 301
3.5.5 Examples: Programming with Variables .................................................... 304
3.5.6 Examples: Programming with Agents ......................................................... 324
3.5.7 Other Programming Tasks ............................................................................ 359
4. Glossary ............................................................................................................ 367
5. Index .................................................................................................................. 372
1. Introduction

Composer Professional Edition (Composer Pro) is a Control4® software application that Control4 Dealers and Installers use to set up and configure Control4 and third-party devices to communicate with each other in the Control4 Home-Automation System.

1.1 Purpose

The purpose of this document is to provide steps, tips, and examples about how to use the Composer Pro software application for the Control4 Operating System (OS 2.0) and later.

Words that appear in red are either listed in the Glossary, or are tips, or examples, and other important information.

1.2 Scope

This Control4® Composer Pro User Guide for OS 2.0 and later is divided into Basic and Advanced sections.

The Basics sections provide information and instructions about:
- Installing devices
- What's new in this release
- Configuring properties
- Configuring devices
- Customizing the Navigators
- Updating Composer and Director
- Example projects
- Troubleshooting the system
- Information about older releases

The Advanced sections provide information and instructions about:
- Setting up the network configuration
- Creating device drivers
- Connecting and verifying devices
- Setting up the media
- Programming the system

If you've never used Composer Pro before, we suggest that you start with either Composer Pro Getting Started available in the Composer Pro application's Help menu or on the Control4 web site as a PDF. If you're already familiar with Composer Pro, you can skip through the Composer Pro Getting Started, and continue with the sections in this document.
1.3 Related Documents and Resources

<table>
<thead>
<tr>
<th>Document file name</th>
<th>Title and location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composer Pro Getting Started (200-00168)</td>
<td>Application Help: Available in the Composer Pro Help menu</td>
</tr>
<tr>
<td></td>
<td>PDF: <a href="http://www.control4.com/dealer/products/documentation/">http://www.control4.com/dealer/products/documentation/</a></td>
</tr>
<tr>
<td>Control4 System Quick Start Guide (200-00153)</td>
<td>PDF Only: <a href="http://www.control4.com/residential/products/resources/#documentation/">http://www.control4.com/residential/products/resources/#documentation/</a></td>
</tr>
<tr>
<td></td>
<td>PDF: <a href="http://www.control4.com/residential/products/resources/#documentation/">http://www.control4.com/residential/products/resources/#documentation/</a></td>
</tr>
<tr>
<td>Control4 Operating System Release Version 2.0.1 Release Notes (TechDoc00031)</td>
<td>PDF Only: Included with software package on the Control4 Dealer web site. Also available on the Control4 Knowledgebase.</td>
</tr>
<tr>
<td>Composer Pro Software Release Update Instructions - Release 1.7.4 to OS 2.0 (TechDoc00024)</td>
<td>PDF Only: Control4 Knowledgebase</td>
</tr>
</tbody>
</table>

2. Composer Pro Basics

If you are a new user, start by using the application Help in Control4® Composer Pro (Composer Pro Getting Started). These sections assume that you are familiar with Composer Pro. This product runs on the Control4 Operating System (OS) Release 2.0 (OS 2.0).

Use the subsections in this Composer Pro User Guide "Basics" section to:

- Learn how to install devices
- Learn how to reboot or reset your Control4 system
- Find out what's new in this release
- Learn how to configure Composer properties
- Learn how to configure the devices
- Learn how to connect everything
- Learn how to customize the Navigators
- Learn how to update Composer and Director
- Learn how to troubleshoot problems
- Find out about specific details about older releases
- Learn how to create a sample project using the Interviewer wizard or Composer views
To learn about the advanced features of Composer Pro (*programming*, setting up networks, *device* drivers, etc.) see “Advanced Topics.”

### 2.1 Installing Devices

Use the Control4® Dealer web site at [http://www.control4.com](http://www.control4.com) to access PDFs of all current and past product installation and setup guides, and then install and set up your Control4 system devices according to these guides. These are the same guides that are included with the hardware, such as a *Controller* or *Touch Screen*.

If you're installing devices that are not Control4, you may need to edit an existing driver or create a new one. See “Creating Device Drivers.”

#### 2.1.1 Procedure

To access the installation, setup, and user documents in PDF format:

2. Log in to the Dealer Login site using your Dealer username and password.
3. Click the **support** tab.
4. Under Support Overview, click **product information**.
5. View the list and click the link for the document you want to view or print.

### 2.2 Rebooting the Control4 System

At one time or another you may have configured the Control4® system incorrectly, or the **connection** to the network is not behaving the way you’d like it to. In this case, you can reboot or reset the system. You don't have to do anything in *Composer* Pro for this procedure other than check that the **device** is on the network.

#### 2.2.1 Procedure

**To reboot a *Controller***:

1. Disconnect the power cord from the Controller.
2. Plug the power cord back in to the Controller.
3. Verify that the Controller comes back on the network in Composer Pro. See “Connecting a Device to the Network” for details.

**To reboot a 7" *Touch Screen***:

1. Of the four (4) programmable buttons on the front of the Touch Screen, press and hold **Buttons 2** and **3** simultaneously.
2. Wait for the screen to reboot and refresh. This should take several minutes.

### 2.3 Resetting the Control4 System

Use the Control4® system *Composer* Pro to reset a *Controller*. You reset a Controller to reset it back to the factory defaults.
2.3.1 Procedure

To reset a Controller:
1. Connect the yellow Composite video cable connectors to the Controller and TV.
2. Connect one end to Composite on the Controller and the other end to a TV.
3. Disconnect the power cord from the Controller.
4. Turn on the TV and go to Video 1 or AUX.
5. Connect the power cord back in to the Controller.
6. Press and hold the ID button on the Controller to reset the Controller.
7. Keep pressing the ID button for several minutes. The TV displays the Control4 information, and will display a message similar to “Release to reset the network configuration...” when the reset has completed.
8. Release the ID button on the Controller. Wait several minutes. A message appears “loading, please wait...” After a few minutes, the TV screen may go blank.
9. Continue to wait until the Control4 logo appears on the screen, at which point you can start Composer and connect to Director using the new IP address that appears (if you are using DHCP).
10. Refresh the Navigators.
11. Disconnect the Composite video connectors from the TV and Controller.

2.4 What’s New in this Release?

The Control4® system Composer Pro software for OS 2.0 contains new features and functions:

2.4.1 OS 2.0.5
- New Control4 logos
- Support for Intercom Agent. See the Agents section in this document for details.
- Support for HC-200B as a Primary Controller (functionality included in software update)
- 5” Mini Touch Screen end of life. Replaced by the 5” In-Wall Touch Screen.

2.4.2 OS 2.0.1
- New Media Player V2 (C4-MP2-E).
- Updates to HC-200B (C4-HC200B-E-B-NR-1) and HC-300C (C4-HC300C-E-B).
- Updates to HC-1000 V3 (C4-HC1000-V2-E-B). Support for rollback to Release 1.7.4 and 1.8.2 using a USB drive.
- Update to System Remote Control SR-250 (enhancements).
- New 5” and 7” In-Wall Touch Screens (C4-TSWMC5-EG-xx and C4-TSWMC7-EG-xx) with Intercom feature.
- Support for Android in Mobile Navigator.
- Removed SRC V1 and V2 from documentation.
- End of Life: 7” Wall-Mount Touch Screen (replaced by 7” In-Wall Touch Screen).

2.4.2.1 Hardware and Software No Longer Supported or Partially Supported
- End of Life: 7” Wall-Mount Touch Screen (replaced by 7” In-Wall Touch Screen).
2.4.2.2 New Media and Hardware

- New Media Player V2 (C4-MP2-E).
- Updates to HC-200B (C4-HC200B-E-B-NR-1) and HC-300C (C4-HC300C-E-B).
- Updates to HC-1000 V3 (C4-HC1000-V2-E-B). Support for rollback to Release 1.7.4 and 1.8.2 using a USB drive.
- Update to System Remote Control SR-250 (enhancements).
- New 5" and 7" In-Wall Touch Screens (C4-TSWMC5-EG-xx and C4-TSWMC7-EG-xx) with Intercom feature.
- Support for Android in Mobile Navigator.

2.4.2.3 New or Updated Sections

- Configuring HVAC Systems
- Configuring Controllers
- Configuring AV Devices
- Configuring Navigators
- Configure an 5" and 7" In-Wall Touch Screen
- Examples: Programming with Agents
- Index

2.4.2.4 Sections No Longer Supported

- Configuring Navigators > Configure System Remote Control – Versions 1 and 2
- Configuring Navigators > Program System Remote Control Programmable Buttons (Version 2 Only)
- Renamed section on 7" Tabletop and 7" Wall-Mount Touch Screens to “Configure a 7" Tabletop Touch Screen.” Removed references to 7" Wall-Mount Touch Screen.

2.4.3 OS 2.0

Electronic Licensing. New Dealer licensing and activation has been added. 4Sight and an Internet connection is required for activation. After activation, Composer can run without an Internet connection. There’s also a new feature to allow Dealers to assign licenses for their associates. This is set up during installation and registration. See TechDoc00024 Managing Dealer Accounts on My.Control4.Com on the Control4 Knowledgebase for details.

- Installation. New Composer installation.
- Flash Navigators.
  - New Flash user interface for current Controllers and Navigators (not including the Mini Touch Screens or 10.5" Touch Screens).
  - Easier navigation on the Navigators via Media Dashboard, views, bread crumbs, etc.
  - Ability to change backgrounds.
  - Customizable (change wallpaper; add new Custom Home pages; create Favorites; change buttons; create Custom Home pages; purchase applications from the 4Store; use 4store applications in My Apps), easy to use (intuitive, fewer steps, consistent), and elegant (3-dimensional, translucent, simple).
  - Support for SSL configurations for tighter security.
• Ability to edit DVDs via Disc Changer.
• Whole-home views; room browse.
• Uses a secure network connection to Director via SSL by default. **Note:** If you configure the system to accept only secure connections, the older Navigators (Legacy Navigators) will not work, as they use an insecure connection to Director.
• The Flash player does not support HTML markups. Dealers who have programmed popups that rely on HTML formatted text will need to change their programming scripts.

- **Customization.** Improved use of the Control4 system for users by providing: whole-home status and control functionality; and information delivery relevant to the homeowner.
- **Web Navigator.** New and improved Web Navigator. Now you can view the system in Flash (same interface as on the Touch Screens and On-Screen Navigator). See the Control4 System User Guide for details.
- **Mobile Navigator.** New and improved Mobile Navigator that supports Apple iPod, iPod touch, iPhone, and iPad. See the Mobile Navigator License Activation and Setup Guide, 200-00099 on the Dealer portal.
- **List Navigator.** Support for analog sources in Zones.
- **Devices.**
  - Support for new devices (Home Controller HC-1000 V3, IO Extender, and Black and Decker KwikSet SmartCode door locks).
  - Ability to change the System Remote Control's backlight, sleep mode, check battery levels, and more from the device's Properties pane in Composer Pro.
  - New accessories (7" Portable Touch Screen: battery pack and stand).
  - Disc Changer. New option in the Properties pane, "Ignore Unexpected Play, Stop, or Pause." This option should be checked if you are configuring a system with lighting, for example, when the movie starts playing, and the lights in the room dim. By nature, Disc Players typically use Play, Stop and Pause functions during movie viewing.
- **Wireless Networks.** WPA is now supported on HC-class Controllers, 7" Touch Screens, and the 10.5" V2 Touch Screen.
- **Platform.** Support for Windows 7.
- **Localization.** Support for internationalization. New Localization option in project > Properties. **Note:** Control4 is not internationalizing:
  - Composer
  - New UI
  - System Remote Control V1 and V2 (**Note:** SR-250 will be internationalized for OS 2.0.)
  - LCD Keypad
  - System functions (splash screens or diagnostics and logging)
- **Composer Pro.**
  - New Macros agent.
  - Lighting Scenes. New Execute On and Execute Off buttons to turn Lighting Scene lighting on and off. Can change the order of Lighting Scenes and lights. Support for Lighting Scenes in the room's Properties > Navigator view. Hide or show and change the order of lights and Lighting Scenes.
  - Media menu. New option 'Tag media files.'
  - Menu bar. New 'Go' menu to all views (System Design, Connections, etc.).
Composer Pro User Guide

- New System Design and Media view tab changes in Composer Pro.
- Wireless Thermostat scheduling and options changes.
- DriverWorks. Ability to add and replace drivers.
- Lua engine.
- Improved Media Management and performance
  - Improved performance.
  - Improved scalability.
  - Improved functionality.
  - Media Manager now runs on the Primary Home Controller's Director.
  - Formatting changes in the Media Database.
    - Third-party Media Management software now works more efficiently.
  - Composer Pro does not need to be connected when scanning files.
  - Storage locations are not available in the Navigators until the media device is scanned.
  - Additional audio codecs.
    - FLAC support (currently in Release 1.8).
    - AAC support (unencrypted, non-DRM).
- ZigBee Pro now benefits the broader market.
- Director. All Director interfaces will be preserved so that the legacy platforms continue to work using the older UI without a change in the system when updated to OS 2.0. New functionality may not be accessible, however, but older functionality still behaves the same way.
- Security. Improved system security:
  - Composer Pro implements license activation.
  - Dealers can now create their own licenses for their Installers. With this license, Installers will not have to be connected to the Internet to use Composer, but a valid 4Sight license is required. See Managing Dealer Account on My.Control4.Com for details.
  - Secure device to device communications.
- Documentation. Improved documentation:
  - Composer Pro Getting Started, Basics and some Advanced Help topics. Getting Started Help is available in the Composer Pro application or on the Control4 Dealer web site. The Getting Started document links to the Composer Pro User Guide (this document) which is available on the Web (includes Basic and Advanced topics) or in PDF.
  - Composer HE and ME. Updated and restructured documents for Composer HE and ME are now available in the Composer HE and ME applications. More detailed Help and a PDF for Composer HE are available on the Control4 web site (Composer HE User Guide). Composer ME is available in the application help (Composer ME User Guide) or as PDF on the Control4 web site.
  - Control4 System User Guide. A new Control4 System Quick Start Guide (Rev A) is available in PDF format on the Control4 web site. More detailed online Help (Control4 System User Guide) is available on the Control4 web site or on the Dealer portal in PDF.
  - Product documents are still available on the Control4 Dealer web site under Support > Product Information, but they will no longer be available in the box in printed form or on CD.
The consumer-facing documents (for example, Control4 System User Guide and Control4 System Quick Start Guide) are available on the Control4 web site (see the Control4 System Quick Start Guide for details).

- **Network.** The Network Status tab in Tools has been changed to Network Tools (Release 1.8.0 and later).

### 2.4.3.1 Hardware and Software No Longer Supported or Partially Supported

- Home Theater Controller (functions as a Secondary Controller, but not as a Primary Controller; On-Screen Navigator continues to use the legacy interface – prior to OS 2.0).
- Media Controller (functions as a Secondary Controller, but not as a Primary Controller; On-Screen Navigator continues to use the legacy interface – prior to OS 2.0).
- Home Controller HC-1000 V1 (no longer sold by Control4 but fully supported with OS 2.0).
- Home Controller HC-500 (no longer sold by Control4 but fully supported with OS 2.0).
- 10" Wall Mount Touch Screen (will be updated to OS 2.0, but continues to use the Navigators prior to OS 2.0. This is the last planned update for this device; future support will be limited to compatibility mode).
- 10.5" Wireless Touch Screen V1 (will be updated to OS 2.0, but continues to use the Navigators prior to OS 2.0. This is the last planned update for this device; future support will be limited to compatibility mode).
- Mini Touch Screen V1 and V2 (will be updated to OS 2.0, but continues to use the Navigators prior to OS 2.0. This is the last planned update for this device; future support will be limited to compatibility mode).
- System Remote Control V1 and V2 do not support ZigBee® Pro (these remotes need to be replaced with SR-150 or SR-250 if used with OS 2.0).
- Contact Relay Extender (does not support ZigBee Pro). Use an IP connection for OS 2.0.
- Audio products (do not support ZigBee Pro). Use an IP connection for OS 2.0.
- Easy Setup.
- Easy Importer.
- Pool Controller. The Flash-based Navigator UI for pool control is not completed in OS 2.0, although the drivers and proxies remain in place in Composer Pro. If this is important, keep at least one of the Legacy Navigators for this purpose.
- USB Restore or USB Install. Because an Internet connection is required, these USB utilities are not supported in OS 2.0. Use the 1.7.x or 1.8.2 versions of these utilities. After a restore, you can update to OS 2.0 from 1.7.4 and 1.8.2 to OS 2.0.
- Web Navigator. Rhapsody and 4Store cannot be accessed from the Web Navigator. Use the Touch Screens or On-Screen Navigators.

For more information, see the Control4 Operating System Release Version 2.0 Release Notes.

### 2.4.3.2 New Media and Hardware

The Control4® system Composer Pro now supports the following media and hardware:

- A new Navigator interface has replaced the interface used in Release 1.8.x and earlier. This interface appears on all of the Touch Screens and On-Screen Navigators except for the Mini Touch Screen and 10" Touch Screens. See the Control4 System Quick Start Guide and Control4 System User Guide for details about how to use this interface.
• A new IO Extender has been added to the Control4 product line.
• A new Home Controller HC-1000 V3 has been added to the Control4 product line.
• Support for a network-attached storage (NAS) device for auto-discovery of AAC music format.
• The AMG lookup service has been switched to Gracenote®. The Sony 777 Disc Changer uses Gracenote, but the Media Controller can no longer access album, title, or artist information from AMG. CDs, however, can be imported and will appear in the Media Database with a date and time stamp.
• Other Media Manager: You can use other media managers, for example, iTunes, Windows Media Player, and Media Monkey to create MP3s. You can still use Composer ME and HE to add music files to Control4.

2.4.3.3 New or Updated Sections
These are the Control4® system Composer Pro User Guide (Getting Started, Basics, and Advanced sections) basic changes for OS 2.0. See the Control4 System Software Release Version 2.0 Release Notes for system details:
• The Composer Pro and Composer Pro-related documents have been updated, sections have been rewritten, and the documents have been restructured for Composer Pro OS 2.0 and later to make it easier for you to get the information you need more quickly. Most sections are available in HTML and application Help in the Composer Pro application and on the Control4 web site (see “Related Documents and Resources”).
• All sections have been restructured, re-ordered, and enhanced with:
  • A new and updated look.
  • New screen displays have been added.
  • New links have been added to the Help topics.
  • Text has been pared down or combined for ease of use and readability.
  • Back and Forward buttons have been added back in to the Help topics.
  • Glossary terms and definitions have been added 'in text' in the Help topics. A Glossary has been added to the PDF version also.
• The Composer Pro User Guide for OS 2.0 has been broken up and restructured into:
  • Composer Pro Getting Started (application help and PDF). The Help files show you how to get set up in Composer Pro and are included in the Composer Pro software with links to the Composer Pro User Guide Web Help. Click the Help button in Composer Pro to launch the Getting Started Help. The PDF version of this document is located on the Dealer portal. See “Related Documents and Resources” for details.
  • Composer Pro User Guide (Web Help and PDF). The Help files and PDF version provide Basic and Advanced topics. The Help files are available on the Control4 web site; the PDF is available in the Dealer portal. See “Related Documents and Resources.”
• New sections have been added for these devices: IO Extender and Home Controller HC-1000 V3.
• New sections: “Editing DVD Information” and "Programming the Control4 Thermostat Schedule" have been added.
• Most references to Contact/Relay Extender, 10" Wireless Touch Screen, and Home Controller HC-500 have been removed. These products are either no longer sold or do not support the Flash-based interface.
General network information has been removed. You can get that information from the Control4 training materials and courses.

Third-party products may be mentioned, but specific details about how to set them up may or may not be included. Refer to the product documentation shipped with the product.

Release information for releases prior to OS 2.0 that apply to Composer Pro have been added to “Information About Older Releases.”

### 2.4.3.4 Sections No Longer Supported

The following Control4® system Composer Pro sections have been moved or are no longer mentioned in this document (as they were in previous releases):

- Third-party product configurations. With some exceptions, configuring devices for third-party Thermostats, Pool Controllers and Security systems are no longer provided in the Composer Pro User Guide.

- Networking Basics. These sections are now included in Control4’s Networking training classes.

- Products no longer supported or partially supported in OS 2.0: Contact/Relay Extender, 10” Wireless Touch Screen, Home Controller HC-500, Home Controller HC-1000 V1, Media Controller, Home Theater Controller, Easy Importer, and Easy Setup. See versions of this document earlier than OS 2.0 for information about these products.

- References to older releases of Control4 products. These references have been moved into “Information about Older Releases.”

### 2.5 Configuring Properties

Use the Control4® Composer Pro Properties pane in System Design to change device properties. The Properties pane lets you make configuration changes to a project, room, or device.

In the Control4 system, you have a choice of configuration options using these properties:

- **Project Properties**—Lets you set project-specific configuration options.

- **Room Properties**—Lets you set room-specific configuration options.

- **List View Properties**—Lets you set device properties listed by location, such as room, floor, house, etc.

- **Device Properties**—Lets you set device-specific configuration options.

### 2.5.1 Procedure

To configure properties:

1. Start Composer and connect to a Director.
2. Click System Design.
3. Select one of the following property types:

   - **Project**—Select the root node in the project tree, for example the project name (such as Franklin Smith Home) to access the project properties and modify the:
     - Project name
     - Zip code
     - Latitude/longitude
     - Date
2.5.2 Example of Device Properties Configurations

Use the Control4® Composer Pro System Design view to check the properties of devices, rooms and projects. The properties in these examples, of course, will vary from product to product.

2.5.2.1 Wireless Dimmer or Wireless Switch Properties

When selecting a lighting product, for example, Wireless Dimmer or a Wireless Switch in System Design, the Properties and Advanced Properties are displayed. These properties let you customize the configuration of the Dimmer or Switch.

Example Properties pane:
2.5.2.1.1 Properties
These properties only are available on the Wireless Dimmer.

- **Click Ramp Rate Up**—The rate in seconds at which the light ramps from Off to On.
- **Click Ramp Rate Down**—The rate in seconds at which the light ramps from On to Off.
- **Preset Level**—The percentage of the load to which the Dimmer ramps when turned On.

2.5.2.1.2 Advanced Properties

- **LED**
  - **Top Color On**—The LED color for the top LED when the LED state is On.
  - **Top Color Off**—The LED color for the top LED when the LED state is Off.
  - **Bottom Color On**—The LED color for the bottom LED when the LED state is On.
  - **Bottom Color Off**—The LED color for the bottom LED when the LED state is Off.

- **Options**
  - **Top LED Link**—If checked, swap the On and Off state and color on the top LED.
  - **Bottom LED Link**—If checked, swap the On and Off state and color on the bottom LED.
  - **Buttons Attached**—If checked, pressing the buttons on the Dimmer or Switch directly controls the connected load.
  - **LED Attached**—If checked, the LED state is controlled by the button presses. If unchecked, the LED state and colors can be controlled by custom programming.

- **Hold Ramp Rate Up**—The rate in seconds at which the load is increased when the top button is held down.
- **Hold Ramp Rate Down**—The rate in seconds at which the load is decreased when the bottom button is held down.

- **Network**—The current channel, gateway, MAC address and firmware version of the selected Dimmer or Switch. These boxes cannot be edited.

2.5.2.1.3 Wireless Keypad Properties

When selecting a Wireless 2, 3 or 6 Button Keypad in System Design, the Properties pane appears. This pane allows custom configuration of the Keypad.

To configure a 3-Way Switch, see “Configuring Lights for 3-Way.”
Keypad Properties:
• **LED**—(button displayed when each button is selected in the Properties pane):
  - **Keypad Managed**—If checked, the LED state is controlled by pressing the buttons on the Keypad.
    - **Push Color**—Indicates the LED color when the button is pushed.
    - **Release Color**—Indicates the LED color when a pressed button is released. If unchecked, the LED state can be controlled by custom programming.
    - **On Color**—The button LED color when its state is On.
    - **Off Color**—The button LED color when its state is Off.

• **Network**—The current channel, gateway, MAC address and firmware version of the selected Dimmer or Switch. These boxes are not editable. To configure a 3-way Switch, see “Configuring Lights for 3-Way.”

### 2.6 Configuring Devices

The following sections provide steps for configuring Control4® devices. Configuration can mean anything from identifying the device to the network to configuring an option in the device.

#### 2.6.1 Guidelines for Configuring Devices

Using the Interviewer method or Composer Pro, you can add a Control4-supported device driver or a third-party driver to an existing project any time. See “Using the Interviewer Wizard to Build a Project” or “Using Composer Views to Build a Project” in the Composer Pro Getting Started.

**Note**: Some devices also require a free application from the Control4 4Store, for example, to take full advantage of Black & Decker KwikSet SmartCode locks you can download their free app. See the 4Store sections in the Control4 System User Guide (OS 2.0) for details.

For general guidelines about adding devices using the My Drivers tab, the Search tab, or the Online Database, see the following sections.

#### 2.6.2 Configuring Third-Party Devices

Use the Control4® Composer Pro System Design and Connections views to configure third-party devices using third-party device drivers.

Samples of third-party drivers and products have been described in previous releases of the Composer Pro User Guide. Due to the difficulty of upkeep, however, Control4 is no longer documenting detailed information about these devices and drivers, although they are still supported in a Control4 system.

Refer to previous versions of the documentation (Release 1.8 and earlier) for some third-party instructions; for example, Thermostats, Pool Controllers and security systems. The same basic steps apply to third-party drivers as with Control4 devices.
2.6.2.1 Procedure

To configure a third-party device:
1. Start Composer and connect to a Director.
2. Click System Design.
3. Locate and add the device to the project tree as described in “Using My Drivers or Search Tabs” or “Using the Online Database to Search for Drivers.”
4. Identify the device to the Control4 system.

2.6.3 Using My Drivers or Search Tabs

Use the Control4® Composer Pro System Design view, My Drivers or Search tabs to locate and add device drivers to the project tree.

2.6.3.1 Prerequisites
1. Read “Purpose of Device Drivers” and “Adding Items to the Project Tree” in Composer Pro Getting Started first to understand how to create a project tree for your project.
2. Install and connect the physical devices that need to be added to the Composer Pro project.

2.6.3.2 Procedure

To add devices:
1. Start Composer and connect to a Director.
2. Click System Design.
3. Click the object in the project tree where you want the device to reside; for example, you want to add a Controller to the Theater.
4. In the Items pane, click either the My Drivers or Search tab.
5. Double-click or drag the device to the System Design pane's project tree.
6. Make the necessary control, network or AV connections. See “Connecting a Device to the Network,” or “Connecting and Managing Control and AV Devices” in this document or “Connecting Devices” and “Testing the Device Connections” in the Composer Pro Getting Started for information.
7. Set any necessary device properties by selecting the device (see “Properties Pane” in Composer Pro Getting Started). If any properties are available for a device, they will display in the Properties pane.
8. If you are adding WiFi devices, refer to the Control4 training courses on the Control4 Dealer web site to learn how to install and configure WiFi.
2.6.4 Using the Online Database to Search for Drivers

Use the Control4® Composer Pro System Design view > Online Database tab to add devices to the project tree. Thousands of third-party device drivers are supported in the Control4 Device Driver Database. Drivers that are not in the Local Database can be found here if they exist.

Notes: Due to the large quantity of drivers in the database, Control4 has not validated every device driver provided. If you experience limited functionality using any device driver provided by Control4, please report the limitations to Control4 Technical Support. To report defects or enhancements, please contact Control4 (phone: 1-888-400-4072 or email: support@control4.com).

On the other hand, some device drivers have been certified. Look for the certification icon to the right of the driver in the list. Certified drivers appear at the top of the list if you search under manufacturer > all certified.

2.6.4.1 Prerequisites

1. Read through "Purpose of Device Drivers" and "Adding Items to the Project Tree" in Composer Pro Getting Started to understand how to create a project tree for your project.
2. Install the devices that need to be added to the project.

2.6.4.2 Procedure

To search for device drivers in the Online Database:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In System Design in the Items pane, click the Search tab.
4. Select the Online Database radio button.
5. To get a device, use the pull-down menus and select Device Type, then Manufacturer or All Manufacturers.
6. Select the room in the project tree, and double-click or drag the device to the project tree.
7. Configure the device by setting up the connections (Network and/or Control/AV tabs). See “Connecting and Managing Control and AV Connections” and “Connecting and Verifying Devices” for details.

2.6.5 Configuring Controllers

Use the Control4® Composer Pro System Design view to add and identify a Controller to the network connection. Refer to the sections below for the Controller type you want to configure. This section also covers other Controller-related tasks.

Note: Home Theater Controller, Home Controller HC-500, and Media Controller are no longer being sold. See "What’s New in This Release" for details.
2.6.5.1 Configure Home Controller HC-200, HC-300, or HC-1000

Use the Control4® Composer Pro System Design view to add and configure the 'HC' line of Home Controllers. These steps are basically the same for any Controller.

2.6.5.1.1 Prerequisites

Ensure that the Home Controller is installed as directed in the Control4 Home Controller HC-200 Installation Guide, Control4 Home Controller HC-300 Installation Guide, or Control4 Home Controller HC-1000 Installation Guide available on the Control4 Dealer web site.

2.6.5.1.2 Procedure

To add and configure a Home Controller HC-x00 or HC-x000 (for example, HC-200):

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the System Design view on the project tree, select the room where the Home Controller resides. In the Items pane > My Drivers tab > Controllers > double-click Home Controller (including the HC version you want to add, for example, Home Controller HC200) to add the object to the project tree. The Digital Media object is added automatically also.

Notes: Home Controller HC-1000 V2 and HC-1000 V3 use the same driver, e.g., HC1000V2/V3. Release 1.7.3 and later use these driver versions. For OS 2.0.1, the HC-200 (C4-HC200B-E-B-NR-1) and HC-300 (C4-HC300C-E-B) have been updated.

Note: If the Home Controller HC-200 is not listed in My Drivers, right-click in My Drivers and select Restore Default List. See “Using My Drivers or Search Tabs.”

4. In the Connections view, use the Network tab to make the necessary network connections. To do this, select the Home Controller object, and click the Identify button.
5. In Identify mode, go to the physical Home Controller, and press the specified button (listed below) on the device to identify the Controller to the Control4 system.
• **HC-200 only**: Press the **LINKS** button on the **Front** of the device.
• **HC-300 only**: Press the **ID** button on the **Back** of the device.
• **HC-1000 only**: Press the **ID** button on the **Front** of the device.

**Note**: The HC-1000 V3 has a Reset button on the front of the unit also, which differs from HC-1000 V1 and V2.

Example Home Controller (HC200) identification screen in the Theater:

![Identification Screen](image)

6. **Click Close** to exit the wizard.

7. To establish a **WiFi** network connection to this Controller, configure a **USB** WiFi Adapter for Home Controllers (sold separately). To do so, see "Configuring a WiFi Connection" or "Configure a USB WiFi Adapter for HC-300." Check with your Control4 Sales representative for details.

8. (Optional) For additional Home Controller setup, configure the **Properties**.
   a. In the System Design view project tree, select the **Home Controller** object.
   b. Modify the properties in the Properties pane:
      • **ZigBee Server**—Lets you view, enable and disable the Zserver. Edit ZigBee Configuration opens the ZigBee Server Settings dialog (updated for Release 1.8).
      • ZigBee Server (HC-200, HC-300 only)—Lets you select the Controller.
      • ZigBee Channel (HC-200, HC-300 only)—Lets you select the channel.
      • ZAPs (HC-200, HC-300 only)—Used for Release 1.8 upgrades from 1.7.4. See Composer Pro Software Release Update Instructions - Release 1.7.4 to 1.8.2 on the Control4.
      • **SD Video Mode**—Lets you set the Standard Definition video format that the Controller handles. NTSC mode is used in the U.S., and PAL mode is generally used in Europe. (Release 1.8 and earlier: This option is called Video Mode.)
2.6.5.2 Configure a USB WiFi Adapter for Home Controller HC-300

Use the Control4® Composer Pro Tools menu and Connections > Network tab to configure a USB WiFi adapter (sold separately).

USB WiFi Adapter for Home Controller HC-300 lets the Home Controller HC-300 communicate with system devices via a WiFi (wireless) network. The USB WiFi Adapter is recommended for use primarily with Secondary Controllers. It can be used also in a Primary Controller in a home-theater solution if no digital audio is streamed to other networked Speaker Points, Mini Touch Screens, or Controllers. Note: These steps can apply to the HC-500 also.

IMPORTANT: Control4 recommends that the USB WiFi Adapter not be used in a Primary Controller for a large system or a Controller that is streaming digital audio to other end points on the network. Those usage scenarios will be better served by an Ethernet connection to the Primary Controller.

2.6.5.2.1 Procedure

To connect and set up the USB WiFi Adapter for a Home Controller HC-300:

1. Connect the Home Controller HC-300 to the Ethernet network using an Ethernet CAT5 cable (this is a temporary connection to support set-up activities).
2. Plug the adapter to the USB port on the Controller.
3. Start Composer and connect to Director on Local Network.
   a. In the Tools menu, select System Manager.
   b. In the Devices pane, select the network address of the device where you want to set up the network configuration, and click Connect.
      • If the device’s network address is not on this list, click Refresh.
      • If it still does not appear, click Add to enter it manually.
      • If you do not know the network address, find it at the Connections view > Network tab.
   c. Click the Network tab, and click Configure.
4. Click Next when a Network Configuration wizard dialog appears.
   a. Continue through the wizard screens, and provide the following information appropriate for your system. Much of this information has to match that of your Wireless Access Point (WAP).
   b. Enter the new device name, but do not include spaces in the new name.
   c. Indicate the network type: Wireless (WiFi) network.
   d. Indicate the method for obtaining the DNS server address: DHCP or Static IP. Control4 recommends DHCP (automatically selected).
   e. Enter the SSID.
   f. Enter the WEP key (if any).
   g. Enter the encryption type (64 or 128).
   h. Click on a Key type (hex or ascii).
   i. Click Finish to complete the wizard and reboot the adapter to apply the network configuration changes.
5. Disconnect the Ethernet CAT5 cable from the Controller.
2.6.5.3 **Ensure that ZigBee Server Is Running**

Use the Control4® Composer Pro System Design view to check the Controller's properties and ensure that ZigBee server is running on a Controller.

*Note:* This does not apply to Home Controller HC-1000.

2.6.5.3.1 **Procedure**

To ensure the Controller properties are set correctly:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the Controller object for the properties to appear.
4. Ensure that the ZigBee server is running. If not, click the Enable button.

---

2.6.5.4 **Ensure That Video Mode Is Set Correctly**

Use the Control4® Composer Pro System Design view to check the Controller's properties and ensure that video mode is set correctly on a Controller. Video Mode lets you set the video format that the Home Controller handles.

2.6.5.4.1 **Procedure**

To ensure the Controller properties are set correctly:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the Controller object for the properties to appear.
4. Ensure that the video format is set correctly. NTSC mode is used in the U.S. and PAL mode is generally used in Europe.
2.6.5.5 Configure Multiple Controllers

Use the Control4® Composer Pro System Design view and Connections > Network tab to configure multiple Controller. If you have more than one (1) Controller in your Control4 system, you must designate one of them as the Primary Controller. The others will be Secondary Controllers.

2.6.5.5.1 Procedure

To add and configure multiple Controllers:

1. Start Composer and connect to a Director on Local Network.
2. From the Director dialog that appears, choose the Director's network address of the Primary Controller hardware you are setting up, and click Connect.
3. If you have multiple Controllers in the system, then when you make this selection, you are defining the Primary Controller to the system. The next time you launch Composer Pro, only the network address of the Director of the Primary Controller appears on this screen. If the correct address is not listed, click Add to add the address manually.
4. Click System Design.
5. In the System Design view, add the room where Controller resides.
6. While selecting a room, click the My Drivers tab under the Controller, and double-click Controller to add it to the system. Do the same for all the Controllers you plan to add to the system.
7. Click the **Connections** view.
8. In the Connections view, select the **Network** tab.
9. Select the first Controller listed, and click **Identify**.
10. On the dialog that appears, follow the on-screen instructions, and click **Next** to continue to identify the other Controllers you have added to the system.
11. When you finish identifying all of the Controllers and any other devices in your project, click **Close** to return to the Network tab in the Connections view.
12. In the IP Network Connections pane under Address make sure that all the devices in your project have an address on the list.
2.6.5.6 Configure an IO Extender

Use the Control4® Composer Pro System Design view to add and configure the IO Extender.

The Control4 IO Extender opens up a whole world of options in the Control4 system to control home theaters, distributed audio systems, video devices, motion sensors, and other devices that use infrared (IR), serial, contact, and relay connections and has digital and analog audio outputs. This device serves as a great companion to the Home Controller HC-1000 to expand output capability.

2.6.5.6.1 Prerequisites

Ensure that the IO Extender is installed and set up as directed in the Control4 IO Extender Installation Guide available on the Control4 Dealer web site.

2.6.5.6.2 Procedure

To add and configure an IO Extender:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the System Design view on the project tree, select the room where the IO Extender is installed. In the Items pane > My Drivers tab > Controllers, double-click IO Extender to add the object to the project tree.
4. In the Connections view, use the Network tab to make the necessary network connection. To do this, select the IO Extender object, and click the Identify button.
5. In Identify mode, go to the physical IO Extender, and press the same button highlighted in the Composer Pro illustration of the physical device to identify it to the Control4 system.

6. Click Close to exit the wizard.
7. (Optional) For additional IO Extender setup, you can adjust the volume for three (3) outputs.
   a. In the System Design view project tree, double-click the IO Extender object.
   b. Use the slider bar to adjust the Stereo Volume x as needed.
2.6.6 Configuring AV Devices

Configuring audio-video (AV) devices means that you want to 'identify' or make the device connection to the Control4® system so the devices communicate with the Controller and other devices in the system. Use the Control4 Composer Pro System Design and Connections views to configure audio-video devices.

These sections provide information about the specific AV devices.

“Configure an Audio Matrix Switch”
“Configure an Audio or AV Switch”
“Configure a Dock for iPod”
“Configure a 4-Zone Amplifier”
“Configure a Multi Channel Amplifier”
“Configure a Multi Tuner”
“Configure a Speaker Point”
“Configure a Media Player”

2.6.6.1 Configure an Audio Matrix Switch

Use the Control4® Composer Pro System Design and Connections views to identify an Audio Matrix Switch to the Control4 system. This device switches up to 16 input sources and up to 16 simultaneous zones.

2.6.6.1.1 Prerequisites

Ensure that the Home Controller is installed as directed in the Control4 Audio Matrix Switch Installation Guide on the Control4 Dealer web site.

2.6.6.1.2 Procedure

To add and configure an Audio Matrix Switch:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the Composer Pro, System Design view on the project tree, select the room where the Audio Matrix Switch - 16 resides.
4. In the Items pane > My Drivers tab > Audio/Video > Audio Switch double-click Audio Matrix Switch - 16 to add the object to the project tree.
5. In the Connections view, click the Network tab to make the necessary network connection. To do this, select the Audio Switch object, and click the Identify button.

**IMPORTANT**: Two (2) Audio Switch objects appear for identification. The Audio Switch can be identified by IP or ZigBee. The Audio Switch can communicate with the Control4 system either using the TCP/IP network or via the ZigBee network. Identify it to the network you want to use for communications. Do not identify it on both the IP and the ZigBee networks.
Note: If using a TCP/IP network and the latest shipping version of this device, you can set this device to either DHCP Client (default) or a client that uses Static IP. To change this setting, see the LCD screen menu on the device.

6. In Identify mode, go to the physical Audio Matrix Switch - 16, and press the Top button to identify it to the Control4 system.

7. Click Close to exit the wizard.
2.6.6.2 Configure an Audio or AV Switch

Use the Control4® Composer Pro System Design and Connections view to set up an audio or audio/video switch.

You can access the AV switch drivers from the System Design view in the Items pane by clicking the Search tab > Device Type: AV Switch or Audio Switch > Manufacturer: All Manufacturers. Use the Driver Wizard for additional support for your audio or AV switch.

2.6.6.2.1 Prerequisites
Install the Audio or AV Switch according to the manufacturer's instructions.

2.6.6.2.2 Procedure

To add and configure an Audio or Audio/Video Switch:

1. Install and set up the audio or audio/video switch and any associated hardware.
2. Add the audio or audio/video switch to your project from the System Design view. To locate the driver, click the Search tab > Device Type: Audio Switch or A/V Switch > Manufacturer: All manufacturers.

   Example: To add the applicable Knox AV switch (RS-232) driver, in the System Design view, click the Search tab > Device Type: A/V Switch > Manufacturer: All manufacturers.

3. Select the Audio Video or AV Switch object in the project tree to view the device properties for that object and make configuration changes if applicable.

   Example: The Knox AV Switch has no properties to modify, but other switches have properties, such as the Control4 Audio Switch.

4. Make any necessary network or control/AV connections as necessary for your configuration. See "Connecting and Managing Control and AV Connections" for details.
5. Modify any room connections as needed for your configuration.

2.6.6.3 Configure a Dock for iPod

Use the Control4® Composer Pro System Design view to configure the Dock for iPod. The Dock for iPod is a dock in which your iPod sits. With your iPod connected to the dock and the Control4 system, you can enjoy music throughout the home.

2.6.6.3.1 Prerequisites
Configure the Dock for iPod as directed in the Control4 Dock for iPod Tabletop Kit Setup Guide available on the Control4 Dealer web site.
2.6.6.3.2 **Procedure**

To add and configure Dock for iPod:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the System Design view select the room where the Dock for iPod resides.
4. On the My Drivers tab or Search tab, double-click iPod to add it to the project.
5. Identify the Dock for iPod. In the Connections view:
   a. Click the Network tab, select iPod in the list, and then click Identify in the IP Network Connections tab.
   b. Enter the IP address assigned to your Dock for iPod in the DriverWorks box that appears.
6. Connect the Dock for iPod.
   a. Click the Control/AV tab.
   b. Select iPod in the project tree.
   c. Define the correct video and audio connections.
7. Check the properties. In the System Design view, select iPod.
8. In the Properties pane, click the Properties tab. View and change the properties as needed:
   - **Cover Art**: Select the delay or Off.
   - **Now Playing Timer**: Select when to play.
   - **Room Off**: Select whether to stop the iPod from playing or pause it when Room Off is pressed on the System Remote Control.
   - **Debug Mode**: Use the drop-down list to select an option to log or print in this mode. Select from Print, Log, or Print and Log. This option is tied to the output options in the Lua tab (Step 9).
   - **Firmware Version**: Shows the version number for the firmware.
9. (Optional) See the **Documentation** tab for more information.
10. Click the Lua tab to view logging output.
2.6.6.4 **Configure a 4-Zone Amplifier**

Use the Control4® Composer Pro System Design and Connections views to add and configure a 4-Zone Amplifier. This device lets you enjoy up to four (4) zones (rooms) of music in the home.

2.6.6.4.1 **Prerequisites**

Ensure that the 4-Zone Amplifier is installed as directed in the Control4 4-Zone Amplifier Installation Guide available on the Control4 Dealer web site.

2.6.6.4.2 **Procedure**

To add and configure a 4-Zone Amplifier:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the Composer Pro, System Design view, select the room where the 4-Zone Amplifier resides.
4. In the My Drivers tab under Audio/Video > Amplifier, double-click Multi Channel Amplifier 4 Zone to add the object to the project tree.
5. Click Connections.
6. In the Connections view, use the Network tab to make the necessary network connection. To do this, select the Amplifier object, and then click the Identify button.

**IMPORTANT**: Two (2) Amplifier objects appear for identification. The Amplifier can be identified by IP only. The Amplifier can communicate with the Control4 system using the TCP/IP network.

**Note**: If you are using a TCP/IP network and the latest shipping version of this device, you can set this device to either DHCP Client (default) or a client that uses Static IP. To change this setting, see the LCD screen menu on the device.

7. In Identify mode, go to the physical 4-Zone Amplifier, and press the Select dial to identify the 4-Zone Amplifier to the Control4 system. Click Close.
8. (Optional) Configure additional 4-Zone Amplifier properties.
   a. In the System Design view on the project tree, select the Amplifier object.
   b. Modify the properties in the Properties pane:
Modifiable properties include:

- **Inputs Locked**— This locks Audio Inputs to set Audio Outputs. You can have one (1) Audio Input with several Audio Outputs, but an Audio Output may only have one Audio Input.
- **Device Firmware**— This displays the version of firmware.

### 2.6.6.5 Configure a Multi-Channel Amplifier

Use the Control4® Composer Pro System Design and Connections views to add and configure a Multi Channel Amplifier. This device provides eight (8) stereo inputs and outputs with full audio switching.

**Note**: In Release 1.8 and later, the Multi-Channel Amplifier does not work with ZigBee Pro. Configure this device with Ethernet.
2.6.6.5.1 **Prerequisites**

Ensure that the Multi Channel Amplifier is installed as directed in the *Control4 Multi Channel Amplifier Installation Guide* available on the Control4 Dealer web site.

2.6.6.5.2 **Procedure**

To add and configure a Multi Channel Amplifier:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the Composer Pro, System Design view on the project tree, select the room where the Multi Channel Amplifier resides.
4. In the Items pane > My Drivers tab > Audio/Video > Amplifier > double-click Multi Channel Amplifier - 16 to add the object to the project tree.
5. In the Connections view, click the Network tab to make the necessary network connection. To do this, select the Amplifier object, and then click the Identify button.

**IMPORTANT**: Two (2) amplifier objects appear for identification. The amplifier can be identified either by IP or by ZigBee. The amplifier can communicate with the Control4 system either using the TCP/IP network or via the ZigBee network. Identify it on the network you want to use for communications. Do not identify it on both the IP and the ZigBee networks.

**Note**: If using a TCP/IP network and the latest shipping version of this device, you can set this device to either DHCP Client (default) or a client that uses Static IP. To change this setting, see the LCD screen menu on the device.

6. In Identify mode, go to the physical Multi Channel Amplifier, and press the Select dial to identify the Multi Channel Amplifier to the Control4 system. After the device is identified, click Close.
7. (Optional) Configure additional Multi Channel Amplifier properties.
   a. In the System Design view on the project tree, select the Amplifier object.
   b. Modify the properties in the Properties pane:

   ![Image of System Design view]

   Modifiable properties include:

   - **Inputs Locked**—This locks Audio Inputs to set Audio Outputs. You can have one Audio Input with several Audio Outputs, but an Audio Output may only have one Audio Input.
   - **Device Firmware**—This displays the version of firmware.
   - **ZigBee Firmware**—This displays the version of firmware.
2.6.6.6 Configure a Multi Tuner – Versions 1 and 2

Use the Control4® Composer Pro System Design view to add and configure a Multi Tuner for Versions 1 and 2. This device provides up to three (3) audio signals and an optional satellite radio signal for multi-zone versatility.

Note: Refer to the Control4 XM Module for Multi Tuner V2 Installation Guide available on the Control4 Dealer web site for instructions about how to add and configure the XM Module that is compatible with Multi Tuner V2.

Notes: 1. If you are installing C4-TUN2-E-B or C4-TUN2-E-B_with_C4-XMOD, refer to Version 2 notes. 2. In Release 1.8 and later, the Multi-Tuner, Version 1 does not work with ZigBee Pro.

2.6.6.6.1 Installation Scenarios

There are several possible installation scenarios for the Multi Tuner products exist, depending on the version.

Version 1:

- Model AVM-TUN1-B (AM/FM tuner): Use the Multi Tuner in the My Drivers tab.
- Model AVM-TUN1X-B (AM/FM/XM tuner): Use the Multi Tuner w/XM in the My Drivers tab.
- XM module being added to an existing AVM-TUN1-B: Remove the original Multi-Tuner driver (AVM-TUN1-B) and replace it with Multi Tuner w/XM (AVM-TUN1X-B), then re-create the connections.

Version 2:

- Model C4-TUN2-E-B: Adding a C4-Multi Tuner V2 (with AM/FM tuners).
- Model C4-TUN2-E-B_with_C4-XMOD: Adding a Multi Tuner V2 (with AM/FM tuners) that also has the XM module installed.
- To add an XM Module to a tuner already installed, you must (1) delete the original tuners in the project tree, Tuner and Tuner 2 (which were added for C4-TUN2-E-B), (2) replace them with C4-TUN2-E-B_with_C4-XMOD (which adds Tuner, Tuner 2, and TunerXM to the tree), and (3) re-create the connections.

See the following sections as applicable to configure the tuner:

“Activate the XM Satellite Radio Service”

“Configure the Multi Tuner”

“Set Up Radio Stations”

2.6.6.6.1.1 Prerequisites

Ensure that the Multi Tuner, Version 1 or 2, is installed as directed in the Control4 Multi Tuner Installation Guide.
2.6.6.1.2 **Procedure**

**Activate the XM® Satellite Radio Service**

**Notes:**
- **Version 1:** Model # AVM-TUN1X-B or tuners upgraded with the XM Module Kit require a monthly subscription to the XM Satellite Radio service to receive XM radio channels.
- **Version 2:** Model # C4-TUN2-E-B_with_C4-XMOD or tuners upgraded with the XM Module Kit require a monthly subscription to the XM Satellite Radio service to receive XM radio channels.

**To subscribe and activate these services:**
1. Use the **Select** dial to tune the XM tuner to channel 0 and record the XM Radio ID (SDARS ID) that displays in the **LCD** window.
2. Contact XM Satellite Radio Inc., to subscribe to the XM radio service. Go to [http://www.xmradio.com](http://www.xmradio.com) or call XM’s Listener Care at 1-800-XMRADIO (800-967-2346), which requires your SDARS ID.
3. When instructed to do so by XM Satellite Radio Inc., tune the XM tuner to Channel 1 for about 20 minutes. When the tuner begins receiving XM stations, the LCD screen is enriched with station-specific information.
4. If the XM tuner is not receiving XM stations after 20 minutes:
   a. Move your antenna to a new location.
   c. Tune to Channel 1 again, and wait approximately 20 minutes for the LCD screen to refresh.

**Configure the Multi Tuner**

**Notes:** 1. If you are installing C4-TUN2-E-B or C4-TUN2-E-B_with_C4-XMOD, refer to the Version 2 notes. 2. If you are installing models AVM-TUN1-B or AVM-TUN1X-B, refer to Version 1 notes.

**To add and configure the Multi Tuner, V1 to an existing system:**
1. Start **Composer** and connect to a **Local** or **Remote Director**.
2. Click **System Design**.
3. In the System Design view, select the **room** in the tree where the Multi Tuner will reside.
4. In the My Drivers tab, go to Audio/Video > Tuner and double-click **Tuner**.
5. In the list displayed, double-click the applicable Control4 Multi Tuner model:
   - **Version 1:** Multi Tuner for the AVM-TUN1-B model.
   - **Version 1:** Multi Tuner w/XM for the AVM-TUN1X-B model or if adding the XM Module to the AVM-TUN1-B model.
   - **Version 2:** C4-TUN2-E-B or C4-TUN2-E-B_with_C4-XMOD if the XM Module upgrade kit [sold separately] is being used with an C4-TUN2-E-B model.
The following screen shows Version 2.

![Composer Pro User Guide](image)

6. Set the AV and Network connections:
   a. In the Connections view, click the Control/AV tab.
   b. For each tuner object in the project tree —such as Tuner, Tuner 2, and Tuner XM (XM Models only)—select each one, and ensure it is connected to a radio.
   c. For each tuner object in the project tree, select each Audio Video Output, and then drag them one-by-one onto an item in the Input Devices list below. The association displays in both lists.
   d. Click the Network tab, right-click on the tuner with the appropriate address type: IP or ZigBee, and then choose Identify.
The following screen shows Version 2.

**IMPORTANT:** (Version 1 only) Two (2) Tuner objects appear for identification. The Tuner can be identified either by IP or by ZigBee. The Multi-Tuner, V1 can communicate with the Control4 system either using the TCP/IP network or via the ZigBee network. Identify it on the network you want to use for communications. Do not identify it on both the IP and the ZigBee networks.

7. Press the *Select* dial on the Multi Tuner front panel to identify this *device* to the system. After a brief delay, the network address for this Multi Tuner is added to the Device list.

8. Verify that Multi Tuner is an accessible device. In the System Design view, select the *room*, and then click the *Properties* tab and *Audio Video Devices* tab to view the Available Audio Sources list for that room.
9. Go to the next section.

Set Up Radio Stations
To provide users easy access to radio stations throughout the system and to enrich the graphical interfaces, use Composer Pro to search for radio broadcasts and refresh your Navigators.

1. Start Composer and connect to Director on Local Network.
2. Click Media.
3. Select a radio in the Media list (on the left): XM Radio, FM Radio, or AM Radio, and then click Search.
4. When the dialog box appears, enter your zipcode in the box, and then click Search. The available stations display in the Search Results list.
5. In the Search Results list, select the stations to add to the Navigators (On-Screen Navigator, Wireless Touch Screen, Mini Touch Screen, System Remote Control, and LCD Keypad). Select them individually or click Select All.
6. Click OK. The selected stations populate the XM, FM, or AM Radio pane.
7. Repeat Steps 3 through 6 for the remaining radios.
8. Refresh the Navigators (see Composer Pro Getting Started for details). Each radio station you select is now available in the Navigators.

For XM Tuner models:
1. Click System Design, and select Tuner XM in the project tree.
2. In the Properties tab, ensure that the tuner has a good signal and that the SDARS ID matches the Radio ID listed on Channel 0 of the tuner.

2.6.6.1.3 Configure an XM Module for Multi Tuner V2
Refer to the Control4 XM Module for Multi Tuner V2 Installation Guide on the Control4 Dealer web site for instructions about how to add and configure this module.

2.6.6.7 Configure Speaker Point – Ethernet or Wireless
Use the Control4® Composer Pro System Design and Connections views to add and configure Speaker Point. This device provides output to multiple speakers while connected to a Control4 system.

2.6.6.7.1 Prerequisites
1. Ensure that the Speaker Point device is installed as directed in the Control4 Speaker Point Installation Guide available on the Control4 Dealer web site.
2. Connect the Speaker Point device to an Ethernet CAT5 cable to set up the Ethernet or wireless connection.

IMPORTANT TIP: The Speaker Point device requires an Ethernet connection for initial setup.
2.6.6.7.2 Procedure
The following procedures teach you to configure:

- Speaker Point for Ethernet use, or
- Speaker Point for WiFi use.

2.6.6.7.2.1 Configure Speaker Point for Ethernet Use
To add and configure an Ethernet Speaker Point to a Control4 project:

Note: By default, Speaker Point is configured for Ethernet use. If you are using WiFi, however, also follow the instructions in the section, "Configure Speaker Point for WiFi Use" later in this section.

1. Start Composer and connect to a Director.
2. Click System Design.
3. In System Design on the project tree, select the room where the Speaker Point resides.
4. In the My Drivers tab, go to Audio/Video > Speaker Point, and then double-click to add the Speaker Point object to the project tree.
5. In the Connections view, use the Network tab to make the necessary network connection. To do this, select the Speaker Point object, and click Identify.

6. In Identify mode, go to the physical Speaker Point, and press the front panel button to identify the Speaker Point to the Control4 system. Click Close.
7. Ensure that the room connections are set correctly for the room.

**Note**: When you add a Speaker Point, Audio or AV switch, or Mini Touch Screen to a room, by default the Audio End Point is assigned by the first device added to the room. When you add a Receiver to a room, it is automatically set or reset as the Audio End Point.

a. To get to Room Connections, go to Connections and select the room.
b. Verify that the Audio End Point setting matches the intended setup of your Control4 system. The Room Connections appear in the center pane. If you are setting up a custom configuration, adjust the Room Connections accordingly. For more information about Room Connections, see "Connecting Rooms."

8. Preset Treble, Bass, and Balance. In either the System Design or Connections view, double-click the Speaker Point object in the project tree to bring up its on-screen controls, and then click to make the adjustments for Treble, Bass, and Balance (supported values are 0 - 100).

9. (Optional) Configure the Speaker Point properties.
Modifiable properties include:

- **Local Amp Mode** not checked (default). When the box is not checked, the Speaker Point streams the analog input through the Control4 audio distribution system, making the source digitized and available to other audio zones throughout the house.

- **Local Amp Mode** checked. When the box is checked, it sets the Speaker Point in Local Amp Mode, enabling a local input source outputs directly, is not digitized and provides audio and video in one room. This enables devices that provide audio and video, such as a DVD, VCR, or Satellite Receiver to send output to the amplified audio outputs: the Right and Left Speakers in the room. If Local Amp Mode is not checked and you try to watch video in the room, the video or audio sound will be out of sync with the video.

10. Now configure the system for WiFi. By default, the Speaker Point is configured for Ethernet use. If you are using WiFi, follow the instructions next.

2.6.6.7.2.2 **Configure Speaker Point for WiFi Use**

To configure Speaker Point for WiFi use:

1. Start Composer and connect to Director on Local Network.
2. In the Tools menu, select System Manager.
3. In the Devices pane, select the network address of the device you want to configure, and click Connect.

4. Click the Network tab, and click Configure.

**Tip:** If the device’s network address is not on this list, click Refresh. If it still does not appear, click Add to enter it manually. If you don’t know the network address, look in the Tools menu > Network Tools.
5. Click **Next** when a Network Configuration wizard dialog appears.
6. If desired, enter a new name for the device, and click **Next**.

**IMPORTANT TIP:** If the device has already been identified on the Control4 system, and you change the name (on this wizard screen), identify the device again. Until it is identified again, the **Controller** cannot recognize the name and will not be able to communicate with the device.
7. Select the type of network you want the device to be a part of, and click **Next**.

**Example:** Wireless network.

8. Select the method to obtain an IP address, such as **DHCP** (first option) or **Status IP** (second option) distribution, and click **Next**.

**Example:** Obtain an IP address automatically using **DHCP**.

9. Select the method to obtain the DNS server address automatically, and click **Next**.

**Example:** Obtain the DNS server address automatically.

10. Enter the **Network Name** (SSID) of your **wireless access point**.
11. Use the pull-down menu to indicate your Data encryption preference (**64** or **128** bit).
12. Select the Key type (**hex** or **ASCII**).
13. Enter your **Network Key** (WEP Key), and click **Test**.

- **Hex:** 64 bit (10 digits) or 128 bit (26 digits)—acceptable values 0 - 9, A- F
- **ASCII:** 64 bit (5 digits) or 128 bit (13 digits)—acceptable values ASCII characters

**Example:**
- **Network Name** (SSID): <name of wireless access point>
- **Data encryption:** wep64
- **Key Type:** hex
- **Network Key** (in hex): ABCDE12345.

**Note:** If the hex Network Key you insert is not valid, a screen with a red exclamation point comes up. In this case, enter your key again.
14. Click **Test** to test your network connection. If it fails, follow the on-screen instructions.
15. Click **Finish** when you come to the “Congratulations! You have successfully changed your network configuration” screen.
16. At this time, the system reboots. Do not disconnect any temporary Ethernet cables until the device has successfully rebooted and is powered on.
17. If you are using the WiFi to communicate to your Control4 Controller, disconnect the Ethernet CAT5 cable.

### 2.6.6.8 Configure a Media Player

Use the Control4® **Composer** Pro System Design and Connections views to add and configure a Media Player. This device auto-scans videos. A Media Player (such as Netgear EVA8000) lets you play media that is stored on a network drive or available through the Internet to a TV.

The Media Player driver lets the **Control4 system** interact with the Media Player hardware through one of the Control4 System Remote Controls. The driver also supports the video playback functionality of the hardware, allowing the Control4 Navigators to be used to select a video title.

**Note**: In Release 1.8, the Media Player (V1) does not work with ZigBee Pro. Use Media Player V2. The Media Player V2 driver is C4-MP2-E, located in the driver database.

#### 2.6.6.8.1 Prerequisites

Ensure that your Media Player is installed as directed in the **Media Player Installation Guide** and **Media Player User Guide** shipped with the hardware or available on the Control4 Dealer web site.

#### 2.6.6.8.2 Procedure

To configure a Media Player in your system:

1. Add a **Network File Storage** driver to your Composer Pro project (available on the My Drivers tab), then configure the properties including browsing to the network location. For information on adding and configuring network file storage, see “Using External Storage Devices.” The network location must be an open share location (no password required). The Network File Storage driver supports both audio and video content.
2. Start **Composer** and connect to a **Director**.
3. Click **System Design**.
4. In the System Design view, select the **room** where the Media Player resides.
5. On the My Drivers tab or Search tab, double-click the **Media Player** model (such as Media Player EVA8000) to add it to the project.
6. Identify the Media Player. In the Connections view:
   a. Click the **Network** tab, select **Media Player** in the list, and then click **Identify** in the IP Network Connections tab.
   b. Enter the **IP address** assigned to your Media Player in the box provided.
7. Connect the Media Player.
   a. Click the Control/AV tab.
   b. Select Media Player in the project tree.
   c. Define the correct video and audio connections.

8. Do one of the following:
   - Scan the videos. In the Media view, scan the videos that are in video_ts format:
     - Select Video Media under the network file share where you want to add the videos.
     - Click Scan. The scan operation identifies the video_ts format video files, adds them to the media database, and automatically associates the video metadata including cover art. When the scan completes, the videos in video_ts format are available for playback from the Navigators.
   - Manually add the videos. In the Media view, manually add videos that are in formats other than video_ts. Video formats other than video_ts that are supported by your Media Player can be added to the media database in Composer Pro manually.
     - Select Video Media under the network file share where you want to add the videos.
     - Click New, and then choose the Browse option next to the Location text box in the pop-up window. A new pop-up window will appear.
     - In the pop-up window, select the drop-down menu for Files of type, and then select the *.* option.
     - Select the file format you want to add to the database.

When the videos in alternative video formats are added to the system manually, those videos become available for playback from the Navigators.

**Note:** When using a System Remote Control Version 2, the Cancel button is mapped to the EVA8000 Back button and the DVR button toggles between aspect ratios.

9. Check the properties. In the System Design view, select the Media Player.
10. In the Properties pane, click the Properties tab.
    Modifiable properties include:
    - **Debug Mode:** Use the drop-down list to select an option to log or print in this mode. Select from Print, Log, or Print and Log. This option is tied to the output options in the Lua tab (see Step 13).
    - **Resolution:** Use the drop-down list to select the video output screen resolution. Auto indicates that the device negotiates over HDMI.
2.6.7 Configuring Lighting and Keypads

Use the Control4® Composer Pro System Design and Connections views to configure Dimmers, Switches and Keypads.

**Tip:** Double- and triple-tap events apply to the Control4 Dimmers, Switches, and Keypads. When you tap a button consecutively two (2) or three (3) times for about one-half of one second the events fire. You can use these events for programming without requiring the more complex programming logic tied to timers and button 'Press/Release' events.

**Note:** When programming using double and triple-tap events, be aware that Press and Release events also occur when double and triple-tap events occur. Plan your programming using these events so that they don't conflict with the intended outcome. In most cases, when using double and triple-tap programming events, don't program on the Press and Release events.

These sections provide information about how to configure the lights or Keypads types for your Control4 system.

"Configure a 2, 3 or 6-Button Keypad"
"Configure a Wireless Switch or Dimmer or an Inline Dimmer"
"Configure a Wireless Outlet Dimmer"
"Configure a Wireless Outlet Switch"
"Configure a Wireless Outlet Switch for Power Sensing AV Devices"
"Configure a Wireless LCD Keypad"
"Configure an Ethernet LCD Keypad"
2.6.7.1 Configure a 2-, 3-, or 6-Button Keypad
Use the Control4® Composer Pro System Design and Connections views to configure Keypads.

Note: To configure a 2, 3, or 6-Button Keypad for a 3-way switch, see “Configuring Lights for 3-Way,” “Configuring a 2-Button Keypad as a 3-Way Light,” or “Configuring a 3-Button Keypad to Control a 3-Way Light.”

2.6.7.1.1 Prerequisites
Ensure that the Keypad is installed as directed in the Control4 Wireless 2, 3, or 6-Button Keypad Installation Guide available on the Control4 Dealer web site.

2.6.7.1.2 Procedure
To add and configure a 2, 3, or 6-Button Keypad:
1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the room where the 2, 3, or 6-Button Keypad resides.
4. In the Items pane > My Drivers tab > User Interface > double-click 2, 3, or 6 Button Keypad to add the object to the project tree.
5. Click Connections.
6. Click the Network tab to make the necessary network connection. To do this, select the 2, 3, or 6 Button Keypad object, and click the Identify button.
7. In Identify mode, go to the physical 2, 3, or 6-Button Keypad, and press the Top button to identify the Keypad to the Control4 system.

8. Click Close to exit the wizard.

9. (Optional) To configure the properties, click System Design. In the project tree, select the 2, 3, or 6 Button Keypad object for the properties to appear.

Modifiable properties include (depending on the device selected):

- **LED**
  - **Keypad Managed.** If Keypad Managed is checked, the LED state is controlled by pressing the buttons on the Keypad. This is the factory default for the Keypad.

If you uncheck Keypad Managed, the following buttons can be activated.
- **Set LED State ON**—Ensures that the LED state is ON with the selected color.
- **Set LED State OFF**—Ensures that the LED state is OFF with the selected color.
- **Set LED Color**—Color when LED is ON or OFF. You can change the color in conjunction with the ON state and OFF state (Set LED State ON and Set LED State OFF).

**Follow Bound Color.** If checked, the Keypad LED colors are set based on the device to which they are bound using the button-link bindings. This lets the Installer specify the On/Off colors for the Keypad LEDs independently of the device to which they are linked.

**Example:** a 3-way Dimmer or Switch can be set to use the same colors for On and Off for the two (2) physical Dimmers if requested by the customer.

**Push Color**—Indicates the LED color when the button is pushed.

**Release Color**—Indicates the LED color when a pressed button is released.

If Keypad Managed is unchecked, the LED state can be controlled by custom programming.

**On Color**—LED color when button is pressed to ON.

**Off Color**—LED color when button is pressed to OFF.

- **Network**
  - **Channel**—Lets you view the channel on which the device is running.
  - **Gateway**—Lets you view the device’s Gateway address.
  - **MAC**—Lets you view the device’s MAC address.
  - **Version**—Lets you view the version of the firmware you are running.

### 2.6.7.2 Configure a Wireless Switch or Dimmer or an Inline Dimmer

Use the Control4® Composer Pro System Design and Connections views to configure Switches and Dimmers.

#### 2.6.7.2.1 Prerequisites

Ensure that the Wireless Switch or Dimmer or Inline Dimmer is installed as directed in the Control4 Wireless Switch Installation Guide, Control4 Wireless Dimmer Installation Guide or Control4 Inline Dimmer Installation Guide available on the Control4 Dealer web site.

#### 2.6.7.2.2 Procedure

To add and configure a Wireless Switch or Dimmer or an Inline Dimmer:

1. Start Composer and connect to a **Director**.
2. Click **System Design**.
3. In the **project tree**, select the **room** where the Wireless Switch, Wireless Dimmer or Inline Dimmer resides.
4. In the items pane > **My Drivers tab** > **Lighting** > **Light** > double-click **Wireless Switch, Wireless Dimmer or Control4 LCZ-IL51-B** (Inline Dimmer; search under Local Database) to add the object to the project tree.
Note: The Wireless ELV Dimmer uses the same driver as the Wireless Dimmer.

5. When the device shows up in the project tree, you can rename it to Switch or Dimmer (or whichever name works the best). See the following Switch example.

6. Click Connections.

7. Click the Network tab to make the necessary network connection. To do this, select the Wireless Switch, Wireless Dimmer or Inline Dimmer object, and click the Identify button as shown below.
8. In Identify mode, go to the physical Switch or Dimmer, and press the Top button to identify the Switch or Dimmer to the Control4 system. The network address appears in the IP Network Connections pane.

9. Click Close to exit the wizard.

10. (Optional) To configure the properties, click System Design. In the project tree, select the Switch or Dimmer object for the properties to appear as shown below.

Modifiable properties include:

Properties (these properties are available only on the Wireless Dimmer and the Inline Dimmer)
- **Click Ramp Rate Up**—The rate in seconds when the light ramps from OFF to ON.
- **Click Ramp Rate Down**—The rate in seconds when the light ramps from ON to OFF.
- **Preset Level**—The percentage of the load to which the Dimmer ramps when turned on.
Advanced Properties

LED

- **Top Color On**—The LED color for the top LED when the LED state is ON.
- **Top Color Off**—The LED color for the top LED when the LED state is OFF.
- **Bottom Color On**—The LED color for the bottom LED when the LED state is ON.
- **Bottom Color Off**—The LED color for the bottom LED when the LED state is OFF.

Options

- **Top LED Link**—If checked, swap on and off the state and color on the top LED.
- **Bottom LED Link**—If checked, swap the on and off state and color on the bottom LED.
- **Buttons Attached**—If checked, pressing the buttons on the Dimmer or Switch directly controls the connected load.
- **LED Attached**—If checked, the LED state is controlled by the button presses. If unchecked, the LED state and colors can be controlled by custom programming.

Hold Ramp Rate

- **Up**—The rate in seconds when the load increases when the Top button is held down.
- **Down**—The rate in seconds when the load decreases if the Bottom button is held down.

Network—The current Channel, Gateway, MAC address and firmware Version of the selected Dimmer or Switch. These fields are not editable.

The following properties apply to the **Wireless Dimmer** only.

**Load Profile**—The minimum and maximum load settings for light output which includes the Cold Start Level and time. Test the settings to determine what fits best with your bulb type. Click **Set** to save your changes.

**Note**: The Navigators show 0% to 100% even though the settings may be set at Minimum On Level percent at 25%, and the Max On Level percent at 80%.

**Minimum On Level (%)**—Use the drop-down box to select the minimum % in 1% increments. The default is 0. The minimum level can vary, depending on the light type (incandescent, florescent, LED, etc.).

This is especially important in compact florescent (CLF) and LED lighting that sometimes have a minimum threshold for producing visible light that could be anywhere from the 10 – 40% range. Some loads will flicker or pulse right at their minimum threshold.

**Example**: A bulb doesn’t produce visible light until it reaches 20%. The minimum On to 25% will ensure a clean On transition.

**Cold Start Level (%)**—Use the drop-down box to select the start level in 1% increments. The default is 0. This level is set above the Minimum on level % setting.

This setting is mainly applicable to CFL loads. Switching from an Off state to On sometimes exhibits a higher visible light threshold than after the CFLs have been on and have warmed up. If a Cold Start % is set (above the Minimum On %), the Dimmer cleanly jumps to that level from Off.
to On. However, when the Dimmer has been on for the time period designated by the Cold Start timer, the Dimmer can ramp below the Cold Start On % to the minimum On%.

**Example:** Fluorescent lights go on, warm up, and then will dim down to the Minimum On Level % setting. Tapping the keypad on a 2-button Dimmer sets the light to its preset level. If you press and hold the button, the light checks the Minimum On Level % setting.

**Cold Start Time (milliseconds)**—Use the drop-down box to select the time in milliseconds. The default is 0. This is the length of time a light takes to warm up before it dims down to the Cold Start Level setting.

**Max On Level (%)**—Use the drop-down box to select the maximum % light level in 1% increments. The default is 100. This is the level set for maximum light output, such as 100%. This setting enables capping of the light level for a given load below 100%, either to enhance bulb life or better match the light level in a given living space. This is an absolute maximum level rather than the Preset On level, which can be bypassed.

11. To apply the changed settings on the Properties tab, click the **Apply to**... button and select the room's Dimmer or Switch.
12. Click **OK**.

### 2.6.7.3 Changing LED Colors on a Switch or Dimmer

After you verify that your connections are correct in Control4® Composer Pro, you can set the properties and configure the system to meet the home control needs.

#### 2.6.7.3.1 Procedure

**To change the LED colors on a Switch or Dimmer:**

1. Start Composer and connect to a **Director**.
2. Click **System Design**. In the project tree, select the Switch or Dimmer object for the properties to appear.
3. For each LED light (Top and Bottom), click the color box to set a different color for the On and Off states.

- **Top Color**: On. The LED color for the Top LED when the LED state is On.
- **Top Color**: Off. The LED color for the Top LED when the LED state is Off.
- **Bottom Color**: On. The LED color for the Bottom LED when the LED state is On.
- **Bottom Color**: Off. The LED color for the Bottom LED when the LED state is Off.

**Tip**: You can change the LED lights based on programming. See the Programming view > Switch or Dimmer objects for the events available. Also, see the actions available for both Switch and Dimmer.
2.6.7.4 Changing LEDs on 2-, 3-, or 6-Button Keypads

Use the Control4® Composer Pro System Design view to change Keypad button LEDs.

2.6.7.4.1 Procedure

To change the LED colors on the Keypad:
1. Start Composer and Connect to a Director.
2. Click System Design.
3. In the project tree, select a 2, 3, or 6 Button Keypad object for the properties to appear.

4. To change the LED color when the button is pushed and released, check Keypad Managed.
   • If Keypad Managed is checked, the LED state is controlled by pressing the buttons on the keypad.
   • If Keypad Managed is unchecked, the LED state can be controlled by custom programming.

Tip: You can change the LED lights based on programming. See the Programming view > 2 Button Keypad, 3 Button Keypad, or 6 Button Keypad objects for the events available. Also, see the actions available for the Keypads.

5. Select the Push and Release colors:
   a. Click the color box next to Push Color for a color dialog to appear where you can select the color. The Push Color indicates the LED color when the button is pushed.
   b. Click the color box next to Release Color for a color dialog to appear where you can select the color. The Release Color indicates the LED color when a pressed button is released.

2.6.7.5 Configure a Wireless Outlet Switch

Use the Control4® Composer Pro System Design and Connections views to configure a Wireless Outlet Switch.
Configure and use the Wireless Outlet Switch and its plugged-in device to:
- Control a plugged-in audio/video component (such as a DVD player or VCR) or other electrical equipment controlled by IR.
- Control power to a plugged-in relay device (such as a pump) or other household appliances.
- Switch a plugged-in lamp On or Off.

Each Wireless Outlet Switch has two (2) outlets: Outlet 1 and Outlet 2. When the Wireless Outlet Switch is plugged into the wall, Outlet 1 is on the left and Outlet 2 is on the right.

2.6.7.5.1 Prerequisites
1. Ensure that the Wireless Outlet Switch is installed as directed in the Control4 Wireless Outlet Switch Installation Guide available on the Control4 Dealer web site.
2. Ensure that your project has a Control4 Controller added and identified in the Control4 system.

2.6.7.5.2 Procedure
To add and configure a Wireless Outlet Switch:

**IMPORTANT TIP:** When configuring the Wireless Outlet Switch, add two (2) drivers: one for the Wireless Outlet Switch and one for the plugged-in device. In addition, define the connection between these two (2) devices in the Connections view > Control/AV tab.

1. Start Composer and connect to a Director.
2. Click System Design.
3. Select the My Drivers tab > Lighting > Light, and double-click the Wireless Outlet Switch object to add it to the project tree.
4. Identify the Wireless Outlet Switch on the network.
5. Click Connections.
6. From the IP Network Connections pane, select the Wireless Outlet Switch, and click Identify.
7. When the Identify screen appears, go to the physical Wireless Outlet Switch, and press the top right button four (4) times to identify the Wireless Outlet Switch to the network.
8. Add a driver for the device you want to plug into the Wireless Outlet Switch as appropriate for your use (power sensing, power controlling, or switching lamps on and off).

**Power Sensing (Contact)**—Using the Wireless Outlet Switch, the system can sense the power state of the plugged-in device, and the Controller can send the appropriate control commands based on the power state.

For a plugged-in device:

a. Add the appropriate driver.

b. (For an AV device only, such as a DVD Player) Edit the driver to change the power management option in the driver for the correct connection to appear in the Connections view. To do this, see the "Change Power Management Options." For other devices, it is not necessary to edit the driver.

c. Before you can use power sensing for the plugged-in device, perform Power Learning on the Wireless Outlet Switch for the plugged-in device on the appropriate outlet. For information about Power Learning when using the Wireless Outlet Switch power sensing, see “Perform Power Learning” later in this section.
Power Control (Relay)—For a plugged-in device, add the appropriate driver.

**Example:** Add a relay device by selecting a Pump to the project. Go to the System Design view in the Items pane, select the My Drivers tab > Motorization, and double-click the Pump object.

Lighting—For a lamp, add an Outlet Light to the project. Go to the System Design view in the Items pane. Select the My Drivers tab > Lighting > Light, and double-click the Outlet Light object.

**Note:** This is the Outlet Light object, and not the regular Wireless Outlet Switch object.
9. **Define** the connection between the Wireless Outlet Switch and the plugged-in device.
   a. Click the Control/AV tab.
   b. Make a connection between the **Wireless Outlet Switch** and the device that is plugged into the Wireless Outlet Switch. Make this connection for any of these three (3) possible uses: power sensing (contact), power control (relay), and switching a lamp On or Off.
   c. In the Connections view, select the **device** that is plugged into the Wireless Outlet Switch.
   d. From the top screen, **drag** the appropriate connection to the Wireless Outlet Switch connection on the bottom screen.

   **Example:** Connection between the Wireless Outlet Switch and the Light Outlet.
2.6.7.5.3 Perform Power Learning

To enable use of the power-sensing features, configure your Wireless Outlet Switch to read the power state of the devices that you plug into it.

To perform Power Learning:

1. Follow the steps in the previous section.
2. **Turn Off** the device plugged into the Wireless Outlet Switch.
3. **Push** and **hold** the button on the Top panel of the Wireless Outlet Switch until the two (2) LEDs toggle Orange On/Off, alternating back and forth.
4. **Choose** an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that corresponds to that outlet number lights up.

   **Example**: If a device is plugged into Outlet 1, release the button when LED 1 lights up. Upon doing so, the LED you chose flashes orange, indicating that the Wireless Outlet Switch is learning a steady state of the device (such as On or Off). When the LED turns solid orange, the Wireless Outlet Switch has learned the steady state, but has not yet determined whether the state is On or Off.

5. With the LED now solid orange, turn the device plugged into the Wireless Outlet Switch to an **On** state. The LED again flashes orange while the Wireless Outlet Switch is learning the On state of the device. When learning completes, the LED glows solid orange again to indicate the Wireless Outlet Switch has learned the steady state.
6. With the LED now solid orange again, turn the device **Off**. The LED flashes orange to indicate the Wireless Outlet Switch is waiting for a steady state. When the device reaches a steady state, the LED glows red to indicate the Wireless Outlet Switch has learned the Off state.
7. With the LED now solid red, turn the device **On** again. The LED flashes orange to indicate it is waiting for a steady state. When the device reaches a steady state, the LED glows green to indicate the Wireless Outlet Switch has learned the On state.
8. With the LED now solid green, press the **button** on the Wireless Outlet Switch one time to save and exit the Power Learning mode.

   **IMPORTANT TIP**: You can use a quick button press during any step of this process prior to the LEDs turning solid Red or Green to exit the Learning mode without saving.

9. Repeat the steps to configure the other outlet (Outlet 1 or 2) as needed for any additional plugged-in device.

**Note**: To unlearn a device, press the **button** nine (9) times, but use with care; this will reset both outlets.
2.6.7.6 Configure a Wireless Outlet Switch for Power Sensing AV Devices

Use the Control4® Wireless Outlet Switch and its plugged-in device to:

- **Control** a plugged-in audio/video component (such as a DVD player or VCR) or other electrical equipment controlled by IR.
- **Control** power to a plugged-in relay device (such as a pump) or other household appliances.
- **Switch** a plugged-in lamp On or Off.

The instructions below describe how to configure an Outlet Switch in Composer Pro for a Samsung television. For instructions about how to configure the other actions, see Configure a Wireless Outlet Switch.

Each Wireless Outlet Switch has two (2) outlets: Outlet 1 and Outlet 2. When the Wireless Outlet Switch is plugged in to the wall, Outlet 1 is on the left and Outlet 2 is on the right.

**IMPORTANT**: When configuring the Wireless Outlet Switch, you need to add two (2) drivers:

- One (1) for the Wireless Outlet Switch
- One (1) for the plugged-in device.

In addition, define the connection between these two (2) devices in the Connections view > Control/AV tab.

**2.6.7.6.1 Prerequisites**

1. Ensure that your project has a Control4 Controller added and identified on the Control4 system.
2. Ensure that the Wireless Outlet Switch object is added to the project tree, and is identified on the Control4 system.
3. Ensure that the AV device, such as the Samsung Television object, is added and configured for the device.
2.6.7.6.2 Procedure

To configure a Wireless Outlet Switch to use an AV device, do the following:

Select the Power Codes
1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, right-click the Samsung Television and select Edit Driver. The Driver Wizard opens.
4. In the Driver Wizard, check Has power feedback.
5. Change the Power Management option to Contact sensor; ensure that the Send toggle code is selected.
6. Click Codes.
   a. In Codes under Default Commands, make sure Power On and Power Off, or Power Toggle items are not checked. If they are, any programming you do in conjunction with power using the Wireless Outlet Switch and the television is invalid.
   b. Click Finish.
   c. Click next to close the window.

IMPORTANT: Don’t click back to check if the selection was saved because it refreshes the screen; in that case, you will need to redefine what you just defined.
Define the Connection

7. **Define** the connection between the Wireless Outlet Switch and the plugged-in device (Samsung Television).

8. To do this, in the **Connection > Control & Audio Video Connections** pane select the Samsung Television that is plugged into the Wireless Outlet Switch.

9. From the top screen drag the **Contact Sensor** connection to the correct sensor on the Wireless Outlet Switch in the bottom screen.

10. Before you can use power sensing for the plugged-in device, perform **Power Learning** on the Wireless Outlet Switch for that plugged-in device on the appropriate outlet. Those steps are explained next.
   a. Turn off the **device** plugged into the Wireless Outlet Switch.
   b. Push and hold the **button** on the top panel of the Wireless Outlet Switch until the two (2) LEDs toggle orange On/Off, alternating back and forth.
   c. Choose an outlet to configure (Outlet 1 or 2) by releasing the **button** when the LED that corresponds to that outlet number lights up.

   **Example:** If a device is plugged into Outlet 1, release the button when LED 1 lights up. The LED you chose flashes orange, indicating that the Wireless Outlet Switch is learning a steady state of the device (such as On or Off). When the LED turns solid orange, the Wireless Outlet Switch has learned the steady state, but has not yet determined whether the state is On or Off.

   d. With the LED now solid orange, turn the device plugged into the Wireless Outlet Switch **On**. The LED again flashes orange while the Wireless Outlet Switch is learning the On state. When the learning completes, the LED glows solid orange again to indicate the Wireless Outlet Switch has learned the steady state.
   e. With the LED now solid orange again, turn the device **Off**. The LED flashes orange to indicate the Wireless Outlet Switch is waiting for a steady state. When the device reaches a steady state, the LED glows red to indicate that the Wireless Outlet Switch has learned the Off state.
   f. With the LED now solid red, turn the device **On** again. The LED flashes orange to indicate it is waiting for a steady state. When the device reaches a steady state, the LED glows green to indicate the Wireless Outlet Switch has learned the On state.
   g. With the LED now solid green, **press** the button on the Wireless Outlet Switch **one time** to save and exit the Power Learning mode.

   **Tip:** Use a quick-button press during any step prior to the LEDs turning solid red or green to exit the Power Learning mode without saving.

11. Repeat these steps to configure the other outlet (Outlet 1 or 2) as needed for any additional plugged-in device.

12. To unlearn a device, press the button nine (9) times, but use with care; as this will reset both outlets.
2.6.7.7 **Configure a Wireless Outlet Dimmer**

Use the Control4® Composer Pro System Design and Connections views to configure a Wireless Outlet Dimmer. Configure the Wireless Outlet Dimmer to control and dim lamps.

2.6.7.7.1 **Prerequisites**

1. Ensure that the Wireless Outlet Dimmer is installed and set up as directed in the Control4 Wireless Outlet Dimmer Installation Guide available on the Control4 Dealer web site.
2. Ensure that your project has a Control4 Controller added and identified on the Control4 system.

2.6.7.7.2 **Procedure**

To add and configure a Wireless Outlet Dimmer:

**Note:** Each Wireless Outlet Dimmer has two (2) outlets: Outlet 1 and Outlet 2. When the Wireless Outlet Dimmer is plugged into a wall, Outlet 1 is on the left and Outlet 2 is on the right.

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the Items pane > My Drivers tab > Lighting > Light double-click the Wireless Outlet Dimmer object driver to add to the project.
4. Double-click the Outlet Light twice to add one for each outlet.
5. Ensure that three (3) objects are added to the project tree:
   - One (1) for the Wireless Outlet Dimmer
   - Two (2) other objects representing Outlet 1 and Outlet 2 (Light 1 and Light 2)
6. In the Connections view, use the Network tab to make the necessary network connection. To do this, select the Wireless Outlet Dimmer object, and click the Identify button.
7. In Identify mode, go to the physical Wireless Outlet Dimmer and press the Button four (4) times to identify the device to the network. The address appears in the box.
8. Click Close to exit the wizard.
9. To configure the properties, click System Design. In the project tree, select the Wireless Outlet Dimmer object to view the device properties.
   - LEDs—Enabled/Disabled radio buttons—Lets you enable or disable the LED lights on the Wireless Outlet Dimmer.
   - Networking
     - Channel—Lets you view the channel that the device is using to communicate on the network.
Gateway—Lets you view the Gateway that the Wireless Outlet Dimmer is using on the network.

MAC—Lets you view the MAC address that the Wireless Outlet Dimmer is using on the network.

Version—Lets you view the Wireless Outlet Dimmer version.

2.6.7.8 Configuring Lights for 3-Way

Rather than creating programming to tie lighting variables and Control4® 3-way lights together, you can use a simplified lighting configuration to set up lighting control. In the Connections view, you can configure global changes in Composer Pro Properties, and configure 3-way lights by dragging the lighting and control connections.

The Push and Release features available on the Keypads let you dim lights like a Dimmer.

Tip: To find out how to configure global changes for lights and other devices, see "Accessing Properties from the Project Tree" in Composer Pro Getting Started.

2.6.7.8.1 Configuring a 2-Button Keypad as a 3-Way Light

Use the Control4® Composer Pro Connections view to configure a 3-way light using a 2-button Keypad.

Example: Configure a 2-Button Keypad to turn On (Top button) and turn Off (Bottom button) a Dimmer, and to use the Push/Release function available on the 2-Button Keypad to dim a light.

2.6.7.8.1.1 Prerequisites

1. Ensure that your Controller hardware is added and identified to the Control4 system.
2. Ensure that you have a 2-Button Keypad and Dimmer (or Switch) added and identified to the project.

2.6.7.8.1.2 Procedure

To configure a 2-Button Keypad as a 3-way light:

1. Start Composer and connect to a Director.
2. Click Connections.
3. Select the 2-Button Keypad in the project tree.
4. In the Control & Audio Video Connections pane under Control Inputs, click the Button 1 Link connection, and drag it to the Dimmers’s Top Button Link in the bottom pane.
5. Click the Button 2 Link connection, and drag it to the Dimmer’s Bottom Button Link in the bottom pane.
6. Test to ensure that the 2-Button Keypad turns the light on and off, and that the Push/Release functions dim the light.

2.6.7.8.2 Configuring a 3-Button Keypad to Control a 3-Way Light

Use the Control4® Composer Pro Connections view to configure a 3-Button Keypad to use a toggle for a 3-way light.

**Example:** Configure a 3-Button Keypad to toggle the light On and Off. Use Push and Release to dim and brighten the light as desired.

2.6.7.8.2.1 Prerequisites

1. Ensure that your Controller hardware is configured properly, and that the 3-Button Keypad and Dimmer (or Switch) are added to the project and identified.
2. Ensure that you have a 3-Button Keypad added and identified to the project.

2.6.7.8.2.2 Procedure

To configure a button on a 3-Button Keypad to control a 3-way light:

1. Start Composer and connect to a Director.
2. Click Connections.
3. In the project tree, select the 3-Button Keypad.
4. In the Control & Audio Video Connections pane, drag the Button 1 Link connection from the top list over the light’s Toggle Button Link in the bottom list.
5. Test to ensure that the 3-Button Keypad turns the light On and Off, and that the Push/Release functions dim the light.

2.6.7.9 Examples of Configurations
This section provides examples about how to change various Switch, Dimmer and Keypad settings in the Control4® system.

2.6.7.9.1 Configure a Wireless Outlet Switch for Power Sensing AV Devices
Use the Control4® Wireless Outlet Switch and its plugged-in device to:

- **Control** a plugged-in audio/video component (such as a DVD player or VCR) or other electrical equipment controlled by IR.
- **Control** power to a plugged-in relay device (such as a pump) or other household appliances.
- **Switch** a plugged-in lamp On or Off.

The instructions below describe how to configure an Outlet Switch in Composer Pro for a Samsung television. For instructions about how to configure the other actions, see “Configure a Wireless Outlet Switch.”

Each Wireless Outlet Switch has two (2) outlets: Outlet 1 and Outlet 2. When the Wireless Outlet Switch is plugged in to the wall, Outlet 1 is on the left and Outlet 2 is on the right.
IMPORTANT: When configuring the Wireless Outlet Switch, you need to add two (2) drivers:

- One (1) for the Wireless Outlet Switch
- One (1) for the plugged-in device.

In addition, define the connection between these two (2) devices in the Connections view > Control/AV tab.

2.6.7.9.1.1 Prerequisites

1. Ensure that your project has a Control4 Controller added and identified on the Control4 system.
2. Ensure that the Wireless Outlet Switch object is added to the project tree, and is identified on the Control4 system.
3. Ensure that the AV device, such as the Samsung Television object, is added and configured for the device.

2.6.7.9.1.2 Procedure

To configure a Wireless Outlet Switch to use an AV device:

Select the Power Codes

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, right-click the Samsung Television and select Edit Driver. The Driver Wizard opens.
4. In the Driver Wizard, check Has power feedback.
5. Change the Power Management option to Contact sensor; ensure that the Send toggle code is selected.
6. Click Codes.
   a. In Codes under Default Commands, make sure Power On and Power Off, or Power Toggle items are not checked. If they are, any programming you do in conjunction with power using the Wireless Outlet Switch and the television is invalid.
   b. Click Finish.
   c. Click next to close the window.

IMPORTANT: Don’t click back to check if the selection was saved because it refreshes the screen; in that case, you will need to redefine what you just defined.
Define the Connection

7. Define the connection between the Wireless Outlet Switch and the plugged-in device (Samsung Television).

8. To do this, in the Connection > Control & Audio Video Connections pane select the Samsung Television that is plugged into the Wireless Outlet Switch.

9. From the top screen drag the Contact Sensor connection to the correct sensor on the Wireless Outlet Switch in the bottom screen.

10. Before you can use power sensing for the plugged-in device, perform Power Learning on the Wireless Outlet Switch for that plugged-in device on the appropriate outlet.
   a. Turn off the device plugged into the Wireless Outlet Switch.
   b. Push and hold the button on the top panel of the Wireless Outlet Switch until the two (2) LEDs toggle orange On/Off, alternating back and forth.
   c. Choose an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that corresponds to that outlet number lights up.

   Example: If a device is plugged into Outlet 1, release the button when LED 1 lights up. The LED you chose flashes orange, indicating that the Wireless Outlet Switch is learning a steady state of the device (such as On or Off). When the LED turns solid orange, the Wireless Outlet Switch has learned the steady state, but has not yet determined whether the state is On or Off.

   d. With the LED now solid orange, turn the device plugged into the Wireless Outlet Switch On. The LED again flashes orange while the Wireless Outlet Switch is learning the On state. When the learning completes, the LED glows solid orange again to indicate the Wireless Outlet Switch has learned the steady state.

   e. With the LED now solid orange again, turn the device Off. The LED flashes orange to indicate the Wireless Outlet Switch is waiting for a steady state. When the device reaches a steady state, the LED glows red to indicate that the Wireless Outlet Switch has learned the Off state.
f. With the LED now solid red, turn the device **On** again. The LED flashes orange to indicate it is waiting for a steady state. When the device reaches a steady state, the LED glows green to indicate the Wireless Outlet Switch has learned the On state.

g. With the LED now solid green, **press** the button on the Wireless Outlet Switch **one time** to save and exit the Power Learning mode.

**Tip:** Use a quick-button press during any step prior to the LEDs turning solid red or green to exit the Power Learning mode without saving.

11. Repeat the steps to configure the other outlet (Outlet 1 or 2) as needed for any additional plugged-in device.
12. To unlearn a device, press the **button** nine (9) times, but use with care; as this will reset both outlets.

### 2.6.8 Configuring Navigators

Use the Control4® Composer Pro System Design and Connections views to configure Navigators for the Control4 system.

**Note:** You may have noticed a "Commissioning Remote Control SR-250" driver in the Online Database; this driver is not used for residential customers.

These subsections provide information about configuring System Remote Controls and Touch Screens:

- "Configure System Remote Control Version 3 SR-150"
- "Configure System Remote Control Version 3, SR-250"
- "Configure an Ethernet LCD Keypad"
- "Configure a Wireless LCD Keypad"
- "Configure an Ethernet Mini Touch Screen"
- "Configure a WiFi Mini Touch Screen"
- "Configure a 7-inch Portable Touch Screen"
- "Configure a 7-inch Tabletop or Wall-Mounted Touch Screen"

#### 2.6.8.1 Configure System Remote Control SR-150

Use the Control4® Composer Pro System Design and Connections views to add and identify this device.

**Prerequisites**

Ensure that the SR-150 is installed as directed in the *Control4 System Remote Control System Remote Control SR-150 Setup Guide*.

**Procedure**

To add and configure an SR-150:
1. Start **Composer** and connect to a **Director**.
2. Click **System Design**.
3. In the **project tree**, select the **room** where the System Remote Control resides. In the Items pane > **My Drivers** tab > **User Interface** > double-click **System Remote Control SR-150** to add the object to the project tree.

4. Click **Connections**.
5. In the Connections view, click the **Network** tab to make the necessary network **connection**.
6. Select the **System Remote Control SR-150** object, and click the **Identify** button.
7. In Identify mode, go to the physical System Remote Control, and press the Red 4 button to identify the System Remote Control to the **Control4** system.

![System Remote Control SR-150](image)

**Note:** To complete the identification process, the System Remote Control must be on the same **ZigBee** channel as the **Controller**, and the Controller must have Zserver enabled. To change the ZigBee channel on the remote, see Step 12.

8. When the MAC address appears in the window, click **Close**.
9. (Optional) To configure the properties, click **System Design**.
10. In the project tree, select the **System Remote Control** object.
11. View and change the properties in the Properties pane.

    **Note:** Press any button on the System Remote Control to display the configurable property values in the Properties pane. Because the SR-150 has no window, some of the options below are not supported in the SR-150.

Modifiable properties include:

- **Screen Backlight**—Lets you set the light level of the backlight. The default is 0%.
- **Keypad Backlight**—Lets you set the light level of the backlight. The default is 0%. Click **Set Level**.
- **Sleep Mode**—Lets you configure sleep mode settings. The default is five (5) seconds, but can be extended to 60 seconds. Select **Wake on Movement** if you want the SRC to wake up when moved.
- **Batteries**—Lets you view the battery level on your System Remote Control.
- **Network**—Lets you view the System Remote Control’s ZigBee channel, *gateway*, MAC address and firmware version.
  - **Channel**—Displays your ZigBee channel (1-15).
  - **Gateway**—Displays the MAC address of the ZigBee server (usually your controller unless you specify differently).
  - **MAC**—Displays the remotes own MAC address.
  - **Firmware Version**—Displays the current firmware version of the remote.
- **Watch/Listen Button Behavior**—If you select one of the options below, the following *action* occurs when you press the **Watch** button.
  - **No Action**—When you press the **Watch** button, nothing happens. This option can be tied to *programming* a button (see the section below).
  - **Select Most Recently Used Device**—Lists the last three (3) devices; e.g., **DVD** player, Media Player, Television, etc.

12. Change the System Remote Control settings as needed at the physical System Remote Control SR-150 using the applicable button-press sequence:

   - **Change Backlight Level**—To increase or decrease the backlight level, press **Room Off, 0, 0, 1** (in that order). After a single blink of Room Off, use the up or down arrows to set the level, then press **Room Off** to exit Edit mode and save the setting.
   - **Check ZigBee Channel**—To determine the current ZigBee channel, press **Room Off, 0, 0, 3** (or **Room Off, 7, 4, 7**) (in that order), and then count the blinks of Room Off. The number of blinks corresponds with the channel number.
   - **Change ZigBee Channel**—To change the ZigBee channel to match the Controller’s channel (which is sometimes changed to improve reception), press **Room Off, 0, 0, 2** (in that order). After a double blink of Room Off, enter the new ZigBee channel on the keypad (supported channels are 01 - 14), and then press **Room Off** to exit Edit mode and save the setting.
   - **Reset to Factory Defaults**—To reset all settings to the factory defaults (including ZigBee channel), press **Room Off, 9, 9, 9**.
2.6.8.1.3 Program the System Remote Control SR-150 Programmable Buttons

On the System Remote Control SR-150, you can program six (6) buttons (Red, Green, Yellow, Blue, *, and #) to perform programmed activities. The buttons can be programmed to execute any of the AV device's macros or IR codes or be programmed by room.

2.6.8.1.3.1 Procedure

To program the buttons:

1. Start Composer and connect to a Director.
2. Click System Design.
3. Ensure that you have the following devices in your project:
   - Controller
   - System Remote Control SR-150
   - An AV device to be controlled
4. Click Connections.
5. Click the Network tab. Ensure that the Controller and the System Remote Control are both network identified.
6. Program the programmable buttons (Red, Green, Yellow, Blue, *, or #) either based on the selected AV device or the selected room.

Based on AV Device:

a. Click System Design.

b. Select an AV device to display the device's Properties page.

c. On the device's Properties page, choose Code or Macro for the button you want to program, and then choose a code or macro from the drop-down list.

d. Edit the Help text as needed, and then choose Set.

Note: Help text describes custom programming to users in the House option in any of the Navigators.
Example: (1) In System Design, select Disc Changer. (2) In the Red button, choose Code. (3) From the drop-down list, choose Subtitle. (4) Choose the Set button to create a Subtitle button.

Based on Room:

- Click Programming.
- Select a room in the Device Events pane.
- Select the Commands radio button in the <Room> Events pane.
- Use the drop-down menu to select a command or button (example, Blue Button).
- In the Actions pane, build the script using the items to program the actions in the selected room when the selected command or button is used.

2.6.8.2 Configure System Remote Control SR-250

Use the Control4® Composer Pro System Pro Design and Connections views to add and identify this device.

2.6.8.2.1 Prerequisites

Ensure that the System Remote Control SR-250 is installed as directed in the Control4 System Remote Control SR-250 Setup Guide available on the Control4 Dealer web site.

2.6.8.2.2 Procedure

To add and configure an SR-250:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the room where the System Remote Control resides. In the Items pane > My Drivers tab > User Interface > double-click System Remote Control SR-250 to add the object to the project tree.

4. Click Connections.
5. In the Connections view, click the **Network** tab to make the necessary network **connection**.

6. Select the **System Remote Control SR-250** object, and click the **Identify** button.

7. In Identify mode, go to the physical System Remote Control, and press the Red 4 button to identify the System Remote Control to the Control4 system.

8. When the MAC address appears in the window, click **Close**.

9. (Optional) To configure the properties, click **System Design**.

10. In the project tree, select the **System Remote Control** object.

11. View and change the properties in the Properties pane.

**Note:** To complete the identification process, the System Remote Control must be on the same **ZigBee** channel as the **Controller**, and the Controller must have **Zserver** enabled. To change the ZigBee channel on the remote, see Step 12.

**Tip:** You can also change most of these settings on the SR-250 using **Info > Config**.

Modifiable properties include:

- **Screen Backlight**—Lets you set the light level of the screen's backlight. Choose a percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click **Set Level**.

- **Keypad Backlight**—Lets you set the light level of the keypad's backlight. Choose a percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click **Set Level**.

- **Sleep Mode**—Lets you set how long the System Remote Control stays awake after no activity. The default setting is five (5) seconds, but can be extended to 60 seconds. Select **Wake on movement** to wake the SR-250 up when moved.

- **Batteries**—Lets you view the battery level (strength in %) of your System Remote Control.

- **Network**—Lets you view the System Remote Control's ZigBee channel, **gateway**, MAC address and firmware version.
• **Channel**—Displays your ZigBee channel (1-15), which should match the ZigBee channel set for the Controller.

• **Gateway**—Displays the MAC address of the ZigBee server (usually your Controller unless you specify otherwise).

• **MAC**—Displays the System Remote Control's own MAC address.

• **Firmware Version**—Displays the current firmware version of the System Remote Control.

• **Watch/Listen Button Behavior**—If you select one of the options below, the following *action* occurs when you press the **Watch** button.

  • **No Action**—If you select this option and you press the **Watch** button, nothing happens. This option can be tied to *programming* a button (see the section below).

  • **Select Most Recently Used Device**—Lists the last three (3) devices; e.g., DVD player, Media Player, Television, etc.

  • **Show Device List**—Lists the source device of the selection.

12. (Conditional) Change ZigBee Channel: If you need to change the ZigBee channel to match the Controller’s channel or to improve reception, do the following at the System Remote Control SR-250.

   If the System Remote Control is NOT identified, follow these steps:

   a. Press buttons 2, 4, 8, 6, #, *, and then press the **List** button (in that order) to get into Edit mode.
   b. Use the **up** or **down** arrows to pick the ZigBee channel.
   c. Press **Select** to change the ZigBee channel.
   d. Press **CNCL** to exit Edit mode.

   If the System Remote Control IS identified, follow these steps.

   a. Press the **List** button once or twice to display the menu options.
   b. Press buttons 2, 4, 8, 6, #, * and then press the **List** button (in that order) to get into Edit mode.
   c. Use the **up** or **down** arrows to pick a ZigBee channel.
   d. Press **Select** to change the ZigBee channel.
   e. Press **CNCL** to exit Edit mode.
2.6.8.2.3  Program the SR-250 Programmable Buttons

On the System Remote Control SR-250, you can program six (6) buttons (Red, Green, Yellow, Blue, *, and #) to perform programmed activities. These buttons can be programmed to execute any of the AV device’s macros or IR codes or can be programmed by room.

2.6.8.2.3.1  Procedure

To program the SR-250 programmable buttons:
1. Start Composer and connect to a Director.
2. Click System Design.
3. Ensure that you have the following devices in your project:
   - Controller
   - System Remote Control SR-250
   - An AV device to be controlled
4. Click Connections.
5. Click the Network tab. Ensure that the Controller and the System Remote Control are both network identified.
6. Program the programmable buttons (Red, Green, Yellow, Blue, *, or #) either based on the selected AV device or the selected room.

   Based on AV Device:
   a. Click System Design.
   b. Select an AV device to display the device’s Properties page.
   c. On the device’s Properties page, choose Code or Macro for the button you want to program, and then choose a code or macro from the drop-down list.
   d. Edit the Help text as needed, and then choose Set.
Note: Help text describes custom programming to users in the House option in any of the Navigators.

Example: (1) In System Design view, select Disc Changer. (2) In the Red button, choose Code. (3) From the drop-down list, choose Subtitle. (4) Choose the Set button to create a Subtitle button.

Based on Room:
  a. Click Programming.
  b. Select a room in the Device Events pane.
  c. Select the Commands radio button in the <Room> Events pane.
  d. Use the drop-down menu to select a command or button (example, Blue Button).
  e. In the Actions pane, build the script using the items to program the actions in the selected room when the selected command or button is used.

2.6.8.2.4 Program the SR-250 Paging Feature

Configure the Beep paging feature for this System Remote Control version through programming. Use this feature to page a lost System Remote Control. You can program a Keypad or a custom button to cause the System Remote Control to beep when pressed.

2.6.8.2.4.1 Procedure

To program the paging feature for this System Remote Control:

1. Start Composer and connect to a Director.
2. Click Programming.
3. Select the Event that you want to use to start the page. Example: To select a Keypad button press, first select the Keypad in the Device Event pane, and then select the button in Events.
4. In the Actions list, select System Remote Control SR-250.
5. In the Commands list, choose an action below for the System Remote Control, and then drag the green arrow to the Script pane.
• **Beep until button press**—The System Remote Control beeps until you press one of its buttons.
• **Beep for X seconds (<254)**—The System Remote Control beeps until X seconds have elapsed or you press one of its buttons.
• **Stop Beep**—The System Remote Control stops beeping.

6. Click **Execute**.

### 2.6.8.2.5 Change the Order of Watch/Listen Sources

#### 2.6.8.2.5.1 Procedure

To change the order of your customer’s sources when they press Watch/Listen:
1. In Composer Pro, click **System Design**.
2. In the project tree, click the **room** to control.
3. Click the **Navigator** tab.
4. From the Menu (left side), select the function to change; for example, **Watch** or **Listen**.
5. Select the item in ‘Device Visibility and Display Order,’ and then click **Modify**.
6. Change to the desired order, and then click **OK**.

### 2.6.8.3 Configure an Ethernet LCD Keypad

Use the Control4® Composer Pro System Design and Connections views to add and configure this device.

#### 2.6.8.3.1 Prerequisites

1. Ensure that the **Ethernet LCD** Keypad is installed as directed in the Control4 LCD Keypad Installation Guide available on the Control4 Dealer web site.
2. Ensure that your project has a Control4 **Controller** added and identified in the Control4 system.
2.6.8.3.2 Procedure

To add and configure an LCD Keypad:
1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the room where the System Remote Control resides. In the Items pane > My Drivers tab > User Interface > double-click LCD Keypad POE to add the object to the project tree.
4. Click Connections.
5. In the Connections view, click the Network tab to make the necessary network connection.
6. Select the LCD Keypad POE object, and click the Identify button.
7. In Identify mode, go to the physical LCD Keypad, and press the Select dial to identify the Keypad to the Control4 system.
8. Click Close.
9. (Optional) To configure the properties, click System Design.
10. In the project tree, select the LCD Keypad POE object.
11. View and change the properties in the Properties pane.
Modifiable properties include:

**Backlight**
- **Level**—Use the up or down arrows to set the light level of the backlight. You can change the brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.

**Sleep Mode**
- **Enable**—Use the up or down arrows to configure the Sleep Mode settings by enabling you to turn On and Off the Sleep Mode option.
- **Wait**—Use the up or down arrows to select how many seconds to wait before Sleep Mode is activated (0-90 seconds).
- **Backlight Level**—Use the up or down arrows to select the percent of backlight brightness while in Sleep Mode; the backlight turns off when the device isn’t used.

**Select Dial Settings**
- **Sound**—Use the drop-down menu to view and select the options.
  - **On Selection**—Makes the click noise when you move to the next line; if you scroll down a list, it will click every time you move down one line.
  - **Always on**—Clicks by the amount of movement on the Select dial.
  - **Off**—Never clicks.
- **Scroll Direction**—Changes the direction the Select dial rotates to move up or down lists.
  - **Clockwise**—Down, Counterclockwise - Up
  - **Clockwise**—Up, Counterclockwise - Down

**Device**—(cannot be modified; the displays depends on the type you have)
- **Firmware Version**—Displays the current firmware version the device is on.
- **Channel**—Lets you view the channel on which the device is running.
- **MAC**—Lets you view the device’s MAC address.
- **Gateway**—Lets you view the device’s Gateway address.

### 2.6.8.4 Configure a Wireless LCD Keypad

Use the Control4® Composer Pro System Design and Connections views to add and configure this device.

**Note:** In Release 1.8 and later, the Wireless LCD Keypad does not work with ZigBee Pro. Use a POE (Ethernet) connection.

#### 2.6.8.4.1 Prerequisites
1. Ensure that the Wireless LCD Keypad is installed as directed in the Control4 Wireless LCD Keypad Installation Guide available on the Control4 Dealer web site.
2. Ensure that your project has a Control4 Controller added and identified in the Control4 system.

#### 2.6.8.4.2 Procedure

To add and configure a Wireless LCD Keypad:
1. Start Composer and connect to a Director.
2. Click System Design.
3. In the **project tree**, select the **room** where the **System Remote** Control resides. In the Items pane > My Drivers tab > User Interface > double-click **LCD Keypad** to add the object to the project tree.

4. Click **Connections**.

5. In the Connections view, click the **Network** tab to make the necessary network connection.

6. Select the **LCD Keypad** object, and click the **Identify** button.

7. In Identify mode, go to the physical LCD Keypad, and press the **Select** dial to identify the Keypad to the Control4 system.

   **Note:** The software displays the Mini **Touch Screen**, but when you identify the device on this screen, you are identifying the LCD Keypad.

8. Click **Close**.

9. (Optional) To configure the properties, click **System Design**.

10. In the project tree, select the **LCD Keypad** object.

11. View and change the properties in the Properties pane.
Modifiable properties include:

**Backlight**
- **Level**—Use the up or down arrows to set the light level of the backlight. You can change the brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.

**Sleep Mode**
- **Enable**—Use the up or down arrows to configure the Sleep Mode settings by enabling you to turn On and Off the Sleep Mode option.
- **Wait**—Use the up or down arrows to select how many seconds to wait before Sleep Mode is activated (0-90 seconds).
- **Backlight Level**—Use the up or down arrows to select the percent of backlight brightness while in Sleep Mode; the backlight turns off when the device isn’t used.

**Select Dial Settings**
- **Sound**—Use the drop-down menu to view and select the options.
  - **On Selection**—Makes the click noise when you move to the next line; if you scroll down a list, it will click every time you move down one line.
  - **Always on**—Clicks by the amount of movement on the Select dial.
  - **Off**—Never clicks.
- **Scroll Direction**—Changes the direction the Select dial rotates to move up or down lists.
  - **Clockwise**—Down, Counterclockwise - Up
  - **Clockwise**—Up, Counterclockwise - Down
Device—(cannot be modified)

- **Firmware Version**—Displays the current firmware version the device is on.
- **Channel**—Displays your ZigBee channel (1-15), which should match the ZigBee channel set for the Controller.
- **Gateway**—Displays the MAC address of the ZigBee server (usually your Controller unless you specify otherwise).
- **MAC**—Displays the LCD Keypad's own MAC address.

2.6.8.5 **Configure an Ethernet Mini Touch Screen**

Use the Control4® Composer Pro System Design and Connections views to add and configure this device.

2.6.8.5.1 **Prerequisites**

1. Ensure that the Ethernet Mini Touch Screen is installed as directed in the Control4 Mini Touch Screen Installation Guide available on the Control4 Dealer web site.
2. Ensure that your project has a Control4 Controller added and identified in the Control4 system.

2.6.8.5.2 **Procedure**

To add and configure a Mini Touch Screen:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the room where the Mini Touch Screen resides. In the Items pane > My Drivers tab > User Interface > double-click Mini Touch Screen to add the object to the project tree.
4. Click Connections.
5. In the Connections view, click the Network tab to make the necessary network connection.
6. Select the Mini Touch Screen object, and click the Identify button.
7. In Identify mode, go to the physical Mini Touch Screen, and press the Select dial to identify the Mini Touch Screen to the Control4 system.

8. Click Close.

9. (Optional) To configure the properties, click System Design.

10. In the project tree, select the Mini Touch Screen object.

11. View and change the properties in the Properties pane.
Modifiable properties include:

**Backlight Level**—Use the up or down arrows to set the light level of the backlight. You can change the brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.

**Backlight Preset Level**—Lets you set the default backlight level. If you ever restart or power the Mini Touch Screen again, this is the backlight level it would go to.

**Click Enabled**—Emits an audible clicking noise as you turn the dial.

**Volume Control Follows Selected Room**—Lets you select other rooms aside from the one that contains the Mini Touch Screen, and change its volume when leaving the room.

### 2.6.8.6 Configure a WiFi Mini Touch Screen

Use the Control4® Mini Touch Screen and Composer Pro System Design and Connections views to add and configure this device.

*Note*: The Mini Touch Screen interface has not been upgraded to the same interface as that used in the Touch Screens and On-Screen Navigator in OS 2.0 and later.

#### 2.6.8.6.1 Prerequisites

1. Ensure that the WiFi Mini Touch Screen is installed as directed in the Control4 Mini Touch Screen Installation Guide.
2. Ensure that the project has a Control4 Controller add and identified in the Control4 system.

#### 2.6.8.6.2 Procedures

To add a WiFi Mini Touch Screen to the project:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the room where the Mini Touch Screen resides. In the Items pane > My Drivers tab > User Interface > double-click Mini Touch Screen V2 to add the object to the project tree.
To configure WiFi on the Mini Touch Screen:
1. Go to the WiFi Mini Touch Screen, and configure the WiFi Mini Touch Screen to connect to a wireless access point:
   b. Press Add to enter the WiFi Mini Touch Screen properties screen.
2. Enter the Network (SSID) into the SSID text box.
   Example: Your personal Wireless Access Point (WAP) Name.
3. To use encryption for system security, place the cursor in the WEP Key text box. In the keypad box that appears, enter your 10-digit WEP key in hex for 65-bit encryption or 26-digit WEP key in hex for 128-bit encryption. The colons automatically appear as you insert the digits.
   The Mini Touch Screen only supports hex—acceptable values 0 - 9, A- F. ASCII characters are not supported on the Mini Touch Screen. If set up your access point using ASCII characters, determine the hex value.
4. Press OK.
   a. At the Network: Wireless Network Properties screen, use the drop-down menu to change the WEP Key Length to 64 bit or 128 bit as appropriate for your system.
   b. Click OK.
5. Your new SSID and WEP key loads. Select the SSID just entered, and press Enable > OK.

To identify the Mini Touch Screen to the network:
1. Return to Composer Pro, and click the Connections view.
2. In the Connections view, click the Network tab to make the necessary network connection.
3. Select the Mini Touch Screen V2 object, and click the Identify button.
4. In Identify mode, go to the physical Mini Touch Screen, and press the Select dial to identify the Mini Touch Screen to the Control4 system.

5. Click Close.

6. (Optional) To configure the properties, click System Design.

7. In the project tree, select the Mini Touch Screen object.

8. View and change the properties in the Properties pane.

Modifiable properties include:

**Backlight Level**—Use the up or down arrows to set the light level of the backlight. You can change the brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.

**Backlight Preset Level**—Lets you set the default backlight level. If you ever restart or power the Mini Touch Screen again, this is the backlight level it would go to.

**Click Enabled**—Emits an audible clicking noise as you turn the dial.

**Volume Control Follows Selected Room**—Lets you select other rooms aside from the one that contains the Mini Touch Screen, and change its volume when leaving the room.

**Version**—Indicates the Touch Screen version.

### 2.6.8.7 Configure a 7” Portable Touch Screen

Use the Control4® Composer Pro System Design and Connections views to add and configure this device.

#### 2.6.8.7.1 Prerequisites

1. Ensure that the 7” Portable Touch Screen is installed as directed in the Control4 7” Portable Touch Screen Installation Guide available on the Control4 Dealer web site.

2. Ensure that your project has a Control4 Controller added and identified in the Control4 system.

#### 2.6.8.7.2 Procedure

To add and configure an 7” Portable Touch Screen:

1. Start Composer and connect to a Director.

2. Click System Design.

3. In the project tree, select the room where the Touch Screen resides. In the Items pane > My Drivers tab > User Interface > double-click Touch Screen - 7” Portable to add the object to the project tree.

4. Click Connections.

5. In the Connections view, click the Network tab to make the necessary network connection.

   **Note:** If this Touch Screen will be providing audio output, the Touch Screen needs to be identified as an Audio end point for the room.

6. Select the Touch Screen - 7” Portable object, and click the Identify button.

7. In Identify mode notice the Touch Screen button highlighted in the Composer Pro pane. Go to the physical 7” Portable Touch Screen, and press the button indicated in Composer Pro to identify the Touch Screen to the Control4 system.

8. When the address appears on the Composer Pro screen, click Close.
9. (Optional) To configure the properties, click **System Design**.
10. In the project tree, select the **Touch Screen - 7” Portable** object.
11. View and change the properties in the Properties pane.

Modifiable properties include:

- **Backlight Level**—Use the up or down arrows to set the light level of the backlight. You can change the brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.
- **Backlight Preset Level**—Lets you set the default backlight level. If you ever restart or power the Mini Touch Screen again, this is the backlight level it would go to.
- **Button Animation Enabled**—Lets you select a button to glow.
- **Volume Control Follows Selected**—Lets you select other rooms aside from the one that contains the Touch Screen, and change its volume when leaving the room.
- **Wake on motion**—Select to wake up the Touch Screen when it is moved.

### 2.6.8.8 Configure a 7” Tabletop Touch Screen

Use the Control4® Composer Pro System Design and Connections views to add and configure this device.

#### 2.6.8.8.1 Prerequisites

1. Ensure that the 7” Tabletop Touch Screen is installed and on (not in Sleep Mode) as directed in the Control4 7” Tabletop Touch Screen Installation Guide.
2. Ensure that your project has a Control4 Controller added and identified in the Control4 system.

#### 2.6.8.8.2 Procedure

To add and configure a 7” Tabletop Touch Screen:

1. Start Composer and connect to a **Director**.
2. Click **System Design**.
3. In the **project tree**, select the **room** where the Touch Screen resides. In the Items pane > My Drivers tab > User Interface > double-click **Touch Screen - 7”** to add the object to the project tree.
4. Click **Connections**.
5. In the Connections view, click the **Network** tab to make the necessary network connection.
6. Select the **Touch Screen - 7”** object, and click the **Identify** button.
7. In Identify mode, notice the Touch Screen button highlighted in the Composer Pro pane, go to the physical 7” Touch Screen, and press the button indicated in Composer Pro to identify the Touch Screen to the Control4 system.
8. When the address appears on the Composer Pro screen, click **Close**.
9. (Optional) To configure the properties, click **System Design**.
10. In the project tree, select the **Touch Screen - 7”** object.
11. View and change the properties in the Properties pane.

Modifiable properties include:

- **Backlight Level**—Use the up or down arrows to set the light level of the backlight, and then click **Set**. You can change the brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.
Backlight Preset Level—Lets you set the default backlight level. If you ever restart or power the
Touch Screen again, this is the backlight level it would go to. Click Set to save your changes.

Button Animation Enabled—Lets you enable animated buttons for a 3D effect.

Wake on proximity—Lets you set the Touch Screen to wake up when someone approaches
within four (4) feet of the device.

Detect Ambient Light Levels—Lets you set the options according to how much light is in the
room. You can use this option in programming also.

Set Threshold—Threshold settings from 0 to 100; 0 means no light; 100 means full light.

Current Light Level—Shows current light level.

2.6.8.9 Configure a 5” or 7” In-Wall Touch Screen

Use the Control4® Composer Pro System Design and Connections views to add and configure this
device.

Note: This Touch Screen includes full duplex point-to-point Intercom sessions, broadcast support to
multiple Touch Screens, and monitoring from the interface. An Intercom driver and agent must be
added and configured in the Composer project. See this section, the Control4 System User Guide,
and “Example: Program Using the Intercom Agent” for details.

Also, you must purchase, assign, and check in an Intercom license for consumers who want this
feature. See Managing Dealer Accounts on My.Control4.Com for information about how to purchase
and assign an Intercom license.

2.6.8.9.1 Scenarios

1. User wants to have full-duplex, room-to-room calling. In this case, the Control4 system must
have at least two (2) 5” or 7” In-Wall Touch Screens installed.

2. User wants to broadcast a message without a response. In this case, the Control4 system
must have at least one (1) 5” or 7” In-Wall Touch Screen installed.

3. User wants to broadcast a message with a response. In this case, the Control4 system must
have at least two (2) 5” or 7” In-Wall Touch Screens installed.

4. User wants to monitor the sounds in another room. In this case, the Control4 system must
have at least two (2) 5” or 7” In-Wall Touch Screens installed.

2.6.8.9.2 Prerequisites

1. Ensure that the 5” and 7” In-Wall Touch Screen is installed as directed in the
Control4 5” and 7” In-Wall Touch Screen Installation Guide available on the Control4
Dealer web site.

2. Ensure that your project has a Control4 Controller added and identified in the Control4 system.

2.6.8.9.3 Procedure

To add and configure a 5” or 7” In-Wall Touch Screen:

1. Start Composer and connect to a Director.

2. Click System Design.

3. In the project tree, select the room where the Touch Screen resides. In the Items pane > My
Drivers tab > User Interface > double-click to add the 5” or 7” driver, C4-TSWMC5-EG or
C4-TSWMC7-EG, to the project tree.

4. Click Connections.
5. In the Connections view, click the **Network** tab to make the necessary network connection.

   **Note:** If this Touch Screen will be providing audio output, the Touch Screen needs to be identified as an Audio end point for the room.

6. Select the **5" Touch Screen** - In Wall or **7" Touch Screen** In-Wall object, and click the **Identify** button.

7. In Identify mode, notice the Touch Screen button highlighted in the Composer pane, go to the physical 5" or 7" In-Wall Touch Screen, and press the button indicated in Composer to identify the Touch Screen to the Control4 system.

8. When the address appears on the Composer screen, click **Close**.

9. (Optional) To configure the properties, click **System Design**.

10. In the project tree, select the **5" Touch Screen** or **7" Touch Screen** object.

11. View and change the properties in the Properties pane as needed.

   Modifiable properties include:

   **Backlight Level**—Use the up or down arrows to set the light level of the backlight. You can change the brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.

   **Backlight Preset Level**—Lets you set the default backlight level. If you ever restart or power the Touch Screen again, this is the backlight level it would go to. Click Set to save your changes.

   **Button Animation Enabled**—Lets you enable animated buttons for a 3D effect.

   **Volume Control Follows Selected**—Lets you select other rooms aside from the one that contains the Touch Screen, and change its volume when leaving the room.

2.6.9 **Configuring Contacts and Relays**

   Use the Control4® **Composer** Pro System Design and Connections views to add and configure contacts and relays.

   These sections provide information about specific contacts and relays.

   “Configure a Gas Fireplace Relay”

   “Configure a Wireless Fireplace Switch”

   “Configure Pulse Single Relay Support”

   “Configure Single Contact Relay Support”

2.6.9.1 **Configure a Gas Fireplace Relay**

   Use the Control4® **Composer** Pro System Design and Connections views to configure a Gas Fireplace Relay.

2.6.9.1.1 **Prerequisites**

   Ensure that the Wireless Fireplace **Switch** is installed as directed in the Control4 Wireless Fireplace Switch Installation Guide available on the Control4 Dealer web site. The Gas Fireplace Relay installs with the Wireless Fireplace Switch.
2.6.9.1.2 Procedure
To add and configure a Gas Fireplace Relay:
1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the room where the gas fireplace resides. In the Items pane > My Drivers tab > Motorization > double-click Gas Fireplace to add the relay object to the project tree.
4. Click Connections.
5. In the Connections view, click the Control/AV tab to make the necessary connection to the Relay Output Device.
   b. Drag the Relay to the device you choose in the Relay Output Devices pane, for example, Home Controller HC300.
6. (Optional) To configure the properties, click System Design.
7. In the project tree, select the Gas Fireplace object.
8. View and change the properties in the Properties pane.

Modifiable properties include:

**Invert Relay:** Normally, the relay is open when the switch is off. If you check this option, the switch's off position closes the relay.

**Radio Buttons:**
   - **Toggle Type.** Select if the fireplace needs two (2) wires always touching to stay on.
   - **Pulse Type.** Select if two (2) fireplace wires only need to touch momentarily to turn the fireplace on or off.

   Pulse length is x milliseconds. Add the desired value here.
2.6.9.2 Configure a Wireless Fireplace Switch

Use the Control4® Composer Pro System Design and Connections views to configure a Wireless Fireplace Switch.

2.6.9.2.1 Prerequisites

Ensure that the Wireless Fireplace Switch is installed as directed in the Control4 Wireless Fireplace Switch Installation Guide available on the Control4 Dealer web site. The Gas Fireplace Relay installs with the Wireless Fireplace Switch.

2.6.9.2.2 Procedure

To add and configure a Wireless Fireplace Switch:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select the room where the gas fireplace resides. In the Items pane > My Drivers tab > Motorization > double-click Fireplace Switch to add the relay object to the project tree.
4. Click Connections.
5. In the Connections view, click the Control/AV tab to make the necessary connections to the Output Device.
   a. Select the Fireplace Switch object in the Fireplace Switch pane under Control & Audio Video Connections.
   b. Drag the desired Button Links to the device you choose in the bottom pane, for example, Home Controller HC300.
6. (Optional) To configure the properties, click System Design.
7. In the project tree, select the Fireplace Switch object.
8. View and change the properties in the Properties pane.

Modifiable properties include:

Properties:
Composer Pro User Guide

Invert Relay—If checked, the relay that appears as normally open becomes a closed circuit. The default is open.

Advanced Properties:

LED

Top Color
- On. The LED color for the Top LED when the LED state is On.
- Off. The LED color for the Top LED when the LED state is Off.

Bottom Color
- On. The LED color for the Top LED when the LED state is On.
- Off. The LED color for the Top LED when the LED state is Off.

Options

Top LED Link—Select to enable. If checked, swap on and off the state and color on the top LED.

Bottom LED Link—Select to enable. If checked, swap the on and off state and color on the bottom LED.

Buttons Attached—Select to enable. If checked, pressing the buttons on the Switch directly controls the connected load.

LED Attached—If checked, the LED state is controlled by the button presses. If unchecked, the LED state and colors can be controlled by custom programming.

Hold Ramp Rate (Seconds)

Up—The rate in seconds when the load increases when the top button is held down.

Down—The rate in seconds when the load decreases if the bottom button is held down.

Network—The network information is added automatically (Channel, Gateway, MAC, and Version).

2.6.9.3 Configure Pulse Single Relay Support

Use the Control4® Composer Pro System Design view to check and change relay properties.

When using a Pulse Type Relay in your project, you can add a single relay device, and then choose to configure it as a "Pulse Type" relay rather than having to program anything to provide the pulse functionality. This option is in the System Design Properties pane when you select a relay.

2.6.9.3.1 Procedure

To view relay properties:
1. Start Composer and connect to a Director.
2. Click System Design.
3. Select the relay object from the project tree. View its properties in the Properties pane.

Modifiable properties include:
Invert Relay: Normally, the relay is open when the switch is off. If you check this option, the switch’s off position closes the relay.

Radio Buttons:

- **Toggle Type.** Select if the device needs two (2) wires always touching to stay on.
- **Pulse Type.** Select if two (2) wires only need to touch momentarily to turn the device on or off.

Pulse length is $x$ milliseconds. Add the value here.

4. To use this option, select the **Pulse Type** radio button, and select the **Pulse Length is $x$ milliseconds** for the relay pulse (the default is 500 milliseconds).

---

**2.6.9.4 Configure Single Contact Relay Support**

Use the Control4® Composer Pro System Design view to check and change Single Contact Trigger support for contacts.

When using a contact in your project, the physical change of the contact’s state might not always result in a single open-to-close or close-to-open state change, but rather bounce between states multiple times before the final state is reached.

To eliminate false notification of the contact state to the Control4 system, you can configure a ‘Debounce Timer’ to allow the system to see only a single state change.

In the System Design view, you can set this option in the Properties pane when you select a contact.

**2.6.9.4.1 Procedure**

To set this option:
1. Start Composer and connect to a Director.
2. Click System Design.
3. Select the contact object from the project tree. View its properties in the Properties pane.

Modifiable properties include:

**Invert Sensor:** Depending on the sensor type, the Controller sends a small amount of voltage through the sensor to close it, if for example when a door is closed with feedback indicating such. You use Invert Sensor if you want to feedback to be the opposite.

**Enable Debounce Timer:** Sets an amount of time that lapses before the sensor triggers to on.

**Debounce Time (ms):** The amount of time in milliseconds before the sensor state changes to on.

4. Check the **Enable Debounce Timer** box.
5. In the Debounce Time (ms) (in milliseconds) drop-down menu, select to delay notification of the contact state (the default is 100 milliseconds).

### 2.6.10 Configuring HVAC Systems

Use the Control4® Composer Pro System Design and Connections views to configure a Control4 Wireless Thermostat. Control4 also supports multiple third-party thermostat models.

**Note:** Previous releases of Composer Pro documentation included instructions about how to configure third-party products and older versions of the Wireless Thermostat. Starting with OS 2.0, third-party **device** configurations are no longer included in the documentation, although they are still supported in the drivers list (for example, EnviraZone and Aprilaire RS232). Refer to previous releases of the
Composer Pro User Guide

Composer Pro User Guide for information about these third-party drivers and examples and older Thermostat models.

These sections provide information about the Wireless Thermostat.

“Setting Up a Wireless Thermostat”
“Programming the Control4 Thermostat Schedule”
“Using the Wireless Thermostat Advanced Properties”

2.6.10.1 Setting Up a Wireless Thermostat
Use the Control4® Composer Pro System Design and Connections views to set up a Control4 Wireless Thermostat.

2.6.10.1.1 Prerequisites
1. Ensure that your project has a Control4 Controller added to the project tree and is identified on the Control4 system.
2. Ensure that the Thermostat is installed at the wall as directed in the Control4 Wireless Thermostat Installation Guide available on the Control4 Dealer web site.
3. Ensure that the Control4 Wireless Thermostat is added to the project tree.

2.6.10.1.2 Procedure
To configure a Wireless Thermostat for the Control4 system:
1. Start Composer and connect to a Director.
2. Click System Design.
3. Verify that the Wireless Thermostat is in the project tree.
4. To identify the device, click Connections.
5. Click the Network tab.
6. Make the network connection. To do this, select the Control4 Wireless Thermostat object in the IP Network Connections pane, and click Identify.
7. In Identify mode, go to the physical Control4 Thermostat, and press the center button four (4) times. This identifies the Thermostat's network address to the Controller, and identifies the device to the Control4 system. The device’s address appears in the following dialog and in the IP Network Connections pane.

8. Click Close to exit the wizard.
   - To program the schedule, see “Programming the Control4 Thermostat Schedule.”
   - To set up advanced properties, see “Using the Wireless Thermostat Advanced Properties.”

2.6.10.2 Programming the Control4 Thermostat Schedule

Use the Control4® Composer Pro System Design view to set a heating and cooling schedule for your Control4 Wireless Thermostat (model number: Control4-CCZ-T1-x for OS 2.0 and later). The Control4 Wireless Thermostat works with your heating and cooling system to maintain a consistent
temperature called a ‘set point.’ Using the Control4 Wireless Thermostat, you can specify separate heating and cooling set points.

**Tip:** New in OS 2.0, you can set the heating and cooling schedule from a Touch Screen or On-Screen Navigator. See the [Control4 System User Guide](#) for details.

The Control4 Wireless Thermostat automatically engages the appropriate heating or cooling system until the room reaches the desired temperature. In Composer Pro, you can set up a Heat Point and a Cool point for six (6) possible Program Events in a day time period.

Program Events include:

- **Awake**—Sets the wakeup time and related Heat/Cool Points.
- **Leave**—Sets the away time and related Heat/Cool Points.
- **Return**—Sets for return time and related Heat/Cool Points.
- **Sleep**—Sets for sleep time and related Heat/Cool Points.
- **Custom 1**—Sets a specified time and related Heat/Cool Points.
- **Custom 2**—Sets a specified time and related Heat/Cool Points.

You can enable these Program Events for weekdays, weekends, or individual days to match activity in the home.

### 2.6.10.2.1 Prerequisites

Ensure that the Thermostat is installed as directed in the *Control4 Wireless Thermostat Installation Guide* available on the Control4 Dealer web site.

### 2.6.10.2.2 Procedure

To program the Wireless Thermostat Schedule:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the System Design view, select the Control4 Wireless Thermostat object.
4. The Properties appear in the center pane. Fahrenheit is selected by default; select Celsius as needed.
5. In the Properties tab, select View/Edit Schedule. The Schedule dialog appears with the currently programmed schedule for Monday through Sunday.

**Note:** You can schedule the Thermostat either in Composer Pro or in the Control4 Touch Screens or On-Screen Navigators. See the *Control4 Wireless Thermostat User Guide* or the *Control4 System User Guide* for information about scheduling a Wireless Thermostat from a Navigator.
Tip: To return to the original settings, click the Restore Default button.

6. For each line item: Awake, Leave, Return, Sleep, Custom 1, and Custom 2, use the up and down arrows to set the day and temperature Heat and Cool set points.

Notes: (1) You can view the schedule by selecting the 12 Hour Display or the 24 Hour Display. (2) The Cool and Heat Points stay two (2) degrees apart. Example: If you set the Heat Point to 72 degrees, the lowest you can set the Cool Set Point is 74 degrees. This keeps your furnace and your air conditioner from competing with each other.

7. When you are finished, click Ok. Your updated schedule displays. You may then set the modifiable properties. See “Using the Wireless Thermostat Advanced Properties.”

2.6.10.3 Using the Wireless Thermostat Advanced Properties

Use the Control4® Composer Pro System Design view to view and change the Wireless Thermostat properties. Set the Properties to create a schedule and the Advanced Properties to modify the Thermostat’s configuration.

2.6.10.3.1 Prerequisites

Ensure that the Control4 Wireless Thermostat (model number: Control4-CCZ-T1-x for OS 2.0 and later) is installed as directed in the Control4 Wireless Thermostat Installation Guide available on the Control4 Dealer web site.

2.6.10.3.2 Procedure

To use the Thermostat Advanced Properties:
1. Start Composer and connect to a Director.
2. Click System Design.
3. Select the Control4 Wireless Thermostat in the project tree.
4. Click the Properties tab to view the list below.

Note: Different properties may appear, depending on the Thermostat model. The properties below apply to the Control4 Wireless Thermostat for OS 2.0.
Modifiable Advanced Properties include:

**Properties**
- Fahrenheit or Celsius—Lets you set the temperature format.
- View/Edit Schedule—Brings up the schedule page to set heat and cool set points for auto mode (see below). In the mode (Awake, Leave, Return, etc.), set the day and temperature set points. Click **OK** to close the window. **Note**: You can view the schedule by selecting the **12 Hour Display** or the **24 Hour Display**.

**Vacation**—Lets you set the Heat Set Point and Cool Set Point when the homeowner is on vacation. Use the **up** or **down** arrows to set the heat and cool set points, and then click **OK**.
Use Remote Temperature Sensor—Sets the Thermostat to use either the on-board Local temperature sensor (default) or an optional Remote temperature sensor to control the HVAC system by selecting the Use Remote Temperature Sensor radio button.

Advanced Properties
General Setup

Buttons—Lets you lock local buttons to prevent unwanted changes to Thermostat settings. Select the Locked and Unlocked radio buttons.

Backlight Mode—Lets you select your preferences for the backlight. Select On Button Press to light the backlight for ten seconds when any button is pressed. Select Always On to keep the backlight on constantly. When using batteries for power with power stealing enabled, the Always On option is not recommended.

Time Format (Date and Time)—Lets you set preferences regarding Date Format (MM/DD/YYYY or DD/MM/YYYY) and Time Format (12 h or 24 h). Click the Sync Time button under Time Format to update the time on your Thermostat manually to the Controller. (The Thermostat also updates automatically at 3:00 AM each morning.)

Advanced Device Configuration
Control4 has enhanced the available Thermostat settings to allow users and installers to modify engage and cutoff temperature deltas as well as maximum and minimum run time, off, and delay times so that the Thermostat can be configured to run optimally with any HVAC system.

**Note:** Allowing such fine tuning of all settings can result in setting improper values and combination of values to cause the HVAC system to run less than optimal. To prevent thrashing the cool and heating engage (constant heat, then cool, engagement), cutoff and set points are enforced to have at least a one (1) degree difference for engage temperatures.

The formula for the dependency of these values is:

**Heat/cool engage delta**—Opposite stage (if heat engage, then cool cutoff and visa versa) cutoff delta + set points delta (cool set point – heat set point) >=1

The screen below shows the Advanced Device Configuration properties.
Temperature Calibration—Use the up or down arrows to set x degree(s), and then click Set Calibration. This lets you fine tune the current temperature reported by the Thermostat by +/- 5 degrees. Example: If your Thermostat reads 72 degrees, and you determine that the current temperature should be 70 degrees, select -2 to lower the Thermostat's reading to 70 degrees. After selecting the number from the menu, click Set Calibration.

Heating Cutoff Point—Use the up or down arrows to set x degree(s) from the set point, and then click Set Heat Cutoff. This sets how far over the set point you want the heating system to remain engaged before shutting off. Example: If the heat set point is set to 68 degrees and the cutoff point is set to 2 degrees, the heat will remain engaged until the current temperature reaches 70 degrees.

Cooling Cutoff Point—Use the up or down arrows to set x degree(s) from the set point, and then click Set Cool Cutoff. This sets how far under the set point you want the cooling system to remain engaged before shutting off. Example: If the cool set point is set to 68 degrees and the cutoff point is set to 2 degrees, the cool stage will remain engaged until the current temperature reaches 66 degrees.

Stage Minimum Off Time (Minutes)—Use the up or down arrows to set the minimum off time in minutes. Note: This setting take effect as soon as the Advanced Device Configuration window is closed.

This is the minimum amount of time that the Heat or Cool stages will be off before the stages start to run again. Example: While engaged, if the current temperature does not reach the heat/cool set point within the maximum run time for that stage, the system will shut off for the minimum off time before re-engaging. If you manually change and engage the modes (heat/cool) when a stage is engaged, the new mode will not be allowed to engage until the minimum off time has expired from when the last stage disengaged.
Stage Configuration (Heat Stage 1, 2; Cool Stage 1, 2; Auxiliary; Emergency)
The stage configuration boxes allows for setting the engage delta, minimum run time and maximum run time for each stage.

**Note:** These settings take effect as soon as the Advanced Device Configuration window is closed.

**Delta (degrees)**—Use the up or down arrows to set the stage engage temperature delta. This sets how many degrees the current temperature will go beyond the set point before this stage will engage.

**Example:**
For heat, if the heat set point is set to 68 degrees and the engage delta is set at 2 degrees, the heat stage will not engage until the current temperature reaches 66 degrees.
For cool, if the cool set point is set to 68 degrees and the engage delta is set at 2 degrees, the cool stage will not engage until the current temperature reaches 70 degrees.
For multi stage systems, the engage deltas for the second stages are cumulative. If the first stage delta is set at 2 degrees and the second stage delta is set at 2 degrees, the second stage will not engage until the current temperature has passed the stage set point by 4 degrees.

**Minimum Run Time**—Use the up or down arrows to set the stage x minimum run time in minutes. The minimum run time is one (1) minute.
This sets the minimum time the stage will remain running before it is allowed to shut off.
**Example:** If a stage is engaged and either reaches the goal set point or is manually shut off, it will not disengage until it has been running for the set minimum run time. This is used to prevent furnace and compressor damage. Many furnace and cooling systems have their own minimum run time built in to the system.

**Maximum Run Time**—Use the up or down arrows to set the Heat Stage x maximum run time in minutes. The maximum run time is 255 minutes.
This sets the maximum time a stage will run without reaching the desired heat set point goal before it will shut down for the minimum off time and then restart. **Example:** If a stage is engaged and runs for the maximum run time set for that stage, without getting the current temperature to reach the set point, the stage will disengage for the set minimum off time and then re-engage. This is to prevent systems from running constantly, if the desired set point goal is not reached.

**Auxiliary Stage**
The Auxiliary and Emergency Heat stages are specifically for heat pump systems. The switches on the back of the Thermostat allow the Thermostat to operate a Heat Pump system.

**Note:** These settings take effect as soon as the Advanced Device Configuration window is closed.

**Stage Delay (Minutes)—**Use the up or down arrows to set the stage delay for x minutes. This sets the amount of time the main heat pump system will run without reaching the desired heat set point goal before the Auxiliary stage will engage. **Note:** If set to the maximum time allowed, the auxiliary system will not come on and will be disabled.
Stage Cutoff Delay (seconds)—Use the up or down arrows to set the stage cutoff delay in seconds. This sets how much of a delay there is before the main heat pump stage cuts off, leaving the Auxiliary heating stage to run on its own. **Note:** If set to the maximum time allowed, the main heat pump stage and the Auxiliary heat stage will run together indefinitely.

**Network**—This is an informational box that provides you with ZigBee networking information (MAC and Firmware Version).

**IMPORTANT!**
Starting with OS 2.0, the new Thermostat driver and firmware use a different temperature scale. Due to this, existing programming which evaluates temperature values will not work correctly and must be deleted and re-done. Also, any Thermostat variables used for the Email Notification Agent must be changed to use the new V1 variables for the temperatures to be displayed correctly.

### 2.6.11 Configuring and IP Camera or Web Image

Use the Control4® Composer Pro System Design and Connections views to configure this device. Internet Protocol (IP) Security Cameras, including on-screen controls in Navigators, such as Pan, Tilt, Zoom, and preset settings are supported along with HTTP control and JPEG or MJPEG images.

#### 2.6.11.1 Prerequisites

1. Ensure that your project has a Control4 Controller added to the project tree and is identified on the Control4 system.
2. Ensure that the IP Security Camera is installed at the wall as directed in the manufacturer's installation guide.

#### 2.6.11.2 Procedure

To add and configure an IP Security Camera or Web JPEG image:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the System Design view, click the My Drivers tab > IP Cameras and locate the IP Camera model.
4. Double-click the IP Camera model to add its driver to the project tree.
5. In the Properties pane, do the following:
   - For an IP Security camera, configure the IP Address, port, and authentication information (if applicable).
   - For Web JPEG Image only, enter the URL and authentication user name and password (if a secure HTTP address), select the refresh rate in minutes, and tests.
   - Click Test HTTP Connection to test it.

### 2.6.12 Configuring Black & Decker Locks

Use the Control4® Composer Pro System Design view to add and configure Black & Decker Kwikset® SmartCode® with Home Connect™ Technology ZigBee Deadbolt locks.
2.6.12.1 **Prerequisites**

Ensure that the Black & Decker locks are installed as directed in the Black & Decker Installation instructions shipped with the product.

2.6.12.2 **Procedure**

To add and configure Black & Decker locks:

1. Start **Composer** and connect to a **Director**.
2. Click **System Design**.
3. In the System Design view on the **project tree**, select the **rooms** where the Black & Decker locks are installed. In the Items pane, click the **Search** tab and search for Black and Decker in the Manufacturer box.
4. Double-click **Black and Decker SmartLock RF ZigBee** to add the object to the project tree. **Tip:** If you are adding several locks in a home, it might be useful to give each lock a unique name.
5. For each lock you add to the project, add a **Relay** to the project tree also. See “Configuring Contacts and Relays.”
6. To identify the device, click the **Connections** view and **Network** tab. Select the **Black and Decker ZigBee Lock** object, and click the **Identify** button. When prompted, press the **Join Network** button four (4) times. For more information, see the table in “Example: Verify the Network Connections.”

7. Click the **Connections** view.
8. In the Connections view, use the **Control & Audio Video Connections** tab to make the necessary control connection.
9. Under Control Outputs, select the **Lock State** and drag it down to the **Relay** in the RELAY Input Devices pane.

10. (Optional) For additional Black and Decker ZigBee Lock setup, configure the Properties.
    a. In the System Design view project tree, select the **Black and Decker ZigBee Lock** object.
    b. Modify the properties in the Properties pane, and then click Set (if applicable).

    **Debug Mode**: Use the drop-down menu to select logging and printing.

    **Lock Sleep Timer**: Use the drop-down menu to select how long the lock is in sleep mode (in seconds).

    **Last Status**: Last change made in Debug Mode.

    **Instructions**: See the Documentation tab.

    **Name, Code x**: Enter the lock name and code here. You can enter up to 32 code entries.

    c. Click the **Documentation** tab for additional information about setting the properties, user codes, and actions for the locks.

**Properties**

**Debug Mode**: Set to On or Off if using to debug a problem.

**Lock Sleep Timer**: The default is 7 seconds. Set to the amount of time the lock sleeps before sending out a request for lock status.

**# of Log Items**: Use the up or down arrows to set the number of items to log.

**Last Status**: Indicates the last action on the lock.

**Firmware Version**: Indicates the ZigBee firmware version for the lock.

**Instructions**: Details about how to set the user codes.

**Name, Code 1**: Set up the user codes here. Type the user's name, then a comma (,), and then add the numeric code (4 to 8 characters allowed). Example: Bob, 12345. Up to 30 codes can
be entered. **Tip:** The codes can be entered also on the Touch Screen or On-Screen Navigator if you download the Black & Decker application from 4Store.

**Documentation**. Describes how to use the locks and events.

**Actions**

- **Get Battery Status**. Click to show the status of the battery on the lock.
- **Show User Codes**. Click to show all of the user codes assigned to this lock. The user codes appear in the Properties tab.
- **Hide User Codes**. Click to hide all user codes assigned to this lock. The user codes appear as x's in the Properties tab.
- **Delete All Codes**. Click to delete all user codes assigned to this lock.

**Note**: You can set the user codes either from Composer Pro, or from the Touch Screen or On-Screen Navigator in My Apps (downloaded from 4Store). The priority for setting user codes and Actions is whoever set the codes or actions last, whether it was in Composer Pro or on a Touch Screen or On-Screen Navigator, will be the valid codes or actions used. See the *Control4 System User Guide* for details.

### 2.7 Customizing the Navigators

Use the Control4® system *Navigator* interface on your Navigator to make adjustments to the Navigator you're using.

**Tip**: You or your customer can customize pages in the Touch Screens or On-Screen Navigators also. See the *Control4 System User Guide* for information.

These sections provide information about how to customize Navigators.
2.7.1 Setting Up the Photo Screen Saver Option

Use the Control4® Composer Pro Agent view to set up a photo screen saver to view from the Touch Screens or On-Screen Navigators.

2.7.1.1 Prerequisites

Have one of the following storage types available before you copy the photos. You will need to set up one or more of them later when you add your photos.

Note: In some cases, the Control4 system may take a few minutes to recognize the device.

- **Controller** — If the Controller has no storage, add and connect a device that contains storage for your photos; for example a USB drive or Network File Share (see Step 6 in the next section).
- **USB Drive** — Ensure that the USB drive is attached to the Controller. When you insert the USB drive, it will appear in the project tree > System Design.
- **Network File Share** — Ensure that the Network File Share object is added to the project tree and connected (see the steps to do this later in this procedure). Ensure that you have access to the Network File Share, that you have a valid Username, Password, and Workgroup, and that you can identify the network location (you will need to add the path).

2.7.1.2 Procedure

To set up the Photo Screen Saver option for the Navigators:

1. Start Composer and connect to a Director.
2. Click Agents.
3. From the Agents view > Agents pane, click Add.
4. From the Available Agents dialog, choose the Screen Saver agent, and click OK.

Note: If Screen Saver already appears in the Agents pane, it has already been added. Go to the next step. If not, see “Example: Program Using the Screen Saver Agent.”

5. In the Agents pane, select Screen Saver.
6. From the storage location list, use the drop-down menu to choose the location where you will save your photos for use on the Navigators (Controller, CBM Flash Disk, the USB drive, or Network File Storage is the Network File Share).

Notes:

If the storage option that you want does not appear in the list, disconnect from Director and reconnect.
At any given time, only one storage location can be set as the photo Screen Saver source.

- **Controller**—If you have a Controller with disk space (for example, Home Controller HC-500 or HC-1000), an option appears in the list (for example, Home Controller HC500).
- **CBM Flash Disk** (USB drive)—If you inserted the USB drive in the Controller earlier, the CBM Flash Disk option appears in the list.
- **Network File Storage**—If you select Network File Storage, specify where the Control4 system needs to go to copy the files. Click System Design and select the Network File Storage icon in the project tree (you will have to add it from the Items pane). In the Properties pane, type the Username, Password, Workgroup and then browse to the network location. Click Connect.

7. Click the Media view, and select Screen Saver.
8. Click Configure in the Screen Saver pane, set the location to copy the files to (for display in the Navigators), and click OK.

**Note:** If you didn't choose a storage location in Step 6, an error message appears. Click OK, and then click Configure to set the location.

9. In the Screen Saver pane, click Add. In the My Pictures dialog, browse to the photos you want to copy to the storage location, select them, and click Open. The files will be copied to the storage location you specified in Step 8, and a folder may be created for you using the Control4 name (example: Control4 pictures).

**Note:** When media is added (copied) to the storage device, it is pre-scaled to the resolution for all of the Navigators. Control4 preserves the aspect ratio of the original image, and boxes the extra space with bars for any given screen size.

10. In Composer Pro, refresh the Navigators you will be using to display the copied photos.
11. To activate the Screen Saver in each Navigator (On-Screen, Touch Screen, or Mini Touch Screen), do the following:
   a. Go to Info > Config > Screen Saver.
   b. Enable the Custom option, and then choose the Photo Screen Saver option along with any other Screen Saver option you want to include. For photos only, check the Photo option. See “Setting Up a Custom Screen Saver” to display the photos on the Navigator.

### 2.7.2 Setting Up a Custom Screen Saver

Use the Control4® Navigator to create a custom screen saver to view on Touch Screens or On-Screen Navigators.

**Note:** This task must be completed on a Navigator. Either the Installer or homeowner can set this up. The Custom Screen Saver option lets users mix and match available screen saver options, including the option to use stored photos.

#### 2.7.2.1 Prerequisites

Before setting up a custom screen saver, photos must be available for viewing from the Navigator. See “Setting Up the Photo Screen Saver Option.”
2.7.2.2 Procedure

To set up a custom screen saver:
1. From the main menu on an On-Screen Navigator or Touch Screen press More > Settings > Screen Saver.
2. In Screen Saver, press the drop-down arrow, and press Custom.
3. In Turn on, press the drop-down arrow, and press an option to enable the Screen Saver.
4. Press Settings.
5. Press to select one or more of the following options:
   - Media
   - Time
   - Date
   - Temp
   - Photo
   - Shuffle
6. Press Done.
7. (Optional) Press Preview to test the settings.

To set up a custom screen saver in the Touch Screens or On-Screen Navigators for OS 2.0 and later, see the Control4 System User Guide for details.

2.7.3 Programming the Screen Saver Sleep Mode or Other

Use the Control4® Composer Programming view to schedule a Screen Saver mode change, such as a ‘Go To Bed’ mode during sleep hours.

1. In Programming, select Navigator actions.
2. Create a Scheduled Event (such as ‘Go To Bed’). See “Programming with Agents” for details.
3. Add the following script:
   “Set the screen saver mode on the [graphical navigator device] to Blank.”
   “Turn the screen saver on after [time interval] on the [graphical navigator device].”

2.7.4 Changing the Time on a Navigator Screen Saver

Use the Control4® Composer Pro System Design view to change screen saver date, time or time zone.

2.7.4.1 Procedure

To change the time on a Navigator screen saver:
1. Start Composer and connect to a Director.
2. Click System Design.
3. In System Design, click the Properties tab.
4. Use the Date & Time drop-down boxes to modify the time and date.

Date: To change the Date (month, date, or year), click the drop-down arrow for a calendar to appear. Click the left or right arrows to select the month, and then select the day.
**Time**: To change Time (hour, minute, second), click the up or down arrows to the appropriate time in hours, minutes, or seconds.

**Tip**: An easy way to change the hour, minute, or second is to highlight the hour, minute, or second number, and then type the new number over the old one.

**Time zone**: To change the Time Zone, at the Timezone box, click **Edit**. Choose the time zone from the drop-down menu, and click **OK**.

### 2.7.5 Hiding Device Availability

Use the Control4® Composer Pro System Design view to hide a device from view in a Navigator.

**Example**: Set availability so that the Mini Touch Screen in the Bedroom cannot control music in the Theater.

#### 2.7.5.1 Prerequisites

Ensure that the following devices are added and identified to the network:

- Controller
- Digital Audio
- Navigator

#### 2.7.5.2 Procedure

To hide a device so others cannot see it:

1. Start Composer and connect to a **Director**.
2. Click **System Design**.
3. In System Design and in the project tree, select **Bedroom**.
4. Go to the **Navigator** tab in the Properties tab.
5. Select **Music** in the Menu box, and then click **Modify**.
6. Select **Digital Audio** in the Theater, click **Hide**, and then click **OK**.

### 2.7.6 Viewing Device Availability in Navigators

Use the Control4® **Composer** Pro System Design view to change the order of devices to view. This task is useful if you have a lot of media devices, and some are used more frequently than others.

**Example:** Change the order of a Tuner to appear in a **Navigator** before the Receiver.

#### 2.7.6.1 Prerequisites

Ensure that the following devices are added and identified to the network:

- **Controller**
- **Digital Audio**
- **Navigator**

#### 2.7.6.2 Procedure

To enable a device to be viewed in a specific order in a Navigator:

1. Start **Composer** and connect to a **Director**.
2. Click **System Design**.
3. In System Design, select **Theater**.
4. Go to the **Navigator** tab in the Properties tab.
5. Select **Radio** under Menu, and then click **Modify**.
6. Click **Tuner**, and then click **Move Up**.
7. Click **OK**.

### 2.8 Updating Composer and Director

Use the Control4® **Composer** Pro software to update Composer Pro and **Director**.

**IMPORTANT:** Before you begin any update, check the **Control4 web site** for any Release Notes or upgrade documents associated with the update, especially if it's a major update such as Release 1.8.2 or OS 2.0. Read those documents first.

**Tip:** The Release Notes for Release 1.8.2 provides a table of all of the releases that Control4 has delivered and their dates. See **Composer Pro Software Release Update Instructions – 1.7.4 to 1.8.2** for details.

Depending on the type of upgrade you need to perform, the following tools and Web site may need to be used:

- **Control4 web site**
- Update Manager
- Network Status
- System Manager
2.8.1 Control4 Web Site
Composer Pro updates (software releases) are available on the Control4 Dealer web site at http://www.control4.com/dealer/products/software/. You will need a Dealer login and password to access this site.

2.8.1.1 Prerequisites
Ensure that Release 1.8.2 and Composer Pro 2.0 are installed before you begin a subsequent update. See Composer Pro Getting Started for details. If you have an earlier release, see the update instructions for that release. You must update first to Release 1.7.4 and then 1.8.2 before updating to OS 2.0.

Activate your licenses. See "Purchasing and Setting Up Dealer Licenses" in Composer Pro Getting Started or Managing Dealer Accounts on my.control4.com on the Control4 Knowledgebase for details.

2.8.1.2 Procedure
To access the software updates:
2. Under Software Updates select the software version to download and install.

The following software releases are available on the Control4 web site:
- Composer 1.2.5
- Composer 1.3.2
- Composer 1.6.0
- Composer 1.7.4
- Composer 1.8.2
- Composer 2.0.4
- Composer 2.0.5

Other software utilities are available for download also.

IMPORTANT: For new installations, it is always a best practice to use the latest version of the released software.

2.8.2 Update Manager
Update Manager in Composer Pro automatically updates Director and all of the IP-connected devices that are available in your project (identified and online), allowing you to update all the devices in the project configuration also. You can use Update Manager to update from all previous releases.

To support multiple releases, the release (for example, 1.7.x) installs in a Composer Pro directory (for example, Composer17x), which differs from previous releases that were installed in the Composer Pro directory. You do not need to uninstall previous releases to install a new release, but you must install Composer 2.0 before you begin the update.

The update to OS 2.0 or later does the following:
2.8.2.1 Procedure
To access Update Manager:
1. Start Composer and connect to a Director.
2. From the Tools menu, click Update Manager.

2.8.3 Network Tools
Some releases, for example, Composer Pro Release 1.7.3 and later use this option.

2.8.3.1 Procedure
To access Network Tools:
1. Start Composer and connect to a Director.
2. From the Tools menu, click Network Tools.
3. Network Tools has three (3) tabs (Release 1.8.0 and later). Use these tabs as required by the software:
   - IP Network
   - ZigBee Network
   - EmberNet Upgrade

2.8.4 System Manager
System Manager provides some of the functionality as in previous releases, but it does not perform the update functionality. Use System Manager to add, refresh, connect, or disconnect devices.

2.8.5 Updating Firmware
Sometimes you'll get devices that aren't on the same firmware version. For all devices to be able to communicate, they do need to be on the same firmware version.

2.8.5.1 ZigBee Devices
ZigBee devices update automatically to the current firmware version when they are installed and identified to the system.

2.8.5.2 IP Devices
To update IP devices, run Update Manager. You can check the firmware version either in System Design > Properties pane (for the device), or in Tools > Network Tools > ZigBee tab for ZigBee devices.
2.8.5.3 **Black & Decker Locks**  
*Note*: Ensure you're running a current version of Composer Pro and Director on the system. Without the current version, the latest firmware will not be available.

**To force a firmware update on the lock:**  
1. Remove the batteries from the lock (press a key or two to eliminate any charge in the lock).  
2. Put the batteries back in.  
3. Press the **top left** button four (4) times.  
4. Press the **top right** button four (4) times.  

The firmware should start updating. If it does not, ensure that your batteries are fresh. If you cannot manually start the firmware update, the lock should automatically checkin for an update after the first checkin of the lock, at 3 AM.

### 2.8.6 Guidelines for Updating a Control4 System

Use these Control4® guidelines to update a *Control4 system*.

**IMPORTANT**: Before you begin any update, check the Control4 Dealer web site for any Release Notes or upgrade documents associated with the update and the release. Read those documents first.

*Note*: The update behavior and steps for various releases differs. Make sure you review any documentation associated with the release before you begin your updates.

Follow these important guidelines for updating *Composer Pro*:

1. **Back Up Your Project**. If you have a project in an earlier version of Composer, back it up before you update.  
2. **Verify the Network Connections**. Update Manager requires an active network *connection* to function properly. Ensure that the network connection is up and working prior to performing the upgrade.  
3. **Update Errors**. If you notice any errors during the update process in the Update Manager’s output pane, take note of the error message, and follow instructions provided at “Troubleshooting the Upgrade Process.”

**IMPORTANT**: You cannot have both connection methods identified on the system. Remove the network connection to *Zigbee* and identify it again using the *Ethernet* connection.

4. **Power On**. Ensure that the power state of all devices is *On*. You can verify that all devices are online from the Network Tools page.  
5. **Know When the Update is Completed**. When upgrading the Control4 *Controller* running *Director*, you are disconnected from Composer Pro and streaming audio stops.  
   a. After this occurs, restart *Composer* and reconnect.  
   b. Go to **Tools > Update Manager** and watch the update process.  
   c. Also, go to **Tools > Network** to ensure that everything is connected. If it is not connected, it cannot update that firmware.
d. After Update Manager indicates that it is completed (you may see a message like "Finished site update attempt," all the IP devices on the system are now updated. This does not include ZigBee devices or hybrid devices (containing both IP and Zigbee).

e. Go to Tools > Network Tools to view the firmware versions to ensure they are updated to this release.

### 2.8.7 Guidelines for Updating Specific Devices

- **Primary Controller.** The Primary Controller holds a new firmware image file, which is transferred and reflashed when an Ethernet network connection is present. After the update, disconnect the IP identification and identify again using Zigbee.

- **Wireless Touch Screen.** When updating the Wireless Touch Screen — 10.5", ensure that the product is On, active, and not in Sleep mode.

  **IMPORTANT:** This requires AC power during the update.

- **ZigBee Devices.** When upgrading a Controller associated with ZigBee devices, such as Dimmers, Switches, and Keypads, these are also upgraded. As these devices upgrade, the device’s LEDs and the associated lighting loads may flicker. This is normal behavior.

- **ZigBee Pro Devices.** Follow the instructions in Composer Pro Software Release Update Instructions - 1.7.3 to 1.8.0 for details about ZigBee Pro updates.

- **Home Theater Controller and Speaker Point.** During the update, the LEDs flash, indicating the upgrade process is in a critical mode.

  **Note:** For OS 2.0, Speaker Point does not support the M4P/AAC format. Use MP3.

  **WARNING:** Do not stop the update or disconnect the network during an update.

- **Audio Matrix Switch, Multi Channel Amplifier, or Contact / Relay Extender.** If you are updating an Audio Matrix Switch, Multi Channel Amplifier, or Contact/Relay Extender that is using a ZigBee connection, you must temporarily connect these devices to an Ethernet connection before updating for the firmware update to occur.

### 2.8.8 Estimating Control4 System Update Times

Use Control4® Composer Pro to update the Control4 system.

#### 2.8.8.1 Estimating Update Times per Device Type

For an update to Release 1.8.2, the update time is dependent on the size of the Control4 system, the available network bandwidth, and the types of devices you are updating.

There are three (3) types of devices: IP devices that communicate solely by TCP/IP, ZigBee, ZigBee Pro devices that communicate via ZigBee or ZigBee Pro, and hybrid devices that use both TCP/IP and ZigBee for communication.

Depending on the device type, some devices, such as the IP devices update in parallel; other ZigBee or hybrid devices are updated sequentially, one after another. Generally, the IP devices are updated in parallel immediately after the Primary Controller updates. After that, the ZigBee devices update in
sequence starting with the System Remote Control, and then followed by the hybrid devices which update in sequential order. The System Remote Control is the first ZigBee device to update if it is in Wake mode. During or after the update, if the System Remote Control was in Sleep mode, it updates immediately after it wakes up.

The following list identifies the Control4 products, the type of device they are considered to be, and also provides an estimate of the how long it takes for a particular Control4 product to update.

- **IP Devices** (updated in parallel immediately after the Primary Controller):
  - Controllers (Home Controllers HC-300, HC-500, or HC-1000, Media Controller, or Home Theater Controller—20 to 40 minutes
  - Mini Touch Screen—30 minutes
  - 7” Touch Screens—15 to 20 minutes
  - Speaker Point—10 to 15 minutes

- **ZigBee Devices** (updated sequentially):
  - System Remote Control—3 to 5 minutes (updated as the first ZigBee device if awake)
  - Dimmer/Keypad/Switches—3 to 5 minutes
  - LCD Keypad/Thermostat—10 minutes per device

- **Hybrid Devices** (both Zigbee and IP - updated sequentially):
  - Multi Channel Amplifier -16—5 minutes
  - Contact / Relay Extender—5 minutes
  - Audio Matrix Switch—5 minutes
  - Multi Tuner V1 and V2—5 minutes
  - XM Module—5 minutes
  - Dock for iPod—5 minutes
  - Media Player—5 minutes
  - IO Extender—5 minutes

**Note:** Release 1.7.4 to Release 1.8.2 updates may take longer than listed above.

**Example:** a total of
- 20 devices may take 110 minutes or longer
- 30 devices may take 150 minutes or longer
- 60 devices may take 300 minutes or longer

to complete the process. Dimmers and Switches do not need to be updated.

You may want to practice on your own Control4 system first before upgrading a customer’s home, as this update to Release 1.8.2 is not trivial.

### 2.8.9 Best Practices for Updating a Control4 System

These sections will help you understand the best practices to follow when performing a Control4® update in Composer Pro. If you follow these sections in order until your system updates successfully, you may avoid some unnecessary pitfalls.
2.8.9.1 General Procedure

To update your system and software:

1. Back up the current project and media.
2. Check that you have a good network connection.
3. Check the currently-installed Composer Pro and Director versions.
4. Update Composer Pro software and drivers.
5. Update Control4 products using Update Manager.
6. If you have problems, see “Troubleshoot the Upgrade Process” or contact Control4 Technical Support.

Tip: The update process is highly dependent on valid network configurations and Internet connection availability and bandwidth. Please confirm that the devices on your network have a valid connection to the Internet. If you are using DHCP, confirm that your DHCP is active and can issue valid IP addresses to clients on the network.

IMPORTANT: Do not use a previous release of Composer Pro to modify a 1.7.0 system. Likewise, do not use a 1.7.0 version of Composer Pro to modify a previous release of the Control4 system.

2.8.9.2 Back Up the Current Project and Media

To back up your current project and media:

1. Back up your current project file from a previous release by using File > Backup As. Give it a filename that clearly identifies it as the backup.
2. (Optional) Back up your media. Copy all directories to your computer's hard drive or other storage media from the media storage location on your Control4 Controller at: <ip address of Control4 controller>\media\audio.
3. Continue to the next section.

2.8.9.3 Check the Currently-Installed Composer Version

It is helpful to check the currently-installed Composer Pro version before installing the update to make any necessary project adjustments.

2.8.9.3.1 Procedure

To check currently installed Composer Pro version:

1. In Composer Pro, click Help > About Composer.
2. From the dialog that appears, write down the Composer Pro and Director version numbers.

Example: Composer, version 2.0.0.938 and Director version: 2.0.0.938.

To ensure that the Control4 system is working properly, the Composer Pro version and Director versions should always be consistent and have the same version number.

Note: You do not need to be on a certain version, however, to update. Update Manager updates the Control4 system from all previous releases. The only reason you need to know this information is to determine when your project was set up. Control4 always recommends that you write down these versions in case this information is needed later.

3. Continue to the next section.
2.8.9.4 Update Composer Software and Drivers

The Composer Pro software download consists of Composer Pro software and new or updated device drivers to support Control4 hardware and other third-party products. The following steps outline how to launch the software executable and ensure that you have the latest drivers.

Note: The Inspector utility can be used to verify each package after installation. Inspector reads all of the md5sums in the /var/lib/dpkg/info directory, and runs a new md5sum against them. Any missing files or files where the md5sums have changed are reported in /tmp/Inspection.$timestamp.

2.8.9.4.1 Procedures

To install a released Composer Pro software version:

The following steps are an example of a software installation. Refer to the Release Notes associated with the software release for specific instructions.

1. Download the software package from the Internet at www.control4.com.
2. Install the current Composer Pro software, for example, Composer Pro 2.0.
3. Follow the on-screen instructions to complete the installation.
4. During the installation process, click the Continue Anyway button for the installation to proceed.
5. Continue to the section, "Update Control4 Products Using Update Manager."

(Optional) To ensure the driver database is updated:

1. From the Drivers menu, select Manage Drivers. In the utility, you can see the creation and modification dates for all drivers in the local database residing on your computer.
2. Click Add to search the Online Database, and compare the modified dates to determine if a new driver is available.
3. If a newer driver is available and you want to download it, check the box next to the device model number, and click OK to download the newer associated driver.

Tip: When Composer Pro is first installed, the My Drivers tab is pre-populated with a list of drivers. The My Drivers tab provides shortcuts to commonly-used drivers. You can add, remove, and re-order items to the My Drivers tab as needed. Removing drivers from My Drivers tab only removes the driver from the list. It still exists in the Local Database. To get back to the default My Drivers tab list and to include newly-added Control4 devices, right-click any device and click Restore Default List. This action does not affect the Local Database in any way. Also, right-click the My Drivers tab, select Add Driver, and then select all the Control4 devices not currently in the list.
2.8.9.5 **Update Control4 Products Using Update Manager**

Refer to the following sections to guide you through the update process:

- Update from older releases. See “Information About Older Releases.”
- Update from Release 1.7.4 to 1.8.2. See “Update from Release 1.7.4 to 1.8.2.”
- Update from Release 1.8.2 to 2.0. See “Update to Release 1.8” or “Update to Release 2.0.”

2.8.10 **Update from Release 1.7.4 to 1.8.2**

Use Control4® Composer Pro to update your system from Release 1.7.4 to Release 1.8.2. Detailed instructions about how to update from Composer Pro Release 1.7.4 to 1.8.2 are not included in this document. For those instructions, refer to the *Composer Pro Software Update Instructions - Release 1.7.4 to 1.8.2* on the Control4 Knowledgebase. The document provides general steps, terms and concepts, and what to prepare for prior to performing the update. It then describes the steps for the update.

Ensure that Composer Pro and Director are using the same version of 1.7.4, and that all devices are identified on the network before starting this update.

2.8.10.1 **What’s New in the Update?**

Release 1.8.x introduces support for ZigBee Pro 1.1. During the update from 1.7.4 to 1.8.2 all ZigBee devices will be updated to run on the ZigBee Pro stack which requires a complete replacement of the firmware on all devices. This enhancement allows Control4 to operate with other ZigBee Pro-compliant devices which opens up a whole world of new devices that are compatible with the Control4 system.

2.8.10.2 **Highlights of the Update**

1. New terms such as ZigBee Access Point (ZAP), ZigBee Pro, MiniApp, and EmberNet are introduced and described.
2. Two (2) stages of upgrade occur for MiniApps (Dimmers, Switches, Keypads, and outlet modules): the ZigBee Pro stack is installed, and then all the devices must be joined to the network. When updating the MiniApps, special LEDs on the devices indicate their status.
3. Products not supported with ZigBee Pro at this time:
   - **System Remote** Control V1 and V2
   - **LCD Keypad** (use Ethernet)
   - **Contact / Relay** Extender (use Ethernet)
4. The Network Tools screen (formerly Network Status) has a new tab for EmberNet Upgrade. This shows all of the devices on the current network that haven’t been updated to ZigBee Pro.
2.8.11 Update to Release 1.8.2

Use the Control4® Composer Pro Update Manager to update to Release 1.8.2.

**IMPORTANT**: To update to Release 1.8.2, the Control4 system first must be updated to Release 1.7.4. After that, follow the instructions in the Composer Pro Software Release Update Instructions - Release 1.7.4 to 1.8.2 on the Control4 Knowledgebase.

2.8.12 Update to Release 2.0

Use the Control4® Composer Pro software to update to OS 2.0.

**Note**: Before you begin the update, ensure that the Control4 system has been updated first to Release 1.7.4 and then to 1.8.2. Also, ensure that you have installed Composer Pro 2.0.

For update instructions, refer to

- Composer Pro Software Release Update Instructions - Release 1.7.4 to 1.8.2
- Control4 System Software Release Version 2.0 Release Notes

on the Control4 Dealer web site or on the Control4 Knowledgebase. These documents provide important terms and concepts that you must understand, and what to prepare for prior to performing the update. It then describes the steps to follow to complete the update.

2.9 Example Projects

Refer to the sections below to use Control4® Composer Pro Interviewer or Composer Pro views to help you understand how to add and identify devices for a Control4 system.

2.9.1 Example Smith Home: Interviewer Method

The following sample project sections step you through the creation of a Control4® project using Interviewer wizard in Composer Pro. Alternatively, you can create a new project using the Composer Pro views in Composer Pro. See Composer Pro Getting Started for details.

2.9.1.1 Procedure

To use the Interviewer wizard:

1. Start Composer and connect to a Director.
2. Click System Design.
3. From the File menu, select Run Interview.

Refer to the following sections to use the Interviewer wizard:

"Example: System Specifications"
"Example: Design and Create the Project"
"Example: Define Devices in Each Room"
"Example: Identify the Devices on the Network"
"Example: Define the Audio/Video Connections"
"Example: Define the Control Connections"
2.9.1.2 Example: System Specifications

Use either the Control4® Composer Pro views or the Interviewer wizard to create a project.

First start by reviewing these system specifications to understand what is in three (3) rooms of the home and which Control4 devices are used in each room. The example scenario sets up home control for a Theater, a Bedroom, and the Front of the home. Follow the sections in order.

2.9.1.2.1 Devices by Room

This project includes the following rooms and Control4 devices in those rooms:

- Theater
  - Controller
  - Theater Dimmer
  - Theater Light Switch
  - Wireless Outlet Switch
  - System Remote Control
  - 6 Button Keypad
  - Receiver
  - Television
  - DVD player or Sony CX 777ES DISC Changer
  - Motorized Screen
  - Door Contact Sensor
- Bedroom
  - Mini Touch Screen
  - Bedroom Dimmer
  - Gas Fireplace
  - Gas Fireplace Relay
- Front
2.9.1.2.2 Hardware Connections

The following tables detail the connections that need to be made for the devices to be automated. Refer to these tables as you move through the project creation process.

Table 1. Output to Input

<table>
<thead>
<tr>
<th>Connect From Output Device:</th>
<th>Connect To Input Device:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Controller</strong></td>
<td></td>
</tr>
<tr>
<td>Video Out 1 (Video—COMPOSITE)</td>
<td>Receiver (INPUT VIDEO 1—Theater)</td>
</tr>
<tr>
<td>Stereo 1 (Audio—STEREO)</td>
<td>Receiver (INPUT VIDEO 1—Theater)</td>
</tr>
<tr>
<td>Contact Sensor 1 (Control—CONTACT_SENSOR)</td>
<td>Motion Sensor (Contact Sensor—Front)</td>
</tr>
<tr>
<td>Contact Sensor 2 (Control—CONTACT_SENSOR)</td>
<td>Doorbell (Contact Sensor—Front)</td>
</tr>
<tr>
<td>Contact Sensor 3 (Control—CONTACT_SENSOR)</td>
<td>Door Contact Sensor (Contact Sensor—Theater)</td>
</tr>
<tr>
<td><strong>IR Output 1 (Control—IR_OUT)</strong></td>
<td>Television (IR Sensor—Theater)</td>
</tr>
<tr>
<td>IR Output 2 (Control—IR_OUT)</td>
<td>Receiver (IR Sensor—Theater)</td>
</tr>
<tr>
<td>IR Output 3 (Control—IR_OUT)</td>
<td>DVD (IR Sensor—Theater)</td>
</tr>
<tr>
<td>Relay Port 1 (Control—RELAY)</td>
<td>Gas Fireplace (Relay—Bedroom)</td>
</tr>
<tr>
<td>Relay Port 2 (Control—RELAY)</td>
<td>Sprinklers (Relay—Front)</td>
</tr>
<tr>
<td>Relay Port 3 (Control—RELAY)</td>
<td>Motorized Screen (Relay—Theater)</td>
</tr>
<tr>
<td>Relay Port 4 (Control—RELAY)</td>
<td>Electronic Gate (Relay—Front)</td>
</tr>
<tr>
<td><strong>Receiver - Tuner — Harman Kardon AVR 230</strong></td>
<td></td>
</tr>
<tr>
<td>Output (Video—COMPOSITE)</td>
<td>Television (AV In — Theater)</td>
</tr>
<tr>
<td>Output (Audio—STEREO)</td>
<td>Television (AV in — Theater)</td>
</tr>
<tr>
<td><strong>DVD Player — Samsung HD841</strong></td>
<td></td>
</tr>
<tr>
<td>Video Out (Video—COMPOSITE)</td>
<td>Receiver (INPUT DVD—Theater)</td>
</tr>
<tr>
<td>Mixed Audio Out (Audio—STEREO)</td>
<td>Receiver (INPUT DVD—Theater)</td>
</tr>
</tbody>
</table>
Table 2. Input to Output

<table>
<thead>
<tr>
<th>Connect from Input Device:</th>
<th>Connect to Output Device:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiver — Harman Kardon AVR 230</td>
<td>Controller (Video Out 1 — Theater)</td>
</tr>
<tr>
<td>INPUT VIDEO 1 (Video—COMPOSITE)</td>
<td>DVD (Output— Theater)</td>
</tr>
<tr>
<td>INPUT DVD (Video—COMPOSITE)</td>
<td>DVD (Output— Theater)</td>
</tr>
<tr>
<td>INPUT VIDEO 1 (Audio—STEREO)</td>
<td>Controller (Stereo 1—Theater)</td>
</tr>
<tr>
<td>INPUT DVD (Audio—STEREO)</td>
<td>Controller (Stereo 1—Theater)</td>
</tr>
<tr>
<td>IR Sensor (Control—IR_OUT)</td>
<td>Controller (IR Output 2—Theater)</td>
</tr>
<tr>
<td>Television — Samsung TX-P1430</td>
<td>Receiver (Output—Theater)</td>
</tr>
<tr>
<td>Input Side (Video—COMPOSITE)</td>
<td>Receiver (Output—Theater)</td>
</tr>
<tr>
<td>Input Side (Audio—STEREO)</td>
<td>Receiver (Output—Theater)</td>
</tr>
<tr>
<td>IR Sensor (Control—IR_OUT)</td>
<td>Controller (IR Output 1—Theater)</td>
</tr>
<tr>
<td>Contact Sensor (Control—Contact_Sensor)</td>
<td>Television</td>
</tr>
<tr>
<td>DVD Player — Samsung HD841</td>
<td>Controller (IR Output 3—Theater)</td>
</tr>
<tr>
<td>IR Sensor (Control—IR_OUT)</td>
<td>Controller (IR Output 3—Theater)</td>
</tr>
<tr>
<td>Motorized Screen</td>
<td>Controller (Relay Port 3—Theater)</td>
</tr>
<tr>
<td>Relay (Control—RELAY)</td>
<td>Controller (Relay Port 3—Theater)</td>
</tr>
<tr>
<td>Door Contact Sensor</td>
<td>Controller (Contact Sensor 3—Theater)</td>
</tr>
<tr>
<td>Contact Sensor (Control—CONTACT_SENSOR)</td>
<td>Controller (Contact Sensor 3—Theater)</td>
</tr>
<tr>
<td>Gas Fireplace</td>
<td>Controller (Relay Port 1—Theater)</td>
</tr>
<tr>
<td>Relay (Control—RELAY)</td>
<td>Controller (Relay Port 1—Theater)</td>
</tr>
<tr>
<td>Electronic Gate</td>
<td>Controller (Relay Port 4—Theater)</td>
</tr>
<tr>
<td>Relay (Control—RELAY)</td>
<td>Controller (Relay Port 4—Theater)</td>
</tr>
<tr>
<td>Sprinklers</td>
<td>Controller (Relay Port 2—Theater)</td>
</tr>
<tr>
<td>Relay (Control—RELAY)</td>
<td>Controller (Relay Port 2—Theater)</td>
</tr>
<tr>
<td>Doorbell</td>
<td>Controller (Contact Sensor 2—Theater)</td>
</tr>
<tr>
<td>Contact Sensor (Control—CONTACT_SENSOR)</td>
<td>Controller (Contact Sensor 2—Theater)</td>
</tr>
<tr>
<td>Motion Sensor</td>
<td>Controller (Contact Sensor 1—Theater)</td>
</tr>
<tr>
<td>Contact Sensor (Control—CONTACT_SENSOR)</td>
<td>Controller (Contact Sensor 1—Theater)</td>
</tr>
</tbody>
</table>

Refer to “Example: Design and Create the Project” to go to the next example steps.

2.9.1.3 Example: Define Devices in Each Room

This section discusses using Control4® Interviewer wizard in Composer Pro to define devices in each room.

Note: This procedure follows “Example: Design and Create the Project.” If you have not read that section, go there first before you review this section.
You are now in the Rooms section of Interviewer. In this section, Interviewer asks you a series of questions about each room to find out what devices you want to control there, and it asks questions about the selected room before moving to the next room.

2.9.1.3.1 Procedure: Define Devices in the Theater

To define devices in the Theater:

1. Check the boxes to indicate the types of devices in this room.

   Example: For the Theater room: De-select Multi-Room Audio. Check Controllers, User Interface, AV Components, Lighting, Motorization, and Sensors.

2. Click next.

3. Add the Controllers that reside in the room.

   The Digital Audio and Controller objects appear in the 'Devices in the Room' pane. The Digital Audio object represents the audio that exists on the Control4 Controller. Only one (1) Digital object added per project, so if you tried to add another Controller, a second Digital Audio object would not be added to the project tree.

   Note: When you click next and return to this screen, the object no longer appears on the screen. However, if you look in Composer Pro project tree, it still appears.

   Example: Add the Controller to the Theater. The Digital Audio and Controller objects appear.

4. Click next.

5. Add the objects for the devices to this room. Double-click a device (or select it and click Add) to move the devices from the 'Available Devices' list to the 'Devices in Room' list.
Example: Double-click 6 Button Keypad and System Remote Control to add them to the Theater room (If you do not have a 6 Button Keypad, add a 3 Button Keypad).

Note: If you have access to a Wireless Touch Screen, add it to your project now.

6. Click next.
7. Add all AV component devices in this room. For example, if a DVD player, a receiver, and a television are in this room, add them as described in the following sub-steps.

    Tip: To add AV components, double-click the device; from the dialog that appears, choose a manufacturer (from the drop-down list), and double-click the model.

   a. Add DVD to the ‘Devices in Room’ list from the Online Database.

      Example: Add the DVD Player, choose Online Database, choose the manufacturer Samsung, and then double-click the model DVD-HD841 [IR] model from the Online Database. If you can access the Sony CX 777ES Disc Changer, add this instead. Instructions about how to scan this bi-directional Disc Changer is described later in this section.

      Double-click to add a DVD to the project. On the dialog that appears, click the Online Database radio button, then use the scroll-down menu in Manufacturer to select Samsung.

      Double-click to add the model to the Devices in the Room list.

   b. Add the Receiver to the Devices in Room list using the Online Database.

      Example: Add the Receiver, select the Online Database, choose the manufacturer Harmon Kardon, and then double-click the model AVR 230[IR] from the list.

   c. Add the Television to the ‘Devices in Room’ list using the Online Database.
Example: Double-click Television, select Online Database, choose the manufacturer Samsung, and then double-click the model TX-P1430. This adds the device driver for cable TV and UHF/VHF.

d. Click next.

8. Add the Dimmers, Switches, and Outlet Switches to the Devices in Room list, and give each a descriptive name (edit immediately after adding while still in edit mode, or right-click later).

Example: Use the previous examples to

Add a Wireless Dimmer, and rename it Dimmer.
Add a Wireless Switch, and rename it Light Switch.
Add a Wireless Outlet Switch, and rename it Television Outlet Switch.

9. Click next.
10. Add the Sensors and Contacts to the Devices in Room list, and give each a descriptive name.

Example: Add a Door Contact Sensor for the door to the Theater.

11. Click next.
12. Add the Motorized Devices to the Devices in Room list.

Example: Add a Motorized Screen to the Theater.

13. You have just completed the setup for the Theater. Click next to move to the Bedroom.

2.9.1.3.2 Procedure: Define Devices in the Bedroom

To define devices in the Bedroom:
1. Notice that the selected room on the left is now Bedroom. For the selected room, check the appropriate boxes to indicate the devices used in this room.

Example: For the Bedroom: De-select AV Components and Sensors. Check User Interface, Multi-Room Audio, Lighting, and Motorization.

2. Click next.
3. Add the devices to this room. Double-click a device to move the devices from the Available Devices list to the Devices in Room list.

Example: Add the Mini Touch Screen to the Bedroom.

4. Click next.
5. Choose how the digital audio is received in this room.
Example: Audio is sent digitally to the Mini Touch Screen. Choose Through a Mini Touch Screen.

6. Click next.

7. Add the Dimmers, Switches, and Outlet Switches to the Devices in Room list, and give each a descriptive name (edit immediately after adding while still in edit mode, or right-click later).

Example: Add a Wireless Dimmer and rename it Dimmer.

8. Click next.

9. Add the Motorized Devices to the Devices in the Room list.

Example: Add the Gas Fireplace to the Bedroom.

10. You have just completed the setup for the Bedroom. Click next to move on to the Front of the house.

2.9.1.3.3 Procedure: Define Devices in the Front Room

To define devices in the Front Room:

1. Notice that the selected room on the left is now Front Room. For the selected room (Front Room), check to identify the types of devices you have in that room, and then click next.

Example: De-select AV Components, Multi-Room Audio, and Lighting. Check User Interface, Motorization, and Sensors.

2. Click next.
3. Identify which Navigators are included in each room by selecting the Navigator, and then clicking the double-arrow button.

   **Example:** Add the 3 Button Keypad and LCD Keypad for the Navigator in the Front Room.

4. Click **next**.
5. Add the **Sensors** to the Devices in the Room list.

   **Example:** Add the Doorbell and Motion Sensor to the Front Room.

6. Click **next**.
7. Add the **Motorized** devices to the Devices in the Room list.

   **Example:** Add the following: Electronic Gate and Sprinklers.

If you have a Thermostat, add it in Composer Pro after you exit Interviewer. See “Configuring HVAC Systems.”

You have just completed defining the devices in each room. Click **next** to continue to the next section to identify the network connections.

2.9.1.4 **Example: Identify the Devices on the Network**

This section discusses using Control4® Interviewer wizard in Composer Pro to identify the devices you’ve added in the project to the network.

**Note:** This process follows “Example: Define Devices in Each Room.”

You are now ready to set up the network connections in the **Network** section of Interviewer. In this section, you identify the physical **device** to its network address so the devices can communicate with the Controller.

Follow the on-screen instructions specific to the selected device to identify it on the network. The first item is selected by default automatically. When selected, the device is placed in 'Identify' mode. Devices that use network connections and associated instructions are found in “Example: Make and Verify the Connections.”

**Note:** To program lighting and Keypad buttons, see “Programming the System.” To set up Lighting Scenes, see “Program with the Lighting Scenes Agent.”

2.9.1.4.1 **Procedure**

To identify devices on the network, go to the physical device and follow these instructions. The diagram for the device indicates which button to press.

1. Go to the Media **Controller** hardware, and press the **Select** dial to identify the device. When the address appears, click **next**.
2. Pick up the **System Remote Control**, and press the 4 button to identify the device. You may need to press it repeatedly until the address appears. When the address appears, click **next**.

3. Go to the **6 Button Keypad**, and press the top left button **four (4)** times in rapid succession to identify the device. When the address appears, click **next**.

4. Go to the **Theater Dimmer**, and press the top **button four (4)** times to identify the device. When the address appears, click **next**.

5. Go to the **Theater Light Switch**, and press the top **button four (4)** times to identify the device. When the address appears, click **next**.

6. Go to the **Theater Outlet Switch**, and press the **button four (4)** times to identify the device. When the address appears, click **next**.

7. Go to the **Mini Touch Screen**, and press the **Select dial** to identify the device. When the address appears, click **next**.

8. Go to the **Bedroom Dimmer**, and press the **top button four (4)** times to identify the device. When the address appears, click **next**.

9. Go to the **3-Button Keypad**, and press the **top button four (4)** times in rapid succession to identify the device. When the address appears, click **next**.

10. Go to the **LCD Keypad**, and press the **Select dial** to identify the device. When the address appears, click **next**.

11. Click **next** to continue to the next section to define Audio/Video connections.

### 2.9.1.5 Example: Define the Audio/Video Connections

This section discusses using Control4® Interviewer wizard in Composer Pro to define the audio and video connections. You set up the software for audio and video connections that directly correspond to your hardware connections between your devices.

**Note:** This process follows “Example: Identify the Devices on the Network.”
You are now in the Audio/Video section of Interviewer. In this section you identify any devices and their connections that carry audio and/or video signals. Using the Smith Home example project (a Controller project), complete the following steps.

2.9.1.5.1 Procedure

To define audio/video connections:

1. Choose the device(s) to which the specified Controller sends audio and video signals.

   Example: The Controller in the Theater Room sends audio and video to the Receiver. Add Theater > Receiver to the Connected Devices list.

2. Click next.

   The Receiver is the only device connected to the Television. Both the DVD player and the Controller route their audio and video signals through the Receiver to get to the Television.

3. Choose how the Controller Stereo Outputs connect to the Receiver.
a. Choose how the Controller Stereo 1 Output connects to the Receiver.

   Example: In Audio Connections, check INPUT VIDEO 1 and check STEREO.

b. Click next.

c. Choose how the Controller Stereo 2 Output connects to the Receiver.

   Example: Ensure that none is checked (Controller Stereo 2 does not connect to the Receiver).

d. Click next.

e. Choose how the Controller Stereo 3 Output connects to the Receiver.

   Example: Ensure that none is checked (Controller Stereo 3 does not connect to the Receiver).

4. Click next.

5. Choose how the Controller Video Out Outputs connect to the Receiver

a. Choose how the Controller Video Out 1 Output connects to the Receiver.

   Example: In Video Connections, check INPUT VIDEO 1, and then check COMPOSITE.

b. Click next.
6. Choose the device(s) to which the DVD sends audio and video signals.

   **Example:** In the Audio/Video list on the left, check DVD, and then double-click Theater > Receiver to add it to the Connected Devices list.

   a. Click next.
   b. Choose how the Theater DVD Output connects to the Receiver.

      **Example:** In Audio Connections, check INPUT DVD, and then check STEREO. In Video Connections, check INPUT DVD, and then check COMPOSITE.

   c. Click next.

7. Choose the device to which the Theater Receiver sends audio and/or video.

   **Example:** Double-click Theater > Television to add it to the 'Connected Devices' list.

   a. Click next.
   b. Choose how the Theater Receiver Output connects to the Television, and then click next.

      **Example:** In Audio Connections, check INPUT AV1, and then check STEREO. In Video Connections, check INPUT AV1, and then check COMPOSITE.

   c. Click next.
d. If applicable, choose the device(s) to which the Theater Tuner sends audio and/or video signals. Make connections only to stand-alone tuners. A tuner that is a built-in component to another AV device, such as Receiver, uses the host’s connections.

Example: The Tuner in this project is a built-in tuner to the Receiver, and therefore, uses the same AV Connections set up previously for the Receiver.

e. Click next.

8. Choose how the Bedroom Mini Touch Screen sends audio and/or video signals.

Example: The Mini Touch Screen does not send audio to any of these devices. It only sends audio to the powered speakers, which are not shown in Composer Pro projects. Ensure that nothing is selected.

9. You have just completed defining audio/video connections. Click next to continue to the next section to define Control connections.

2.9.1.6 Example: Define the Control Connections

This section discusses using Control4® Interviewer wizard in Composer Pro to define the Control connections.

Note: This process follows “Example: Define the Audio/Video Connections.”

You are now in the Control section of Interviewer. In this section, you identify all Control connections in the system.

Tip: To complete this section, refer to the control connection tables shown in the “Hardware Connections” section “From Output to Input” in “Example: System Specifications.”

Using the Smith Home example project (a Media Controller project), complete the following steps.

2.9.1.6.1 Procedure

To define Control connections:

1. Define the IR OUT port connections on the Controller.
   a. Choose IR OUT 1 to Television IR Sensor, and then click next.
b. Choose **IR OUT 2** for the **Receiver IR Sensor**, and then click **next**.

c. Choose **IR OUT 3** for the **DVD IR Sensor**, and then click **next**.

**Tip:** If you prefer to set up a video or **contact** sense **loop** instead of using a macro, see "Changing Power Management Options." After you add a video sense loop connection to the DVD player driver, add a **control connection** between the Controller and DVD player.

2. Define the **Contact** and **Relay** connections on the **Controller**.

   a. Choose **Contact 3** for the **Theater Door Contact Sensor**, and then click **next**.

   b. Choose **Relay 3** for the **Theater Motorized Screen**, and then click **next**.

   c. Choose **Relay 1** for **Bedroom Gas Fireplace**, and then click **next**.

   d. Choose **Contact 2** for the **Motion Sensor**, and then click **next**.

   e. Choose **Contact 1** for the **Motion Sensor**, and then click **next**.

   f. Choose **Relay 4** for the **Electronic Gate**, and then click **next**.

   g. Choose **Relay 2** for the **Sprinkler**, and then click **next**.

3. You have completed the setup of the system. Click **next** to exit the system.

After you have completed setting up the system using Interviewer, you may want to do one of the following:

- If you followed the "Example" instructions exactly and have completed all the Interviewer screens, you are ready to verify your connections and test the **device** control on the system. For instructions about how to do this, see “Connecting Devices.”

- If you want to learn how to set up the same example project using the Composer Pro screens rather than Interviewer, you can clear your sample project, and go to “Example Smith Home: Composer Views Method.”
If you understand what occurred in the previous procedure and you are ready to create your own project, go the Composer Pro Getting Started for planning and design steps.

2.9.2 Example Smith Home: Composer Views Method

The following sample project sections step you through the creation of a Control4® project using the Composer Pro views. Alternatively, you can create a new project using the Interviewer wizard in Composer Pro.

2.9.2.1 Procedure

To use Composer Pro views:

1. Start Composer and connect to a Director.
2. Click System Design.

Follow these sections in the order shown to use the Composer Pro views:

"Example: System Specifications"
"Example: Design and Create the Project"
"Example: Make and Verify the Connections"
"Example: Verify the Network Connections"
"Example: Define the Control and Audio/Video Connections"

2.9.2.2 Example: Design and Create the Project

There are two (2) ways you can design and create a project. Use the Control4® Composer Pro views or Interviewer wizard in Composer Pro to design and create a project.

2.9.2.2.1 Interviewer Wizard

You begin the Interview with the System section. In this section, Interviewer asks you questions regarding the entire system, including types of devices, the rooms that contain devices, etc.

2.9.2.2.1.1 Procedure

To define system information:

1. Start Interviewer.
2. Type the Project Name: Franklin Smith Home.
3. Type a valid zip code to automatically populate the appropriate latitude and longitude coordinates, and then click next. These coordinates are editable if necessary. The Control4 system uses these coordinates to identify the local sunrise and sunset times (to be used in future programming calculations).

Example: Enter Zip code: 84003
4. Check the boxes to indicate which types of devices you are adding to the system.

   **Example:** Check AV Components, Multi-Room Audio, Lighting, Motorization, Temperature Control, and Sensors.

5. Click **next**.
**Tip:** Temperature control is not fully implemented in Interviewer. If you have a Thermostat, you need to add it and identify it to the system outside of Interviewer. For instructions on how to do this, see “Configuring HVAC Systems” for more information.

6. Add rooms by double-clicking a room or selecting a room, and clicking the **double-arrow** button.

   **Example:** Add Theater, Bedroom, and Front.

7. When you’ve added the rooms, click **next**.
8. Choose the method that distributes multi-room audio. Multi-room audio choices include:
   - **Digitally**—Set up a multi-room audio system utilizing the network as an audio distribution system with digital-end points.
   - **Audio Switch**—Install and set up a multi-room audio system, utilizing a traditional analog audio switch and amplifiers.
   - **Receivers**—Install and set up a multi-room audio system, utilizing a receiver in each room to distribute audio.

   **Example:** Audio is streamed (through *Ethernet*) to the Mini *Touch Screen* to the Bedroom, so you would choose **Digitally**.

9. You have just completed your System setup. Click **next** to continue to the next section to complete Rooms setup.

**2.9.2.2.2 Composer Views**

In this view, you create the foundation of the Control4 system by building the *project tree*.

**2.9.2.2.2.1 Procedures**

To design the Smith Home project:

1. Start **Composer** and connect to a **Director** on a **Local Network**.

2. Enter the Project Properties for the Smith Home.
   - **Name:** Franklin Smith Home.
   - **Zip Code:** 84003 or enter a Latitude and Longitude manually.
   - **Date & Time:** Use the drop-down menu to change these as desired.
   - **Time Zone:** Use the drop-down menu to select the appropriate zone.

3. Add rooms to the project tree.
   a. In the Locations tab, double-click on a **room** to add it to the project tree.
   b. Continue to add **rooms** until you have included all rooms you want in the house (rooms that will have automated devices). You can also drag these items to an object in the project tree.

   **Example:** Add three (3) rooms.
   - Theater
   - Bedroom
   - Front

**Tips:** To build the system design, define the project configuration in the project tree. You do not have to add all the items in the project tree manually, such as Site > Building > Floor > Room because Composer Pro automatically adds the required infrastructure.

Also, you can rename the objects as desired; for example, Franklin Smith Home > Home > House > Main > Theater. For more information, see **Composer Pro Getting Started**.
To add the devices:

1. Add the **Controller** to a **room** in the project tree.
   a. When setting up a system, first add the Controller driver to the list. In the project tree, choose the room where you want the Controller to reside. In the **Items pane > My Drivers** tab, double-click a **Controller** to move it to the room. See the example below.

   **Note:** If you installed this version of Composer Pro on a computer with an older version of Composer Pro, right-click in the **My Driver** tab, and choose **Restore Default List**. This will update the My Driver list.

   **Example:** Add a Controller to the Theater Room:

   b. From the project tree, select **Theater**. In the **Items pane > My Drivers** tab under Controllers, double-click **Controller** or drag it to the room where it resides—in this case, Theater. The Controller and Digital Audio appear in the project tree. The Digital Audio object resides on the Controller, but shows up as a separate object in the project tree. The Digital Audio provides the functionality to play media.
2. Add the Lighting and Navigators to the applicable rooms. The example below shows some devices you can add.

**Example:** Select Theater in the project tree. In the My Drivers tab, do the following:

a. In Lighting > Light, double-click Wireless Dimmer, and then rename to Dimmer.

b. In Lighting > Light, double-click Wireless Switch, and then rename to Light Switch.

c. In Lighting > Light, double-click Wireless Outlet Switch, and then rename to Television Outlet Switch.

d. In User Interface, double-click System Remote Control.

e. In User Interface, double-click 6 Button Keypad.

f. In User Interface, double-click LCD Keypad.

**Tip:** Use a descriptive name. When adding devices to the home, right-click and choose Rename to rename them with a descriptive name. For example, if you have two (1) Dimmers in a room, give them a descriptive name such as "Wall Dimmer" or "East Dimmer." This helps you identify the specific Dimmer later when identifying connections. If there's only one Dimmer or Switch in a room, however, you can keep the generic title "Dimmer" or "Switch."

3. Add a Receiver to the applicable room.

**Example:** Add a Receiver to the Theater. To add, select Theater in the project tree. From the My Drivers tab, do the following:

a. In Audio/Video, double-click Receiver.

b. In the dialog box that appears, choose Online Database, choose the manufacturer Harmon Kardon, and then double-click AVR146[iR] to add the Receiver to the project tree.
4. Add a **Television** to the applicable **room**. This will probably be the same room where the Controller is.

**Example:** Add the **Television** to the **Theater**. To add, select **Theater** in the project tree. From the **My Drivers** tab, do the following:

a. In Audio/Video, double-click **Television**.

b. In the dialog box that appears, choose **Online Database**, choose the manufacturer **Samsung**, and then double-click **HC-J655W[IR]**.

The UHF/VHF object may be added to enable you to scan for UHF/VHF broadcast channels.
5. Add additional **Audio/Video** devices to the **room**.

   **Example:** Add the **DVD Player** to the **Theater**. To add, select **Theater** in the project tree. From the **My Drivers** tab, do the following:

   a. In Audio/Video, double-click **DVD**.
   b. In the dialog box that appears, choose **Online Database**, choose the manufacturer **Samsung**, and then double-click **DVD HD841[IR]**.

   **Note:** If you can access a Wireless Touch Screen, add it now to your project. If you previously had a Wireless Touch screen on your system prior to Release 1.3, follow the special update instructions in “Information About Older Releases.”

6. Add a **motorized** device or **sensor** to the applicable room.

   **Example:** From the My Drivers tab, add a **Motorized** screen and a **Door Contact Sensor** to the Theater room from the Online Database. To add, select **Theater** in the project tree. In the **My Drivers** tab, do the following:

   a. In Motorization, double-click **Motorized Screen**.
   b. In Sensors, double-click **Door Contact Sensor**.

7. Repeat Steps 2 through 6 as needed to add more devices to the applicable rooms.

   **Example:** To finish creating the project tree for the example project, add devices to the **Bedroom** and **Front Room** as follows.

   **Bedroom:**

   Select **Bedroom** in the project tree. In the My Drivers tab, do the following:

   - In Lighting > Light, double-click **Wireless Dimmer**, and then rename it to **Bedroom Dimmer**.
   - In User Interface, double-click **Mini Touch Screen**.
   - In Motorization, double-click **Gas Fireplace**.

   **Front Room:**

   Select **Front Room** in the project tree. From the My Drivers tab, do the following:

   - In User Interface, double-click **3 Button Keypad**.
   - In Motorization, double-click **Electronic Gate**.
   - In Motorization, double-click **Sprinklers**.
   - In Sensors, double-click **Doorbell**.
   - In Sensors, double-click **Motion Sensor**.
2.9.2.3 Example: Make and Verify the Connections

This section discusses using Control4® Composer Pro views to make and verify the connections.

**Note:** This process follows Example: Design and Create the Project.

In the Connections view, you can:
- Identify Control4 devices to establish a Network connection
- Check all Network connections
- Define AV connections
- Define Control connections

**Note:** When only one appropriate connection is available in a room for a given connection type, Composer Pro assumes the connection (example: if a TV is the only Audio Output device in a room, the system assumes that the Audio Output connection is routed to the TV). This feature adds value to Composer Pro, but increases the need to verify every connection.

**Note:** To remove a connection, right-click on the connection and choose Disconnect.

2.9.2.3.1 Procedure

To make connections:

1. In Composer Pro, click the Connections view.
2. Identify the Control4 devices that connect to the Controller through the network. Go to each physical device and press the button indicated on the Composer Pro screen.

   a. Click the Network tab > IP Network.

   Notice the devices that do not have an address listed under the Address column.
b. Select the Controller, and then click Identify. The screen to identify the Controller appears (in this example, the HC500).

c. At the physical Controller, press the Select dial one time to the right of the screen. This identifies the Controller with a unique address in the system. When the address appears on the screen, click Next.

d. Select Dimmer, and then click Identify. The screen to identify the Dimmer appears. Press the top Dimmer button four (4) times. This identifies this specific Dimmer with a distinctive address to the system. When the address appears, click Next.

e. When the Light Switch identification screen appears, press the top button four (4) times. When the address appears, click Next.

f. When the System Remote Control identification screen appears, holding the physical System Remote Control press the red 4 button once. When the address appears in the box, click Next to continue.

g. If you have a Wireless Touch Screen in your project, press the Enter button on the front of the Touch Screen. When the address appears in the box, click Next to continue.
h. When the Outlet Switch identification screen appears, press the button on the module four (4) times.

i. When the 6 Button Keypad identification screen appears, press the top left button four (4) times. When the address appears, click Next.

j. When the Dimmer identification screen appears, press the top button four (4) times. When the address appears, click Next.

k. When the Mini Touch Screen identify screen appears, press the dial one time. When the address appears, click Next.

l. When the 3 Button Keypad identification screen appears, press the top button four (4) times. When the address appears in the box, click Next.

m. When the Control4 Wireless Thermostat identification screen appears, press the middle button four (4) times. When the address appears in the box, click Close to exit Identify mode.

n. When you finish identifying the devices, notice that the Address column now has an address for every network device.

3. Define the AV and Control connections.

Control and AV connections for a device are visible when you click the Connections view > Control/AV tab, and then select the device. To make a connection between inputs and outputs, from the top pane drag a device’s input (or output) to the output (or input) in the bottom pane.

For each device, define the following when applicable:

- Video connections (path of video signals)
- Audio connections (path of audio signals)
- Control connections (how the Controller communicates with the device)
a. Define the AV connections for the Receiver.

Example: In the Connections view under Theater, click Receiver. The right top pane displays all the inputs and output on the back of the Receiver. For Receiver, from the top pane in Audio Video Inputs, make the following connections:

- Click INPUT DVD (Video—COMPOSITE), and drag it to DVD (Output—Theater) in the bottom pane.
- Click INPUT VIDEO 1 (Video—COMPOSITE), and drag it to Media Controller (Video Out 1—Theater) in the bottom pane. This connects the Receiver Video 1 input to the Media Controller Video 1 output.
- Click INPUT DVD (Audio—STEREO), and drag to DVD (Output—Theater) in the bottom pane.
b. Define the Control connection for the Receiver to the Controller.

Example: In the Connections view under Theater, click Receiver. The right top pane displays all the inputs and output on the back of the Receiver.

For Receiver, from the top pane under Control Inputs, make the following connections:
• Click IR Sensor (Control—IR_OUT), and drag it to Controller (IR Output 2—Theater) in the bottom pane.

![Connections view with Receiver and Controller connections](image)

b. Define the Control connection for the Receiver to the Controller.

Example: In the Connections view under Theater, click Receiver. The right top pane displays all the inputs and output on the back of the Receiver.

For Receiver, from the top pane under Control Inputs, make the following connections:
• Click IR Sensor (Control—IR_OUT), and drag it to Controller (IR Output 2—Theater) in the bottom pane.

![Connections view with Receiver and Controller connections](image)

c. Define AV and Control connections for the Television.

Example: In the Connections view under Theater, click Television. The right top pane displays all the inputs and outputs on the back of the Television. For Television, from the top pane do the following:

In Audio Video Inputs:
• Click AV (Video—COMPOSITE), and drag it to Receiver (Output—Theater) in the bottom pane.
• Click AV (Audio—STEREO), and drag it to Receiver (Output —Theater) in the bottom pane.

In Control Inputs, click IR Sensor (Control—IR_OUT), and drag it to Controller (IR Output 1—Theater) in the bottom pane.
d. Define the **Control** connections for the **DVD player** to the **Controller**.

**Example:** In the Connections view under Theater, click **DVD**. The right top pane displays all the inputs and outputs on the back of the DVD. From the top pane, do the following:

In Control Inputs, click **IR Sensor (Control—IR_OUT)** and drag it to **Controller (IR Output 3—Theater)** in the bottom pane.

**Tip:** If you prefer to set up a video sense **loop** instead of using a macro, see “Changing Power Management Options.” After you add a video sense loop connection to the DVD player driver, add a control connection between the Media Controller and the DVD player.

e. Define the **Control** connections for the **Motorized Screen** to the **Controller**.
Example: In the Connections view under Theater, click **Motorized Screen**. The top right pane displays all the inputs and outputs on for the screen.

In the top pane under Control Inputs, click **Relay (Control—RELAY)**, and drag to **Controller (Relay Port 3—Theater)** in the bottom pane.

Example: In the Connections view under Theater, click **Door Contact Sensor**. The top right pane displays all the inputs and outputs for the Door Contact Sensor.

In the top pane under Control Inputs, click **Contact Sensor (Control—CONTACT_SENSOR)**, and drag it to **Controller (Contact Sensor 3—Theater)** in the bottom pane.

f. Define the **Control** connections for the **Door Contact Sensor** to the **Controller**.

Example: In the Connections view under Theater, click **Door Contact Sensor**. The top right pane displays all the inputs and outputs for the Door Contact Sensor.

In the top pane under Control Inputs, click **Contact Sensor (Control—CONTACT_SENSOR)**, and drag it to **Controller (Contact Sensor 3—Theater)** in the bottom pane.

g. Define the **Control** connections for the **Gas Fireplace** to the **Controller**.

Example: In the Connections view under Bedroom, click **Gas Fireplace**. The top right pane displays all the inputs and outputs for the Gas Fireplace.

In the top pane under Control Inputs, click **Relay (Control—RELAY)**, and drag it to **Controller (Relay Port 1—Theater)** in the bottom pane.

h. Define the **Control** connections for the **Electronic Gate** to the **Controller**.

Example: In the Connections view under Front, click **Electronic Gate**. The top right pane displays all the inputs and outputs for the Electronic Gate.
In the top pane under Control Inputs, click Relay (Control—RELAY), and drag it to Controller (Relay Port 4—Theater) in the bottom pane.

i. Define the Control connections for the Sprinklers to the Controller.

**Example:** In the Connections view under Front, click Sprinklers. The top right pane displays all the inputs and outputs for the Sprinklers.

In the top pane under Control Inputs, click Relay (Control—RELAY), and drag it to Controller (Relay Port 2—Theater) in the bottom pane.

j. Define the Control connections for the Contact Sensor to the Controller.

**Example:** In the Connections view under Front, click Doorbell. The top right pane displays all the inputs and outputs for the Doorbell.

In the top pane under Control Inputs, click Contact Sensor (Control—CONTACT_SENSOR), and drag it to Controller (Contact Sensor 2—Theater) in the bottom pane.

k. Define the Control connections for the Motion Sensor to the Controller.

**Example:** In the Connections view under Front, click Motion Sensor. The top right pane displays all the inputs and outputs for the Motion Sensor.

In the top pane under Control Inputs, click Motion Sensor (Control—CONTACT_SENSOR), and drag it to Controller (Contact Sensor 1—Theater) in the bottom pane.

4. Go to the next section, “Example: Verify the Network Connections.”

2.9.2.4 **Example: Verify the Network Connections**

This section discusses using Control4® Composer Pro views to verify the network connections.

**Note:** This process follows “Example: Make and Verify the Connections.”

There are two (2) places to verify network connections:

1. The Network tab
2. The Tools menu
Follow the instructions below to check your connections in both locations.

2.9.2.4.1 Procedure
To check your connections from both locations:
1. From the Connections view > Network tab, verify that every device that communicates to the Controller using TCP/IP, WiFi, and/or ZigBee has a network address. If a device doesn’t have a network address, the device needs to be identified.
2. To identify a device from this location, right-click on the device and choose Identify (or click the Identify button). Follow the on-screen instructions provided for each device, such as those listed in the following table.

After identifying the network connection, the device’s address appears in the list.

<table>
<thead>
<tr>
<th>Device</th>
<th>Instructions to Identify a Device to the Control4 System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controllers</td>
<td>Press the Identification button on the Controller.</td>
</tr>
<tr>
<td>Lights and Keypads</td>
<td>Press top button 4 times (6 Button Keypad — press top left button). For Release 1.8 and later, press any button 4 times. MiniApp mode: press bottom left or bottom button 4 times.</td>
</tr>
<tr>
<td>System Remote Controls</td>
<td>Press the red 4 button on the remote control.</td>
</tr>
<tr>
<td>Mini Touch Screens</td>
<td>Press the Select dial on the Mini Touch Screen.</td>
</tr>
<tr>
<td>LCD Keypads</td>
<td>Press the Select dial on the LCD Keypad.</td>
</tr>
<tr>
<td>Speaker Point</td>
<td>Press button 1 time.</td>
</tr>
<tr>
<td>Multi Tuners</td>
<td>Press button 1 time.</td>
</tr>
<tr>
<td>16 Channel Amps</td>
<td>Press button 1 time.</td>
</tr>
<tr>
<td>Thermostats</td>
<td>Press center button 4 times.</td>
</tr>
<tr>
<td>Wireless Outlet</td>
<td>Press button 4 times.</td>
</tr>
</tbody>
</table>
### Device Instructions to Identify a Device to the Control4 System

<table>
<thead>
<tr>
<th>Device</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Switches</strong></td>
<td></td>
</tr>
<tr>
<td>Wireless Touch Screens</td>
<td>Press the <strong>Enter</strong> button on the front of the Touch Screen 1 time.</td>
</tr>
<tr>
<td>Black &amp; Decker Kwikset Locks</td>
<td>Press the <strong>Top Left</strong> button on the top of the board (remove the lock’s cover first) 4 times. To disconnect, press the <strong>Top Right</strong> button on the top circuit board 9 times.</td>
</tr>
<tr>
<td>1-Button Products</td>
<td>Release 1.8 and later, press 4 times.</td>
</tr>
<tr>
<td>IO Extenders</td>
<td>Press the Link button on the back of the IO Extender.</td>
</tr>
<tr>
<td>Media Players</td>
<td>Press the Link LED button on the front of the Media Player.</td>
</tr>
<tr>
<td>Touch Screens (not Mini)</td>
<td>Press the button indicated on the diagram of the device in Composer Pro.</td>
</tr>
</tbody>
</table>

#### 2.9.2.4.2 Using the Network Tab

To ensure all devices have been identified from the Network tab:

1. Click Connections > Network tab > IP Network.
2. In the Address column, check if there is an address for every line item.

![Diagram of Network Tab](image)

#### 2.9.2.4.3 Using Network Tools

To ensure all network connections exist and are active from Network Tools:

1. From the Tools menu, select **Network Tools**.
2. Check both the **IP Network** and **Zigbee Network** tabs for Green, Yellow, and Red connection icons. The colors indicate the following:
   - **Green**—An address is identified, and the device is online (communicating).
     **Example:** The Dimmer is identified and communicating to the system.
   - **Yellow**—An address is identified, and the device is offline (not communicating).
     **Example:** If the System Remote Control goes to sleep, the status turns Yellow. This indicates that the System Remote Control has been identified, but is offline (not communicating). Make the device active so it can communicate to the system.
• **Red**—A device is not identified. Go to the Connections view > Network tab, and identify the device to the system or see “Example: Make and Verify the Connections.”

3. If you find Yellow or Red icons, do the following:
   - **Yellow Icons**—Go to the device, and activate it according to its documentation.
   - **Red icons**—Go to the Connections view > Network tab, and identify the device to the system.

   **Example**: At this point in your example project, the System Remote Control should be yellow (or the only device not green). The System Remote Control turns green as soon as you wake up the System Remote Control. To wake up the System Remote Control, press the red Control4 4 button.

2.9.2.5 **Example: Define the Control and Audio/Video Connections**

This section discusses using Control4® Composer Pro views to define AV connections.

**Note**: This process follows “Verifying the Network Connections.”

Control/AV connections are visible when you select the Control/AV tab in the Connections view. The Control/AV tab lets you define the physical connections between the Controller or other devices, including AV signals, IRs, relays, contacts, and/or serial connections.

**Tip**: If connections do not appear as needed, edit the driver to create the needed connections. See “Editing a Driver Using the Driver Wizard.”
The following steps are described in the next sections:

- “Verify that all Control and AV Connections use Room Properties”
- “Disconnect/Remove Control/AV Connections”
- “Re-assign Control/AV Connections”
- “Update Connections in the project if you change locations”

### 2.9.2.5.1 Procedures

#### 2.9.2.5.1.1 Verify that all Control and AV Connections Use Room Properties

To verify all Control and AV connections by checking room properties:

1. Click the **System Design** view.
2. Select a **room**.
3. On the default tab Audio Video Devices, see if your **AV** devices are accessible in the room. If an AV **device** is not there, see “Make and Verify Connections.”

#### 2.9.2.5.1.2 Disconnect/Remove Control/AV Connections

To disconnect or remove a control/A/V **connection**:

1. Click the **Connections** view.
2. Select the **Control/AV** tab.
3. In the Control/AV **project tree**, select a **device** for the device’s control and AV connections to appear.
4. In the Control and AV Connections pane, right-click an **input** (or output) connection and choose **Disconnect**.

#### 2.9.2.5.1.3 Re-assign Control/AV Connections

To reassign Control/AV connections:

1. Click the **Connections** view > **Control/AV** tab.
2. In the project tree, select a **device** for the device’s control and AV connections to appear.
3. In the Control and AV Connections pane, **drag** an input from the top pane to a different output on the bottom pane. The connection is moved to the specified output.

#### 2.9.2.5.1.4 Update Connections in the Project if You Change Locations

If you use the same project but you change locations, you have to update all of the connection information.

To update the connection information in an existing project:

1. Click the **Connections** view.
2. Click the **Control/AV** tab, and **review** your connections to ensure that they are updated in the current control and AV topology.
3. Click the **Network** tab and **disconnect** all connections by **right-clicking** and selecting **Disconnect**.
2.10 Troubleshooting the System

These sections provide some information about troubleshooting a Control4® system.

“Guidelines for Troubleshooting”
“Troubleshooting a Director Connection”
“Troubleshooting Controllers”
“Troubleshooting Device Control”
“Troubleshooting Dimmers, Switches and Keypads”
“Troubleshooting Driver Creation”
“Troubleshooting Media”
“Troubleshooting Navigators”
“Troubleshooting the System”
“Cannot Identify the Device to the Network”
“Troubleshooting the Upgrade Process”

2.10.1 Guidelines for Troubleshooting

This section outlines general troubleshooting guidelines to check first if you are having problems with a Control4® system.

The following table lists the main areas typically found to resolve some issues on the Control4 system.

<table>
<thead>
<tr>
<th>Guideline</th>
<th>Where To Go</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check room connections</td>
<td>Composer Pro automatically sets room connections when you set up a system. These settings are default settings, and may not necessarily match your physical connection. Ensure that the room connections are set to match your specific system. If you move a device to another room, move it in the project tree also, and then identify it again to make sure it's connected properly. For more information, see: “Connecting Rooms” “Testing Device Controls”</td>
</tr>
<tr>
<td>Check Control/AV connections</td>
<td>The Control and AV connections identify the physical connections to the system. When these are defined, the system is completely automated and programmable. However, if one of the connections is not correctly identified, it can cause the system not to run properly. Ensure that the control and AV connections match the physical configuration. For more information, see: “Control/AV Tab” (see Composer Pro Getting Started) “Control and Audio Video Connections” (see &quot;Control/AV Tab&quot; in Composer Pro Getting Started)</td>
</tr>
<tr>
<td>Check network connections</td>
<td>If a device is not using a control connection to communicate to the Control4 Controller, it uses a network connection: a type of connection that uses a</td>
</tr>
</tbody>
</table>
## Where To Go

<table>
<thead>
<tr>
<th>Guideline</th>
<th>Where To Go</th>
</tr>
</thead>
</table>
| network address such as TCP/IP (Ethernet), ZigBee, ZigBee Pro and WiFi. | 1. Ensure that the network connections viewable in the Connections view > Network tab all have a network address associated with the device. If not, identify the device again.  
2. Ensure that the Control4 Controller, such Home Controller HC-300, has a network address. If the address is not appearing, identify the device again.  
   - From the Tools menu, select **Network Tools**. This lets you see all of the ZigBee and IP network addresses on the network. It shows whether the device has an address, and if it has an active connection to the network (status is online).  
   - For more information, see:  
     - “Network Tab” (see *Composer Pro Getting Started*)  
     - “Network Tools Dialog” (see “Tools Menu” and “Network Tools Dialog” in *Composer Pro Getting Started*)  
   - Connecting a Device to the Network (see “Connecting Devices”)  
   - “Cannot Identify the Device to the Network”  
   - “Verifying the Network Connections” |
| Ensure Navigators are connected to Director | From any of the Navigators (On-Screen, Mini Touch Screen, 7” Touch Screen), press **Info > Director** (for releases prior to 2.0) or **More > Settings > Network** (OS 2.0 and later) to ensure that you are connected to the Control4 Controller’s network address. You can find out the Control4 Controller’s network address from the Connections view > Network tab.  
   - For more information, see “Customizing Navigators.” |
| Ensure music is added and scanned | In Composer Pro, ensure that your music is available (added to the Controller) and is scanned into the system.  
   - 1. Make sure the stored or broadcast media is added or scanned.  
   - 2. Check the Room Properties page to see if the media was added.  
   - 3. Ensure that Navigators were refreshed after scanning media.  
   - 4. If the Controller reboots, re-scan the media.  
   - For more information, see:  
     - “Items Pane” (see *Composer Pro Getting Started*)  
     - “Setting Up Media Stored on a Controller”  
     - “Setting Up Media Stored in a Disc Changer”  
     - “Setting Up Media for Television Channels”  
     - “Setting Up Media for Radio Stations”  
     - “Using External Storage Devices”  
     - “Adding an Audio Switch or Audio/Video Switch”  
     - “Creating a Playlist”  
     - “Editing Media Information” |
2.10.2 Troubleshooting Controllers

The following table lists troubleshooting problems on Control4 system Controllers.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Problems and Solutions</th>
</tr>
</thead>
</table>
| The Controller has N/A for IP address       | 1. The Controller has no network connection. Plug in your Ethernet cable. After a few moments, the addresses should appear.  
2. The power cable is not plugged in. Plug in your power cable.  
3. No DHCP on the network. Ensure that DHCP is operational. |
| The Controller has a blank front display    | 1. Either your cables are unplugged, or they are not connected. If both are connected, unplug them and connect the Ethernet cable before connecting the power cord.  
2. The Controller is not connected to a cable/modem/switch/ using DHCP.  
3. Ensure that the Reset button is not jammed behind the plastic cover. |
| The Controller doesn’t come back up after a power outage | To receive a notification of the Controller going down and coming back up, set up an Email Notification agent to alert you when the project is loaded and the Controller comes back up. When you create the alert, place the alert on the project (Device Events top level). See Example: “Program Using the E-Mail Notification Agent.” |

2.10.3 Troubleshooting a Director Connection

The following table lists troubleshooting problems connecting to a Director.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Problems and Solutions</th>
</tr>
</thead>
</table>
| Cannot see the Network Address of Director in the Director’s dialog | 1. In Tools > System Manager, click Refresh several times to see if the network address appears.  
2. If not, choose Add and enter the name and network address.  
3. Make sure Director is enabled on the controlling device.  
a. At a command line, enter telnet [controller IP address].  
b. Enter the root username and password.  
c. Enter sysman status.  
d. If Director is not enabled, enter sysman enable director.  
e. Enter sysman status and verify the Director is now enabled.  
f. Enter exit. |
2.10.4 Troubleshooting Media

The following table lists troubleshooting problems with Control4 system media.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Problems and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVDs not showing up in the Disc Changer</td>
<td>Ensure that you have a serial Disc Changer. Only bi-directionally-controlled serial Disc Changers can scan media.</td>
</tr>
<tr>
<td></td>
<td>If you have a serial Disc Changer, see the following:</td>
</tr>
<tr>
<td></td>
<td>1. Ensure that music is added and scanned</td>
</tr>
<tr>
<td></td>
<td>2. Check these sections:</td>
</tr>
<tr>
<td></td>
<td>“Setting Up Media Stored in a Disc Changer”</td>
</tr>
<tr>
<td></td>
<td>“Connecting Rooms”</td>
</tr>
<tr>
<td></td>
<td>“Checking Control/AV Connections”</td>
</tr>
<tr>
<td></td>
<td>“Connecting a Device to the Network”</td>
</tr>
<tr>
<td>Cannot play music or music channels not appearing in the Navigators</td>
<td>If music is not running, see the following:</td>
</tr>
<tr>
<td></td>
<td>1. Ensure that the Navigator is connected to the Director. See Composer Pro Getting Started.</td>
</tr>
<tr>
<td></td>
<td>2. Ensure that a room is appearing on the Navigator. If not, click the room and change the room to one that can play music.</td>
</tr>
<tr>
<td></td>
<td>3. Ensure that music is added and scanned.</td>
</tr>
<tr>
<td></td>
<td>4. See “Connecting Rooms.”</td>
</tr>
<tr>
<td></td>
<td>5. See “Checking Control/AV Connections.”</td>
</tr>
<tr>
<td></td>
<td>6. See “Connecting a Device to the Network.”</td>
</tr>
<tr>
<td></td>
<td>7. Refresh the Navigators. See the Composer Pro Getting Started.</td>
</tr>
</tbody>
</table>

2.10.5 Troubleshooting Device Control

The following table lists some control problems on Control4 system devices.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Problems and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Device is not Controllable from a Navigator</td>
<td>If the device, such as a Dimmer, is not controllable from the Device Control window (double-click the device from the project tree); no connection exists.</td>
</tr>
<tr>
<td></td>
<td>Refer to the following sections:</td>
</tr>
<tr>
<td></td>
<td>“Connecting Rooms”</td>
</tr>
<tr>
<td></td>
<td>“Checking Control/AV Connections”</td>
</tr>
<tr>
<td></td>
<td>“Connecting a Device to the Network”</td>
</tr>
</tbody>
</table>
2.10.6 Troubleshooting Navigators

The following table lists troubleshooting problems with Control4 Navigators.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Problems and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not seeing Room Location on the Navigators</td>
<td>From a Navigator (On Screen, Mini Touch Screen or Touch Screen), ensure that the device is connected to Director. See “Connecting Rooms.”&lt;br&gt;Check the connections:&lt;br&gt;1. For an On-Screen Navigator, see “Checking Control/AV Connections.”&lt;br&gt;2. For Touch Screens, see “Connecting a Device to the Network.”</td>
</tr>
</tbody>
</table>

2.10.7 Troubleshooting Driver Creation

The following table lists troubleshooting problems when creating Control4 drivers.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Problems and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR Learning is not working</td>
<td>1. A Controller must exist in the project to run IR Learning. Add a Controller.&lt;br&gt;2. The process of capturing IR codes is very sensitive to lights, such as sunlight, fluorescent lights. If it is not working properly, turn off the lights or cover the physical hardware so that the light cannot interrupt the code capture.&lt;br&gt;For a complete list of IR capturing guidelines, see “Guidelines for Capturing IR Codes.”</td>
</tr>
</tbody>
</table>

2.10.8 Troubleshooting Dimmers, Switches, and Keypads

The following table lists troubleshooting problems with Control4® system Dimmers, Switches, and Keypads.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Problems and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimmers, Switches, or Keypads are not behaving correctly</td>
<td>1. <strong>Reboot.</strong> Try rebooting the device by tapping the <strong>top</strong> button 15 times. On the 6-Button Keypad, this is the top left button. This action reboots the device, but does not clear programming associated with the device.&lt;br&gt;2. <strong>Reset.</strong>&lt;br&gt;   a. Tap the <strong>top</strong> button 5 times.&lt;br&gt;   b. Tap the <strong>bottom</strong> button 5 times.&lt;br&gt;   c. Tap the <strong>top</strong> button again 5 times. If you are using the 6-Button Keypad, this is the top left and bottom left button. This clears all your network connections.&lt;br&gt;   d. Go back into the <strong>Connections view &gt; Network</strong> tab, and identify the device again after resetting.</td>
</tr>
</tbody>
</table>
2.10.9 Cannot Identify the Device to the Network

This section provides troubleshooting instructions to identify a Control4® system device on the network.

If you cannot identify a device on the network, follow these steps until the problem is resolved:

1. Make sure the Control4 Controller is identified in Composer Pro. In the Connections > Network tab, see the line item for the Control4 Controller. Is there a network address for the Controller?
2. (Controller only) In System Design, select the Controller object to check the Zserver status. Is the Zserver running? If not, click Enable.
3. If the Control4 Controller is identified and Zserver is running, check whether any other devices identify. Do they?
   • If yes, a problem exists with the individual device. On Switches, Dimmers, and Keypads, if you tap the top of the button 9 times, the bottom 9 times, and the top 9 times again (pause for a breath in between each 9 count), this will reset the device. Doing the same thing with 7, 4, and 7 will make the device's LED flash the channel it's on (if it's on channel 14, it will flash 14 times). If the channel doesn't match the one for your System Remote Control and Controller, the channel will need to be changed. Call Control4 Technical Support.

   Note: For Release 1.8 and later, ZigBee Pro devices choose one (1) channel. Control4 recommends that you not change the channel; Zserver determines which channel to use automatically based on the available frequency space. Refer to the Composer Pro Software Release Update Instructions - 1.7.4 to 1.8.2 on the Control4 Knowledgebase or on the Dealer web site for details.

   • If no, some other devices in the house may be causing interference. Power down any 2.4 GHz devices, such as microwaves and cordless phones. Continue to the next step.
4. Will the devices identify now?
   • If yes, something in the house is causing interference. Replace whatever it is, or reset the channel on all of your devices. You cannot reset the channel on Wireless Dimmers, Switches, etc., at this time. Call Control4 Technical Support.
   • If no, a problem exists with the Controller's radio transmitter. Call Control4 Technical Support.

2.10.10 Troubleshooting the Upgrade Process

Follow these guidelines if you are experiencing Control4® upgrade or update problems.

2.10.10.1 Basic Troubleshooting Guidelines

1. Reset the device’s network settings. See “Resetting the Control4 System.”
2. Attempt to have the update successfully downloaded while connected to a different network or by using a USB drive update (see “Information About Older Releases”).
3. Allow the device to retry downloading the update as it automatically restarts and retries it.
4. Is the defect install/update related to an ongoing system operation?
5. Media not available? If it is a USB drive or network file share, make sure it is mounted (use the System Design view). If the media is on USB drive connected to a Secondary Controller, re-scan the media for that device.

   6. Navigator not connected to Director? Reconnect Navigator to Director.
7. Are strange things happening to the devices?
   - Make sure all ZigBee devices are updated to the latest firmware.
   - Make sure Director and Composer Pro are using the same version.
   - Disconnect and identify any problematic devices again.
   - Powercycle all IP devices.
   - Be patient.

8. Turn on Diagnostic Logging (in Composer Pro, Tools > System Diagnostics > Logging > Start). Use the Logging tool to determine what was happening on the system. Can you duplicate it, and is there a workaround? For details, see “Logging Diagnostics Information.”

**Tip:** Report any problems during the update process to:

**Control4 Technical Support:** [http://www.control4.com/residential/products/resources/#techsupport](http://www.control4.com/residential/products/resources/#techsupport)

**Email:** support@control4.com

**Telephone:** 1-888-400-4072

<table>
<thead>
<tr>
<th>Status Message</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Device IP address detected with a different version — update needed.</td>
<td>The Director discovered a device that is a different version than the Director box.</td>
<td>Perform update.</td>
</tr>
<tr>
<td>2. Device IP address indicated it needs to be updated.</td>
<td>The device sent a status message to the Director that says it needs to be updated.</td>
<td>Perform update.</td>
</tr>
<tr>
<td>3. Finished update attempt.</td>
<td>Current update is completed. A separate message notifies you of how many devices succeeded or failed.</td>
<td>(Status message only) No action is required.</td>
</tr>
<tr>
<td>4. Update information was missing or invalid. Reinstall the files for the USB drive, and attempt the update again. If the problem persists, contact Technical Support.</td>
<td>A Director could not find the matching update information for a device retrieved from the USB drive. This would be the case if files were deleted from the USB drive.</td>
<td>Re-install the files for the USB drive, and attempt the update again. If the problem persists, contact Technical Support.</td>
</tr>
<tr>
<td>5. Update information was missing or invalid. Contact Technical Support.</td>
<td>The Director could not find the matching update information for a device retrieved from the Web. The database contains invalid data.</td>
<td>Contact Technical Support.</td>
</tr>
<tr>
<td>6. Director device is not yet identified. Please identify the Director device and attempt the update again.</td>
<td>The system has not yet discovered the Director device.</td>
<td>Identify the Director device, and perform the update again.</td>
</tr>
<tr>
<td>7. Starting update to version <code>&lt;targetVersion&gt;</code>. Director version is <code>&lt;version of Director&gt;</code>.</td>
<td>An update has started.</td>
<td>(Status message only) No action is required.</td>
</tr>
<tr>
<td>8. Detected USB device containing update information. The USB device will be used for the update.</td>
<td>The system has detected a USB drive.</td>
<td>(Status message only) See &quot;Update from 1.3.x Release with a USB Stick&quot; in &quot;Information About Older Releases&quot; for information about</td>
</tr>
</tbody>
</table>
Status Message | Description | Resolution
--- | --- | ---
9. Device <ipaddress>: <Status data received from the device> | The system received data from the device. | (Status message only) No action is required.
10. Updated: <number of updated devices> Failed: <number of failed devices> | Follows the message “Finished update attempt” (number 3) to provide specific details. | Reconnect, re-identify, and restart the update.
11. Device <ipaddress> failed to update. | Provides the specific IP address of any device that failed to update. Follows the message number 10 when applicable. | Try to identify the device again, and try the update again. If not successful, contact Technical Support.
12. Failed email results to <entered email address>“. Error was: <error number>. Verify that the VPN is correctly setup and functioning on your Director box and that a valid mail address was entered. Contact Technical Support if this problem persists. | This is called if an error is returned when trying to send the summary via email. | Verify that the VPN is correctly set up and functioning on your Director box, and that a valid mail address was entered. Contact Technical Support if this problem persists.
13. Unable to obtain update version information from the Web interface at URL <url used for getting the version, i.e., http://webdev-1.control4.com/...>. Verify that Internet access is available from Director. | System has not received the version information back from the database. | 1. Ensure that you can communicate to the Internet to the Web site from your computer. Use a prompt box to ping the address. 2. Ensure that you can connect to the Control4 Controller through the Local Area Network. 3. Ensure that a firewall is not blocking the update. 4. If you still cannot update, use a USB drive for the installation.
14. Detected devices that still need to be updated. Restarting the update process. | | (Status message only). No action is required.
15. The information on the USB drive is invalid. Reinstall the update on the USB drive and attempt the update again. | The system cannot parse the update-info.html file on the USB drive. The file is not valid xml. | Re-install the update on the USB drive, and attempt the update again.
16. Not enough free space on file system to store update information. Disk free = <amount of free space> needed = <space needed>. Remove stored media, log files, etc., and attempt the update again. | There is not enough free space on the box running Director to store the largest set of packages for a device type. | Remove the stored media, log files, etc., and attempt the update again.
17. Unable to access the directory for update information. Please | System cannot access the /packages directory. Either the disk has a serious problem, or the | 1. Ensure that you can communicate to the Internet to the Web site from your computer. Use
## 2.10.1.2 Diagnosing Trouble Spots

Use the Control4® System Diagnostics tool in Composer Pro to view, monitor, and troubleshoot a Control4 system.

These sections provide information about system diagnostics.

“System Diagnostics Tool”
“System Diagnostics Interface”
“Viewing Controller Performance Information”
“Using the Controller Networking Information”
“Using System Information”
“Logging Diagnostics Information”

### Status Message

<table>
<thead>
<tr>
<th>Status Message</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>contact Technical Support.</td>
<td>mounts didn’t work right.</td>
<td>a prompt box to ping the address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Ensure that you can connect to the Control4 Controller through the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Local Area Network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Ensure that a firewall is not blocking the update.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. If you still cannot update, use a USB drive for the installation.</td>
</tr>
<tr>
<td>18. Out of file space for packages.</td>
<td>Ran out of disk space while downloading the software packages. The update fails, then restarts after 5 minutes, and the “Not enough free space” message (number 16) displays.</td>
<td>Remove the stored media, log files, etc., and attempt the update again.</td>
</tr>
<tr>
<td>19. Device &lt;ipaddress&gt; failed because it reported a status of &lt;reported device status&gt;.</td>
<td>The device reported that it failed to update.</td>
<td>Try to identify the device again, and restart the update. If it fails again, contact Technical Support.</td>
</tr>
<tr>
<td>20. Touch Screen device at &lt;IP address&gt; must be docked before upgrading. Please dock the Touch Screen and restart the update.</td>
<td>A Wireless Touch Screen was not properly seated in its dock when the update started.</td>
<td>Please dock the Touch Screen, and restart the update.</td>
</tr>
</tbody>
</table>
2.10.10.2.1 **System Diagnostics Tool**

Use the Control4® Composer Pro System Diagnostics tool to view, monitor, and troubleshoot a Control4 system.

2.10.10.2.1.1 **Procedure**

To access the System Diagnostics tool:

1. Start Composer and connect to a Director.
2. From the Tools menu, select **System Diagnostics**. The tool is available over a LAN connection using remote access.
3. Use the tool to diagnose problems on your own, or capture and send information to Control4 Technical Support.

The diagnostics information is organized into four (4) tabs:

1. **Controller Performance**
2. **Controller Networking**
3. **System Info**
4. **Logging**

The Control4 system includes many devices running embedded operating systems communicating over a wired or wireless network. During installation, configuration, and troubleshooting, the ability to look at the overall status of the components becomes very useful.

The System Diagnostics tool lets you gather system information to help you determine if any issues encountered are configuration problems, performance issues, or potential defects.

2.10.10.2.1.2 **System Diagnostics Uses**

Possible uses of the System Diagnostic tool include:

- Viewing Controller Performance information:
  - CPU usage
  - CPU usage history
  - Memory usage
  - Memory usage history
  - Processes running
- Viewing Controller Networking information:
  - Network type
  - Connection status
  - MAC address
  - IP address
  - Subnet mask
  - **Gateway**
  - **DHCP** status
  - DNS server information
  - View system information
• Viewing System Information:
  • Detailed lower-level information about the devices listed
• Viewing Logging information:
  • When troubleshooting a problem that is reproducible, use the System Diagnostics tool to capture logged information while reproducing the problem to email to Control4 Technical Support.
  • When troubleshooting a problem that is not reproducible, connect the Controller, enable logging, and allow the logging to continue running for a specified period of time to capture the problem. The logs are then captured and emailed to Control4 Technical Support.

2.10.10.2.2 System Diagnostics Interface
Use the Control4® System Diagnostics tool in Composer Pro (Tools menu > System Diagnostics) to view the interface and these tabs: Controller Performance, Controller Networking, System Info, and Logging.

• Controller Performance—Lets you view Controller performance information, including CPU and memory usage.

1. Click the History button to view the history of the CPU and memory performance.

• Controller Networking—View Controller networking information, including network type, connection status, MAC address, IP address, Subnet mask, Gateway, DHCP status, and DNS server information.

2. Click the Test Internet Connection button to test the current Internet connection.
• **System Info**—View detailed System information.

3. Click the **Save to File** button to specify the location and filename for a text-file version of the output.

• **Logging**—Log system problems.

4. Click the **Start Logging** button to indicate what type of logging you want displayed, and then allows you to “Start” the logging process.
5. Click the **Stop Logging** button to stop the tool from logging information.
6. Click **Open Controller Log** to view the logged information in a file.

### 2.10.10.2.3 Viewing Controller Performance Information

Use the Control4® Composer Pro System Diagnostics tool (**Tools** menu > **System Diagnostics**) to view **Controller** performance.

The Controller Performance tab contains information regarding CPU and memory utilization for the Primary Controller of the project. Asynchronous messages from the **Director** regarding its current state are also displayed.

#### 2.10.10.2.3.1 Procedure

To view Controller Performance information, including CPU and memory usage:

1. Start **Composer** and connect to a **Director**.
2. From the Tools menu, select **System Diagnostics**. The Controller Performance tab is viewable by default.
3. View information displayed on the Controller Performance tab:
   - **CPU Usage**—Shows a graphical form of current CPU usage and CPU usage history for the Primary Controller, which is the Control4 Controller used to control the system if multiple controllers exist on a system.
   - **Memory Usage**—Shows in graphical form the current memory usage and memory history for the Primary Controller.
   - **CPU and Memory Usage by Component**—Shows percentages of CPU and memory use per component.
4. Refresh the screen or update the speed. To do this, from the View menu you can:
   - **Refresh Now**—Restart the real-time display of CPU and Memory usage.
   - **Update Speed**—Change the speed to High, Normal, Low, or Paused.

5. View the Directory messages by clicking the **History** button.

### 2.10.10.2.4 Using the Controller Networking Information

Use the Control4® Composer Pro System Diagnostics tool (Tools menu > **System Diagnostics**) to use **Controller** networking information.

View the information, including:
- Network type
- **Connection** status
- MAC address
- IP address
- Subnet mask
- **Gateway**
- **DHCP** status
- DNS server information

#### 2.10.10.2.4.1 Procedure

To use Controller Networking information:
1. Start **Composer** and connect to a **Director**.
2. From the Tools menu, select **System Diagnostics**, and then click the **Controller Networking** tab.
3. Ensure that the network information shown is reflective of your network.
4. To test your Internet connection, click the **Test Internet Connection** button. The screen displays the current status of networking services, including the **CD & DVD** Lookup Service, Media Web Service, and Updates Web Service.

This screen shows that the example services failed.

5. Click **Close** to exit the dialog box.
2.10.10.2.5 Using System Information

Use the Control4® system Composer Pro System Diagnostics tool (Tools menu > System Diagnostics) to use system information.

View System Info current configuration settings, state of the Primary Controller and any other Control4 device in the Control4 system’s current project. The information displayed is a summary of several commands.

2.10.10.2.5.1 Procedure

To use system information:

1. Start Composer and connect to a Director.
2. From the Tools menu, select System Diagnostics, and then click the System Info tab.
3. Select a device or sub-category (expanding the list as needed) in the left pane to display the system configuration information in the right pane.

4. To save the displayed information to a file, click Save to File and specify the location and name for the file.

2.10.10.2.6 Logging Diagnostics Information

Use the Control4® system Composer Pro System Diagnostics tool (Tools menu > System Diagnostics) to use the logging feature and log files.

View Logging to configure, start, stop, and schedule diagnostic logging of the Control4 system.

- Capturing Information While Reproducing a Problem—When troubleshooting a problem that is reproducible, use the System Diagnostics tool to capture logged information while reproducing the problem to email to Control4 Technical Support.

- Enabling Logging for Debugging—When troubleshooting a problem that is not reproducible, connect to the Controller, enable logging, and allow the logging to continue
running for a specified period of time to capture the problem. The logs are then captured and emailed to Control4 Technical Support.

- **ZigBee and I/O Communications**—These items are available for logging in System Diagnostics.
- **DirectorState.corrupt**—If for any reason Director is unable to load a project file, it is saved to DirectorState.corrupt prior to loading a clean project file (Tools > System Diagnostics > Logging).

### 2.10.10.2.6.1 Procedure

To use system logging:

1. Start **Composer** and connect to a **Director**.
2. From the Tools menu, select **System Diagnostics**, and then click the **Logging** tab.

3. To enable logging, click **Start Logging**, and then choose whether to save the information currently displayed (if any).
4. Select the logging categories, and then click **Start**. The results are displayed.
5. (Optional) To save the log, but continue logging the results, click **Clear Output**. The logging feature remains enabled, but a Save As dialog box lets you specify the location and name of the text version of the log.

6. (Optional) To save the log and disable the logging process, click **Stop Logging**. The logging feature is disabled, but a Save As dialog box lets you specify the location and name of the text version of the log.

7. To view the Controller Log, click **Open Controller Log**.
2.11 Information about Older Releases

Some Composer Pro tasks may refer to older software releases (prior to OS 2.0) for the Control4® system. See the sections below (Release 1.3 and earlier and Release 1.8 and earlier) or refer to the Release Notes for a particular release.

2.11.1 Release 1.8.x and 1.7.x

2.11.1.1 Release 1.8.2

- **Navigators.** Resolved focus issues which were fixed in Release 1.7.4 but not included in Release 1.8.2.56194 due to release timing.
- **Dock for iPod.** Resolved a problem where the Control4 Dock for iPod would prematurely stop playing music when it was being used in a multiple room session and rooms left the session.
- **Rhapsody.** Resolved the problem with the Rhapsody agent always being re-enabled (if it had been disabled) when Director loads the project.
- **Composer.** Fixed the issue with the ‘Project is Locked’ message which would occasionally occur even if the Controller was not being updated.
- **ZigBee Server.** Fixed a problem where the ZigBee Server would not talk to the ZAP if its IP address changed. Other minor fixes to improve ZigBee Server are also included.
- **Thermostat Firmware/Driver.**
  - The minimum separation between the Heating/Cooling Engage and Cutoff points has been reduced from two (2) degrees to one (1) degree Fahrenheit.
  - Improvements to the Control4 Thermostat’s ability to control residential heat pump systems.
  - New Advanced Properties: Disabling The Call For Auxiliary Heat—Setting the Auxiliary Heat Stage Delay to 255 will prevent the Thermostat from making a call for auxiliary heat. Values in the range of 0 to 254 will be the number of minutes the Thermostat engages the heat pump before calling for auxiliary heat.
  - New Advanced Properties: Heat Pump and Auxiliary Heat Overlap—The Auxiliary Heat Cutoff Delay is the length of time in seconds that the Thermostat allows concurrent operation of the heat pump and auxiliary heat. A value of 255 will cause them to run together indefinitely (subject to maximum run times and/or achieving the goal temperature).
- **Card Access.** Updated Card Access firmware for the Wireless Contact Relay and Heavy Duty Power Switch devices that enables them to support parenting functionality. This change will benefit installations with sparse meshes that are using these Card Access devices to extend the mesh.
- **Black & Decker Smart Code Door Locks.**
  - Improvements were made to the Black & Decker Door Lock driver and firmware (01.05.00).
  - The Black & Decker door lock doesn’t update until after 3 AM; a message “update failed” will appear until the update takes place. The following functionality does not work until the locks have been completely updated:
    - Email notifications
    - Incorrect status feedback – UI and Composer Pro
Composer Pro User Guide

- Is controllable from Composer Pro and bound to a keypad
- Message "Unknown response from lock" appears in the last status message dialog box in Composer Pro
- Firmware Version will state "Not Connected"

- **Media.** Changed the media lookup service to c4lookup.
- **Security.** Added a check to the SSL server certificate creation to detect a malformed certificate. If detected, the server certificate will be recreated automatically when the Controller is rebooted. This corrects the occasional occurrence of "project locked" when not being updated.

### 2.11.1.2 Release 1.8.0

- **Agents**
  - The Composer Pro Timer agent interface has been updated to allow for specification of timer duration in a more flexible way. Timer selection is now in the format hh:mm:ss.
  - Now include Control4 system and user-defined variables in the templates created using the E-mail Notification agent. To use this new capability, the Installer can create or modify email templates using Composer Pro, Agents, E-mail Notification, and then use the ‘Add Variable’ option.
  - Deleting the Timer agent doesn’t remove the programming.

- **Audio**
  - Fixed a problem where using the Apply To button to set parametric equalizer settings on the Amplifier settings were not getting set correctly.

- **Channels**
  - In Control4 Software Release 1.7.0 and previous versions, Dealers used multiple ZigBee Servers running on different channels to enable more responsive and higher node count (or distributed) EmberNet networks. With ZigBee Pro, only one channel is used for the entire system. The channel is selected automatically based on an RF energy scan at the time that the ZigBee Pro network is established; but it can be changed manually. Multi-ZAP configurations automatically and seamlessly provide the benefits that used to be realized by multiple Zserver and channels.

  Prior versions of Control4 systems used Channels 1-14. With ZigBee Pro, the channel numbering now uses Channels 11-26 in order to comply with the channel numbering specified in the ZigBee Pro standard. The actual channel frequencies are the same throughout. The new channels are the same as the old channel number + 11. Example: The default channel was 14 on which all EmberNet devices were shipped.

  In ZigBee Pro, it is now channel 25 (14+11=25). The ZigBee channel number can be changed any time as long as the Control4 system is not being updated. All ZigBee Pro devices on the mesh network automatically move to the new channel.

- **Controllers**
  - Fixed a problem where the Announcement agent was not showing the Home Controller HC-200 as a video end point.
• Diagnostics
  • Corrected the 'Test Internet Connection' feature in System Diagnostics so that it doesn’t return invalid failure notices.

• Drivers
  • Added a driver for Black & Decker locks.

• Keypads
  • When programming a conditional on a Keypad, we now include the Keypad name in the programming script.

• Lighting
  • Implemented multicast Lighting Scenes in conjunction with the ZigBee Pro firmware. Each device stores information about its defined behavior in up to 32 different Lighting Scenes. When you execute a scene, a multicast is sent to all devices on the mesh. Devices immediately respond based on their defined behavior, eliminating “popcorn” lighting.
  • Added an option to the Properties page of the 2-button, 3-button, and 6-button Keypads to 'Follow Bound Color.' This is the default configuration, and has been the only option in previous releases. In this configuration, the Keypad LED colors are set based on the device to which they are bound using button-link connections. New with Release 1.8.0, Installers can uncheck this option. This lets the Installer specify the on/off colors for the Keypad LEDs independently of the device to which they are linked.
  • Added double- and triple-tap events to the Control4 Dimmers, Switches, and Keypads. When you tap a button consecutively two (2) or three (3) times for about one-half of a second, these events fire. Now you can use these events for programming without requiring the more complex programming logic tied to timers and button Press / Release events.

Note: When programming using double and triple-tap events, be aware that Press and Release events also occur when double and triple-tap events occur. Plan your programming using these events so that they don't conflict with the intended outcome. In most cases, when using double and triple-tap programming events, don't program on the Press and Release events.

• Network
  • Added a new Network Tools menu. We replaced the Network Status menu with enhanced functionality including tree views.

• System Remote Control
  • Added programming events to the System Remote Control SR-150 and SR-250 ‘Watch’ and ‘Listen’ button presses. This lets the Installer use Control4 programming to define room-specific behavior when the Watch / Listen buttons are pressed. The Watch / Listen button options now include: ‘No Action’ (new – used for programming your own behavior), ‘Select Most Recently Used Device,’ and ‘Show Device List.’ You can select the desired behavior using the Composer Pro System Design view. Programming triggered by the Watch and Listen buttons is performed using the room events.

• Thermostat
  • Undershoot/overshoot configuration now applies to both heat and cool. With the updated Thermostat firmware, the ‘undershoot’ and ‘overshoot’ settings are now used to determine when the Thermostat will call for heating and cooling.
Previously, the overshoot setting was only used for determining when to disengage the heat, and the undershoot setting was only used for determining when to disengage the air conditioning.

With Release 1.8.0, the undershoot setting determines when both the heating and cooling systems are engaged, and the overshoot setting determines the cutoff for when the heating and cooling systems are disengaged.

**Examples:**

Heating – Set point set to 72. With an undershoot of 1, the heater will engage at 71 degrees. With an overshoot of 1, the heater will cut off at 73 degrees.

Cooling – Set point set at 78. With an undershoot of 1, the cooler will engage at 79 degrees. With an overshoot of 3, the cooler will cut off at 75 degrees.

- **Third-Party devices.** The following third-party devices are no longer documented in Control4 documentation. Refer to Release 1.8 and earlier about configuration information for these devices.
  - VLinx Serial Server. Appendix C: Configuring Devices, "Add a VLinx Serial Server to Expand Serial Control" has been removed from the Composer Pro User Guide and online Help.
  - HVAC devices.

2.11.1.3 **Release 1.7.3**

- Updated firmware for the 4-Zone Amplifier, with the following changes:
  - Better fan speed control (less fan “noise”)
  - Input gain control from front panel
  - Power save enable/disable from front panel
  - Balance control from front panel
  - Shorted output detect

2.11.1.4 **Release 1.7.2**

- **Polling.** Removal of “polling” functionality from Director: With the introduction of Control4’s 1.6 system software, functionality was added to the system for polling dimmers to determine their current light level. Now, with the 1.7.2 release, Control4 has removed polling functionality from Director. Each time the Dimmer light level changes, the system is automatically notified. This improves graphical navigator tracking of light levels and linked keypad LED tracking.

- **Drivers.** A new security driver for the GE Networx NX8-587E virtual keypad interface (added to the Online Database for drivers).

- **Commands.** Added a device-specific programming command to the Control4 Dock for iPod driver which allows the LED on the dock to be turned on/off using programming. Please note that the LED will automatically turn on when the Identify button is pressed.

- **Dimmers.** In conjunction with the support for the new Control4 Wireless ELV Dimmer, on all Control4 Dimmers you now have the ability to configure a load profile. While the load profile
settings are primarily intended for the Wireless ELV Dimmer, they also work on the standard Dimmer. Specifically, you can use Minimum On Level (%) for Dimmers that have a dimmable fluorescent (or CFL) load. This changes the dimming range so that the 0-100% seen by the user starts at the Minimum On Level %.

- **Touch Screens.** Resolved problem where the 7” Touch Screen buttons would stop working if the Touch Screen was rebooted or lost, and regained its network connection while the system was still running.

- **Zones.**
  - Resolved problem where phantom audio zones would remain displayed on the Zones page of a Touch Screen if a network message wasn’t received.
  - Resolved a problem with the zone feedback from an HAI OmniPro security panel incorrectly displaying off by 1.

- **Thermostat.** Resolved a problem whereby using Composer HE or Composer Pro’s device control for a Control4 Thermostat would set the mode to Off.

- **Screen Saver.** Enabled photo Screen Saver for Home Controller HC-200, HC-300, and HC-500 operating in PAL display mode.

- **IP Cameras.** Resolved problem which prevented IP Cameras from being hidden or re-ordered using Composer Pro.

### 2.11.1.5 Release 1.7.1

- Support for the Control4 Dock for iPod hardware release.
- Support for the 7” Wall-Mount Touch Screen.
- Support for ISO file scanning using the Video Media interface on network file storage devices.
- Improved functionality for the Watch / Listen buttons on the System Remote Control SR-250. With the 1.7.1 release, you can choose between two modes of operation for the Watch / Listen buttons on the SR-250. You can select either the toggle most recently used mode or the new device list mode of operation. This configuration is selected using the Composer properties page of the SR-250. If you choose to utilize the device list mode of operation, use the Navigator tab (in Composer Pro, System Design) for the room you are controlling to configure the device visibility and display order for these menus.
- Support within Composer Pro and driver Web service to enable the downloading of DriverWorks drivers from the online driver service.
- Support for inter-command delay in one-way serial drivers.
- Fixed bug that didn’t allow the debounce timer in the sensors drivers to be enabled.
- Fixed bug that caused the sunrise/sunset “next occurrence” values to be incorrectly set on a new project after the previous project was cleared.
- Fixed bug that prevented the selection of playlists after a media scene was deactivated.

### 2.11.1.6 Release 1.7.0

- **Media Player** and digital video file support. The 1.7.0 release introduces support for Media Player devices and the ability to select digital video files from Navigator for playback through Media Player devices. The Media Player devices can be found under the A/V section of My Drivers in Composer Pro’s System Design view. The Media Player device type encompasses A/V devices that have the ability to playback or decode digital video files for playback through standard A/V equipment. Release 1.7.0 includes support for the Netgear EVA8000 as a Media Player. Digital video files can be stored on a Network File Storage
device in a Control4® system, configured with associated meta-data in Composer Pro’s Media view and can be selected from Navigator’s Video menu.

- **Import DVD List from File.** In Composer Pro’s Media view, any Disc Changer can now quickly and easily be populated with all of the meta-data associated with the DVDs stored in the Disc Changer. By right-clicking on the Disc Changer in the Media view and selecting the “Import DVD List from File” option, Composer Pro will automatically populate the slots of the Disc Changer with the DVDs stored in each slot as listed in the file that is imported. The imported file must be a CSV (comma separated value) file listing the slots and the titles of the DVDs, one per line. This file can be created using a simple text editor or spreadsheet program by exporting a spreadsheet file in a CSV formatted file. This new feature provides a simple and easy way to quickly configure all of the DVDs in any manufacturer’s Disc Changer.

  **Example** formatting for CSV file:

  1. Toy Story
  2. The Incredibles
  3. The Perfect Storm

- **Composer.**
  - Composer Pro support for 64-bit edition of Windows Vista.
  - Composer Pro may not automatically reconnect during update – During the update to 1.7.0, Composer Pro may not automatically reconnect to the controller. If this is encountered, disconnecting and reconnecting to the controller will allow you to resume monitoring the update status. It is not required to be connected for the update to proceed.

- **Info Tab.**
  - All important information relative to a customer’s project can now be stored in the project in Composer Pro’s Info tab.
  - When viewing the System Design view, you will find the Info tab next to the Properties and List View tabs in the middle pane of the window.
  - Information about the system owner, the dealer, installer, all relative contact information and specific notes regarding the system’s configuration can all be saved in the project when entered in Composer Pro’s new Info section.

- **Touch Screens.**
  - Programmatically changing backlight levels on a Touch Screen when in screen saver mode now executes as programmed.
  - Mini Touch Screen waking up from screen saver may incorrectly display top buttons – If a Mini Touch Screen is configured to wake up from the screen saver and go to a default view that is other than the main view such as the lighting or music view, the top row of buttons along the top of the Mini Touch Screen’s display may be displayed incorrectly. Going back to the home screen will reset this display.

- **LED Colors.** Custom colors are now persistent in the custom color list for Dimmer, Switch and Keypad LED color configuration.

- **Agents.**
  - Several configurations of announcements or deselecting the “Show OK” button in Composer Pro’s Announcement Agent view could cause Composer Pro to crash in 1.6.0. This issue is now resolved.
Images used in the Announcement Agent and in the web images from the camera driver should be no larger than 300 KB – The display of images in the Announcement Agent and the display of web images through the web images camera driver is designed to work with small images commonly used on websites or in graphical user interfaces. The recommended size for these images is 300 KB or less. Larger images will be scaled to the required size for Navigator but this scaling process for very large images can cause a Mini Touch to restart.

Deleting an agent configuration may not delete all associated programming – When deleting an agent, please confirm that all associated programming is also deleted. It may be required to manually delete some elements of associated programming.

Events.
- Using a randomized time for a scheduled event start time now properly uses a randomized time value.
- In the 1.6 version of Composer Pro, the issue of seeing Scheduler events duplicated in the Scheduler Agent view has been resolved.

Variables.
- Container variables in Media Scenes or connection outputs on an Amplifier now function as configured. An issue was discovered with this type of configuration in 1.6.0.
- Use of random numbers is programming variables has been improved.
- Container variables and lights – As with previous releases, we recommend that you not utilize container variables for lighting. The 2-way feedback from the individual lights can cause undesired light level oscillation when a light level is adjusted and multiple light loads are included in a container variable.

Blinds. The Somfy blinds' Stop option was incorrectly grayed out in Composer Pro. This function is now available and functional.

Thermostat. Selecting the “Locked” radio button on the Control4 Thermostat properties page did not work properly. It now reflects the state properly.

Media Scenes.
- In some configurations, Composer Pro may lock up and/or crash when selecting Media Scenes in previous releases. This issue has been resolved.
- Controlling volume for whole session using zones page with Media Scene will cause volume control problems – When using a Media Scene with volume control tracking enabled will create volume control problems if trying to control volume from the session controls in the Zones page. This configuration should be avoided in situations where the zones page is used and volume tracking is enabled.

Wakeups. An error not allowing a Wakeup to be executed during the hour of 12 PM has been fixed. Attempts to configure this in 1.6 would revert to 12 AM instead of 12 PM.

Audio Matrix Switch. The Audio Matrix Switch no longer increments by 8 when increasing the volume in a room with the Audio Matrix Switch configured as its audio endpoint.

Conditionals. Programming conditional “If time is day time” or “night time” may not execute correctly within one minute after sunset – If programming exists that is triggered at sunset or sunrise and then other programming exists that is triggered immediately upon this change that executes the conditional on day time or night time, the change may not be immediately recognized. It may take up to a minute for this programming to execute correctly on the change from night to day or from day to night.
• **Home Theater Controllers**
  • Home Theater Controllers with 128 MB of internal storage should not be used as primary controllers in multi-controller projects – Home Theater Controllers produced earlier than December 2005 had 128 MB of internal storage. Home Theater Controllers produced subsequent to that date have 256 MB of internal storage (use System Diagnostics, System Info, HTC, disk free to check disk space) in the Home Theater Controller. Using a Home Theater Controller with 128 MB of internal storage as a primary controller in a multi-controller system is not recommended. There is insufficient internal storage to allow Update Manager to update the entire system. There is no problem using an HTC with 128 MB of storage as a secondary controller.
  • Using multiple audio outputs simultaneously on a Home Theater Controller or Media Controller when Navigator is running simultaneously may cause audio playback to skip – In systems with multiple audio zones with the HTC or MC used as audio endpoints, it is recommended that these controllers do not run Navigator simultaneously.
  • Home Theater Controller may take a long time to update – In some projects, we have found that the Home Theater Controller may take up to two hours to complete the update. If you suspect a problem, please let the controller continue to attempt to update for at least two hours. If the issue persists, please attempt to recover the controller using the USB Recovery Utility.

• **ZigBee.** ZigBee firmware update when using an HC-300 as Zserver may not successfully finish the ZigBee firmware update – Some of the early HC-300s may exhibit a slow or halted ZigBee firmware update. If you encounter these issues, please contact technical support for additional assistance.

• **Analog.** Streaming an analog source from audio input on a Controller to a WiFi audio endpoint is limited to one stream – Audio signals that are processed through the analog input on a controller are processed as a PCM stream and require much more bandwidth than streaming an MP3 stream to a WiFi audio endpoint. In this configuration, Control4 recommends that only one stream be used at any one time.

• **Hybrid Devices.** Firmware on hybrid devices didn’t update? – The Multi Channel Amplifier, Audio Matrix Switch, Multi Tuner, and Contact Relay Extender can be configured using IP or ZigBee. However, in order to receive a firmware update, they must be configured and connected via IP only. If they show up in the Connections->Network Identification screen as being identified as both IP and ZigBee, then the ZigBee connection needs to be disconnected. If they were previously configured as ZigBee and have been changed to IP, but are still not updating, you may need to restart Director (use System Manager to Disable and then Enable).

• **USB stick.** Scanning a large USB hard drive appears to hang Composer Pro – If you attach a large capacity USB hard drive (230 GB of MP3s used in this example) to an HC-300 and scan that drive, Composer Pro will appear to lock up and the system will appear to become unresponsive. This is not true. Though the system appears to be locked up, it is processing the data necessary to perform the scan. After you press the Scan button, this scenario will play out as follows:
  • Preparing to scan, Director Status: Idle, Connected for a second then:
  • Preparing to scan, Director Status: Idle, Disconnected for about 60 seconds then:
  • Preparing to scan, Director Status: Comparing Files with Database for about 10 or more MINUTES then:
  • Scanning, Director Status: Idle, Connected for another couple of minutes then you will finally see albums populating in the list.
• **Audio Endpoint.** Static on Audio Output? – As a reminder, occasionally, when using the Home Theater Controller, Media Controller, Mini Touch Screen or Speaker Point as an audio endpoint, occasionally the devices will output static from one or both of the audio outputs when music is being played. This can be resolved by power cycling the device. The Mini Touch Screen’s click sound may also play very loudly, and sound very harsh. This is caused by the same root problem and power cycling the device will resolve it. Note: the devices need to be completely unplugged and not just rebooted for the audio device to reset properly.

• **Controller.** Cannot register a controller with a “.” in the name – Due to network device naming conventions, it is not possible to successfully register a controller that has been configured with a “.” in the name of the controller. Control4 advises dealers to avoid this configuration.

• **Zones.** Hidden rooms show up as a blank line in Zones page – The hidden rooms that are used for audio distribution by Media Scenes show up in the Zones page on a blank line. This does not affect functionality.

2.11.1.7 **Release 1.3 and Earlier**

• **Wireless Touch Screens.** From the printed version of Composer Pro User Guide, Chapter 3, "Build a Project in System Design:" Previously, it was not necessary to add the Wireless Touch Screen in the Composer Pro project; however, this is now a requirement for versions 1.3 and above. If you previously had a Wireless Touch screen on your system, follow the special update instructions at "Update the Wireless Touch Screen from Pre-1.3 Release."

• **Connecting Rooms:** In the 1.3 Release, the method to assign the volume control in the room is using the priority End Points rather than the volume, as with earlier releases. With the 1.3 Release, the use of Volume 1 and 2 for Volume management only when the Volume management is different from the End Point as might be the case in different configurations, such as when a switch is part of the audio or AV path. To use the priority 1 or 2 feature (End Point or Volume), configure the highest-priority volume provider as the device that is least likely to be in the path. For example, a Television is always in the path, but a Receiver is not in the path unless one is added. Therefore, set the Receiver as the first device (Video Volume 1).

• **Audio End Points 1 and 2:** With the 1.3 Release, the Audio End Points 1 and 2 also define the first and second device that handles Volume control for audio in the room.

• **Video End Points 1 and 2:** Prior to the 1.3 Release, this option was the only way to manage video volume.

• **Video Audio End Point:** With the 1.3 Release, the Video Audio End Point 1 and 2 also define the first and second device that handles Volume control for audio when watching video in the room.

• **Audio Volume 1 and 2:** Prior to the 1.3 Release, this option was the only way to manage audio volume. Note that legacy projects might still contain Volume 3; however, this is no longer available in the 1.3 Release.

• **Latitude and Longitude.** In the 1.3 Release, the longitude changed to make it consistent with worldwide conventions. Western hemisphere longitudes are now registered as a negative value rather than positive (they were all positive in prior releases). When your system is updated from 1.2.x to 1.3, this is automatically converted. However, if for any reason you load a backup project created with a prior release, this conversion does not take place. Your scheduled sunrise/sunset-based events still happen, but based on times appropriate for somewhere in the Eastern hemisphere. If it does not happen automatically, enter your zip code again to automatically correct your longitude value.
Composer Pro User Guide

- **Media Scenes Agent:** Prior to the 1.3 Release, if you wanted to put audio in multiple rooms, you needed to start a session, start a party, and add rooms. Do this each time you want to play music in multiple rooms.
- Prior to Release 1.3.2, the following features were not supported:
  - Media Scene Status added — Shows activated, deactivated, or changed.
  - Discrete Volume setting available for a Scene — Used primarily with the Control4 Multi Channel Amplifier. Works well with Tracking. Overrides Initial Volume. The source selections do not change the volume in a room.
  - Command “Last Selected Room” added — Activate a Media Scene based on the most recent room selected instead of the Last Source Selected default.
  - Event “When Scene changes” added.
  - Conditionals “If Activated” and “If Deactivated” added.

2.11.1.7.1 **Updates Earlier than Release 1.2.0**
For projects created prior to 1.2.0.91 (which was released on 9/21/2005), Control4 recommends that you re-create your project configuration.

2.11.1.7.2 **Update from Release 1.3 to 1.7.x from the Internet**
To update from 1.3.x to 1.7.x:
1. Ensure that the existing installed Composer Pro version is 1.7.x.
2. From the Tools menu, select **Update Manager**.
3. Ensure that all devices that you want to update have been identified in your project before starting. The Update Manager dialog appears.

Possible states of the Update Manager:

- **Idle** — No upgrading is occurring.
- **Updating** — Upgrading of a device(s) is occurring.
- **Update Pending** — Upgrading of a device is stalled. See “Troubleshooting the Upgrade Process.”

4. To begin the update, select **Update**.
5. The Update System dialog appears. Click **Begin Update**. To cancel the upgrade, click **Cancel**. During the update, **Director** will disconnect from Composer Pro.
6. A screen appears with status messages about the update. The status screen closes and Update Manager opens where you can check the update progress. The current update shows “Complete” in the Update Status column when each device has been updated. Devices that were not recognized as connected show as “Failed.”
7. Wait for Update Manager to complete the full update process for all devices.
8. Update Manager is done when the current version is correct for all devices — the status will show as Idle. Zserver updates continue for some time for all **ZigBee** devices.
9. Reconnect to **Director** after the **Controller** restarts.
10. Ensure that Director and Composer Pro are the same version.
To update from Release 1.3.x using a USB drive:
To use the USB drive install, first download from the Internet the USB install onto a computer, and then move it to a USB drive. A computer with at least 120 MG of free disk space that is formatted as FAT32 is required.

The USB Install supports updates from version 1.3.0 to later versions. It does not support updates from versions prior to 1.3 (such as 1.2.5).

To update using a USB drive:
1. Download the USB Install to a local computer.
2. Insert the USB drive into the computer.
3. Run the file by double-clicking it for a wizard to appear.
4. After the wizard is finished, insert the USB drive into the USB port on the Controller.
5. Launch the USB Install in Composer Pro by going to Tools > Update Manager and selecting Update. The Update Manager detects the USB Install and indicates that it is using the USB Install for the update.

To update the Wireless Touch Screen from a release prior to 1.3:
Prior to Release 1.3, the Wireless Touch Screen — 10.5” was not part of the project. It is now a requirement to add the Wireless Touch Screen to the project so the update can update every device.

1. On the Wireless Touch Screen, go to Info > About and write down the IP address of this device.
2. Ensure you have successfully updated your system to 1.7.x.
3. In the System Design > My Drivers tab, double-click to add the appropriate Wireless Touch Screen to your project:
   - Mini Touch Screen
   - Touch Screen - 7” Wall Mount
   - Touch Screen - 7” Portable
   - Touch Screen - 7” Table Top
   - Wireless Touch Screen - 10.5”
   - Wireless Touch Screen V2 - 10.5”
   - In-Wall Touch Screen - 10.5”
4. In the Connections view > Network tab, identify the device to the Control4 system. To do this, select the Wireless Touch Screen, and click Identify. When the Identify dialog appears, type in the IP address that you wrote down previously.
5. On the Identify dialog, click Close.
6. Launch the update to 1.7 (Tools > Update Manager) again to update the Wireless Touch Screen to Release 1.7. When the update is completed, the Wireless Touch Screen is updated each time you run the update for the Control4 system.
7. After the Wireless Touch Screen is updated, identify the device again by following the instructions in Step 3 and pressing the button.
Note: After you have completed the initial update of performing the special steps for the Wireless Touch Screen, you do not need to perform any additional steps; the Wireless Touch Screen is now part of the project and will receive updates automatically.

3. Advanced Topics
If you are a new user, this section assumes that you are familiar with Composer Pro Getting Started and The Basics. The Advanced sections are designed for more advanced Composer Pro users.

Use the subsections in this Advanced section to
- Learn how to set up a network configuration
- Learn how to create device drivers
- Learn how to connect and verify devices you've installed and set up
- Learn how to set up media
- Learn how to program the Control4 system in Composer Pro

3.1 Setting Up a Network Configuration
Use the Control4® Composer Pro Tools menu to set up a WiFi network configuration using static IP addresses.

For more information about setting up the network for a Control4 system, refer to the "Basic Networking" training sessions conducted by the Control4 Training team. Training information is available in the Dealer portal.

Note: This example procedure only applies to Speaker Point, Touch Screens, Amplifiers, Tuners and Audio Switch devices.

3.1.1 Procedure
To set up the network configuration for Speaker Point or Touch Screens:
1. Start Composer and connect to a Director.
2. From the Tools menu, select System Manager.
3. In the Devices pane, select the network address of the Director for the device for which you want to set up the network configuration, and click Connect.
Tip: If the device’s network address is not on this list, click Refresh. If it still does not appear, click Add to enter it manually. If you do not know the network address, find it at the Tools menu > Network Tools.

4. In the device's pane (double-click the device in "Devices" to open the device pane), click the Network tab, and click Configure.
5. Click Next when a Network Configuration Wizard dialog appears.
6. In the dialog, enter the new name of the device, and click Next.

Note: An error occurs if there are any spaces in the new name text. Do not include spaces in the new name.

If the device has already been identified on the Control4 system, and you want to change the name, identify the device again because the Controller no longer recognizes the name, and it cannot communicate with the device.

7. Select the network you want the device to be a part of, such as an Ethernet or Wireless, and click Next.
8. Select the method for obtaining an IP address, such as DHCP (first option) or Status IP (second option), and click Next.

   Example: "Obtain an IP address automatically using DHCP"

9. Select the method to obtain the DNS server address, such as DHCP (first option) and Static IP (second option), and click Next. Control4 recommends that you obtain the DNS server address automatically.

   Example: "Obtain DNS server address automatically"

10. Click Finish when you come to the "Network Configuration Wizard Complete" screen. Note your settings on the screen.

11. Wait for the Controller to check the hard disk and restart the system. Do not disconnect any temporary Ethernet cables or the power cord until the device is finished and it returns to the first Control4 screen.

3.2 Creating Device Drivers

Learn how to create Control4® device drivers and use IR inputs to program System Remote Controls in these sections:

"Overview of Creating Device Drivers"
"Why Create a Device Driver?"
"Using the Driver Wizard"
"Creating IR-Controlled Drivers"
"Creating a Serial-Controlled Device Driver"
"Creating 2-Way Serial or TCP/IP-Controlled Drivers Using DriverWorks"
"Related Tasks"

To complete device support using Composer Pro for a Control4 system, every device requires a corresponding driver.

To add a device to the Control4 system that does not have a supporting driver, use the built-in Driver Creation wizard in Composer Pro to create the driver prior to adding the device.

3.2.1 Procedure

To use the Driver Wizard from the Driver menu:

Select Create New Driver. See "Menu Options" in Composer Pro Getting Started for details.

The Driver Creation wizard (or Driver Wizard) lets you add device support to the system, including support for:
• **Infrared (IR)-Controlled** — Devices that are controlled using wireless remotes. Commands are sent via pulses of infrared light to the device.

  Examples of IR-controlled devices: receivers, televisions, plasma screens, projectors, DVD/CD players, DVD/CD changers, VCRs, satellites, cable boxes, DVRs, tuners, audio/video switches, amplifiers, blinds, and other specialized equipment.

• **Serial-Controlled** — Devices are controlled via a serial connection (RS-232, RS-422, or RS-485) to the Controller hardware, for example, a Home Controller HC-500. Serial-controlled devices often control a device at a higher level than IR-controlled devices.

  Examples of serial-controlled devices: projectors, multi-disc DVD changers, and other serial-controlled devices.

### 3.2.2 Why Create a Device Driver?

A hardware driver is a small piece of software that allows a computer program to communicate with a specific **device** in the Control4® system. Every device in the Control4 system requires a driver, and that driver must be added to the project tree in Composer Pro. Some devices do not have existing drivers in the Composer Pro driver database, or the drivers there cannot control a device. In that case, a new device driver needs to be created.

**Example:** A computer may use a printer driver to send a print order to a printer. Every controllable device uses codes that represent commands on that device. To control the device, you must capture or enter these codes in the driver.

**Example:** An IR-controlled **CD** player’s commands are Play, Stop, Pause, etc. Using the Driver Wizard and Controller hardware along with the manufacturer’s remote control supplied with the equipment, you can capture these codes and build a working driver using the codes. Serial-based devices are also supported; you can enter the serial codes to the Driver Wizard manually.

**Tip:** Each driver consists of a collection of files. One of those files is a configuration file, which is an XML file referred to as a Config Data file or .c4i file. This file provides specific IR, serial, or connection codes that are pertinent to supporting a device model on the Control4 system. In the default Composer Pro installation, these files are located on your PC at: c:\program files\control4\Composerxxx\drivers\virtual.
3.2.3 Overview of Creating Device Drivers

These sections provide steps and guidelines for creating Control4® device drivers:

- Why Create a Device Driver?
- Guidelines for Creating Device Drivers
- Guidelines for Defining Power Management
- Using the Driver Wizard
- Limitations to the Device Driver Wizard
- Creating IR-Controlled Drivers
- Creating a Serial-Controlled Device Driver
- Using a New Device Driver in an Existing Project

3.2.4 Guidelines for Creating Device Drivers

The most important information you need to know before you begin to create your own Control4® device driver is to understand how your devices work. After that, you can use the Driver Wizard and/or the DriverWorks SDK to create your own drivers. Contact Control4 Technical Support for details.

IMPORTANT: Before you begin, check the manufacturer's documentation to learn about the codes or customized macros required to support your device, and understand the inputs and outputs that your device supports and other details about the device as needed.

For best results, understand the following concepts and guidelines:

1. **Supported Commands and Inputs/Outputs of the Device.** Prior to starting the Driver Wizard, have a basic understanding of the device.

2. **Discrete versus Toggle.** In the Driver Wizard, the term 'discrete' indicates a direct setting rather than a toggle option between settings. For example, a receiver might have 'discrete input select,' which lets you select the input directly (DVD) rather than using a toggle button that cycles through all the inputs (DVD, VCR, TV), such as Input Toggle.

3. **IR Codes versus Macros.** In the Driver Wizard, some IR codes complete the needed command; however, to complete the commands, you may need a macro (a sequence of codes).

4. **Adding All Options for AV Connections.** When adding AV connections, select all possible options for the device so all options are available for selection.

5. **Power Management Options.** A variety of supported Power-Management options are available to choose from, but the optimal method depends on the device. When no other option works, use the Assume the Device is Always On option, and leave it up to the user to ensure manually that the device is on. See “Guidelines for Defining Power Management.”

6. **Adding Commands and Custom Commands.** The Driver Wizard supports a set of default commands for each device type, such as Television, VCR, DVD, etc. If a command you need does not appear on the Default Command list, click Add and use the pull-down menu to look for the command. You can also add custom commands if necessary.

7. **Driver Wizard Screens Vary for Device Types.** Because different devices, such as televisions, VCRs, and DVDs have different functionality, the Driver Wizard steps you through different questions as appropriate for that device type, and there are pre-defined generic Device Types that have a common set of commands with varying capabilities that you can use as a base.
Driver Wizard prompts you to select the appropriate commands from these basic commands, as well as identify any additional capabilities that the particular device is able to perform.

**Example:** All televisions have Up/Down channel and Up/Down volume commands, so these basic commands are already included in the generic TV device type. However, not all televisions have direct channel selection, where you can select a channel by pressing a sequence of numbered keys.

8. **Creating or Editing Multi-Featured Device Drivers.** You can create only combination types that are listed in the Create New Driver wizard. Control4 recommends that you start with an existing driver in the Online Database, add it to your Local Database, and then edit it as needed to meet the new device-driver need. Be patient. You may need to change IR codes if a code doesn't work with your device.

9. **DriverWorks** can be used to create 2-way drivers for AV and non-AV devices. It requires some **programming** skills, however, but leverages the Lua-embeddable scripting language, a powerful, fast, and light-weight (when compared to other scripting languages). See “Creating 2-Way Serial or TCP/IP-Controller Drivers Using DriverWorks.”

**Tip:** When a device driver is created, you may want to distribute it to multiple projects on different computers. To do this, copy the driver file from the default install directory: `C:\Program Files\Control4\Composerxxx\Drivers\Virtual` to the same directory on the other computers.

This action makes this driver file available to all the projects stored on that computer. Driver files are named by device type, protocol, manufacturer, and model with a.c4i extension.

**Example:** `tv_ir_samsung_tx-p1430.c4i`.

### 3.2.5 Driver Wizard

Use the Control4® Driver Wizard in Composer Pro to create device drivers for your devices.

#### 3.2.5.1 Using the Driver Wizard

These sections provide information about how to create device drivers.

"Limitations of the Driver Wizard"

"Editing a Driver Using the Driver Wizard"

"Verifying Driver IR Codes Using the Driver Wizard"

"Creating IR-Controlled Drivers"

"Creating an IR Television Driver"

"Creating a Serial-Controlled Device Driver"
3.2.5.2 Limitations of the Driver Wizard

The Control4® Driver Wizard is not designed or intended to create drivers in the following situations:

- **Bi-directional drivers**—Bi-directional drivers provide enhanced support for two-way communication between the device and the Controller. Custom bi-directional drivers are available for some devices (check the Online Database). The Driver Wizard does not create bi-directional drivers. If you need to create a custom bi-directional driver, ask your Control4 Sales Representative about the Control4 software development kit (SDK) program.

- **Logical Calculations**—Some devices require logical calculations. The Driver Wizard can provide only limited support for devices that require logical calculations.

- **Relays and Contacts**—The Driver Wizard is not designed to create drivers for relays and contacts. If you cannot find a specific driver for your Contact or Relay device, use the generic drivers provided in the Online Database.

- **Serial Codes**—To create serial drivers, get the serial codes from the manufacturer’s documentation. Control4 collects the serial codes in a database from the manufacturers/dealers that obtain these codes. If you need serial codes, contact Control4 Technical Support or contact the manufacturer directly.

3.2.5.3 Editing a Driver Using the Driver Wizard

To make changes to a driver located in your local Control4® driver database that is NOT fully-configured and connected in a project, you can use the Composer Pro Driver menu > Edit Existing Driver option. This option lets you modify and update the driver options in the Driver Wizard.

3.2.5.3.1 Procedure

To edit a driver using Driver Wizard:
1. Start Composer and connect to a Director.
2. From the Driver menu, select Edit Existing Driver.
3. In the next screen, select the driver type, such as VCR.
4. Select the Model type.
5. Select a section, and click next to advance to the screen that you want to edit.
6. Edit the screens or recapture the codes as needed. See “Creating IR-Controlled Drivers” for details.
7. When you’ve edited the driver, click finish, and click next.

**IMPORTANT**: If you edit any inputs or outputs of the driver after editing a driver, you must remove the driver from the project, add it to the project again from the Search tab, and then make the connections.

3.2.5.4 Verifying the IR Codes Using the Driver Wizard

Use the Edit Existing Driver menu option to verify your IR codes for the Control4® system.

**Note**: Make sure the Controller is connected to the device via IR, and that all necessary connections are made.
3.2.5.4.1 Procedure

To verify driver IR codes using the Driver Wizard:
1. Start Composer and connect to a Director.
2. From the Driver menu, select Edit Existing Driver.
3. Select the driver type, such as VCR.
4. Select the Codes section.
5. Click next to advance to the screen for the first IR code listed.
6. On the left side, use the scrollbar to select the code you want to test, and click Emit to verify the function of the specific IR code.
7. Edit or recapture the codes as necessary.
8. After you’ve edited the driver, click finish.
9. Click next to save your changes.

**IMPORTANT**: If you edit any inputs or outputs of the driver after editing a driver, you must remove the driver from the project, add it to the project again from the Search tab, and make any necessary connections.

**Tip**: To exit the Driver Wizard without saving your changes, click x at the top right of the screen.

3.2.6 Power Management

3.2.6.1 Guidelines for Defining Power Management

Control4® Power Management options are modifiable using the Driver Wizard in Composer Pro which is accessible through the Driver menu during creation or driver edits.
3.2.6.1.1 Editing Power Management Options

If resetting the connections is not required, you can sometimes edit the Power Management options from the Composer Pro project tree:

1. Right-click the device.
2. Click Edit Driver.
   a. If the Edit Driver option does not appear, edit this driver from the Driver menu.
   b. Remove and then add the device to the project tree again.

Options on this screen include:

- **Assume the device is always on**—Choose this option if the device is always on, or if the device is turned on and off by pressing the same button. For example, the system has no way to acknowledge if a television is on when the television uses a toggle button (such as buttons labeled 'Power' or 'On/Off') instead of discrete (separate) On and Off buttons.
  
  **Note**: Use this option for Power Management of a multi-zoned receiver.

- **Send Toggle Codes**—This option is selected automatically when you check the Has Power feedback box. You can select the other available options, such as Macro. Click next to return to this page and reset the page to this option.

- **Use discrete on/off codes**—Choose this option if the device features a separate button for On and Off versus one button used to cycle between On and Off.

- **Use On/Off macros**—Use this option to control power on the device by using a sequence of button presses to determine the power state of the device.

  **Example**: You know the state of most DVD players by sending a Play command, because Play typically changes the power state to On.

  You can set up a macro that
  
  - Sends a Play command.
  - Sends a power toggle command to turn the device off.
  - Sends a power toggle command to turn the device on.

  The system can determine with certainty that the power state is On.

- **Has Power Feedback**.
  - **Video sense loop**—Check this option if you want the system to determine (using a Composite video connection) whether a device is On or Off based on whether a video signal is present.
  - **Contact sensor (power sensing)**—Check this option if the device is plugged into a Wireless Outlet Switch and is configured as a Contact Sensor.
  - **Control power directly (power control)**—Check this option if the device is plugged into a Wireless Outlet Switch and is configured as a relay. With this option, you can set two (2) delays to accommodate special devices.

For more information, see “Configure a Wireless Outlet Switch.”
3.2.6.1.2 ConfiguringAssignableInputsandOutputs

In a driver, you want to create all possible inputs and outputs on a device. However, a driver can only support the physical inputs and outputs that exist on that device. Do not attempt to create inputs or outputs that do not exist on the device.

3.2.6.2 Changing Power Management Options

Use the Power Management options in the Composer Pro Driver menu to change power for a Control4® system.

To change the Power Management option of a driver, you can edit the driver to provide a different Power Management option. After editing a driver, you may need to add the driver to the project and set up the necessary connections.

3.2.6.2.1 Procedure

To change Power Management options in a Driver:
1. Start Composer and connect to a Director.
2. From the Driver menu, select Edit Existing Driver.
3. Select the driver type, such as VCR.
4. Select the Manufacturer type, such as Mitsubishi.
5. Select the Model type.

Example: To change the Power Management option, check Has power feedback, and then select the Video sense loop option.

7. After you edit the driver, click finish, and click next.

Example: The Video Sense Loop requires a Control connection. A control Video Sense connection has been added to the DVD driver.

8. Make any necessary connections to configure the new Power Management option.

Example: With the Video Sense Loop Power Management option, connect the Control connection.

a. From Connections, select Control/ AV > DVD.
b. From the top pane in Control Connections, drag the Video Sensor connection to a Video Sense Loop connection on the Controller (such as Home Controller HC-500).
3.2.7 IR-Controller Drivers

3.2.7.1 Creating IR-Controlled Drivers

This section provides instructions for creating and testing a driver using the Control4® Driver Wizard in Composer Pro. Depending on the device type, the Driver Wizard asks you questions for the driver you are creating. The Driver Wizard varies between device types because different device types have different functions. Follow the Driver Wizard screens until your driver is created.

3.2.7.1.1 Prerequisites

For the IR Learning capability to work, you must be connected to a Director and have a Controller added to your project.

3.2.7.1.2 Procedure

To use the Driver Wizard:

1. Start Composer.
2. From the Driver menu, choose Create New Driver.
3. From the list, choose the type of driver you want to create, and click ok.
4. Enter the Device Information.
   a. Fill out the requested information, such as device’s Manufacturer, Model number, and the name of the Driver Creator (whoever is creating the driver), and click next.
   b. Check whether the device is IR or Serial controlled, select the appropriate options, and click next.
   c. Define the type of power management, audio parameters, and device properties there are, and click next.
   d. Identify the relevant commands, add custom commands as necessary, and click next.
5. Capture, paste, or enter the device codes using one of the following:
   • IR: Use the manufacturer’s remote and the Controller’s IR Learning capability for capturing IR commands.
   • Serial: Enter the codes.
6. Create and identify the input and output connection options for the device, and click next.
7. Create macros if necessary.
8. Find your driver, add it to the project, and test it. See Composer Pro Getting Started for details about how to do this.

3.2.7.2 Guidelines for Capturing IR Codes

For best results when capturing IR codes for a Control4® system, follow the on-screen prompts in the Composer Pro Driver Wizard.

Follow these guidelines:

• Point your manufacturer's remote control directly at the IR window located just below the dial on the front panel of your Controller hardware (such as Home Controller HC-500). Avoid aiming the beam at an angle, and keep the beam in the same axis as the IR window.
While capturing the first few codes, the Controller begins to recognize the frequency. Note that a message about 'an alternate frequency' might display. This is normal, and it means that the Controller is adjusting to the remote frequency.

To help ensure a successful capture:
1. **Hold the manufacturer's remote** at a distance of approximately 6” away from the Controller hardware, and then press the button requested.
2. **When prompted, press the button again** to confirm the code captured. You are prompted a third, fourth, and possibly a fifth time to press each of the first few buttons.
3. **If another device in the room emits IR**, such as a bi-directional IR device, block the IR so it does not interfere with IR capture.
4. **The process of capturing IR codes is very sensitive to light**, such as sunlight and fluorescent lights. If it is not working properly, turn off the lights, close the drapes or blinds, or cover the physical hardware so that the light cannot interrupt the capturing of codes.
5. **When capturing IR codes, press and release the remote button** in one (1) second.

**Note**: Do not press and hold for long periods (longer than three (3) seconds). Doing so increases repeat counts. Typical repeat counts are between three (3) and five (5) seconds.

6. **When capturing IR codes, look for a green light to turn on and off** on the Controller hardware. Also, watch the Driver Wizard screen; it changes the steps to indicate that codes are captured.
7. **Avoid IR interference** from your laptop by disabling or powering off the IR devices.

After successfully capturing a few codes:
1. **Hold the manufacturer's remote** at a distance approximately 8” - 12”, and then press the next button requested.
2. **When prompted, press the button again** to confirm the code captured. Most buttons are confirmed with the second button press. You may be prompted repeatedly to confirm the code captured, including:

If the remote uses alternative codes—Some manufacturers provide alternate codes or a second code to differentiate between two (2) distinct button presses, such as ‘1’ and then ‘1’ again for Channel ‘11.’ Some remotes have a different code for each ‘1.’

If an incorrect button was pressed, or if there was interference during the IR capture—if you press the wrong button for a code or there was some interference during IR capture, the system may sense this and ask for a different code or request the same code again. If you test the code, and it doesn't work, try to capture it again.

If you pressed a button longer than three (3) seconds.

To disable the devices from the laptop's Control Panel:
1. Select **Wireless Link**.
2. Click the **Hardware** tab, and click **Properties**.
3. Ensure that any IR devices are disabled.
4. After capturing the codes, enable the IR devices again.

When the system has finished capturing codes for a device the Driver Wizard moves to the Input/Output category.

3.2.7.3 Creating an IR Television Driver

This section provides an example for creating an IR television driver using the Control4® Driver Wizard in Composer Pro. The example uses the Samsung TX-P1430 television; we will be creating a driver for it.

The major steps are:
1. Create an IR-Controlled Television
2. Select the Volume and Other Properties for IR
3. Indicate How Power Is Handled for IR
4. Identify the Commands that the Device Supports
5. Capture the Device Codes for IR
6. Identify the Input/Output Connections
7. Define the RF/Antenna and Connection Type
8. Define the Set Channel Macro
9. See “Add the IR Driver to the Project Tree.”
10. See “Connect the Devices for IR Control.”

3.2.7.3.1 Conditions

- The Samsung TV is using IR for device control as an example.
- There is not a discrete power on/off option, so you cannot control the power; the control system needs to assume this device is always on.
- As with most TVs, there is Discrete Channel Selection; and the TV can provide audio output.
- The TV does not have discrete volume control, but it does have mute toggle capability.

3.2.7.3.2 Procedure

To create an IR-controlled television using the Samsung TXP1430:
1. Start Composer and connect to a Director.
2. Ensure that you add a Controller to your project (such as Home Controller HC-500). This should be the first device added.
3. To add a Controller:
   a. Select the room (such as Theater) where the Controller is installed.
   b. Click the My Drivers tab.
   c. Under Controllers, double-click a Controller (such as Home Controller HC-500). This adds the Controller and the Digital Audio object that resides on the Controller to the project tree.
   d. In the Connections view, identify the Controller you just added.
4. Start the Driver Wizard. From the Driver menu, select **Create New Driver**.

5. Select the device driver you want to create, and click **ok**.
6. Enter the information for the driver you are creating, such as device’s Manufacturer, Model number, and name of Driver Creator, and then click next.  
   - The Created, Modified, and Copyright information is automatically generated.  
   - Manufacturer: Samsung.  
   - Model: TX-P1430.  
   - Device Creator: ACME Integrators.

7. Under How is this device controlled? select the IR radio button to indicate that this television is controlled with an IR device, check Direct Connect if applicable (if IR codes are running through a direct cable, such as S-link), and then click next.

Select the Volume and Other Properties
8. Under Volume Properties, select the volume properties for this device, and click next.  
   a. Select Audio.  
   b. Select Mute.  
   c. Leave the other options as they are.

9. Select the properties that apply to this device, and then click next.  
   Options for this screen include:  
   - Select Discrete Input Selection—This television has this capability and indicates that a television has the ability to select inputs directly. On the television’s remote you can select Video 1, Video 2, or Video 3 using three (3) different buttons rather than one (1) toggle button that toggles to each selection.  
   - Do not select Discrete Channel Selection—This television does not have this capability and indicates that the television has the ability to select channels directly. On the remote you can select a “discrete” channel by clicking 05 rather than toggling through channels by clicking the Channel Up and Channel Down buttons.

Indicate How Power Is Handled for IR
10. Determine how power is handled for the device:  
    - For the Samsung TX-P1430 television driver, select Assume device is always on.  
    - For a description of each option, see “Guidelines for Defining Power Management” to help with a selection.

11. Click next.

Identify the Commands that the Device Supports
12. De-select the default commands not relevant to the device, add any custom commands (additional buttons) required, and then click next.  
   a. Deselect Cancel.  
   b. Deselect Info.  
   c. Deselect TV/Video.
Capture the Device Codes for IR

13. Capture the device codes using the manufacturer’s remote and the Controller’s IR Learning capability. Follow the guidelines listed in “Guidelines for Capturing IR Codes” and the on-screen instructions.

Use the Samsung TX-P1430 television remote control to capture the codes by pointing the remote directly at the IR window on the Home Controller HC-500.

When a code has been captured, Composer Pro puts a check next to the captured code in the Codes list, and selects the next code to be captured. When you capture all the codes, Driver Wizard automatically moves you to the next section: Input/Output.

(Optional) After you capture a code, if you want to view the code, click back. You can also edit and emit the code from this screen.
14. When you are finished, click **next**.

**Note:** Sometimes a device can have alternative patterns. In this case, multiple codes show up on the screen.

15. Read the television manufacturer’s documentation to find out the necessary inputs/outputs.

**Identify the Input/Output Connections**
16. Click **Add** to identify the Input/Output connections on the television, and then click **ok**.
17. For the Samsung TX-P1430 television driver, add the following inputs:
   - **Line Input**—Choose Input and Line Level type.
   - **RF Antenna**—Choose Input and RF/Antenna type.
   - **Monitor Out**—Choose Output and Line Level type.
The inputs appear in the Input/Output Connections window.

18. When the Input/Output Connections list is completed, click next.

19. Define the connection types for Inputs/Outputs, and then click next.
For the Samsung TX-P1430 television driver, define the Line Input:

- Under Audio Connections, select **Stereo (RCA)**.
- Under Video Connections, select **Composite and S-Video**.

**Define the RF Antenna and Connection Type**

20. Define the RF/Antenna type on the input RF Antenna, and then click **next**.

   For the Samsung TX-P1430 television driver, select the **UHF/VHF** radio button.

21. Define the connection type for output Monitor Out, and then click **next**.

   - Under Audio Connections, select **Speaker**.
   - Under Video Connections, select **Composite and S-Video**.

**Define the Set Channel Macro**

22. Define a Set Channel macro to set the number of digits required by the TV to change channel so that the system can imitate the behavior of the TV’s remote. Some TVs require two (2) numbers and others require three (3).

   The Samsung uses a 2-digit channel entry. Select **CHANNEL 3** and use the Minimum Length drop-down menu to change to **2**.

23. Increase the inter-digit delay (delay button code) if necessary for the TV you are adding.

24. Click the blue number sign (#) to move the settings into the center pane.

25. Click **next**.
26. You have completed the setup of this driver. You can view the driver you created in the Search tab. Click next, and then click ok to continue.

27. Next, add the new driver to the project tree and connect the device. See “Add an IR Driver to the Project Tree” and “Connect the Devices for IR Control” below.

3.2.7.3.3 Add the IR Driver to the Project Tree

After you create an IR driver using the Control4® Composer Pro Driver Wizard, you must add it to the Composer Pro project tree. This section uses the Samsung TXP1430 as an example.

3.2.7.3.3.1 Procedure

To add the IR driver to the project tree:
1. Start Composer and connect to a Director.
2. Click System Design.
   a. In the project tree, remove the existing television driver that you previously added to the example project (if it was added).
   b. From the Search tab, use the drop-down menu to select the Device Type and Manufacturer of the driver you just created.

Example:
   • At Device Type, choose Television.
   • At Manufacturer, choose Samsung.
3. Double-click the new driver to add it to the project tree. Example: Samsung TXP1430.
4. Make the connections. See “Connect the Devices for IR Control.”
3.2.7.3.4 Connect the Devices for IR Control

After you create an IR driver using the Control4® Composer Pro Driver Wizard, you must add it to the Composer Pro project tree and connect the device. This section uses the Samsung TXP1430 as an example.

3.2.7.3.4.1 Procedure

To connect the IR device:

1. Start Composer and connect to a Director.
2. Click the Connections view to make the appropriate video, audio, and control connections or network connections (if appropriate) for the device.
3. For the Samsung TX-P1430 television driver, select Television.
4. Make all the necessary Control and AV connections.
   
   **Example** (Television): In Connections under Theater, click Television. The right pane displays all of the inputs and outputs on the back of the television. For television, from the top pane:

   Under Audio Video Inputs, drag the object from the top pane to the bottom pane:
   
   a. Click **AV In (Video—COMPOSITE)**, and drag it to **Receiver (Output—Theater)**.
   b. Click **AV In (Audio—STEREO)**, and drag it to **Receiver (Output—Theater)**.
   c. Under Control Inputs, click **IR Sensor (Control—IR_OUT)**, and drag it to **Home Controller HC-500 (IR Output 1—Theater)**.

5. Click System Design, and double-click the device on the project tree.
6. Use the Device Control window to test the control of the device. For the Samsung TX-P1430 television driver, double-click Television.

3.2.7.4 Editing an IR-Controlled Receiver Driver

This section takes you through an example of creating a custom IR-controlled Receiver driver for a Control4® system by starting with an existing driver with multiple outputs, and then editing it.

**Example:** In this example, pick the driver for the Harman Kardon AVR-230 Receiver. The Harman Kardon AVR-230 receiver is using IR for device control.

3.2.7.4.1 Conditions

- There is a discrete power on/off option.
- Like most receivers, the device uses Discrete Input Selection and Discrete Surround Selection.
- It does not have Volume Discrete Control, but it does have Mute toggle capability.
- The Harman Kardon AVR-230 Receiver has the capability of Discrete Power on/off.

3.2.7.4.2 Procedure

To edit an existing device driver:

1. Start Composer and connect to a Director.
2. Pick an existing driver in the Online Database to edit.
   
   a. From the Driver menu, choose Manage Drivers.
   b. In the Local Driver Database screen, click Add to access the Online Database.
c. In the Search dialog box, use the drop-down menus to choose the **Device Type** and **Manufacturer**, and then click **Search**.

**Example**: For the Harman Kardon AVR-230 use the following information:

- Device Type: **Receiver**.
- Manufacturer: **Harman Kardon**.

d. In the Search Results list, select the **Model Number**.

**Example**: Select Harman Kardon AVR-230.

- Click **OK** to add this driver to your Local Database.
- Click **Exit**.

3. From the Driver menu, choose **Edit Existing Driver** to begin editing the driver in your local database.

**Note**: If you right-click on the driver in the **project tree**, you will edit ONLY the driver in the project and not the driver in your local database.

4. Select the **Device Type** (such as Receiver) to view list of manufacturers.
5. Select the **Manufacturer** (such as Harmon Kardon) to view list of model numbers.
6. Select the **Model Number** (such as AVR-230).
7. Click **OK** to open the existing driver (with all of its current settings) in the Driver Wizard.

![Driver Wizard](image)

**Edit the Device Information**

8. Edit the Device Info form as needed, including Manufacturer, Model number, and Driver Creator. This should reflect how you want this driver to display in your Local Database.

9. For the Harman Kardon AVR-230 use the following information:

- Manufacturer: **Harman Kardon**.
Driver Creator: ACME Integrators.

10. Click next.

Indicate How the Device Will Be Controlled
11. Indicate how this device is controlled using IR or Serial. Example: Select IR and Direct Connect.
   - IR—Select this radio button if the device you want to create a driver for is IR (infrared) controlled.
   - Direct Connect—Check this box if your IR codes are running through a direct cable, such as S-link.
   - Serial—See “Creating a Serial-Controlled Device Driver” for information and example implementation.

12. Click next.

Edit the Volume Properties
13. Edit the volume properties for the Harman Kardon AVR-230:
   - Check Audio.
   - Check Mute, but do NOT check Discrete Control. The Harmon Kardon AVR-230 has mute toggle only.

14. Leave the other options unchecked. The Harman Kardon AVR-230 does not have these features.
15. Click next.

Edit the Existing Properties for the Driver
16. Edit the existing properties for the driver as needed.
17. For the Harman Kardon AVR-230 driver:
   a. Accept the defaults of Discrete Input Selection and Discrete Surround Sound Selection.
   b. Click Add to add surround sound modes and in the dialog that appears type the Name, and click ok.
   c. Do this for each of the surround sound modes, including Dolby Pro Logic, DTS Neo 6, and THX.

18. Click next.

Indicate How Power Is Handled for the Device
19. For the Harman Kardon Receiver driver, select Use discrete on/off codes, and click next. See “Guidelines for Defining Power Management” for help making a selection on this screen.
20. Click next.
21. De-select the commands not relevant to the device as needed, For the Harman Kardon Receiver driver, click to de-select.
   - Cancel
   - Info
   - Mute Off
   - Mute On
   - Power Toggle
• Pulse Surround Mode
• Recall
• Toggle Input
• TV/Video

22. See the diagrams that follow.

Add the Commands
23. From the extended command list, add several commands: DVD and Video 1.
24. To add the commands from the extended command list for each individual command, click Add.
25. On the dialog that appears, use the drop-down menu to select the commands, and click ok. The new command appears in the Default Commands pane.
26. Add custom commands for surround modes, including DTS Neo 6, Dolby Pro Logic, and THX. To add custom commands for each individual command, click Add.
27. Enter the name of the command, and then click ok. The new commands appear in the Custom IR Commands pane.
28. Click **next**.

**Capture the Codes**

29. Capture (or recapture) the device codes as needed using the manufacturer’s remote and the Controller’s IR Learning capability. Follow the guidelines for capturing IR codes in “Guidelines for Capturing IR Codes.”

When a code has been captured, Composer Pro puts a check next to the captured code in the Codes list, and selects the next code to be captured. When you have captured all the codes, it automatically moves you to the next section Input/Output.
30. Use the Harman Kardon AVR-230 Receiver remote control to capture the codes by pointing it directly at the IR window on the Home Controller HC-500.
31. Use the Harman Kardon Receiver remote control to capture the codes.

**Add the Input and Output Connections**

32. Add the input and output connections. For the Harman Kardon Receiver driver:
   a. Add 2 inputs: **DVD** and **Video 1**.
   b. Add 1 output: **Monitor Out**.

   The inputs and outputs appear as shown:

   ![Input and Output Connections](image)

   33. Click **next**.
   34. Define the **connection** types for input **DVD**.
      a. In Audio Connections, check **Stereo**.
      b. In Video Connections, check **Composite**, **S-Video**, and **Component**.
   35. Click **next**.
   36. Define how you select **DVD**. Select **Code**. Use the drop-down menu, and select **DVD**.
   37. Click **next**.
   38. Define the connection types for input **Video 1**.
      a. In Audio Connections, check **Stereo**.
      b. In Video Connections, check **Composite**, **S-Video**, and **Component**.
   39. Click **next**.
   40. Define how you select **Video 1**. Select **Code**; use the drop-down menu, and select **Video 1**.
   41. Click **next**.
   42. Define connection types for input **Video 1**.
      a. In Audio Connections, check **Stereo**.
      b. In Video Connections, check **Composite**, **S-Video**, and **Component**.
43. Click next.
44. Define connection types for input Monitor Out.
   a. In Audio Connections, check Stereo.
   b. In Video Connections, check Composite, S-Video, and Component.
45. Click next.
46. Define three (3) macros for Dolby Pro Logic, DTS Neo 6, and THX.
   a. Use the scrollbar to skip all the macros until you get to “Set output Mon...”
   b. Select this macro.
   c. Go to the window in the bottom right corner and find Dolby Pro Logic.
   d. Ensure Pulse is selected, and click the green arrow. This adds the macro to the center pane.
      The screen heading should read “Define the macro to: Set Monitor Out surround mode to Dolby Pro Logic?”
   e. Do the same for DTS Neo 6 and THX.
47. Click finish.
48. See the diagram series that follows.
49. You have now completed your driver setup. View the driver you edited in the **Search** tab.

50. Drag the new driver to the project tree.

51. Connect the video, audio and control or network connections (as appropriate) for the device.

52. Click **System Design**, and double-click the device in the project tree.

53. Use the Device Control window to test the control of the device.
54. For the Harman Kardon Receiver driver, double-click **Receiver**.

### 3.2.8 Serial-Controlled Device Drivers

#### 3.2.8.1 Creating a Serial-Controlled Device Driver

Create serial drivers using the Control4® Driver Wizard in Composer Pro. Instead of capturing the code as you do with IR, you enter the specific serial data that you must send for each command.

#### 3.2.8.1.1 Procedure

To create a serial-controlled driver:

1. Follow the same steps used in “Creating IR-Controlled Drivers” and select a serial-controlled driver rather than an IR-controlled driver.
2. Follow the wizard pages to create the driver.

#### 3.2.8.2 Guidelines for Entering Serial Codes

This section describes the different formats you can enter for the serial data of each command in Control4® serial drivers.

These formats include:

- **Basic Method to Enter Bytes**—Shows you how to enter a basic code.
- **Method to Enter Delays**—Shows you how to enter a delay code that you need to control some devices.
- **Method to Enter Parameters**—Shows you how to enter the needed parameters.
- **Method to Enter Checksums**—Shows you how to enter the checksums.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Basic Method to Enter Bytes** | All serial data in the end becomes bytes. There are three (3) basic formats to represent bytes, but in the end the resulting data is just bytes, and any format would suffice for the entry. For ease-of-use, multiple formats are supported. Examples for all methods: Data is equivalent to the ASCII string “DVD” with a carriage return at the end. **Decimal Data**—With decimal data and between any of the different formats there must be a space to act as a delimiter between different pieces of data. To enter decimal data, enter the value to be stored in the byte in decimal. Valid data is from 0-255. **Example** Data (“DVD” with carriage return): 68 86 68 13 **Hexadecimal Data**—With hexadecimal data and between any of the different formats, there must be a space to act as a delimiter between different pieces of data. To enter hexadecimal data, enter the ‘$’ symbol immediately followed by the value to be stored in the byte in hexadecimal. Valid data is from $00-
## Method to Enter Delays

Many times it is necessary to create delays when sending data to a serial device. The `#` character is used to represent that the following number is a delay in milliseconds. A space is required between each element in the data.

**Example**: This example assumes that the protocol calls for a “PWON\r” command followed by a 1500 millisecond delay followed by a “PLAY\r”.

**ASCII Example**:

```
"PWON\r" #1500 "PLAY\r"
```

**Decimal Example**:

```
80 87 79 78 13 #1500 80 76 65 89 13
```

## Method to Enter Parameters

Many commands have parameters. Examples of these commands are the GO_TO_CHANNEL command for TVs and Satellite receivers or GO_TO_DISC commands for DVD and CD changers.

During driver creation, you are allowed to create macros to embed the parameter in the data that is being entered. This creates different problems depending on...
Method | Description
--- | ---
 | whether the protocol is a binary or ASCII protocol. When entering ASCII parameters, use a modified version of the format that C uses in its printf function.

**Example:** This example is a GO_TO_CHANNEL command where the protocol specifies that the devices need the ASCII command “Channel XXX\r” where the XXX is the three digit (decimal) channel number that is being requested with zeroes padded (on the left) if the number is less than 100. The parameter name is CHANNEL_NUMBER.

**ASCII Example:**

“ChannelHarman Kardon03dCHANNEL_NUMBER \r”

Later, at run time when this command is called with the channel 56, the output appears as follows:

“Channel 056\r”

During driver creation, you can also enter parameters in a binary protocol format. Borrowing from the last format with the modification that following the%, first is the byte count (valid counts are 1, 2 and 4), followed by the byte order (E = big endian, e = little endian), followed by the data format (D = decimal, others to follow). This is obviously followed by the actual parameter name as in the example above.

**Example:** This example assumes the protocol needs a start byte that is the number 2, followed by the GO_TO_CHANNEL command code which is 57, followed by a 2-byte big endian channel number, followed by the end byte which is 0.

2 57%2EDCHANNEL_NUMBER 0

Later on at run time when this command is called with the channel 357 the output looks like the following using our format.

2 57 1 101 0

(Hint 0x0165 is hexadecimal for 357, and 1 = 1 in decimal and 65 = 101)

If the protocol used little endian for the parameter, the data entry is:

2 57%2eDCHANNEL_NUMBER 0

The output for the previous example is:

2 57 101 1 0

**Method to Enter Checksums**

Many protocols require a calculated checksum. A way must be provided for the user to calculate a checksum. There are several formats for checksums, so different types of checksums must be allowed. The ‘&’ signifies that the software needs to enter a checksum followed by a byte count (valid counts are 1, 2, and 4), followed by the byte index in the command where the checksum calculation starts.
<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
</table>
| (valid numbers are 0-9), followed by the byte size of the checksum chunks (valid sizes are 1 and 2), followed by byte order (E = big endian e = little endian), followed by the checksum calculation format (STD = standard (chunk size wide) addition inverted, CRC = CRC). | **Example:** The example uses the same devices as previously mentioned and assumes the big endian GO_TO_CHANNEL command, where that command needs a checksum (before the 0 end byte) starting at the beginning of the command, and the command is a simple 1-byte checksum. The data entry displays the following:  

2 57%2EDCHANNEL_NUMBER &101ESTD 0  

And the output for the previous examples is (channel = 357):  

2 57 1 101 94 0 |

### 3.2.8.3 Example: Creating a Serial Driver InFocus LP850 Projector

When creating a serial driver using the Control4® Driver Wizard in Composer Pro, the driver supports one-way communications.

**Example:** In this example, you create a driver to support the serial-controlled InFocus LP850 Projector.

#### 3.2.8.3.1 Procedure

**To create a new serial driver:**

1. Connect to a Director.
2. Ensure that you have added a Controller to your project (this should be the first device added).
3. To launch the Driver Wizard, from the Driver menu select Create a New Driver.
4. In the Driver Wizard, select the device driver you want to create, and click ok.
5. Fill out the driver information, such as Manufacturer, Model, and Driver Creator name. The date created, date modified, and the copyright information is generated automatically.

For the InFocus LP850 Projector, use the following information:

- Manufacturer: InFocus
- Model: LP850
- Driver Creator: ACME Integrators

6. Indicate how this device is controlled using IR or Serial. **Example:** Serial.
7. Set up the serial settings.
   - **Serial**—Select this radio button if the device you want to create a driver is for serial controlled. The following serial options are specific settings on serial devices.
Composer Pro User Guide

- **Baud Rate**—The number of symbols or characters per second sent over a serial link. Options: 110, 300, 1200, 2400, 4800, 9600 – default, 19200, 38400, 57600, 115200, 230400, 460900, 921600.
- **Data Bits**—Use the drop-down menu to select (5, 6, 7, 8 – default).
- **Flow Control**—The control of the transfer of data to avoid congestion. Options: None - default, Xon/Xoff, Hardware.
- **Stop Bits**—Options: 1-default, 1.5, 2.
- **Parity**—Process for detecting whether bits of data have been altered during transmission of data. A parity bit is appended to an array of bits to make the sum of all the bits always odd or always even for error detection. Options: None – default, Even, Odd, Mark, Space.

8. For the InFocus LP850 Projector, use the following settings:
   - Baud Rate: **19200**
   - Data Bits: 8
   - Flow Control: **None**
   - Stop Bits: 1
   - Parity: **None**

9. Click next.

**Define the Audio Parameters**

10. **Example:** Projectors do not have audio, so do not check anything.

11. Click next.

12. Fill out the device properties for the driver you are creating. Properties are features that vary between the different models of the same device type. For example, some Televisions have discrete power control and some only offer toggle power on/off. You must define in the driver you’re creating the features supported in the model.

13. For the InFocus LP850 Projector driver, check **Discrete Input Selection**.

14. Click next.

**Indicate How the Power Is Handled**

15. For the InFocus LP850 Projector driver, select **Use discrete on/off codes**. For more information about power management options, see “Guidelines for Defining Power Management.”

16. Click next.

**Choose the Appropriate Codes**

17. For the InFocus LP850 Projector driver, de-select the following commands:
   - Cancel
   - Channel Down
   - Channel Up
   - Enter
   - Info
   - Number 0 through 9

18. Click **Add** to enter any custom commands.

19. Add the following options:
20. Enter the serial code for each serial command.
21. Click next to continue through the codes. For information about how to enter serial codes, see "Create a Serial-Controlled Driver."
22. Click Add to identify the Input connections on the device.
23. For the InFocus LP850 Projector, add the following input connections:
   - Video 1 (Input, Line Level)
   - Video 2 (Input, Line Level)
   - Video 3 (Input, Line Level)
   - Computer 1 (Input, Line Level)
   - Computer 2 (Input, Line Level)
   - Computer 3 (Input, Line Level)
24. Click next.

Define the Connection Types for the Inputs and Outputs
25. Define the connection types for Inputs/Outputs for all the inputs/outputs. For the InFocus LP850 Projector driver, define all the previous inputs identified previously.
26. Click next until you have defined all of the inputs and outputs.

Define the Macros
27. Enter any additional serial codes needed to perform the desired action. For Serial Drivers, based on the selections you made in the Device Info section (where you defined Driver capabilities), both Codes and Macros have to have the serial strings entered.
28. Click next.
29. Click next again.
30. Click OK to return to Composer Pro. The driver you created is located in the Search tab in Composer Pro.
31. You have now completed the setup of you driver. Choose the Search tab and the driver type you just created.
32. To check whether your driver is in the Online Database, choose the driver. For the InFocus LP850 Projector driver, select Projector > InFocus LP850.
33. Drag and drop the new driver to the project tree.
34. Make the appropriate video, audio, and control connections or network connections (if appropriate) for the device.
35. Click System Design and double-click the device in the project tree. Use the Device Control window to test the control of the device.

Example: Double-click Projector.
3.2.9 2-Way Serial or TCP/IP-Controlled Driver Using DriverWorks

3.2.9.1 Creating a 2-Way Serial or TCP/IP-Controlled Driver
You can create most serial drivers using the Control4® Driver Wizard in Composer Pro. Instead of capturing the code as you do with IR, you enter the specific serial data that you must send for each command.

Use DriverWorks instead of the Control4 Driver SDK to create 2-way drivers for AV and non-AV devices that are controlled using a serial or TCP/IP connection.

DriverWorks exposes each of the driver APIs previously published through the Control4 Driver SDK (now discontinued). It is an SDK framework that allows 2-way drivers to be written for the Control4 system.

DriverWorks drivers can be written and installed without requiring platform- and version-specific compiling. Using DriverWorks does require some programming skills, but this tool leverages the Lua-embeddable scripting language, which is powerful, fast, and light-weight language (when compared to other scripting languages). DriverWorks comes installed with Release 1.6 and later software releases.

For information on using DriverWorks, refer to the SDK DriverWorks documentation (“Getting Started with DriverWorks”), which is downloadable from the documentation area on the Control4 Dealer Web site: Go to http://www.control4.com/dealer/products/software/ under Software Updates.

3.2.10 Related Tasks
Here are a few other tasks related to using Control4® device drivers in Composer Pro.

“Exporting a Driver in the Project"
“Verifying IR Codes Using the Driver Wizard”

3.2.10.1 Using a New Device Driver in an Existing Project
A new device driver can be added to an on-going project in the Control4® system.

3.2.10.1.1 Procedure
To add a new driver to an existing project:
1. Start Composer.
2. Delete (right-click > Delete) the driver from the existing project.
3. Add the device to the project again.
4. Re-configure any connections (see the Network or Control/AV tabs in the Connections view) and any associated programming.

3.2.10.2 Exporting a Driver in the Project
For all audio/video equipment, you can export a Control4® driver to save or add to other projects. This essentially saves a driver for other uses outside of the current project.
Example: Export the driver you have edited on one Control4 system to another Control4 system, and save it with your company name.

3.2.10.2.1 Procedure

To export a connected driver:

1. Start Composer and connect to a Director.
2. In an existing project and from the project tree, right-click the driver you want to export and select Export Driver. This option is available from System Design, Connections, or Programming.
3. On the dialog that appears, type your company name in the Creator Name box.
4. Click the Search tab to find the saved driver.

3.3 Connecting and Verifying Devices

After you plan and create the project in Composer Pro's System Design for a Control4® system (adding the buildings, rooms, devices, etc.), you are ready to make the necessary connections in the system. Just like you connect cables and wires between your physical devices so they work together, those same connections need to be added virtually in Composer Pro using the Connections view.

These subsections provide information about how to connect the devices to the Control4 system:

"Why You Need Connections"
"Connect and Verify Devices"
"Connecting a Device to the Network"
"Control and Audio Video Connections"
"Room Connections"
"Device Connections"
"Test Device Controls"

3.3.1 Why You Need Connections

The software connections represent either connections between the Controller and its attached devices OR connections among AV devices.

When you identify the connections in Composer Pro, the software connections mirror the hardware connections in the system where appropriate. The system can then control the connected devices and identifies where to route media when it’s available.
These types of connections are used in the Control4 system:

- **Network Connections**—Defines the devices that use a network address. Network connections include IP and ZigBee or ZigBee Pro devices.
- **Control Connections**—Defines the control connection between a device and the Controller. Control connections include contacts, relays, serial, and IR-controlled devices.
- **Audio and Video Connections**—Defines the devices that have audio and/or video signals.
- **Room Connections**—Defines the video, audio, or video/audio end points and the video/audio or audio volume for the selected room.

### 3.3.2 Connect and Verify Devices

In Composer Pro Connections, you can:

- Identify Control4 devices to establish a network connection
- Check all network connections
- Define AV connections
- Define control connections

When only one (1) connection is available in a room for a given connection type, Composer Pro assumes that connection.

**Tip:** To remove any inappropriate connection, right-click the connection, and choose Disconnect.

**Example:** If a TV is the only Audio Output device in a room, the system assumes that the Audio Output connection is routed to the TV. This feature adds value to Composer Pro, but increases the need to verify every connection.

### 3.3.2.1 Procedure

**To connect devices:**

1. Start Composer and connect to a Director.
2. Click Connections.
3. Identify the devices to add their network addresses to the project.

   a. In Connections, click the Network tab > IP Network (default).

   Notice the devices that do not have an address listed in the Address column. These devices need to be identified and connected.
b. Select an unidentified device in the address list, then right-click and choose Identify (or click the Identify button in the list header). A device-specific instruction screen with a graphic of the device displays (such as the Home Controller HC-500).

c. At the physical device, press the Identification button or dial, as indicated on the screen. The button to be pushed on the device flashes on the screen.

d. When the device’s network address displays in the box, click Next to continue, or click Close if you’ve identified the IP network device. Follow these steps for each device.

When you are finished, notice that the Address column is populated with an address for every network device.
Define the Control and AV Connections

4. For each device, define the following when applicable:
   - Video connections (path of video signals)
   - Audio connections (path of audio signals)
   - Control connections (how the Controller communicates with the device)

   a. In Connections, click the Control/AV tab.
   b. Select a device in the Control/AV tab. The Control & Audio Video Connections for the selected device display in the top pane.
   c. Select one of the device’s connections in the top pane. The available connections for the selected connection display in the bottom pane.
   d. To make a connection, drag a device’s input (or output) in the top pane to the output (or input) in the bottom pane.

Example 1: Make Receiver Connections
In the top pane under Audio Video Inputs:

1. Click **INPUT DVD (Video—COMPOSITE)**, and drag it to **DVD (Output—Theater)** in the bottom pane.

2. Click **INPUT VIDEO 1 (Video—COMPOSITE)**, and drag it to **Home Controller HC-500 (Video Out 1—Theater)** in the bottom pane. This connects the Receiver Video 1 input to the Controller Video 1 output.

3. Click **INPUT DVD (Audio—STEREO)**, and drag it to **DVD (Output—Theater)** in the bottom pane.

4. Click **INPUT VIDEO 1 (Audio—STEREO)**, and drag it to **Controller (Stereo 1—Theater)** in the bottom pane.

5. In the top pane under the Control Inputs pane (scroll down), click **IR Sensor (Control—IR_OUT)**, and drag it to **Controller (IR Output 2—Theater)** in the bottom pane.

---

**Example 2: Make Television Connections**

In the top pane under the Audio Video Inputs pane:

1. Click **AV (Video—COMPOSITE)**, and drag it to **Receiver (Output—Theater)** in the bottom pane.

2. Click **AV (Audio—STEREO)**, and drag it to **Receiver (Output—Theater)** in the bottom pane.

3. Under Control Inputs, click **IR Sensor (Control—IR_OUT)**, and drag it to **Controller (IR Output 1—Theater)** in the bottom pane.
3.3.3 Connecting Rooms

Use the Control4® Composer Pro Room Connections to set configuration connection options to customize and optimize audio and AV paths to control devices in a room.

3.3.3.1 Get Room Connections

3.3.3.1.1 Procedure

To get to Room Connections:

1. Start Composer and connect to a Director.
2. Click Connections.
3. Select the room in the project tree.
4. Click the Control/AV tab. The Control & Audio Video Connections pane displays.

If you run Interviewer or set up your system using System Design, room connections use the default settings according to the devices you add.
Example: For a basic system with a Television, DVD player, VCR, and Satellite, Composer Pro by default makes the Television the Video end point which is the end of the AV path for viewing video. The Video Audio End Point is the end of the AV path for listening and managing volume for sound when viewing a DVD, VCR or Satellite.

Example: Video End-Point — Plasma Television displays video for DVD, VCR, and Satellite

Note: For the Control4 system to work properly, verify that the default settings match your physical environment. Define each room connection according to your Control4 system. If the default settings do not match your system setup exactly, change the settings to match the physical environment, and define each room connection according to that system setup.

An End Point defines the software path that an audio or video signal must follow to reach the desired destination.

Example: When a device is selected as a Video End Point, start at the device and work backward to figure out the source-selection and input-switching that must take place to display video.

Note: Speakers are not included in the Control4 project configuration.
A room provides two (2) priority levels for End Points of audio (Audio End Point 1 and 2) and two (2) for audio playing for video (Video Audio End Point 1 and 2). The system automatically connects the first End Point in the room to End Point 1 as the first priority. If that device is part of AV path selected, it manages the volume in the room automatically.

### 3.3.3.2 Room Connection Types

The general types of room connections are:

- **Video End Point**—On the Control4 system, this is the end of the path in the selected room that defines video. The default is the Television.

- **Audio End Point 1 and 2**—On the Control4 system, this is the end of the path in the selected room that defines audio. The default is the first applicable devices added to the system, such as a Speaker Point or Mini Touch Screen. However, when a Television is added, it overrides the initial setting. When a Receiver is added, it overrides the Television.

- **Video Audio End Point**—On the Control4 system, this is the end of the path in the selected room that defines audio when watching video on the Control4 system. The default is the first applicable device added to the system. However, when a Television is added, it overrides the first device. When a Receiver is added, it overrides the Television.

- **Video Volume 1 and 2**—Options that let you set the volume management to a device that is not an Video Audio End Point or a Video Audio End Point.

  **Example**: If you added an AV Switch to your system, the Television is probably the Video Audio End Point, but you want to use the AV Switch for volume control to utilize added features of the Switch.

- **Audio Volume 1 and 2**—Options that let you set the volume management to a device that is not an Audio End Point or an Audio End Point.

  **Example**: If you added an Audio Switch to your system, another device is probably the Audio End Point, but you should use the Audio Switch for volume control.

- **On-Screen Device**—Defines the device (television) that displays the On-Screen Navigator.

- **Temperature and Temperature Control**—Defines the device that manages the temperature in the room, such as a Thermostat.

- **Security System**—Defines the device that manages the security system in the room, such as a Security System.

### 3.3.3.3 Examples of System Configurations

The following examples show possible system configurations: **Video Audio End-Point 1 and 2**—The Plasma Television is Video Audio End-Point 1 and the Receiver is Video.

**Example 1**: **Audio End Point 2**—The Plasma Television manages the volume when the homeowner watches cable, and the Receiver manages the volume when the homeowner watches the DVD or VCR.
**Example 2: Video Audio End-Point 1**—The Receiver is Video Audio End Point 1 and manages the volume in the room when the homeowner watches video using the DVD, VCR, or Cable.

**Example 3: Video End-Point**—Plasma Television switches video for DVD, VCR, and Satellite.

**Example 4: Video Audio End-Point (combined)**—Receiver switches both audio and video for DVD, VCR, and Satellite.

**Example 5: Audio End-Point**—Receiver switches audio for DVD, VCR, and Satellite.
Tip: Understand the physical room connections on your system. The system uses default settings. It cannot auto-detect how your system is set up.

3.3.3.4 Verify Default Room Connections

3.3.3.4.1 Procedure

To verify default room connections including prioritized AV Audio End Point providers:

1. Set up a project either using Interviewer or Composer Pro views. See Composer Pro Getting Started for details.

While you set up the project, room connections are set for you according to default settings automatically. The defaults are set by rules in the system, and they might not match your physical environment. Manually ensure that the settings match your desired outcome.

2. Verify that initial room connections are set up correctly for each room.
   a. From Connections, click the Control/AV tab (default).
   b. Click the room in the project tree.
   c. Verify each connection by ensuring that it mirrors your exact hardware setup.
   d. To change a connection, select a device in the project tree, and then select the device to change in the Control & Audio Video Connections pane.
   e. In the Room Control list, select an item in the upper list, and then drag it to an item in the lower list to connect the two (2) items. When successful, both lists are updated to reflect the connection.

Example: To show how to change a connection from the top center pane, click Video Audio End Point (RoomControl—AUDIO_SELECTION), and drag it to the bottom pane to connect it to Television (Room Selection - Output—Theater).
**Example Project:** Using the sample project, ensure that the following room connections exist as outlined in the table.

<table>
<thead>
<tr>
<th>Room</th>
<th>End Point or Volume</th>
<th>Device (End Point or Volume Management)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theater</td>
<td>Video End Point 1</td>
<td>Television (default setting)</td>
</tr>
<tr>
<td></td>
<td>Audio End Point 2</td>
<td>Receiver (default setting)</td>
</tr>
<tr>
<td></td>
<td>Video Audio End Point 1</td>
<td>Receiver (default setting)</td>
</tr>
<tr>
<td></td>
<td>Video Volume</td>
<td>Not set</td>
</tr>
<tr>
<td></td>
<td>Audio Volume</td>
<td>Not set</td>
</tr>
<tr>
<td>Bedroom</td>
<td>Audio End Point Mini</td>
<td>Mini Touch Screen</td>
</tr>
<tr>
<td></td>
<td>Audio Volume</td>
<td>Mini Touch Screen</td>
</tr>
<tr>
<td>Front</td>
<td>There are no video or audio End Points or any devices that can manage volume in the Front room, so you don’t need to identify the video or audio source or volume control device in that room, or modify the room for room connections.</td>
<td></td>
</tr>
</tbody>
</table>

3. Create a connection to define the other devices in the room where you want volume.
   a. Select a room in the project tree.
   b. In the Room Control list, select an item in the Control & Audio Video Connections, and then drag it to an item in the lower list to connect the two (2) items. When successful, both lists are updated to reflect the connection.

**Example:** From the top center pane, click Video Volume 2 (RoomControl—AUDIO_VOLUME), and drag to the bottom center pane to connect it to Television (Room Selection - Output—Theater).

### 3.3.4 Connecting Devices to the Network

After you complete your planning and design of a Control4® system (adding the buildings, rooms, devices, etc. - see Composer Pro Getting Started for details), you are ready to make the necessary connections in the system.

These sections provide information about connecting your devices to the Control4 system.

- “Connecting Devices to the Network”
- “Connecting and Managing Control and AV Devices”
- “Connecting and Verifying Devices”
- “Connecting Rooms”

#### 3.3.4.1.1 Connecting a Device to the Network

The Control4® Composer Pro Network tab lists all devices in the systems with a network connection and lists network addresses.

Verify the network address for any device that communicates to the Controller using TCP/IP, WiFi, ZigBee, ZigBee Pro or any other device that uses a network address.

---

**Copyright © 2010 Control4. All Rights Reserved.**
3.3.4.1.1 Procedure

To connect network devices:
1. Start Composer and connect to a Director.
2. Click Connections > Network tab.
3. Select the device, and then click Identify for the wizard to open.
4. Follow the on-screen instructions to identify each device as indicated. After identifying the network connection, the device’s address appears.
5. Use the Network tab to identify devices to the Control4 system that use a network address. There are two (2) places to verify network connections: the Network tab and the Tools menu.

3.3.4.1.2 Configuring a WiFi Connection

Use the Control4® Composer Pro System Manager tool to connect to WiFi.

Some devices can be connected directly to Ethernet, and then can be configured on a Navigator. See your device’s installation instructions for details about how to configure wireless on a Navigator page (More > Settings > Network).

3.3.4.1.2.1 Prerequisites

To establish a WiFi network connection to an Home Controller HC-300 or other wireless device in the Control4 system, first establish an Ethernet connection, and then configure a USB WiFi Adapter for Home Controllers (sold separately).

3.3.4.1.2.2 Procedure

To connect to WiFi, complete the following steps:
1. Establish an initial temporary Ethernet connection from the device to the Ethernet network using a Category 5 (CAT5) cable.
2. Plug the USB WiFi Adapter into the USB port on the Controller (if configuring WiFi on a Controller).
3. Start Composer and connect to a Local Director.
4. From the Tools menu, select System Manager.
5. From the Devices pane, select the network address for the device you want to set up, and click Connect.
   - If the device’s network address is not on this list, click Refresh.
   - If it still does not appear, click Add to enter it manually.
   - If you do not know the network address, you can find it at the Connections > Network tab.
6. Click the Network tab, and then click Configure.
7. Click Next when the Network Configuration Wizard dialog appears. Continue through the wizard screens and provide the following information appropriate for your system. Much of this information has to match that of your Wireless Access Point (WAP).
8. Enter the new device name. Do not include spaces in the new name.
9. Indicate the network type: Wireless (WiFi) network.
10. Indicate the method for obtaining DNS server address: DHCP or Static IP. Control4 recommends DHCP (automatically selected).
11. Enter the SSID number.
12. Enter the WEP key (if any).
13. Enter the encryption type (64 or 128).
14. Click on a key type (hex or ascii).
15. Click Finish to complete the wizard; reboot the adapter to apply the network configuration changes.
16. Disconnect the Ethernet CAT5 cable from the Controller.

3.3.4.1.3 **Verifying the Network Connections**

Use the Composer Pro Network tab or Network Tools to verify the Control4® system network connections.

3.3.4.1.3.1 **Prerequisites**

Ensure that the devices to be connected have been added to the project.

3.3.4.1.3.2 **Procedures**

**Network Tab**

To ensure that all network connections are identified on the Network tab:
1. Click Connections > Network tab > IP Network.
2. In the Address column, check whether there is an address for every line item.

**Network Tools Option**

To ensure that all Network connections are connected and active at the Network Tools:
1. From the Tools menu, select Network Tools.
2. Check both the IP Network and Zigbee Network tabs for Green, Yellow, and Red connection icons.
The colors indicate the following:

- **Green**—That an address is identified and the *device* is online. For example, the Dimmer is identified and communicating to the system.

- **Yellow**—That an address is identified and the device is offline. For example, if the System Remote Control goes to sleep, the status turns Yellow. This indicates that the System Remote Control has been identified, but is offline. Make this device active so it can communicate to the system.

- **Red**—That a device is not identified. Go to the Connections view > Network tab and identify the device to the system.

3. If you find Yellow or Red icons, do the following:

   - **Yellow icons**—Go to the device and activate it according to its documentation.
   
   - **Red icons**—Go to the Connections view > Network tab and identify the device to the system.

**Example:** At this point in your project, the System Remote Control should be yellow (or the only device not green). The System Remote Control turns green as soon as you wake it. To wake the System Remote Control, press the red Control4 button.
3.3.4.2 Connecting and Managing Control and AV Devices

Control/AV connections are visible when you select the Control/AV tab in the Control4® Composer Pro Connections view. The Control/AV tab lets you define the physical connections between the Controller or other devices, including AV signals, IRs, Relays, Contacts, and/or serial connections.

Tip: If connections do not appear as needed, edit the driver to create the needed connections as described in “Editing a Driver Using the Driver Wizard.”
3.3.4.2.1 Verifying Control and AV Connections

Use the Control4® Composer Pro Control & Audio Video Connections pane to verify connections, and use the System Design view to verify room connections.

3.3.4.2.1.1 Procedure

To verify all Control and AV connections by checking the connection list:
1. Click Connections, and select the project from the project tree. The Control & Audio Video Connections pane displays.
2. Carefully go through all your Control and AV connections by verifying each connection in the pane.

To verify all Control and AV connections by checking room properties:
1. Start Composer and connect to a Director.
2. Click System Design.
3. Select a room in the project tree.
4. Click the List View tab. On the List View tab check whether your AV devices are accessible in the room. If an AV device is in a room and in your project; but if it is not in the view, see “Connecting and Verifying Devices.”

3.3.4.2.2Disconnecting or Removing Control/AV Connections

Use the Control4® system Composer Pro Connections view to remove and disconnect a connection.

3.3.4.2.2.1 Procedure

To disconnect or remove a Control/AV connection:
1. Start Composer and connect to a Director.
2. Click Connections.
3. Click the Control/AV tab.
4. In the Control/AV project tree, select a device for the device’s control and AV connections to appear.
5. In the Control and AV Connections pane, right-click an input (or output) connection and choose Disconnect.
3.3.4.2.3 Reassigning Control/AV Connections

Use the Control4® Composer Pro Connections view to reassign connections.

3.3.4.2.3.1 Procedure

To re-assign Control/AV connections:
1. Start Compose and connect to a Director.
2. Click Connections > Control/AV tab.
3. In the project tree, select a device. The device’s control and AV connections appear.
4. In the Control and AV Connections pane, drag an input from the top pane to a different output on the bottom pane. The connection is moved to the specified output.
3.3.4.2.4 Updating Connections When a Location Changes

If you use the same project but you change locations, update all of the Control4® system connection information in Composer Pro.

3.3.4.2.4.1 Procedure

To update the connection information in an existing project:

1. Start Composer and connect to a Director.
2. Click Connections.
3. Click the Control/AV tab, and review your connections to ensure they are updated in the current control and AV topology.
4. Click the Network tab. Disconnect all connections by right-clicking and selecting Disconnect.
5. Re-assign each connection.

3.3.5 Testing Device Connections

Use the Control4® Composer Pro Connections view to test that connected devices work.

After you've added and identified the device, in Connections check the Network tab to see if an IP address appears in the IP Network Connections pane. If it doesn't, the device has not been connected properly. Try to connect the device again.

These sections provide more information about testing connections:

“Testing Device Controls”
“Connecting Devices”
"Connecting and Verifying Devices"
"Connecting a Device to the Network"

3.3.5.1 Testing Device Controls
After you add an item to the Control4® Composer Pro project tree and the device is physically connected, test that you can control the device.

3.3.5.1.1 Procedure
To ensure the devices are controllable:
1. Click System Design.
2. In the project tree, double-click the icon of each device for its Device Control window to appear.

   Example: Television

3. Click the available controls in the graphical representation to:
   • Ensure that the commands work
   • Set the parameters temporarily (such as configuring the LED lights on Dimmers)

   Notes:
   1. If you double-click a device and a Device Control window does not appear, it indicates that one is not available for that device or item.
   2. These user interfaces are not specific for each device and model. Understand the capabilities of a device before testing it.

3.3.5.2 Discrete Power Control
   Example: The Samsung TX-P1430 Television does not have discrete power control.

Discrete Power Control means that a device can turn on with the On button and turn off with the Off button. Some devices, like the Samsung television, only offer Toggle Power Control which means you can toggle between On and Off using one button. The control system has to assume that toggle devices are always On, because with a power toggle, the power state cannot be determined with
these models. For the Samsung model, the Television Device Control shows discrete power buttons. These buttons do not apply to devices that do not have discrete power.

**Device Control Examples**

**Note:** The Device Control windows in Composer Pro are provided for testing purposes only. When you make changes on the Device Control windows for each device, it only changes the device settings temporarily. Use the Properties pane or programming to change the device settings permanently.

The following examples show Device Control windows for various devices:

**3 Button Keypad**

![3-Button Keypad](image1)

**6 Button Keypad**

![6-Button Keypad](image2)
Controller

Dimmer

**DVD Player**
Electronic Gate

Gas Fireplace

Motorized Screen
Receiver

Sprinkler System

**System Remote Control, SR-250**
Television

Wireless Thermostat
3.4 Setting Up the Media

To take full advantage of media lookup services by Gracenote®, your customers must be registered in 4Sight. See Composer Pro Getting Started for details.

To add and scan songs and albums for playlists, they must be available in MP3, M4A/AAC, or FLAC format on a PC, Controller, or network share.
You can set up your customer's audio and video media in a Control4® system for:

- Controllers
- Disc Changers
- Media Players
- Dock for iPod
- Television broadcast channels
- Radio broadcast stations
- Satellite broadcast channels or music stations
- Other external storage devices: USB flash drives and shared network drives

You can also

- Add CDs and DVDs
- Add individual songs
- Add cover art, titles, albums, etc.
- Create playlists
- Use the auto-scan feature to scan movies or music
- Add and scan supported files from third-party media managers, for example, iTunes
- Edit media information for DVDs, CDs, etc.
- Test media control

To view and select the media from the Navigators, including Wireless Touch Screens, On-screen, Mini Touch Screen, and System Remote Control devices, you first need to add and scan the media to the Control4 Controller (for example, Home Controller HC-1000).

With the MP3, M4A/AAC, or FLAC files you add and scan, you can create playlists saved to the Control4 Controller's hard drive in the Media Database.

**Note:** Speaker Point does not support M4P/AAC. Play songs through Speaker Point using MP3. However, for example, an HC-300 connected to an amplifier will play MP4/AAC.

**Tip:** The Control4 system must be functioning correctly before performing any of the tasks mentioned in this section. For example, if a Disc Changer does not appear in the project tree and is identified and connected to the system, media cannot be added to it.

### 3.4.1 Overview of Media Management

Media configuration and media management are controlled in the Control4® Composer (Pro, HE, and ME) software. The Primary Home Controller that runs Director always runs Media Manager and the Media Database (SQLite 3.1).

- **Media Database.** Migrating from pre-OS 2.0 to OS 2.0 requires a Media Database conversion and schema changes; consequently, the Media Databases in OS 2.0 are smaller.
- **Media Manager.** All scans are performed by the Media Manager running Director on the Primary Controller. **Note:** Composer Pro configures scanning only, and does not scan the media.
Media Lookup Service. This service now runs either in Composer Pro or Media Manager.

Composer New/Edit - Search. For media metadata lookup when media has not been scanned properly. The information retrieved can be edited and written to the Media Database, and/or the metadata can be written to the tags.

Media Manager. Uses online media lookup. IMPORTANT: Controller registration is required on my.control4.com to use this service for versions later than Release 1.6.

Note: The AMG c4lookup service used in previous releases has been changed to Gracenote®. The Sony 777 Disc Changer uses Gracenote, but the Media Controller can no longer access album, title, or artist information from AMG. CDs, however, can be imported and will show up in the Media database with a date and time stamp.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media player, and Media Monkey to create MP3s. You can still use Composer Pro, Composer ME and Composer HE to add files to Control4.

3.4.1.1 Media Manager

3.4.1.1.1 New Scans
1. Id3 tags are in the file.
2. The title, album and artist names are extracted from the file system folder and filenames.
3. The metadata lookup based on title searches comes from Gracenote®.
4. With OS 2.0, scans are now much faster.
5. Press F5 to refresh after new scans.
6. Scans can be tied to events or button presses, etc.

3.4.1.1.2 Scans Where Content Is in the Media Database
1. Id3 tags are in the file, or you can synchronize the Media Database based on the configuration.
2. If no metadata is in the Media Database, the metadata lookup is based on title searches from Gracenote®.

3.4.1.1.3 Other Media Manager Considerations
- Media Manager scans only one device at a time. If several devices are configured and are in the queue, they will be scanned sequentially.
- Composer Pro does NOT need to be connected when Media Manager is performing a scan.
- Scans can be performed manually in Composer Pro as an event or in an automated schedule.
- If the path becomes disconnected, the metadata will not be deleted.
- If devices are modified, the tags will update.
- If you are using a third-party Media Manager, synchronization will occur if set.

3.4.1.1.4 Media Storage
Audio and video files can be stored on one or more of the following devices:

- **Home Controller disk space.** Home Controllers with disk space can host audio and video content. Note: Dealers must provide their own backup solution or use a NAS with mirror/recovery capabilities.
• **USB-attached storage.** Both audio and video can be stored on these devices, although Control4 does not recommend it due to poor performance.

• **Network-attached storage** (Samba-mounted). Control4 recommends this solution for audio and video files due to better performance and backup/recovery capabilities.

As with previous releases, all media storage devices must be added and configured in the Composer Pro project. Composer Pro does not automatically discover new media storage devices. Also, the storage locations are not available in the Navigators until the device is scanned.

### 3.4.1.1.5 Media Lookup service

- Control4 uses Gracenote® for its lookup services.
- Media lookup is optional. See the Media view in *Composer Pro Getting Started* to disable lookup (set to *Never* in scheduling).
- Media lookup requires that the Home Controller be registered at my.control4.com.

### 3.4.2 Configure Video Scanning of Network File Storage Devices

Use the Control4® Composer Pro System Design view to set up scanning of video devices, such as Disc Changers or Media Players to play video files from network-attached storage. Scanning can occur for devices or extensions.

#### 3.4.2.1 Prerequisites

1. Ensure that the video device is installed as directed in the Control4 Installation and Setup Guide for the device.
2. Ensure that the Network File Storage driver is added to the room in the Composer Pro project.

#### 3.4.2.2 Procedure

To configure video scanning:

1. Start Composer and connect to a Director.
2. Click System Design.
3. In the project tree, select Network File Storage.
4. (Optional) To access the files in the storage, if you have password protection enter your user name, password, and workgroup in the Properties pane. If you do not have password protection, go to Step 6. Click the browse button to locate the path if you don't know it.
5. Click the Search button to locate the storage.
6. Click Connect.
7. Click the **Media** view.

8. In the tree, select **Media Scanning Options** to set up a schedule for scanning. To set up to scan the media now, click **Scan Now** and skip Step 9, and then the Scanning Schedule in Step 10.

9. Set up the scanning schedule and the files to scan.

10. Set the schedule as follows:

    - **Scanning Schedule.** Select one.
      - **Never.** Select if you never want to schedule an automatic scan.
      - **Every x Days or Weeks** (up to 10). Select the frequency to scan.
      - **On the following days.** Select **Sunday** through **Saturday**.
      - **At <time>.** Use the **up** and **down** arrows to select the time. Highlight AM or PM and type the value: AM or PM.

    - **Files To Scan.** Select a device and extension.
• **Network File Storage.** Select if you have a NAS you want to scan.

• **USB Drive.** The manufacturer's USB drive appears here. Select if you have a USB drive you want to scan.

• **Extensions.** Use the up and down arrows to choose the format to add or remove from the list. To add a format if it doesn't appear in the list, use the down arrow to select the extension, select Video, and then click Add. Click Remove to remove that format from the list. **Note:** The list only allows format types that are supported in the Control4 system.

• **Use Online Media Lookup to improve scan results.** Check if you don't want the search to access the Internet for every format lookup, for example, a specific title or cover art. **Tip:** Properly tagged files will result in much faster access.

• **Remove media from the database if the files no longer exist.** Check to remove database information when a media file has been deleted. Be careful, however, because if for example you disconnect a USB drive with media on it, the database files will delete them if checked, and you may not want to delete them if you use the drive again.

• **Update media database if file tags have changed.** Check to have the database updated if the metadata changes.

11. Click **Apply**.
12. Click **Scan Now** to start the scan immediately or **Stop Scan** if you've started the scan and want to stop it.

### 3.4.3 Setting Up Media Auto-Scan

Use the Control4® auto-scan feature in Composer Pro to scan media automatically. This section applies to Disc Changers, Media Players, network-attached storage, and USB drives.

**Note:** Composer Pro does not need to be open to scan media. This lets you use other media managers (iTunes, Windows Media Player, etc.). Also, scheduled scans can run automatically or be started through programming.

#### 3.4.3.1 Prerequisites

1. Ensure that the video device is installed as directed in the Control4 Installation and Setup Guide for the device.
2. Ensure that the Network File Storage driver is added to the room in the Composer Pro project.

#### 3.4.3.2 Media Player

**Note:** The Media Player uses the Network File Storage option in the Media view. Anytime you add new content, scan the files.

For information about scanning files for the Media Player, see the Media Player Installation and Setup Guide, Media Player User Guide, or the Documentation tab in the Media Player's Properties pane.

#### 3.4.3.3 Disc Changer

This section applies to a Sony CX777ES Disc Changer. The benefits of running a Disc Changer with bidirectional communications (RS-232), such as the Sony CX777ES, is that you can scan your DVDs/CDs stored in the Disc Changer to identify and index media, and automatically apply cover art and information about the media.
You can configure your system in Composer Pro to scan media on the associated Disc Changer either automatically or manually when the **Auto Scan** option is selected in the System Design Properties pane for the Disc Changer. The default is to scan media manually (Auto Scan: Off).

When the Auto Scan Enabled option is checked on the Disc Changer Properties page, the Auto Scan feature automatically detects when a disc is added to an empty slot or when a disc is removed. The Navigators are automatically updated with the change. The Auto-scan feature does not detect when a disc is replaced or swapped.

**Note:** If a DVD/CD is scanned and the media is not recognized, it is titled 'unknown.' You can edit the information about the DVD/CD, and manually provide this information from either Composer Pro or the Navigators. If this DVD/CD is then moved to a different slot, the system applies this same information.

### 3.4.3.3.1 Procedure

**To auto-scan added media to a Disc Changer:**

1. Start Composer and connect to a **Director**.
2. Click **System Design**.
3. In the **project tree**, select the device, for example, **Disc Changer** with a serial **connection** (RS-232) to the **Controller**, for example, the Sony CX 777ES Disc Changer.
4. In the device's Properties pane, ensure that the **Auto Scan Enabled** option is checked.
5. Open the Disc Changer drive, and **add** or **remove** the DVD/CD.
6. Close the drive to begin the auto-scan. The information for the added DVD/CD is automatically made available on the Navigators. See also “Setting Up Media Stored on a Disc Changer.”

### 3.4.4 Setting Up Media Stored on a Controller

If you set up media on a Control4® **Controller** with storage space for that media, the Controller has a built-in Digital Audio Player. Digital Audio is the segment of the Controller that provides the digital audio streaming. Each source **device** that can provide an audio stream, whether it is a **CD changer**...
plugged into the analog inputs on a Control4 Speaker Point® or a Control4 Controller, it can provide audio to the Digital Audio servers. Each must have a connection to the Digital Audio components. When configuring these types of connections in the Composer Pro Connections view, there is always an open connection to the Digital Audio components for each Digital Audio Server or Digital Audio client. You can see many connections to the Digital Audio components depending on the hardware configured in the project.

3.4.4.1 Prerequisites

1. Ensure that a Controller is added to your project and identified to the network.
2. Ensure that your Controller has storage space for media.

3.4.4.2 Procedure

To add and scan available media on a Controller:

1. Start Composer and connect to a Director.
2. Click System Design.
3. Click Connections.
4. In the Network tab, ensure that the Controller has an address. If it does not, you must go back and identify the Controller to the network.
5. Click Media.
6. Select the Controller with the media you want to add, and click Add.

Tip: If a dialog box displays and states that you cannot add the media, make sure you identify the Controller in the Connections view > Network tab.

7. Browse to the directory of music files to be added to the Controller.
   After you add the files, the scan automatically starts. After a few moments, the media is scanned, and a list of albums appears. You may see the On-screen Navigator update during this process.
Tip: Another way to add files from a network share to a Controller is to go to the Windows Start menu, and select Run. Type //<Controller's IP Address>/media/audio/music/<Artists>/<Albums> and copy the files there.

8. From the File menu, choose Refresh Navigators to make the new media is accessible through the Navigators in the Control4 system.

3.4.5 Setting Up Media Stored on a Disc Changer

Use the Control4® Composer Pro Media view to add and scan media according to the options available on your Disc Changer. Adding and scanning DVDs and CDs loaded in the Disc Changer populates the media information in the Media Database. This permits users to view the media from their Navigators.

This section covers how to:
- Add media to a Disc Changer
- Scan media in a Disc Changer

3.4.5.1 Prerequisites

1. The system must be registered at my.control4.com, and registration must be complete before using the online Media Services. To register the system, see 'Registering the System' (Composer Pro Getting Started).

2. Ensure that a Controller is added to the project tree and identified to the network.

3. Ensure that a Disc Changer is added to the project tree and identified to the network.

3.4.5.2 Procedure

To add media to a Disc Changer:

1. Start Composer and connect to a Director.
2. Click Media.
3. Select Disc Changer in the Media project tree. If any of the following options are available for the selected Disc Changer, the buttons will be active (not grayed out):

**Scan**—Lets you scan all media located on the Disc Changer to add to the Media Database (recommended if available).

**Note**: Because media scanning has been moved to the background, the scanning status is only available through Director status messages. To do this, you can either watch the Director status line or re-select the media to view the content that has been scanned.

**Search**—Lets you search for media titles located on the Disc Changer to scan and add them to the Media Database.

**Edit**—Lets you edit your entries (artist, album, title, etc.).

**New DVD or New CD**—Lets you add new DVDs and CDs to the Media Database.

4. Always use **File > Refresh Navigators** to make the new media accessible through the Navigators in the Control4 system.

**Note**: Control4 has not implemented a UI for browsing CDs stored in a Disc Changer. Use a Legacy Navigator (prior to OS 2.0) that supports this functionality if this is important.

The following sections describe how to add media to the Media Database using the options listed above.

### 3.4.5.3 Scanning Media in a Disc Changer

**To scan media loaded in a Disc Changer to add it to the Media Database:**

1. Click **Connections**.
2. Ensure the Disc Changer is connected to a serial port on the Controller.

**Example**: From the Control/AV tab, select **Sony CX777ES DISC Changer**; ensure that the **Serial RS-232** is connected to the correct serial port (1 or 2).

3. From the **Network** tab, ensure that the Controller has an address.
4. Click **Media**.
5. Select **Disc Changer**.
6. In the Disc Changer pane, click **Scan > OK to Scan all**.
Note: If the following error message displays, "Your system has not been registered on my.control4.com," you can click Yes to continue scanning music without registering, but the music scans based only on the current metadata stored in the music files. You will need to enter any missing information manually for each disc.

Example: If no cover art is found in the file's metadata, then no cover art is associated with the music unless the system is registered in 4Sight, and you can go to the online media lookup (Media view > Edit > Name > Search > Select > Next) to obtain the cover art for the music. See "Registering the System in Composer" in Composer Pro Getting Started for instructions.

3.4.5.4 Automatically Scan Media

The following steps use the Sony CX777ES Disc Changer as an example.

To auto-scan added media:
1. From the project tree, click the Sony CX 777ES Disc Changer. The device Properties pane appears for this device.
2. Ensure that the Auto Scan Enabled box is checked.

When you select the Auto Scan Enabled option from the device's Properties page in Composer Pro, an automatic scan of the disc(s) is available if you add a new disc to an empty slot, or if a disc is removed. In those cases, the Disc Changer automatically recognizes the change, and the Navigators automatically update the changes. The Disc Changer recognizes the changes in its slot when its door closes to perform the auto-scan. The Auto-scan feature does not detect when a disc is replaced or swapped.

Note: Control4 recommends that you check the Ignore Unexpected Play, Stop, or Pause option. This option should be checked if you are configuring a system with lighting, for example, when the movie starts playing, and the lights in the room dim. Normally, you can use the Play, Stop and Pause functions on the Disc Changer during the course of a movie being played. By checking the option, these functions are ignored by the system.
3. Open the Disc Changer drive's bay, and change the existing DVD or CD.
4. Close the bay.
5. The auto-scan begins automatically when the Disc Changer door closes, and the information for the new DVD or CD is available in the Navigators.

3.4.5.5 Searching Media in a Disc Changer

To search media loaded in the Disc Changer to add it to the Media Database:

1. Click Media.
2. Select the Controller in the project tree.
3. In the Disc Changer pane, click Search.
4. Type the DVD name in the blank box. The possible DVD titles from the Web database appear in the Search Results window. Use the scrollbar to find the appropriate DVD title.

**Example:** “A Beautiful Mind”
Select the appropriate DVD title, drag it over the empty line item, and then select it again.
5. Repeat the previous steps for each of the DVDs/CDs in the Disc Changer you want to add to the Media Database.
6. Click Finished.

3.4.5.6 Edit CD or DVD Information

To edit a scanned DVD or CD:
1. Select the CD or DVD to edit.
2. Click Edit.
3. Change the Title, Director or Artist, Album or Movie, Studio, Genre, etc. You can also change the location, locate the cover art (Find Art File), and so on.
4. Click OK.
3.4.5.7 Adding a DVD or CD

To add a DVD or CD:
1. Click Media.
2. Select Disc Changer in the Media pane.
4. Click either New DVD or New CD as appropriate. The New Movie or New Album dialog appears.
5. In the Title box, enter the DVD you want to play.

   Example: "A Beautiful Mind"

6. Click Search.

![New Movie dialog](image)

7. When the Search dialog appears, use the scrollbar to find the appropriate cover art, and select it.
8. Change the search criteria, and search again if needed. The possible matches from the Web database appear in the Search Results window.
9. Click Next.
10. (Optional) Customize the DVD/CD information before adding it to the Media Database by editing the text in the box.
11. Click **Finished**.
12. Click **OK**.

### 3.4.6 Setting Up Videos for a Media Player

Use the Control4® Composer Pro **Media** view to identify the videos that you want the Media Player to play.

#### 3.4.6.1 Prerequisites/Procedure

1. Ensure that the Media Player is installed and added to Composer Pro as directed in the *Control4 Media Player Installation and Setup Guide* and *Control4 Media Player User Guide*.
2. Ensure that the network-attached storage contains the videos that will play on the Media Player, and that the NAS is added to your Composer Pro project.

### 3.4.7 Setting Up Media for Radio Stations

Use the Control4® Composer Pro **Media** view to set up radio stations for a Control4 system.

#### 3.4.7.1 Procedure

To set up media for Radio Broadcast Stations:

1. Start **Composer** and connect to a **Director**.
2. Click **Media**.
3. Select the broadcast media type (UHF/VHF, Satellite, Cable, etc.).
4. Click **Search**. When the dialog appears, type the zip code of where the Control4 system is located in the box.
5. Click **Search**, and use the pull-down menu to select **Local Broadcast Listings**. The available channels are populated in the Search Results window.
6. Check the individual boxes of channels that you want to make available in the Navigators; or click **Choose All**, and then click **OK**.
The selected channels populate the media source channel list (such as the UHF/VHF channel list shown next).

7. Repeat the previous steps for each additional media source, such as Cable, Satellite, XM Radio, AM Radio, or FM Radio. (Each of these services must be set up separately.)

3.4.8 Setting Up Media for Television Stations

Use the Control4® Composer Pro Media view to set up television channels for the Control4 system.

3.4.8.1 Procedure

To set up media for television broadcast channels:
1. Start Composer and connect to a Director.
2. Click Media.
3. Select the broadcast media type (UHF/VHF, Satellite, Cable, etc.).
4. Click **Search**. When the dialog appears, type the zipcode for the Control4 system's location in the box.

5. Click **Search**, and use the pull-down menu to select **Local Broadcast Listings**. The available channels are populated in the Search Results window.

6. Check the individual boxes of channels that you want to make available in the Navigators; or click **Choose All**, and then click **OK**.

![Search dialog](image)

The selected channels populate the media source channel list (such as the UHF/VHF channel list shown next).

![Media source channel list](image)

7. Repeat the previous steps for each additional media source, such as Cable, Satellite, XM Radio, AM Radio, or FM Radio. (Each of these services must be set up separately.)
3.4.9 Importing a DVD List from a File

Use the Control4® Composer Pro Media view to populate DVD metadata stored on a Disc Changer.

3.4.9.1 Prerequisites

Ensure that the Disc Changer is installed as directed in the Control4 Disc Changer Installation Guide.

3.4.9.2 Procedure

To import a DVD list:
1. Start Composer and connect to a Director.
2. Click Media view.
3. Right-click on the Disc Changer, and select Import DVD List from File. Composer Pro automatically populates the slots of the Disc Changer with the DVDs stored in each slot as listed in the file that is imported.

The imported file must be a CSV (comma-separated value) file listing the slots and the titles of the DVDs, one per line. You can create this file using a simple text editor or spreadsheet program by exporting a spreadsheet file in a CSV formatted file. This new feature provides a simple and easy way to quickly configure all of the DVDs in any manufacturer’s Disc Changer.

Example formatting for CSV file:
1, Toy Story
2, The Incredibles
3, The Perfect Storm

3.4.10 Using External Storage Devices

You can access digital music from an external storage device in your Control4® system. External storage devices include USB flash drives, USB external hard drives, or a shared network storage area (for example, a computer’s hard drive).

The following applies when setting up an external storage device:
- USB flash drives or USB external hard drives must be formatted as FAT32 devices.
- Shared drives on a Windows system cannot contain a space in the directory/pathname.

Set up the external storage device or networked file storage as described in this section.

Note: When you disconnect the external drive (USB, network, etc.) from the system, the music is no longer available. Reconnecting the external drive makes the media available again.
3.4.10.1 Procedures

3.4.10.1.1 Attach and Scan External Storage Devices

To attach and scan external storage devices using a USB connection:

- **Note:** External storage devices must have media stored in unprotected MP3 format.

1. Power up the external storage device.
2. As appropriate, use the documentation provided with your Control4 Controller to attach the external hard drive using the USB port.
3. Start Composer and connect to a Director.
4. Click Media.
5. In the project tree, select the external device.
6. Click Scan in the device's pane.

You can add media from the external storage device when it is connected to the Controller. However, it is recommended that you connect your external drive directly to the PC where you want to copy the media. When scanning, the media appears on the device.

3.4.10.1.2 Access and Scan Network Storage Devices

To access and scan network storage devices:

- **Note:** The network location must be an open share location (no password required).

1. As appropriate, use the documentation provided with your operating system to create a shared network drive.

   **Example:** Using Windows XP to make a local C:/ Drive directory available on the network, right-click the folder and select Sharing and Security. Click the Share this folder button.

2. Click System Design.
3. From the My Drivers tab, double-click Network File Storage to add it to the project tree.
4. Highlight Network File Storage in the project tree, and configure the username, password, and workgroup (or domain) for the network file share, and then browse to its network location.
This information varies between types. Contact your System Administrator or Control4 Technical Support if you need help with this information.

5. Click **Media**.


7. To add or scan audio files, in the Media list select **Audio Media**, and then click **New** or **Scan**.

**Notes:**
1. When adding music to Network File Storage from the desktop, the music folder must reside in **My Network Places** so components can access the music files. A mapped network drive is not applicable in this situation.
2. Audio files must be in one of the following formats to be scanned and played by the Control4 system: MP3 or FLAC. If you connect an iPod or another audio device, the Control4 system can play back the files supported on that device; but only MP3 files can be decoded.

8. To scan Video files, in the Media list select Video Media, and then click Scan.

Notes:
1. Video files must be in one of the following formats to be scanned by the Control4 system: .avi, DVD, .iso, .m4a, mpeg, .mpg, or .wmv. These video files can only be played using a Media Player device.

2. Video is not supported from a USB drive, so the Video Media option is not displayed in the list under a USB drive.

3.4.11 Adding an Audio or Audio/Video Switch

Use Control4® Composer Pro to add audio or audio and video switches to a Control4 system.

3.4.11.1 Prerequisites
Set up the audio or audio/video switch and any associated hardware to the Control4 system.

3.4.11.2 Procedure
To add an Audio Switch or Audio/Video Switch:
1. Start Composer and connect to a Director.
2. Click System Design.
3. In System Design, from the Search tab add the audio switch or audio/video switch to your project.
4. Using the Local or Online Database, choose the device type: Audio Switch or AV Switch, and choose All manufacturers.

Example: To add the applicable Knox AV switch (RS-232) driver, use the Search tab, and choose the Device Type: AV Switch > Manufacturer: All manufacturers.

5. When the AV Switch object is added to the project tree, select the object to view the device properties and change the configuration if applicable.

Example: The Knox AV Switch has no properties to modify, but other switches have properties, such as the Control4 Audio Switch.

6. Connect the network or control/AV devices as necessary for your configuration.
7. Modify any room connections as needed for your configuration.
3.4.12 Creating a Playlist

Use Control4® Composer Pro to create a playlist from streaming media, such as Rhapsody®.

You can create playlists from the Touch Screens or On-Screen Navigators also. See the Control4 System User Guide for details.

3.4.12.1 Procedure

To create a playlist:
1. Start Composer and connect to a Director.
2. Click Media.
3. In the Media view, go to the Media menu, and choose New Playlist.
4. Name the playlist.

Tip: You can rename it any time by right-clicking the playlist, selecting Rename Playlist, and then typing a new name.

5. Select the Controller or other media on which the songs are stored, and ensure that you have scanned the media from the storage to make the media known to the Controller.
6. Drag the list of songs to the playlist.

These playlists are designed exclusively for streaming media in Digital Audio. If the customer subscribes to the Rhapsody Music Service, then Rhapsody playlists can be created using a Navigator (see the Control4 System User Guide for details). In OS 2.0 and later, playlists can include CDs/DVDs, broadcast channels or stations, but they are a separate playlist from those in Rhapsody.

Note: To set up a Rhapsody subscription on behalf of the user or yourself, obtain a Rhapsody account at http://www.control4.com/rhapsody, and then refer to the information about Rhapsody in the Control4 System User Guide.

7. Drag every album or song you want to add to the playlist onto the playlist name.
8. After adding at least one (1) album or song, select the playlist to view the contents.

9. (Optional) Remove songs:
   - To remove a song, right-click and choose **Delete**.
   - To remove multiple songs, press and hold the **Shift** key. Select the songs, right-click anywhere in the selected list, and choose **Delete**.

The playlist can now be played from or edited in the Navigators.
3.4.13 Testing the Media Connection

To test control of media through the Control4® Navigators (**System Remote** Control, On-Screen **Navigator**, **LCD** Navigator, or any of the other Navigators or Touch Screens), use the steps outlined in the **Control4 System User Guide**.

Suggested test items:
- Play an album
- Add an album or track to the Now Playing queue
- Play a playlist created in **Composer Pro**
- Create a playlist on a Touch Screen or On-Screen Navigator
- Play multiple streams of music (play different music in different rooms)
- Play a movie on the television

3.4.14 Editing Media Information

Use the Control4® **Composer Pro** Media view to edit the media information for 'unknown' DVDs or CDs. You can edit the media information in the Navigators: On-Screen **Navigator**, **Touch Screen**, or Mini Touch Screen.

3.4.14.1 Editing CD Information

Use the Control4® **Composer Pro** Media view to edit CD album names, artists, genre, or cover art for a Control4 system.

3.4.14.1.1 Procedure

To edit information about a CD:

1. Start **Composer** and connect to a **Director**.
2. Click **Media**.
3. In the **project tree**, double-click the **CD storage device** on which you want to edit CD information; for example, CD, Disc Changer, or **Controller**.
4. Select an album and click the **Edit** button, or double-click the **album title**.
5. In the Album tab, edit the Album Name, Artist, Label, Genre, or Art. Make text changes as applicable.

6. Click OK, or use the additional features outlined below.
7. Search on a **Name** or **Artist** to search the database for similar entries.
8. Select a search result. Double-click to select an album title, and click **Next**.

9. View or edit the information about the album: Name, Artist/Composer, Label, Genre, Year, Art, and Notes.

10. Change the information as needed, and then click **Finished** to save your changes.
11. Choose the **Track** tab, and edit or remove tracks as needed.
12. Choose the **Notes** tab, and edit as needed for future reference.

### 3.4.14.2 Editing DVD Information

Use the Control4® Composer Pro Media view to edit **DVD** title, **director**, studio, genre, runtime, release date or rating in a Control4 system.

**Tip**: New in OS 2.0 and later, you can edit DVD and video titles on the Touch Screens and On-Screen Navigators.

#### 3.4.14.2.1 Procedure

To edit information about a DVD:

1. Start **Composer** and connect to a **Director**.
2. Click **Media**.
3. In the **project tree**, double-click the **Disc Changer** or **DVD**.
4. Select a movie and click the **Edit** button, or double-click under **Discs**.
5. In the Movie dialog under the Movie tab, edit the DVD title, director, studio, genre, runtime, release date or rating information as needed.
6. Click OK, or use the additional features outlined below.

7. Click Search to present similar entries.
8. In the results list, double-click a DVD.
9. Edit the DVD information.

10. Replace the cover art using one of the options provided.
11. Click the Cast and Synopsis tab to edit text displays as needed.
12. Click Finished to save your changes.

3.5 Programming the System

Use the Control4® Composer Pro Programming view to program the Control4 system. This section assumes that you have a general understanding about how to use Composer Pro to add and identify devices, and that you are now familiar with the Composer Pro interface. If not, read “The Basics” sections or refer to Composer Pro Getting Started.

These sections provide information about how to program a Control4 system:

“Programming Basics”
“Programming with Commands”
“Programming with Conditionals”
“Programming Using Digital Audio and Rooms”
“Programming with a While Statement”
“Programming with Variables”
“Program with Bookmarks”
“Programming with Agents”
3.5.1 Programming Basics for Control4 Systems

Use the Control4® Composer Pro Programming view to program events and other actions that affect Control4 system devices.

Tip: A useful tool is available in OS 2.0 that can help you keep track of your programming scripts. The tool is called Programming Detective, and you can find it at: http://downloads.control4.com/updates/PD/SelfExtract/ProgrammingDetective.exe.

3.5.1.1 Procedure

To get to the Programming view:

1. Start Composer and connect to a Director.
2. Click Programming. In the Programming view, you can perform basic programming task.

Programming is based on events. When an event is triggered, other actions can take place.

Example: If you program to lower the projector screen in the Theater by pressing a Keypad button. You can program the Receiver, DVD player, and projector to power up and start playing a DVD also. Programming the system is where the true value of Composer Pro becomes a reality.

To program the system using Composer Pro, you drag and drop Events and Actions that you create for corresponding devices to a programming Script pane. The sections below show these panes.
Events (Programming Pane)
Select the event (left side of the window):
Actions (Actions Pane)
Select the action(s) (right side of the window):

Script (Script Pane)
Drag the Events and Actions commands to the Script pane (middle pane):

The next table describes Events, Actions, and the Script.
## Programming Item

### Events

All programming begins with events. An event is a “when” statement. An event is the trigger that something happened that results in an automation. Events happen instantaneously. On a Keypad, pushing a button is one event. Actions all occur under Events. Examples of events include:

- When the door opens
- When it is 7:00 AM
- When it is sunrise

### Actions

After the event identifies to the system that something occurred, it sends actions. The following are the methods that are used by the system to define actions:

- **Commands.** The Commands tab displays all available commands for a selected item in the Action Device Tree. A *command* is a “do” statement. Commands are actions the Director tells the device to do. Examples of commands include:
  - Light: on, off
  - VCR device: play, stop, pause
  - CD Changer device: go to disk
  - Security device: arm, disarm
  - TV device: Power on/off, change channel

- **Conditionals.** The Conditionals tab displays all available conditionals for a selected item in the Action Device tree. A *conditional* is an “if” statement. An “if” statement asks a true/false question to the device. Examples of conditionals include:
  - If door is open
  - If after 5 PM
  - If light is greater than 50 percent

- **Loops.** The Loops tab displays all available loops for a selected item in the Action Device tree. A *loop* is another type of conditional. A conditional loop is a “while” statement. It is something that is ongoing. Examples of conditional loops:
  - While the sprinklers are on
  - While the motion detector detects movement
  - While a doorbell *switch* is being pressed

- **Delays.** A delay stalls a program from running to ensure actions that occur at the right time.

### Script

The linking of events and actions is defined in the script.
**Tip:** To configure or program devices, you can use properties, agents and variables also. These are considered advanced configuration and programming tasks. See “Programming with Agents” or “Programming with Variables.”

3.5.1.2 **Programming Elements**

Basic programming consists of two (2) parts:

1. Define a device’s events that trigger actions.
2. Define a device’s actions to trigger when an event fires.

The following steps introduce the basic programming flow and script creation:

1. Define the device’s event (Events pane) and select the event.

2. Define the device’s actions (Actions pane): commands, conditionals, or loops.

3. Drag the actions to the script (Script pane).
4. In the Script pane, click **Execute**.

**Note:** Programming can make use of agents also, where you can include pre-programmed system functionality, such as scheduling, delays, or setting up Lighting Scenes. **Example:** To program around sunrise and sunset, use the Scheduler agent.

See “Programming with Agents” for more information about using agents in programming.

See the next section or *Composer Pro Getting Started* for example programs you can create.
3.5.2 Programming with Commands

A Command for a Control4® system is a “do” statement. Commands are actions that tell a device what to do.

**Example:** The example in this section shows you how to program a 3-Button Keypad to turn on the sprinkler system using Relay 2 for control.

3.5.2.1 Procedure

To program a 3-Button Keypad to toggle sprinklers on and off:

1. Start Composer and connect to a Director.
2. Click System Design.
3. The following devices need to be added and identified in the project:
   - Controller
   - 3 Button Keypad
   - Sprinklers
4. Click Connections.
5. Make sure the sprinklers are connected to the correct Relay port.
   a. Click the Control/AV tab.
   b. Select Sprinkler System from the project tree.
   c. In the Control & Audio Video Connections pane, ensure Sprinklers is connected to Relay 2.
6. Click the Network tab.
7. From the Network tab, ensure that the Controller and 3-Button Keypad have an address in the IP Network Connections pane.
8. Click Programming.
9. In the Device Events pane project tree, select 3-Button Keypad.
10. In the 3-Button Keypad Events pane, click the button that you want to program—Button 1 (default). This automatically identifies the Press event for programming Button 1 on the Keypad. The event appears at the top of the Script pane.
11. In the Actions pane, click Sprinkler System.
12. Click the Commands tab, and select Toggle the Sprinkler System. The command you chose is displayed in the Sprinkler System Actions pane with a green arrow. 
   **Note:** The title of this pane varies depending on the device you choose.
13. Click the green arrow, and drag it to the Script pane (center pane).

14. Click **Execute** in the Script pane to turn on the sprinklers.
15. Click **Execute** again to turn off the sprinklers.
3.5.2.2 Programming with Delay, Stop and Break Commands

Control4® Composer Pro programming provides a Delay command in response to an event that waits for a specified amount of time before executing the next command in a code sequence. See “Programming with a While Statement” for one example; another example is listed below.

When programming a device, you always have the following options:

- **Delay**—Lets you delay an action from taking place (available in previous versions).
- **Stop**—Lets you stop all programming.
- **Break**—Lets you break out of a ‘While’ or loop or ‘If’ statement when a specified condition is met and returns to the programming outside of the loop.

**Note**: Break commands do not break out of a conditional. See “Programming with Conditionals” for details.

3.5.2.2.1 Delay Command

To use the Delay command during programming, see this example using a Motorized Screen and a DVD player:

1. Start Composer and connect to a Director.
2. Click Programming.
3. Select the Motorized Screen in the project tree.
4. Select the event When the Motorized Screen is put down. Notice the string that appears in the Script pane.

Results: The Top Button of the 3-Button Keypad now toggles the Sprinklers on and off.
5. To use the Delay command, in the Device Actions pane click **Programming Control**. Scroll to the bottom of the tree to find it.

6. In the Programming Control Actions pane, click the **Commands** tab.

7. Select **Delay** and type 5, then use the drop-down menu and select **seconds** (default).

8. Drag the **green arrow** Delay command to the Script pane. This ensures that there is a five-second delay after the projector powers up.

9. Scroll up and select **DVD** in the project tree.

10. Click the **Commands** tab, and click **Power > On**.

11. Drag the **green arrow** ‘Turn on the <room’s> DVD’ to the Script pane.
3.5.2.2.2  Stop Command

To use the Stop command during programming, see this example using a Motorized Screen and a DVD player:

1. In the DVD Events pane, select the DVD and click Power On. ‘When <room>-> DVD Turns On’ appears at the top of the Script pane. This assumes that the device is on before turning it off and using the Stop command.
2. Go to the Device Actions pane, and click Programming Control.
3. Click the Commands tab, and select Delay and 5 seconds (default).
4. In the Programming Control Actions pane, click the green arrow ‘delay 5 seconds,’ and drag it to the Script pane.
5. Click the DVD in the Device Actions pane project tree.
6. In the DVD Actions pane, click the Conditionals tab, and then click On.
7. Click the blue question mark next to ‘If the <room’s->DVD is On,’ and drag it to the Script pane.
8. Click the Commands tab, and click Off.
9. Drag the green arrow ‘Turn Off the <room’s>- DVD’ over the blue question mark in the Script pane to nest it below ‘If the <room’s>-DVD is On.’
10. Click Programming Control, and click the Commands tab.
11. Click Stop, and drag the green arrow ‘Stop’ over the blue question mark in the Script pane to nest it below ‘Turn off the <room’s>-DVD.’
12. Add other conditionals and commands as desired. In this case, the conditional ‘If the <room’s>- >Motorized Screen is down’ and nested command ‘Put the <room’s>-Motorized Screen up’ are added, along with another conditional and command.
13. In the Device Actions pane, click Motorized Screen in the project tree, and click the Conditionals tab.
14. Select the Motorized Screen is down, and then drag the blue question mark ‘If the <room’s>- >Motorized Screen is down’ to the Script pane.
15. Click the Commands tab, and select Put the <room’s>-Motorized Screen up.
16. Drag the green arrow ‘Put the <room’s>-Motorized Screen up’ on top of the blue question mark ‘If the <room’s>-Motorized Screen is down’.
3.5.2.2.3 Break Command

Here are some rules about using the Break command (see example script below).

1. A break in a 'While' loop jumps to the first statement after the While statement.
2. A break in an 'If' statement (nested in a 'While' statement) jumps to the first statement after the 'If.'
3. A break not in a 'While' or an 'If' statement should behave like a Stop command (jumps to the first statement after the function).

Note the 'Break' command in the statement below. If the 'While' statement above the 'Break' command (in an 'If' statement) is met (True), then the program continues to the next 'While' statement. Otherwise it skips to the next command (green arrow) statements at the bottom of the script.
See “Programming with a While Statement” or “Programming with Conditionals” for details.

3.5.2.3 Programming with a While Statement

A ‘While’ statement runs continuously in a loop until the evaluation is shown to be False (Boolean value). While statements can be repeating ‘if’ statements also.

3.5.2.3.1 Procedure

To program a While statement, follow this example:

1. Start Composer and connect to a Director.
2. Click System Design.
3. Ensure that you have the following devices in your project:
   - Controller
   - Door Contact Sensor
   - Theater Dimmers
4. Click Connections.
5. Make sure the devices are connected to the correct Relay port.
6. Click the Control/AV tab. Select Door Contact Sensor in the project tree, and ensure it is connected to Contact Sensor in the Control & Audio Video Connections pane.
7. Click the Network tab, and ensure that the Controller and Bedroom Dimmer have an address.
8. Click Programming.
9. Before programming the ‘While’ statement, program a way to turn off the ‘While’ statement by doing the following (when the door closes, the Bedroom Dimmer turns off):
   a. Click Programming, and choose Door Contact Sensor to trigger an event in the Door Contact Sensor Events pane.
   b. Choose the When the Door Contact Sensor closes event. The selected event appears at the top of the Script pane.
   c. In the Actions pane, select Theater Dimmer.
d. Click the **Commands** tab below, and choose **Off**. The action appears in the right middle Actions pane.

e. Drag the **green arrow** to the **Script** pane. This turns off a blinking light when the door closes.

10. Program the While statement (when the Door opens, and while it is open, turn the Theater Dimmer on):

   a. In the **project tree**, select **Door Contact Sensor** to trigger an event.

   b. Choose the **When the Door Contact Sensor opens** event. The event appears at the top of the Script pane.

   c. In the Actions pane, select **Door Contact Sensor** to trigger an action.

   d. Click the **Loops** tab, and select the While Loop option: **the Door Contact Sensor is Open**.
The While loop While the Living Room > Door Contact Sensor is open appears in the Actions pane next to a red circle arrow.

e. Drag the red circle arrow to the Script pane.

![Diagram of Composer Pro interface]

f. In the Actions pane, select Theater Dimmer.

g. Click the Commands tab, and choose On.

h. Drag the green arrow icon Turn on the Theater > Theater Dimmer on top of the red circle arrow icon in the Script pane to nest it under the loop statement.

![Diagram of Composer Pro interface with actions and delays]

i. Delay the action 5 seconds. In the Actions pane, scroll down to choose the Programming Control Delay agent.

j. Click the Commands tab, and set the Delay time to 5 seconds.
k. Drag the **green arrow** on top of the **red circle arrow** in the Script pane to place the delay action below the previous action.

l. Turn the **Theater Dimmer** off. In the Actions pane, select **Theater Dimmer** again.

m. Click the **Commands** tab, and choose the **Off** command.

n. Drag the **green arrow** icon on top of the **red circle arrow** icon in the Script pane to place the command below the previous action.

o. Delay 5 seconds. In the Actions pane, scroll down to **Programming Control** to choose the Delay agent.

p. Click the **Commands** tab, and set the **Delay** time to **5 seconds**.

q. Drag the **green arrow** icon on top of the **red circle arrow** icon in the Script pane to place the command below the previous command.
r. Test the While statement by opening the actual door. The light should blink on and off while the door is open.
s. Close the door. The light should turn off when the door is closed.
t. Choose the **When the Door Contact Sensor opens** event.

3.5.2.4 **Programming with Favorites (Bookmarks)**

Use the Control4® Composer Pro Programming view to add a bookmark page created in a Touch Screen or On-Screen Navigator to a programming script.

3.5.2.4.1 **Prerequisites**

1. Ensure that the Touch Screens or On-Screen Navigators that contain the bookmarks have been added to the system.
2. Ensure that the bookmark you want to use in the script has been created on a Touch Screen or On-Screen Navigator. See *Control4 System User Guide* for information about how to create a bookmark (Favorite).

3.5.2.4.2 **Procedure**

To add a bookmark to a programming script:
1. Start **Composer** and connect to a **Director**.
2. Click **Programming**.
3. Ensure that the following devices are in the project:
   - 3 Button Keypad
   - 7" Touch Screen
   - Access to 4Store
4. In the Device Events pane, select the device to program, for example, **3-Button Keypad**.
5. In the 3-Button Keypad Events pane, select the button, for example, **Button 1**.
6. In the Device Actions pane, select the **Touch Screen** that contains the bookmark you created.
7. In the Touch Screen - 7" Actions pane, select the **Commands** tab.
8. Scroll to the bottom of the tab, and locate the **Bookmarks** options. There should be a list of favorites from which to choose (see the screen below for details). Select the bookmark to use, for example, **4Store**.

![Bookmarks options](image)

9. When you press **Button 1** on your 3-Button Keypad, the Touch Screen displays the 4Store page.

### 3.5.3 Programming with Conditionals

A Control4® **conditional** is an 'If' statement in **Composer** Pro that asks a true or false question to the device.

- A 'Break' command used in an 'If' statement should jump to the first statement after the 'If'. See “Programming with Delay, Stop and Break Commands” for details. **Note:** A 'Break' command in an 'If' statement won't behave as a 'Stop' command, but will move to the next level in the script.
- A break *not* in a 'While' or 'If' statement should behave like a 'Stop' command (jumps to the first statement after the function).

**Example:** The example in this section shows how to use conditionals in **programming**. If a light is off when the doorbell is pressed, the light is programmed to turn on. Conditionals also use **When** statements (events). When the doorbell is pressed, if the light is off, program the light to turn on.

#### 3.5.3.1 Procedure

To program a conditional that turns on the light when the doorbell is pressed and the light is off:

1. Start **Composer** and connect to a **Director**.
2. Click **System Design**.
3. Ensure that the following devices are in the project:
   - **Controller**
   - **Doorbell**
   - **Theater Switch**
4. Click **Connections**.

5. Make sure the control or network *connection* is made.
   a. Click the **Control/ AV** tab.
   b. Select the **Doorbell** in the *project tree*.
   c. In the Control & Audio Video Connections pane, select **Doorbell**. Ensure it is connected to the **Contact Sensor**.

6. Click the **Network** tab.

7. In the IP Network Connection pane, ensure that Controller and Theater Switch have an address.

8. Click **Programming**.

9. In the Device Events pane project tree, select the **Doorbell**.

10. Select the **When the Doorbell is pressed** event. The event appears at the top of the Script pane.

11. In the Actions pane, select the **Theater Switch**. Notice that the Theater Switch actions that can be programmed for this device appear in the Theater Switch Actions pane below the Device Actions project tree.

12. Click the **Conditionals** tab, and select **Is Off**. Composer Pro displays the conditional you chose in the Theater Switch Actions pane: *? If <room>'s Theater Switch is off.*

13. Drag the **blue question mark** icon to the **Script** pane.
14. Click the **Commands** tab, and select **On**. The command you chose displays in the Theater Switch Actions pane.

15. Drag the **green arrow** to the **blue question mark** in the Script pane to make it a child under the "When..." statement.

**Tip**: If you drag the **action** to the text, or you drag the action under the text to the open space, it places the action as an equal above the conditional.

If you drag the action to the question mark, it becomes a subset of the conditional. Notice the direction of the arrow to place the action as a peer or a subset under the statement.

16. With the Theater Switch light off, press the doorbell; the light should come on.
3.5.4 Programming Using Digital Audio and Rooms

You can program a Control4® system using the Digital Audio and Room objects in Composer Pro. You can use digital audio events when a session starts or stops. A session is when a song or playlist begins and ends. A list of songs can be compiled into a playlist. You can compile the list by songwriter, album, song type, or any combination. Room events include turning the room off and on, when media sessions begin and end, etc.

These sections provide information, tips, and examples about Digital Audio and Room Programming:

“Program a Button to Play Media or a Playlist”
“Program a Button to Turn Up the Volume”
“Program a Button to Add a Room to Another Room’s Music Session”
“Set the Default for a Room’s Music Volume”

3.5.4.1 Program a Button to Play Media or a Playlist

Use the Control4® Composer Pro Programming view to program a button on a Keypad to play an album or playlist.

Example: The example in this section uses a 6-Button Keypad for the Theater room. When you press Button 1, music or a movie plays in the Theater room.

3.5.4.1.1 Prerequisites

1. Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad Installation Guide.
2. Ensure that your project has an audio End Point, such as Speaker Point, added and identified on the network.

3.5.4.1.2 Procedure

To program a button on a 6-Button Keypad to play music:

1. Start Composer and connect to a Director.
2. Click Programming.
4. In the 6-Button Keypad Events pane, press Button 1, and select the Press radio button.
5. In the Device Actions pane, select the Theater room.
6. Click the Commands tab, and press the Select Media radio button.
7. In the new window, select the media type to play, such as Playlist.
8. Select the movie, playlist, etc.
9. Click OK.
10. In the Actions pane, drag the green arrow to the Script pane.
11. Click Execute in the Script pane.
3.5.4.2 Program a Button to Turn Up the Volume

Use the Control4® Composer Pro Programming view to let you use a Keypad button to turn up the volume in a room.

**Example:** The example in this section uses a 6-Button Keypad for the Theater room. When you press Button 2 the volume increases in the Theater room.

3.5.4.2.1 Prerequisites

1. Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad Installation Guide.
2. Ensure that your project has an audio End Point, such as a Speaker Point, added and identified on the network.

3.5.4.2.2 Procedure

To program a button to turn up the volume:

1. Start Composer and connect to a Director.
2. Click Programming.
4. In the 6-Button Keypad Events pane, press Button 2, and then select the Press radio button.
5. In the Device Actions pane, select the Receiver.
7. Drag the green arrow in the Receiver Actions pane to the Script pane.
8. Click Execute.

3.5.4.3 Program a Button to Add a Room to Another Room’s Music Session

Use the Control4® Composer Pro Programming view to use a Keypad button to play music in additional rooms.

**Example:** The example in this section uses a 6-Button Keypad for the Theater room. When you press Button 3, music starts playing in the Bedroom as well as the Theater room.

3.5.4.3.1 Prerequisites

1. Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad Installation Guide.
2. Ensure that your project has an audio End Point, such as Speaker Point, added and identified on the network.

3.5.4.3.2 Procedure

To program a button to add another room’s music session:

1. Start Composer and connect to a Director.
2. Click Programming.
4. In the 6-Button Keypad Events pane, press Button 3, and then select the Press radio button.
5. In the Device Actions pane, select Digital Media.
6. Click the Commands tab.
7. Use the pull-down menu to select the **Theater** room as the Selected Room. Select the **Add Rooms** radio button.
8. Check the box next to **Bedroom** to indicate that this is the room that is going to join the music session.
9. Drag the **green arrow** in the Digital Audio Actions pane to the **Script** pane.
10. Click **Execute**.

3.5.4.4 **Set the Default for a Room’s Music Volume**
Use the Control4® Composer Pro System Design view to set the default music or media volume for a room.

**Example:** The example in this section uses the Theater room. When you set the default, the volume stays at a certain level for the Theater room until you change it. You can change the volume for every room that uses music or media.

3.5.4.4.1 **Prerequisites**
1. Ensure that the **Controller** is added and identified on the network.
2. Ensure that your project has an audio **End Point**, such as Speaker Point, added and identified on the network.

3.5.4.4.2 **Procedure**
To set the default volume for a room:
1. Start **Composer** and connect to a **Director**.
2. Click **System Design**.
3. In the project tree, click a **room**.
4. In the Properties pane, click the **Miscellaneous** tab.
5. In the Miscellaneous tab, check the **Enable Default Volume** box. Adjust the Audio Volume and Video Volume as desired for the room. The default volumes are enabled immediately. Repeat these steps for each room in the **Control4 system**.

3.5.4.5 **Program a Button Using Room Programming**
Use the Control4® Composer Pro Programming view to use a Keypad button to add another room to a program, for example, music.

Refer to “Program a Button to Add a Room to Another's Room's Music.” The steps are the same, except that the example in that section refers to adding a music session.
3.5.5 Examples: Programming with Variables

Use the Control4® Composer Pro Programming view to program the Control4 system using configuration, properties, variables, delays and agents.

Variables provide other programming options not available using Commands, Conditionals or Loops.

There are three (3) types of variables you can use:

1. **Room Variables**—Provide you with additional programming options not available in the Room object programming. Use Room object programming as a preference to room variables whenever possible. See “Example: Using Room Variables.”

2. **Custom Variables**—Let you define additional programming options using:
   - **Boolean**—Provides a True/False option. For example, the light is on or off. If the light is on, it is True; if the light is off, it is False.
   - **Device**—Provides a list of device options.
   - **Number**—Provides a value option. For example, the light level is 70 percent.
   - **String**—Provides the option to enter a string.

   To program using a custom variable, in the Agent view select Variable and click New to set up a New Variable.

   **Example**: Use one Keypad button to toggle between turning on the Theater Dimmer and the Theater Switch.

3. **Container Variables**—Provide the ability to connect two (2) or more devices together by using the device variables. A variable is a representation of information about the controlled devices, such as a power state or current level of the device. It works much like a Media Scenes agent (see "Programming with Agents" for details. Container variables are available in the Agent view by selecting Variables.

   **Note**: Container variables are provided only for backward capability in Release 1.3 and subsequent releases. Issues with various implementations have been found. The use of Container variables for future implementations is not recommended. Where possible, replace existing implementations with alternate programming.

   The sections below provide examples you can follow when you use variables.

3.5.5.1 Example: Using Room Variables

Control4® room variables provide greater flexibility in programming, letting you program using events and actions at the room level.

**Note**: Most of the functions in Room Variables are available by selecting the Room object which is the recommended method for programming the room. Whenever possible, use the Room object rather than Room Variables.
3.5.5.1.1 Procedure

To use room variables:
1. Start Composer and connect to a Director.
2. Click Programming. In this view listed under every room in the project tree is a Room Variables object.
3. Click to expand the Room Variables options. Room variables are available as events and actions.
The room variables are described in the following table.

<table>
<thead>
<tr>
<th>Events/Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT_SELECTED_DEVICE</td>
<td>Lets you do programming when any device changes in the room.</td>
</tr>
<tr>
<td>CURRENT_MEDIA</td>
<td>Lets you do programming when any media changes in the room.</td>
</tr>
<tr>
<td>POWER_STATE</td>
<td>Lets you do programming when any device’s power state changes from True to False in the room (read only). A device in the room is required to detect the power state.</td>
</tr>
<tr>
<td>CURRENT_VOLUME</td>
<td>Lets you do programming when the volume of the currently selected audio path changes in the room (requires discrete volume). Use conditional programming.</td>
</tr>
<tr>
<td>HAS_DISCRETE_VOLUME</td>
<td>Lets you do programming when any devices changes in the room (requires discrete volume). Use command programming.</td>
</tr>
<tr>
<td>HAS_DISCRETE_MUTE</td>
<td>Lets you do programming when Mute state is known (MUTE_ON or MUTE_OFF).</td>
</tr>
<tr>
<td>IS_MUTED</td>
<td>Lets you do programming when in Mute state (MUTE_ON).</td>
</tr>
<tr>
<td>IN_NAVIGATION</td>
<td>Lets you do programming when On-screen is available.</td>
</tr>
<tr>
<td>USE_DEFAULT_VOLUME</td>
<td>Lets you do programming any time a selection changes to reset the default volume. For example, when changing from viewing a DVD to listening to music, the volume is reset to the default discrete set volume.</td>
</tr>
<tr>
<td>DEFAULT_AUDIO_VOLUME</td>
<td>Lets you program the default Audio volume.</td>
</tr>
<tr>
<td>DEFAULT_VIDEO_VOLUME</td>
<td>Lets you program the default Video Audio volume.</td>
</tr>
<tr>
<td>VOLUME_IS_LINKED</td>
<td>Lets you set programming not to affect already linked volume.</td>
</tr>
<tr>
<td>MUTE_IS_LINKED</td>
<td>Lets you set programming not to affect already linked mute state.</td>
</tr>
<tr>
<td>ROOMOFF_IS_LINKED</td>
<td>Lets you set programming not to affect already linked room off state.</td>
</tr>
<tr>
<td>SELECTIONS_LINKED</td>
<td>Lets you set programming not to affect already linked selections.</td>
</tr>
<tr>
<td>ROOM_HIDDEN</td>
<td>Lets you set programming to hide rooms from appearing on the navigation device.</td>
</tr>
<tr>
<td>MEDIA_SCENE_ACTIVE</td>
<td>Lets you set programming to set a media scene as active.</td>
</tr>
</tbody>
</table>

3.5.5.1.2 Variable Handling

In programming, Variables are easier to define than Conditional Loops.

**Note:** It is important to type the variable names precisely. A typographical error causes the program fail.

Variable handling enhancements:

- **Preserve user-defined variables**—Preserves the user-defined variable values (such as the current Dimmer light level) across a normal system restart. It may not preserve them if the system shuts down abnormally.
• **Program a system startup event** —Initializes variables or performs other programming at system startup with a system startup event (in Programming, select the root of the project, and then select the event **When the project is loaded**).

• **Define one Variable to equal another** —Defines one variable to equal another variable. This can be used to save and restore variable values.

**Example:** The level of a light or the volume of music in a room.

After this value is saved to the variable, you can restore the system variable to the value stored in the user variable. The system can then compare the two variables and determine if it needs to reset one of them.

• **Create the event “When a System reboots”** —Sends an email notification to the Control4 Dealer that a customer’s system rebooted, helping the Dealer monitor the system’s performance.

### 3.5.5.2 Example: Using Custom Variables Agent Boolean

Use the Control4® Composer Pro **Programming** view to create custom variables in an **Agent** using a **Boolean** value.

In this example, when someone is at the door:

• Program to activate the Media Scene 'Someone is at the door,' and turn on the porch light.
• Program to play a song in the Bedroom and the Theater.
• When the Motion Sensor stops sensing motion at the door, program to turn the music and porch light off.

#### 3.5.5.2.1 Prerequisites

The following devices are added and identified in the project:

• **Controller**
• Porch Light **Switch**
• Bedroom music
• Theater music
• Motion Sensor

#### 3.5.5.2.2 Procedure

To program using a Custom Variable Agent Boolean:

1. Start Composer and connect to a **Director**.
2. Click **System Design**.
3. Click **Connections**. Make sure the connections are correct.

**Note:** Ensure that the Front Light is connected to the correct **Contact** Sensor on the Controller.

4. Click the **Network** tab, and ensure that the Controller and Porch Light have an address.
Create a New Variable
5. Click Agents.
6. Select Variable. The Variables view appears.
7. Click New.
8. On the dialog that appears, do the following:
   a. Click New Variable.
   b. In the drop-down menu, select Boolean.
   c. Name the Variable Power State and click OK. The default value is false.

Create a Media Scene ‘Someone is at the door’
9. Select Media Scenes, and click New.
10. Name the Media Scene Someone is at the door. Click OK.
Add the Bedroom and Theater Room

11. Click **Add Room**, and add the **Theater** and the **Bedroom**.
12. Set the volume in the Bedroom to **50**, and the volume in the Theater to **75**.

13. Click **Programming**.
14. In the *project tree* and the *Device* Events pane, click to expand Variables, and select **Power State**.
15. In the project tree and in the Device Actions pane, click to expand Variables, and select **Power State**.

**Add the Conditionals and Commands**
16. Click the **Conditionals** tab.
17. In the Conditionals tab, click **Is False**, and drag the blue question mark to the **Script** pane.
18. Click the **Commands** tab.

19. In the Commands tab, click **Set to True**, and drag the **green arrow** on top of the **blue question mark** in the **Script** pane to make it the **first** subset item of the **first conditional**.

20. In the Device Actions pane, select **Porch Light**.

21. Click the **Commands** tab.

22. In the Commands tab, click **On**, and drag the **green arrow** on top of the **blue question mark** in the **Script** pane to make it the **second** subset item of the **first conditional**.

23. In the project tree and in the Device Actions pane, select **Media Scenes**.
24. Click the **Commands** tab.
25. Click **Activate** in the Commands tab, and drag the green arrow on top of the blue question mark in the **Script** pane to make it third subset item of the first conditional.
26. In the project tree and in the Device Actions pane under Variables, select **Power State**.
27. Click the **Conditionals** tab.
28. In the Conditionals tab, click **Is True**, and drag the blue question mark to the **Script** pane.
29. Click the **Commands** tab.
30. In the Commands tab, click **Set to False**, and drag the green arrow on top of the blue question mark in the **Script** pane to make it the first subset item of the second conditional.
31. In the project tree and in the Device Actions pane, select **Front Light**.
32. Click the **Commands** tab.
33. In the Commands tab, click **Off**, and drag the green arrow on top of the blue question mark in the **Script** pane to make it the second subset item of the second conditional.
34. In the project tree and in the Device Actions pane, select **Media Scenes**.
35. In the Commands tab, click **Deactivate**, and drag the green arrow on top of the blue question mark in the **Script** pane to make it the third subset item of the second conditional.

36. In the project tree and in the Device Events pane, select **Media Scenes** and choose the **event Someone is at the Door**.
37. In the project tree and in the Device Actions pane, select the **Bedroom** object. (Repeat the next four steps for the Theater.)
38. Click the **Commands** tab.
39. In the Commands tab, click **Select Media**.
40. In the dialogue that appears, select the album and song that you want to play when Someone is at the Door executes. In this example, 'Knock Three Times' by Lynn Anderson is used. Click OK.

41. Drag the green arrow to the Script pane.

42. Repeat steps 37-41 for the Theater.

43. In the project tree and in the Device Events pane, select Motion Sensor under Front, and choose the event When the Motion Sensor senses motion.

Add the Boolean Values
44. In the project tree and in the Device Actions pane, click to expand Variables, and select Power State.

45. In the Conditionals tab, click Is False, and drag the blue question mark to the Script pane (this is the third conditional).

46. In the Commands tab, click Set to True, and drag the green arrow on top of the blue question mark to make it the first subset of the third conditional.

47. In the project tree and in the Device Events pane, choose the event When the Motion Sensor stops sensing motion.

48. In the project tree and in the Device Actions pane, click to expand Variables, and select Power State.

49. In the Conditionals tab, click Is True, and drag the blue question mark to the Script pane.

50. In the Commands tab, click Set to False, and drag the green arrow on top of the blue question mark to make it the second subset of the third conditional.

Results: The Porch Light turns on and plays a song in the Bedroom and Theater whenever the Motion Sensor senses motion at the front door.
3.5.5.3 Example: Using a Custom Variable Agent Number

Use the Control4® Composer Pro Programming view to create custom variables in an Agent using a numeric value.

In this example, program one Keypad button to toggle between turning on the Theater Dimmer and the Theater Switch.

3.5.5.3.1 Prerequisites

The following devices are added and identified in the project:
- Controller
- Dimmer (Theater)
- Light Switch (Theater)
- 6-Button Keypad

3.5.5.3.2 Procedure

To program using a Custom Variable Agent number:
1. Start Composer and connect to a Director.
2. Click System Design. Make sure the project has the correct devices and rooms.
3. Click Connections. Make sure the connections are correct.

Note: In the Network tab, ensure that the Controller, Dimmer (Theater), Light Switch (Theater), and 6 Button Keypad have an address.

Add a New Variable
4. Click Agents.
5. Select Variables. The Variable Agents view appears.
6. Click New.
7. On the dialog that appears, do the following:
   a. Select New Variable.
   b. Name the variable Keypad_releases.
   c. Use the Variable Type pull-down menu to select the number.
   d. Click OK.
8. In the Variables pane, select the variable `Keypad_releases`. The available variables for your devices appear in the right pane.
9. Enter the value as 0 (zero).

**Create an Event**
10. Click **Programming**.
11. In the project tree and in the **Device** Events pane, select 6 Button Keypad.
12. Click **Button 1** on the 6 Button Keypad.
13. Select **Press** for the **event**. The event appears at the top of the Script pane.

**Create the Actions**
14. In the Actions pane, scroll down to view the agents.
15. Click to expand **Variables**.
16. Select **Keypad_releases**.
17. In the Commands tab, select the following to add 1 to the present value:
   a. Select the radio button by the plus (+) sign.
   b. Ensure the plus sign is selected.
   c. Select 1 (one).
   The **action** appears in the Actions pane.
18. Drag the **green arrow** icon to the **Script** pane.

**Create the Conditionals**
19. Click the **Conditionals** tab.
   a. Select the **Is** radio button option.
   b. Select equals (=) sign.
   c. Select 1 (one).
20. Drag the **blue question mark** below the previous *command* in the *Script* pane. This places the *conditional* Action parallel to the previous Action command.

21. In the Actions pane, select **Theater Dimmer**.

22. In the Command tab, select **On**. The action command appears in the Actions pane.

23. Drag the **green arrow** to the **blue question mark** in the *Script* pane to make it a subset of this conditional item.

24. In the Actions pane, scroll down to the agents.

25. In the Variable agent, select the **Keypad_presses** variable.

26. Click the Conditional tab.
   a. Select the **Is** radio button option.
   b. Select equals (\(=\)) sign.
   c. Select **2** (two).

27. Drag the **blue question mark** to the blank space under the previous Action command. This places the conditional Action parallel to the previous Action conditional.

28. In the Actions pane, select **Theater Switch**.

29. In the Command tab, select **On**. The action command appears in the Actions pane.

30. Drag the **green arrow** to the **blue question mark** in the *Script* pane to make it a subset of the conditional item.

31. In the Actions pane, scroll down to the agents.

32. In the Variable agent, select the **Keypad_presses** variable.

33. In the Commands tab, select the following:
   a. Select the **Set to Value** radio button.
   b. Set the value to **0** (zero). The Action command appears in the Actions pane.

34. Drag the **green arrow** icon to the **blue question mark** icon in the *Script* pane to make it a *second* subset of the conditional.

**Results**: Press **Button 1** on the 6-Button Keypad to toggle between turning on the Theater Dimmer and the Theater Switch.
3.5.5.4 Example: Using a Custom Variable Agent String

Use the Control4® Composer Pro Programming view to create custom variables in an Agent using a numeric value. The steps in this section are for more advanced users of Composer Pro.

In this example, program Button 4 on a Keypad to toggle through four (4) playlists.

Note: This procedure is relatively complicated to create. Review the steps first to understand how the conditionals work.

3.5.5.4.1 Prerequisites

The following items are added and identified in the project:

- Controller
- 6-Button Keypad
- 4 Playlists: Mom’s Favorites, Dad’s Favorites, Choral Music, and Kid’s Music

3.5.5.4.2 Procedure

To program using a Custom Variable Agent string:

1. Start Composer and connect to a Director.
2. Click System Design. Make sure the project has the correct devices and rooms.
3. Click Connections. Make sure the connections are correct.

Note: In the Network tab, ensure that the Controller and the 6 Button Keypad have an address.

Add a New Variable

4. Click Agents.
5. Select Variables. The Variables agent list appears.
6. Click New.
7. On the dialog that appears, do the following:
   a. Select New Variable, and name the variable My Playlists.
   b. In Variable Type, use the pull-down menu to select String, and click OK.

Set Up Mom’s Favorites Playlist in the Theater

8. Click Programming.
10. In 6-Button Keypad Events, click Button 4 on the Keypad.
11. In the Device Actions pane, scroll down and click to expand **Variables**.
12. Select **My Playlists**.
13. In My Playlists Actions pane, click the **Conditionals** tab, and enter the name of a *playlist*; for example, **Mom's Favorites**.
14. Drag the first **blue question mark** to the **Script** pane.

15. In Device Actions, select the **Theater** room object.
16. In Theater Actions, select **Media**.
17. In the window that pops up, select **Playlists, Mom's Favorites**, and then click **OK**.
18. Drag the **green arrow** icon on top of the first **blue question mark** in the **Script** pane to make it the first subset of the first **conditional**.
19. In Device Actions, select **My Playlists**.
20. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for example, **Mom’s Favorites**.
21. Drag the **green arrow** on top of the first **blue question mark** to the **Script** pane to make it a **second** subset of the **first** conditional.

The next time the button on the Keypad is pressed, the value of the variable will be **Mom’s Favorites**, and will then cue that playlist in the **Theater**.
22. In Device Actions, scroll up and select the **6 Button Keypad** in the **Theater**.
23. In 6 Button Keypad Actions, click **Button 4**.
24. Click the **square of color** to choose the color you want Button 4’s LED to be when Mom’s Favorites plays. Choose the color in the menu that pops up (in this example: green), and click **OK**.

25. Drag the **green arrow** on top of the first **blue question mark** in the **Script** pane to make it a **third** subset of the **first** conditional.
26. In Device Actions, scroll down and select Programming Control.
27. In the Programming Control Actions, select the Stop radio button.
28. Drag the green arrow on top of the first blue question mark in the Script pane to make it a fourth subset of the first conditional.

**Note:** It is important to add a Stop command here so that when the conditional is fulfilled, the programming will not continue. Because of the way this programming is set up when it's finished, without the stop, the button on the Keypad will always select the last playlist in the script.

---

**Set Up Dad's Favorites Playlist**

29. In Device Actions, select My Playlists again.
30. In the Conditionals tab, next to 'Is' enter Dad's Favorites in the text box.
31. Drag the second blue question mark to the Script pane.
32. In Device Actions, select the Theater.
33. In Theater Actions, select Media.
34. In the window that pops up, select Playlists, Dad's Favorites, and then click OK.
35. Drag the green arrow on top of the second blue question mark in the Script pane to make it the first subset of the second conditional.

---

**Set Up Kid's Room Playlist**

37. In the Commands tab under My Playlist Actions, enter the name of the next playlist that you’d like to play; for example, Kid's Music.
38. Drag the green arrow on top of the second blue question mark in the Script pane to make it a second subset of the second conditional.
39. In Device Actions, select the 6 Button Keypad in the Theater.
40. In 6 Button Keypad Actions, click on Button 4. Click the square of color to choose the color you want Button 4’s LED to be when Kid’s Music plays. Choose the color in the menu that pops up (in this example: purple), and click OK.
41. Drag the green arrow on top of the second blue question mark in the Script pane to make it a third subset of the second conditional.
42. In Device Actions, select Programming Control.
43. In the Programming Control Actions pane, select Stop.
44. Drag the green arrow on top of the second blue question mark to make it a fourth subset of the second conditional.
45. In Device Actions, select My Playlists again.
46. In the Conditionals tab, enter Kid’s Music.
47. Drag the blue question mark to the Script pane to make it the third conditional.
48. In Device Actions, select the Theater room object.
49. In Theater Actions, select Select Media.
50. In the window that pops up, select Playlists, Kid’s Music, and then click OK.
51. Drag the green arrow on top of the third blue question mark in the Script pane to make it the first subset of the third conditional.

Set Up Choral Music Playlist
52. In Device Actions, select My Playlists.
53. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for example, Choral Music.
54. Drag the green arrow on top of the third blue question mark to make it a second subset item of the third conditional.
55. In Device Actions, select the 6 Button Keypad in the Theater.
56. In 6 Button Keypad Actions, click on Button 4. Click the square of color to choose the color you want button 4’s LED to be when Kid’s Music plays. Choose the color in the menu that pops up (in this example: red), and click OK.
57. Drag the green arrow on top of the third blue question mark in the Script pane to make it the third subset of the third conditional.
58. In Device Actions, select Programming Control.
59. In the Programming Control Actions, select the Stop radio button.
60. Drag the green arrow on top of the third blue question mark in the Script pane to make it a fourth subset of the third conditional.
61. In Device Actions, select My Playlists again.
62. In the Conditionals tab, enter Choral Music.
63. Drag the fourth blue question mark to the Script pane.
64. In Device Actions, select the Theater room object.
65. In Theater Actions, select the Select Media radio button.
66. In the window that pops up, select Playlists, Choral Music, and then click OK.
67. Drag the green arrow on top of the fourth blue question mark in the Script pane to make it the first subset of the fourth conditional.
68. In Device Actions, select My Playlists.
69. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for example, *Mom’s Favorites*.

70. Drag the green arrow on top of the fourth blue question mark in the Script pane to make it a second subset of the fourth conditional.

71. In Device Actions, select the 6 Button Keypad in the Theater.


73. Click the square of color to choose the color you want Button 4’s LED to be when Choral Music plays. Choose the color in the menu that pops up (in this example: yellow), and click OK.

74. Drag the green arrow on top of the fourth blue question mark to make it a third subset of the fourth conditional.

75. In Device Actions, select Programming Control.

76. In the Programming Control Actions, select the Stop radio button.

77. Drag the green arrow on top of the fourth blue question mark to make it a fourth subset of the fourth conditional.

78. In Device Actions, select the Theater room.

79. In Theater Actions, select Media.

80. In the window that pops up, select Playlists, Mom’s Favorites, and then click OK.

**Note:** You do this is because the first time the button on the Keypad is pushed, the string variable does not have a value, and nothing happens. This last command is created when none of the conditionals are fulfilled, something will play; each time the button is pushed thereafter, a conditional is fulfilled.

81. Drag the green arrow below the previous Stop command in the Script pane. It is not a subset of the previous conditionals, but a command on its own.

82. In Device Actions, select My Playlists.

83. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for example, Dad’s Favorites.

84. Drag the green arrow below the previous command in the Script pane.

85. In Device Actions, select the 6 Button Keypad in the Theater.

86. In 6 Button Keypad Actions, click on Button 4. Click the square of color to choose the color you want Button 4’s LED to be when Mom’s Favorites plays. Choose the color in the menu that pops up (in this example: green), and click OK.

87. Drag the green arrow below the previous command in the Script pane. You do not need a stop at this point, because the programming automatically stops at the end of the script.

**Results:** Press Button 4 on a 6-Button Keypad repeatedly to toggle through four (4) playlists.
3.5.6 Examples: Programming with Agents

Use the Control4® Composer Pro Agents and Programming views to program agents.

3.5.6.1 Major Steps

When you program with agents, you typically use these general steps:

1. In Agents, define an instance of a type of agent.
2. In Programming, use the instance of the agent to program event actions.

Example: In the Agent view, you can create an instance of a Custom Button where you identify all the buttons you want to program. In Programming, you program the Custom Buttons.

Note: Agents vary greatly in functionality.

3.5.6.2 Agent Types

- **Announcements**—Plays a pre-recorded .WAV file, or displays a text message whenever a given event occurs. You can play an audio announcement on any audio output device with a supporting text message that displays on selected Navigators.
  
  Example: A Doorbell announcement plays a .WAV file that sounds like chimes and displays the following text on a Mini Touch Screen: “Someone is at the door” each time a doorbell is pressed. See “Example: Program Using the Announcement Agent.”

- **Custom Buttons**—Lets you make user interface buttons for specialized devices on the Navigators. See “Example: Program Using the Custom Buttons Agent.”

- **E-mail Notification**—Lets you send an email message to your email address when specified events occur as defined in programming. See “Example: Program Using the E-Mail Notification Agent.”

  Notes:

  Remote Access is required to use the E-mail Notification Agent. See the Composer Pro Getting Started for details about Remote Access.

  Avoid setting up email notifications for events that occur frequently (e.g., when a Motion Sensor detects motion). If the email notification trigger event occurs too often, it will cause the system to become sluggish.

- **Intercom**—Sets up the Intercom function for 5” or 7” In-Wall Touch Screens.

- **Lighting Scenes**—Sets up a Lighting Scene.
  
  Example: By pressing one button on a Keypad, you can turn on assigned lights to specified ramp levels. See “Example: Program Using the Lighting Scenes Agent.”

- **Media Scenes**—Creates a media scene that plays music in selected rooms on your system.
  
  See “Example: Program Using the Media Scenes Agent.”
• Macros—Macros agents associate programming with events. Example: You can create one macro to use in several different programming events or to use on a Touch Screen when creating Favorites. See “Example: Program Using the Macros Agent.”
• Rhapsody—Lets you activate or disable a Rhapsody account. See “Example: Program Using the Rhapsody Agent.”
• Scheduler—Defines conditionals of time to the system, and adds the ability to have scheduled events. See “Example: Program Using the Scheduler Agent.”
• Screen Saver—Lets you set up a Screen Saver agent so you can create various Screen Savers. See “Example: Program Using the Screen Saver Agent.”
• Timer—Starts, stops, or repeats a timer based on a given event and action. Example: If a Motion Sensor in the system turns on a light when it detects motion, you can use a timer to turn off the light after 15 minutes. Alternatively, you can set a timer to repeat an action whenever the timer expires. See “Example: Program Using the Timer Agent.”
• Variables—Create Boolean, string, and number variables. Review “Programming with Variables” for information about creating Variable agents.
• Video Wall—(10.5” Touch Screens only) Creates a video wall for simultaneous viewing and control of multiple video sources on multiple displays. A video wall is commonly used for viewing multiple sports or news channels while in the same room. It incorporates multiple video displays and multiple cable/satellite tuners equipped with Digital Video Recorders (DVRs). The agent provides the ability to control these multiple video displays from the Wireless Touch Screen. See “Example: Program Using the Video Wall Agent.”
• Wakeup—Initiates a pre-specified wakeup time in the Navigators. This agent lets you play music, turn on lights, and change temperatures. See “Example: Program Using the Wakeup Agent.”

The agent examples listed in the following sections will guide you through the programming steps for each agent type.

3.5.6.3 Example: Program Using the Announcements Agent

Use the Control4® Composer Pro Agents and Programming views to program this agent.

You can create announcements that:
1. Display a text-message or Web page on any of the Navigators (TV On-Screen menu, Touch Screens, or LCD Keypad)
2. Play a WAV-formatted audio announcement through any audio end point
3. Combine the two mentioned above

Note: The Control4 system allows up to 10 MB of files for the Announcement agent, and plays a maximum of 15 seconds per announcement.

Example: This example demonstrates how to create a 'Dinner is Ready' announcement that is activated when the family chef (or dad) presses a custom-programmed button. When the button is pressed, the text message 'Dinner is ready' displays on all of the Navigators in the home, and an audio file of a dinner bell ringing plays.
3.5.6.3.1 **Prerequisites**
The following devices are added and identified (with a network address) in the project:
- **Controller**
- Audio output *device* (Television or connected speakers)
- **Navigator** with a screen (*Touch Screen*, LCD Keypad, Television)
- Any device involved in the triggering *event* (Doorbell *Contact*, 3-Button Keypad, etc.)

3.5.6.3.2 **Procedure**
To set up an Announcement agent:
1. Start **Composer** and connect to a **Director**.
2. Click **Agents**.
3. (Initial Announcement agent only) Click **Add**.
4. Select **Announcements**, and then click **OK** to add Announcements to the agent types list in the project. The next time you want to create an announcement, just select the Announcements item in the Agents pane and click **New**.
5. With Announcements selected in the left pane, click **New**.
6. Name the **new announcement**, and click **Create**. **Example**: Come to Dinner!
7. Set up the Navigator text message you want to display.
   a. Check the Display Navigator Message box.
   b. Click **Edit Text/Image**.
   c. Type a text message, a URL, or browse to an image (JPG, GIF, or PNG) to display.
The text box accepts any HTML code. While certain links and scripts won’t be handled, when the announcement is triggered, for example, if you put this text in an announcement, it will show up just as if it were a Web page. For example, the following HTML text will display the latest snapshot of a Web page:

<HTML><BODY><IMG SRC="http://tbn0.google.com/images?q=tbn:1uOhCnlc3zbQgM:http://www.inkycircus.com/jargon/images/mountain.jpg" ALT="pumpkin"><a href="http://www.w3schools.com/">Visit W3Schools!</a></BODY></HTML>

**Note:** A static image file (JPG, GIF, or PNG) only has to be added to your project once because it is copied to the Controller. When added, it is available in the Text Message drop-down menu for use in any additional announcements created.

a. Select the **time** you want the text message to display using the **Close after** drop-down menu (supported display times are from 5 seconds to 10 minutes).

b. Click **Add/Remove** and check the Navigators that will display the message. Click **OK**.

8. **Audio file.** Add a WAV audio file, and set up the audio file to be played.
   a. Check the **Play Audio File** box.
   b. (One time per audio file) Click **Add** and browse to the WAV audio file to add it to the drop-down menu.

**Note:** An audio file only has to be added to your project one time because it is copied to the Controller. When added, it is available in the Audio File drop-down menu for use in any additional announcements created.

c. Choose the WAV file from the drop-down menu.

d. Click **Add/Remove Rooms** and check the **rooms** where the audio file will play. Click **OK**.

e. Set the volume of the audio play for each room.

**Note:** The volume for an announcement only can be set on devices with discrete volume control.

9. Click **Programming**.

10. Verify that the new Announcement agent displays in the Actions list (bottom of list).
    a. Select **Announcements**.
    b. Make sure the 'Come to Dinner!' message displays in the Announcement Actions pane, and that the **command** is there (green arrow).

11. Program the announcement to play or display with a triggering event.

    **Example:** Program a button-press event (left pane) to trigger the Announcement agent to run 'Come to Dinner!' (right pane).
3.5.6.4 **Example: Program Using the Custom Buttons Agent**

Use the Control4® Composer Pro Custom Button Agent to create up to four (4) custom screens to display on the Navigators (including Touch Screens and On-Screen devices).

**Example**: If you have a heated driveway or some other specialty device, you can set up a screen with custom buttons to operate the heated driveway from the Navigators.

3.5.6.4.1 **Guidelines**

- You can access each screen on the Navigators from the Control4 main menu or for a room from four (4) available tabs. **Example**: The heated driveway screen is accessed from a custom tab on the main menu. You can configure the tab to be viewed system-wide on all screens, or to view in one room only.
- The Navigators allow up to four (4) tabs per room to access custom screens with custom buttons. Each screen can provide up to six (6) custom buttons for a total of 24 custom buttons. The four (4) tabs in each room can be allocated as either room or as global tabs.
- On the Navigators, you can set up a room or global tabs. The example shows the creation of custom tabs that appear in the Front Room and access a custom screen.

**Note**: If you want to create a Custom tab to appear globally, check the Global box next to the Screen Name. Because only four (4) screens are available for each room, if a Global button is added and another room already has four (4) screens, the Global button replaces the first screen in that room.

3.5.6.4.2 **Prerequisites**

The following devices are added and identified (with a network address) in the project:

- **Controller**
- Electronic Gate (In the Control & Audio Video Connections tab, ensure that the Electronic Gate is connected to Controller Relay Port 4.)

3.5.6.4.3 **Procedure**

To set up a Custom Buttons agent:

1. Start Composer and connect to a Director.
2. Click Agents.
3. In the Agents view, click Add to choose an agent type Custom Buttons.
4. When the dialog appears, from the choose Custom Buttons.
5. Click OK.
6. Select the **Custom Buttons** agent.
7. From the list that appears in the left pane, select the **room** for the Custom Button.
8. Select **Front**.

9. When the Custom Buttons interface appears, in the Screen 1 area, click **Add**.
10. Enter the name of the buttons to appear on the **Navigator** screen.
11. Enter the relevant information for the device.

   The Screen Name is the name that appears on the access tab to enter the custom screen. The buttons are the names that appear on the custom buttons.

   **Example:** For the Electronic Gate, enter the following:

   - Screen Name: **Electronic Gate**
   - Button 1: **Toggle**

12. Click **OK**.
13. Click the Programming view to program your Custom Button.

14. In the Device Events pane, scroll down to the agents and select the Custom Buttons agent.
15. In the Custom Buttons Events pane, ensure that Front-Electronic Gate is selected under the Event Screen next to Toggle, and then select the Press radio button. When custom button ‘Toggle’ on screen ‘Electronic Gate’ in Front is pressed, it appears at the top of the Script pane.
16. In the Actions pane, select **Electronic Gate**.
17. From the **Command** tab, select the **Toggle the Electronic Gate** radio button. The **action** command appears in the Actions pane.
18. Drag the **green arrow** to the **Script** pane.
19. Select **File > Refresh Navigators**.

### 3.5.6.5 Example: Program Using the E-Mail Notification Agent

**IMPORTANT**: An active 4Sight Internet Service subscription is required for Email Notification to work. See *Composer Pro Getting Started* or the *Control4 System User Guide*.

Use the Control4® Composer Pro E-Mail Notification **Agent** to have an email sent to an email address automatically when specific events occur as defined in **programming**.

**Example**: If you want to know when the basement door opens, you can set up an E-mail Notification agent to send an email to your email application’s Inbox when the Basement door opens.

- The E-mail Notification is a Control4 service. To use E-mail Notification agent, **remote access** is required to facilitate a secure **connection** between the **Controller** and the Control4 service.
- The E-mail Notification agent uses templates to enhance usability. You can use a template to define a To, Subject, or Body for use when creating instances of the Email Notification agent. See "Connecting to a Director Using Remote Access" in *Composer Pro Getting Started*.
- Use the Programming view to define the individual instance that triggers an email and completes the definition.
Example: A security threat to the house notified you of broken windows, doors opening, and motion detected in Away mode. In the template, you define Subject: Security Alert and To: fsmith@myemail.com. In the Programming view, you might define the zone. Examples of other incidents to use E-mail Notification include: Basement Door Opened, Front Gate Opened, Water Sensor detection, Carbon Monoxide Sensor detection, Motion Sensor detection, Sprinklers On/Off, etc.

Tip: When setting up an E-mail Notification agent, note the frequency that an event can happen; because if it is too frequent, it can slow down the system. For example, if an email is sent when a Motion Sensor detects motion, the frequent email messages could cause sluggishness.

3.5.6.5.1 Prerequisites
The following example devices are added and identified (with a network address) in the project:

- Controller
- Door Contact Sensor

3.5.6.5.2 Procedure
To set up an E-Mail Notification agent:

1. Start Composer and connect to a Director.
2. Click Agents.
3. In the Agents view, click Add to an agent type.
4. When the dialog appears, select Email Notification.
5. Click OK.
6. Select Email Notification, and click Add in the pane that follows. The New Template Name dialog appears.

Tip: Control4 now includes Control4 system and user-defined variables in the templates created using this agent. To use this function, you can create or modify email templates using Composer Pro, Agents, E-mail Notification, and then use the Add Variable option.

7. Enter a name on the dialog that appears, for example, ‘Security Alert.’
8. Click Create.
9. In Email Notification Template Name, select Security Alert for the Composer Pro email screen to appear.
10. Fill out the information for the email you want sent to you when an event occurs.

Example:
To: fsmith@myemail.com
Subject: Security Alert
Body: The security of the Franklin Smith House may have been compromised.
11. Do the following as needed:
   a. Click **Send Email** to test and see if you receive and email to your email address.
   b. Click **Add Variable** if you've created a variable agent. Scroll down the list to locate the variable, and then click **OK**.
   c. Click **Save** to exit and go to the Programming view to set up the programming.
   d. Click **Reset** to clear the To, Subject, and Body of the email to start again.

12. With the Agent template created, you can create one instance of the Security Alert for each security zone (or object). When you've saved the template, click **Programming**.

13. In Programming under Theater, select **Door Contact Sensor**.

14. In Door Contact Sensor Events, select **When Door Contact Sensor opens**.

15. In the Actions pane, scroll down and select **Email Notification**.

16. Make any changes to the email as necessary.

17. Drag the **green arrow** to the **Script** pane.

18. In the File menu, click **Refresh**.

19. Test the Email Notification agent by going to the door and opening it. An email is sent to your Inbox with the Security Alert as a subject.

3.5.6.6 **Example: Program Using the Intercom Agent**

Use the Control4® Composer Pro Agents and Programming views to program this agent.

The Intercom agent lets you configure the 5” or 7” In-Wall Touch Screens so that the Control4 system acknowledges the Intercom system and can communicate with it. **Note**: Only these Touch Screens models are capable of Intercom functionality.

You can send broadcasts, monitor a room, and other controls with this agent. **Example**: If you have an elderly parent living in their own home, you can create a macro and assign it to a keypad button. If your family member is in stress, they simply press the keypad button to notify you that something is wrong. Another example is a “Good Night” setting where all Touch Screens in the house can be set to
“Privacy Enabled” when it’s time to go to sleep. Or you can monitor your kids’ room after they’ve gone to bed to ensure that they’re going to sleep when they should.

**Example:** This example demonstrates how to send a ‘test’ announcement to a Touch Screen in the Master Bedroom that says “You are being monitored.” The Master Bedroom is then monitored.

### 3.5.6.6.1 Prerequisites

The following devices are added and identified (with a network address) in the project:

- Controller
- 5” or 7” In-Wall Touch Screen
- Intercom license
- Intercom agent (see below)

**Note:** An Intercom license must be assigned and active on the consumer’s account. See *Managing Dealer Accounts on My.Control4.Com* for details.

### 3.5.6.6.2 Procedures

**To set up an Intercom agent:**

1. Start **Composer** and connect to a Director.
2. Click **Agents**.
3. (Initial Intercom agent only) Click **Add**.
4. Select **Intercom**, and then click **OK** to add Intercom to the agent types list in the project. The next time you want to configure the Intercom function, just select the Intercom item in the Agents pane.

To add an Intercom group:

You can create Intercom groups (groups of Touch Screens) to send broadcast messages to.

1. Select **Intercom** in the left pane, and click **New**.
2. Name the Intercom group, and click **Add**. **Example:** easy/reader.
3. Add the devices to the new group.

**Group Properties:**
You can add devices to an existing group of 5" or 7" In-Wall Touch Screens that are installed and added to the system. This lets the broadcaster from one Touch Screen send out broadcasts to the group of devices.

The Group Properties pane shows the Intercom Devices in the system and which device group these devices are in.

**To add or remove devices in a group:**
1. **Add:** Select the device in Intercom Devices, and then click Add. Click OK.
2. **Remove:** Select the device in Devices in Group, and then click Remove. Click OK.

**Intercom Device Properties:**
Each 5" or 7" In-Wall Touch Screen in the Control4 system appears in the Intercom Device Properties pane (see figure above).

You can customize the following communication options for each Touch Screen:

- **Manual Answer Popup Timeout (seconds):** This is the amount of time the popup remains on the screen if the Set Answer mode's Manual option is selected.
- **Microphone:** Raise or lower the microphone volume using the slider bar or the up or down arrows. **Note:** This can be set also on the Touch Screen or in programming.
- **Speaker:** Raise or lower the speaker's volume using the slider bar or the up or down arrows. **Note:** This can be set also on the Touch Screen or in programming.
- **Exclude from Navigator:** Select if you do not want these options enabled. This option is useful when you want to broadcast messages to the Touch Screens.
- **Privacy:** Select to enable privacy which ensures that other Intercom devices cannot listen in through this Touch Screen (office, bathroom, etc.).
- **Ring Disabled:** Select to disable a particular Touch Screen from being notified via a ring tone.
- **Set Answer mode:**
  - **Manual:** Select to have the user answer manually when someone calls in a full-duplex session.
  - **Auto:** Select to automatically initiate a full-duplex call without requiring any user interaction. To broadcast a message, select this option.
  - **Do Not Disturb:** Select to ensure that the Intercom device does not receive any broadcasts. **Note:** If you select Privacy AND Do Not Disturb, the Touch Screen is not available for broadcasts or calls.

Click **Apply Changes** when you’re finished.

**To set up a program that monitors a room using the Intercom agent:**
1. Create an announcement with a WAV file that says “You are being monitored.” See “Example: Program Using the Announcements Agent.”
2. In Programming under Device Events, click **Intercom**.
3. In the Intercom Events pane, select the Touch Screen to monitor.
4. Click Session Started.
5. In the Actions pane, click the Conditionals tab.
6. Drag the blue question mark “If Master > 5” Touch Screen is Monitored” to the Script pane.
7. In the Actions pane, select Announcements.
8. Click the Announcements Actions tab and select test.
9. Drag the green arrow “Execute Announcement “test” to the Script pane.
10. Click Execute.

When the monitoring session starts, an announcement comes out of the Master Bedroom’s Touch Screen that the room is being monitored.

3.5.6.7 Example: Program Using the Lighting Scenes Agent
Use the Control4® Composer Pro Agents and Programming views to program this agent. Lighting Scenes let you set up lights in a home at a pre-determined setting and ramp rate.

Note: The Off state in Lighting Scenes is available only in programming and is not in the OS 2.0 Flash Navigators. Use specific Off scenes where needed for the Navigators.

Example: Set up the Bedroom Dimmer and Theater Dimmer at a pre-determined level and ramp rate when turned on. Turn the switch off and on. Assign the Lighting Scene to Button 1 on a 6-Button Keypad.

3.5.6.7.1 Prerequisites
The following devices are added and identified (with a network address) in the project:
- Controller
- Theater Dimmer
- Theater Switch
- Bedroom Dimmer
3.5.6.7.2 Procedure

To set up a Lighting Scenes agent:
1. Start Composer and connect to a Director.
2. Click Agents.
3. (Initial Lighting Scene Agent only) Click Add and click OK.
4. In the Agents pane, select Lighting Scenes and then click New.
5. Enter a name on the dialog that appears, e.g., Evening Lights.
6. Click Create.
7. The instance of the agent you created appears below the Agents pane. Select the instance you just created, and click Add/Remove Load to continue.
8. Check the lighting loads that you want to add, and then click OK. This can be a single light, a single room, all lighting loads in an entire house, or any combination of these options.
9. Set the specific settings for each load:
   - Dimmer Options:
     - Level—Lets you set a lighting level as appropriate by using the bar or Level pull-down menu, such as 50 percent for the Bedroom Dimmer and 20 percent for the Theater Dimmer.
     - Ramp Rate—Lets you set the Ramp Rate, which is the speed the load ramps to the specified lighting level. Use the pull-down menu to set the Milliseconds, Seconds, or Minutes of the ramp rate. Then set the amount of time you want the level to change. Example: Set the time to 1 second for both the Bedroom Dimmer and the Theater Dimmer.
     - Remove Load—Lets you remove this particular load by clicking Remove Load.
   - Switch Options—You can turn the light On or Off for the Theater Switch. Example: Lighting Scene, select Off.
10. When the settings are configured for each load in this Lighting Scene, click Execute On Scene.
Note: Other buttons may apply as needed:

- **Add/Remove Load**—Click to add or remove Dimmers or Switches. Select the Dimmer or Switch from the project tree and click **OK**.
- **Execute On Scene**—Click to have all Dimmers and Switches in this scene turn on when executed.
- **Execute Off Scene**—Click to have all Dimmers and Switches in this scene turn off when executed. Can combine with other scenes to turn off.
- **Sync This Scene**—Click to synchronize the behavior of the devices in this scene. Used mostly for updates and testing.
- **Sync All Scenes**—Click to synchronize the behavior of all devices in all scenes. Used mostly for updates and testing.

11. A dialog appears that the scene is executed. Click **OK**.
12. Click **Programming**.
13. In the project tree, select the **device** to program. **Example**: 6-Button Keypad.
14. In the Events pane, click an **event**; for example, if you chose the 6-Button Keypad, click **Button 4**.
15. Select **Press** at the event to trigger programming. The event appears at the top of the Script pane.

16. From the Actions pane, scroll down to view the available agents in the **project tree**.
18. In the Commands tab, select the command to view it, for example, 'Evening Lights - ON.'
19. Drag the green arrow to the Script pane.
20. Press Button 4 on the 6-Button Keypad, or click Execute in the Script pane to test the Lighting Scene.

3.5.6.8 Example: Program Using the Macros Agent

Use the Control4® Composer Pro Agents and Programming views to program this agent. Macros agents are routines that associate programming with events. Examples: You can create and name a macro to use in several different programming events. The macro can be called from a particular program in the Programming Actions pane or you can create a Favorite on your Touch Screens or On-Screen Navigator to call a Macros agent.

You can create Macros agents:

- To use in various programmed events
- To use in Custom pages
- To embed directly into the Navigators
- To create shortcuts (Favorites)

3.5.6.8.1 Prerequisites

The following devices are added and identified (with a network address) in the project:

- Controller
- Light Switch
- Navigator with a screen (Touch Screen, LCD Keypad, Television)
- Any device involved in the triggering event (Doorbell Contact, 3-Button Keypad, etc.)

3.5.6.8.2 Procedure

To set up a Macros agent:
1. Start Composer and connect to a Director.
2. Click Agents.
3. (Initial Macros agent only) Click Add.
4. Select Macros, and then click OK to add the agent types list to the project.

To create a new Macros agent:
1. Select Macros in the Agents pane, and click New.
2. Name the new macro, for example, Bob, and then click Create.

To add the agent's programming script:
In this script, select the Living Room Right Switch which is on, and then turn off everything in the Living Room.
1. Click the Programming view.
2. In the Device Events pane, scroll down to Macros and select Bob. "When Bob is executed" appears in the Script pane.
3. In the Device Actions pane, select Living Room and the Right Switch.
4. Drag the green arrow 'Living Room ->Right Switch->LIGHT_STATE=True' to the Script pane.
5. In the Device Actions pane, select Living Room.
6. Drag the green arrow 'Turn off Living Room' to the Script pane.

7. You can add the Macros agent to many programs that you create if you want to perform similar tasks, or you can program the agent for a specific device. For example, you can assign this agent to Button 1 on a 3-Button Keypad to run the program when executed.

Note: A unique Macros agent cannot be edited or copied; only created or deleted. If you want to create a new Macros agent based on another one, you must create a new one.
3.5.6.9 **Example: Program Using the Media Scenes Agent**

Use the Control4® Composer Pro Media Scenes agent to allow simpler multi-zone audio control. Media Scenes link source, volume, and room-off commands. With Media Scenes, you can configure one or more rooms in a system to play the same music at the same volume.

**Example:** A Media Scene for the entire house can include all the rooms in the Control4 system. Another Media Scene can include only the Master Bedroom and Bath. You can create any number of Media Scenes containing any number of rooms.

3.5.6.9.1 **Guidelines**

1. To successfully activate a Media Scene (with the rooms being controlled simultaneously), activate the Media Scenes agent before starting any music playback.

2. Media scenes are persistent; when activated, a Media Scene remains active until deactivated or until the Controller is powered down. If a Media Scene is deactivated while music is playing, the music continues to play in the associated rooms, but the rooms are no longer controlled in unison. Therefore, music can be stopped in one room while it continues to play in another room.

3. You can set up a Media Scene one time, and activate it when desired. Then play the music.

3.5.6.9.2 **Procedure**

To create a Media Scenes agent:

1. Start Composer and connect to a *Director*.
2. In the Agents view, click *Add*.
3. On the dialog that appears, click *Media Scenes*, and then click *OK*.
4. In the Agents pane, select *Media Scenes*, and click *New*.
5. Enter a name for your new Media Scene. **Example:** *Party Music*.
6. In the Agents pane, select *Party Music*, and then click *Add Room* in the Media Scenes pane.
7. In the dialog box is a list of rooms in your system. Check the rooms where you want to play your Party Music, and then click OK. **Example:** Theater and Front.

**Tips:** To remove a room from a scene, click **Remove Room**. To create another Media Scene, return to Step 1.

Tip: You can add all rooms on a floor by clicking **Main**. This automatically selects all other rooms in that category. You can also include all rooms in your entire system in the Media Scene by clicking **House**.

The rooms you selected appear in the new Media scene 'Party Music.'

8. To activate the scene, click **Activate Scene** at the top of the screen.
To deactivate, click the **Deactivate Scene** button.

9. You can program a button for your Media Scene. Do this by creating a new Custom Button.
   a. In the Agents view, click **Custom Buttons**, and then below, click a **room**. In the Custom Buttons pane, click **Add**.
   b. In the Add Screen dialog that appears, enter the name of the Custom Button, and then click **OK**.

   **Example**: Click **Theater** and call the Screen name **Media Scene**. Name Button 1: **On/Off**.

   The custom button name appears in the pane.

10. Click the **Programming** View.
11. In the **Device** Events pane, scroll down and click **Custom Buttons**. In the pane below, Custom Button Events, select the screen you want to program, and then select the **Press** radio button.

   **Example**: Select the screen **Theater - Media Scene**, and select the **Press** radio button.

12. In the Actions pane, select **Theater**.
13. In the Theater Actions pane under Conditionals, press the **Media Scene Active** button, and then the **True** button.
14. Drag the **blue question mark** to the **Script** pane.
15. In the Actions pane, scroll down and select **Media Scenes**.
16. In the Media Scenes Actions pane under Commands, press the **Deactivate** button, and then select **Party Music**.
17. Drag the **green arrow** on top of the **blue question mark** in the **Script** pane.
18. In the Actions pane, scroll up and select **Theater**. In the Theater Actions pane and in Conditionals, press the **Media Scene Active** button, and then the **False** button.
19. Drag the blue question mark to the Script pane.
20. In the Actions pane, scroll down and select Media Scenes. In the Media Scenes Actions pane and in Commands, press the Activate button, and then select Party Music.
21. Drag the green arrow icon on top of the blue question mark in the Script pane.

The Script pane now reads, "When custom button 'On/Off' on screen 'Media Scene' in Theater is pressed...Activate scene 'Party Music.'"

22. To execute the scene, click Execute.

3.5.6.10 Example: Program Using the Rhapsody Agent
Use the Control4® Composer Pro Agents view to activate or disable a Rhapsody agent.

Note: Rhapsody is a subscription-based music service that gives you unlimited access to a catalog of millions of full-length, CD-quality tracks. You can listen to whatever you want whenever you want, in any room of your house through the Control4 system.

3.5.6.10.1 Prerequisites
1. Ensure that a Rhapsody account has been set up. See "Register Your System" in Composer Pro Getting Started.
2. Ensure that the devices you want to use for Rhapsody output are added and identified to the system.

3.5.6.10.2 Procedure
To activate a Rhapsody agent:
1. Start Composer and connect to a Director.
2. Click Agents.
3. (Initial Rhapsody agent only) Click Add.
4. Select Rhapsody, and then click OK to add Rhapsody to the agent types list in the project.
5. With Rhapsody selected in the left pane, click **New**. The following dialog box appears in the right pane.

![Account Properties](image)

6. Enter your Rhapsody account name and password.
7. Click **Save**.
8. Click **Activate**.

To disable Rhapsody:
1. Start **Composer** and connect to a **Director**.
2. Click **Agents**.
3. Select **Rhapsody** from the agents list.
4. Select **Disable Rhapsody**.

3.5.6.11 Example: Program Using the Scheduler Agent

Use the Control4® **Composer Pro** Agents and **Programming** views to program this **agent**. The Scheduler agent lets you schedule time on the Control4 system to trigger specific events to occur. You can program a specific one-time **event** or multiple events to re-occur daily, weekly, monthly, yearly, etc.

**Example:** Schedule an event to play dad’s favorite song at 7:30 AM on his birthday.

3.5.6.11.1 Prerequisites
The following devices are added and identified (with a network address) in the project:

- **Controller**
- 3-Button Keypad

3.5.6.11.2 Procedure
To set up a Scheduler agent:
1. Start **Composer** and connect to a **Director**.
2. Click **Agents**.
3. In the Agents pane, click **Add**.
4. Select **Scheduler** in the Agents list, and click **OK**.
5. In the Agents pane, select **Scheduler**. The Scheduler panes appear.
6. In the Scheduler pane, click New.

7. In the New Event dialog, enter the relevant information for this Scheduler instance:
   a. In Name: type Dads Birthday.
   b. In Time, add the following:
      - Select the Time radio button.
      - Highlight the hour: 07, minutes: 30, and AM. Use the drop-down menu to select each time separately.
      - Select Sunrise/Sunset, and choose Sunrise from the drop-down menu.
   c. In Start Date, select one of the following:
      - Select the Start on radio button. Use the drop-down menu to select today's date.
      - Select the Start on the radio button to choose an exact day, month, and year. Use the drop-down menus to make your selections.
   d. Select Repeats.
      - Select Yearly.
      Example: You want dad’s favorite song to play at 7:30 AM. This dialog lets you schedule one-time events and recurring events.
      - Select Stop on, and use the drop-down menu to select a month and year to stop this agent.
   e. Click OK. The event is now added to the list of events.
   f. To delete an event, select the event in the list, and click Delete.

8. Click Programming.

9. In the Device Events pane, select the Scheduler object at the bottom of the list.

10. In Scheduler Events, click Dads Birthday event. The Script pane shows Dads Birthday event.

11. Choose the Device Actions to initiate in the Actions panes.

12. Drag the actions to the Script pane. These scripted actions execute when the Dad’s Birthday event executes.

13. You can use the Scheduler agent in Programming also to add Conditionals or Loops to your scripts.
14. In the project tree, select the **3 Button Keypad**.
   a. In the Actions pane, scroll down and select the **Scheduler** agent.
   b. Click the **Conditionals** tab, select **Time**, and **Within 5 minute(s) Before Sunset**.
   c. Drag the **blue question** mark to the Script pane.
   d. In the **project tree**, select the **light**.
   e. In the **Commands** tab, select **turn the room on**, and drag the **green arrow** on top of the **blue question** mark in the Script pane.

**Results:** When the top button on the 3-Button Keypad is pressed, if it is within 5 minutes before sunrise, the light comes on. The Scheduler Agent lets you define one-time events and recurring events.

### 3.5.6.12 Example: Program Using the Screen Saver Agent

Use the Control4® Composer Pro Agents view to set up a Screen Saver agent.

#### 3.5.6.12.1 Prerequisites

Ensure that the devices you will use to set up a screen saver and store your photos (for example, a network-attached storage) are added and/or identified to the Control4 system.

#### 3.5.6.12.2 Procedure

**To set up a Screen Saver agent:**

1. Start **Composer** and connect to a **Director**.
2. Click **Agents**.
3. (Initial Screen Saver agent only) Click **Add**.
4. Select **Screen Saver**, and then click **OK** to add Screen Saver to the agent types list in the project.
   The next time you want to create a Screen Saver, click the **Screen Saver** item in the Agents pane, and then click **New**.
5. With Screen Saver selected in the left pane, click **New**.
6. From the drop-down menu, select the **File Storage Location**.
See also:

“Setting Up the Photo Screen Saver Option”
“Setting Up Custom Screen Saver”
Control4 System User Guide

3.5.6.13 Example: Program Using the Timer Agent

Use the Control4® Composer Pro Agents and Programming views to program this agent. The Timer agent lets you start, stop, or repeat a timer based on a given event and action.

Example: A Motion Sensor turns on a light when it detects motion; use a timer to turn off the light after 15 minutes. Alternatively, you can set a timer to repeat an action whenever the timer expires, such as a Bathroom fan that restarts each time the Bathroom light turns on.

3.5.6.13.1 Prerequisites

The following devices are added and identified (with a network address) in the project:

- Controller
- Any device involved in the triggering event (e.g., a Motion Sensor)

3.5.6.13.2 Procedure

To set up a Timer agent:

1. Start Composer and connect to a Director.
2. Click Agents.
3. Add Timer to the list of types of agents in this project:
   a. Select Timer.
   b. Click New.
   c. Click OK.
4. Type the name of the new timer (for example, Bathroom Fan), and click Create.
5. In Interval, use the drop-down menu to set the timer in seconds, minutes, or hours (hh:mm:ss), and click OK.
6. Click Start to start the timer.
7. Click Programming.
8. Select the Timer Action in the Actions pane, and ensure the new timer options display in the Commands tab (Start, Stop, Reset, and Change).
9. Start, Stop, Restart, or Change the timer as needed.

The following table outlines how the timer behaves depending on the state of the timer when a command is executed.
### Command Execution Table

<table>
<thead>
<tr>
<th>Command Executed is...</th>
<th>Time is...</th>
<th>Then Event</th>
<th>Effect on Timer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Running</td>
<td>None</td>
<td>Restarts</td>
</tr>
<tr>
<td>Reset</td>
<td>Stop and Start</td>
<td>Start</td>
<td>Restarts</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop</td>
<td>Start</td>
<td>Starts</td>
</tr>
<tr>
<td>Start</td>
<td>Not Running</td>
<td>Start</td>
<td>Starts</td>
</tr>
<tr>
<td>Reset</td>
<td>Start</td>
<td>Stop</td>
<td>Stops</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop</td>
<td>Stop</td>
<td>Stops</td>
</tr>
</tbody>
</table>

- When you program to execute a **Start** command on a timer when a timer is running, no event is fired and the time is restarted.
- When you program to execute a **Start** command on a timer when the timer is not running, the **Start** event is fired and the timer starts.
- When you program to execute a **Restart** command on a timer when a timer is running, the Stop and Start events are fired and the time is restarted.
- When you program to execute a **Restart** command on a timer when a timer is not running, the **Start** event is fired and the time is restarted.

### Programming Example

10. Program to connect the timer to an event and action, and choose to **Start**, **Restart**, or **Stop** the timer.

See the example programming screens that follow. Notice how the timer is first used as an action, and then as an event.
Event Screen:

Action Screen:
3.5.6.14 **Example: Program Using the Variables Agent**

Use the Control4® Composer Pro Agents view to set up a Variables agent. Ensure that the devices you want to use for variables are added and identified to the system.

These sections provide information about how to create the type of variable that you want to use in programming.

"Example: Using Room Variables"
"Example: Using a Custom Variable Agent Number"
"Example: Using a Custom Variable Agent String"
"Example: Using Custom Variables Agent Boolean"

3.5.6.15 **Example: Program Using the Video Wall Agent**

Use the Control4® Composer Pro Video Wall agent to create a Video Wall for simultaneous viewing and control of multiple video sources on multiple displays. A video wall is commonly used for viewing multiple sports or news channels in the same room. It incorporates multiple video displays and multiple cable/satellite tuners equipped with Digital Video Recorders (DVRs). The agent provides the ability to control these multiple video displays with the use of the Wireless Touch Screen.

**Note:** The UI for the Video Wall is not completed for OS 2.0 Navigators. If this is important, keep at least one Legacy Navigator active that uses the older UI.

**Example:** You can have a Video Wall with multiple video displays (center, left, and right) and the same number of satellites with the same functionality, service, and set of channels. You can use the Video Wall for replaying sports, news, or any user-specified set of channels, including full-control of the Video Wall through a single interface—the 10.5" Wireless Touch Screen.

The following hardware is required to use the Video Wall agent:

- **Controller and Navigator**—Control4 Home Controller and 10.5" Wireless Touch Screen.
- **Video displays**—One center and multiple auxiliary displays. A total of three (3) displays are supported, including screens, televisions, and video monitors.
- **Video sources**—Cable/Satellite tuner for each monitor. Each must provide the same broadcast on the same channel, e.g., ESPN is on Channel 110. For instance, each must have DVR capability.
- **Video switching capability**—The video source received on each video display can switch between each of the video displays. This traditionally is done using a video switching device, but can be accomplished using modulators also.
- **Audio output capability**—A mechanism to provide audio signal output for the center display. This is accomplished through the use of receivers and speakers.

**Example:** The following configuration steps include: 3 Televisions, 3 Satellite systems, 1 Receiver, and 1 Controller as shown next.
3.5.6.15.1 **Procedure**

To add a Video Wall:

1. Add and configure all applicable devices to the system required for the Video Wall.

   In Composer Pro, when you add the second or third monitor to the project, add them to a separate Room object. This physical device still exists in the same room, but the Television object must reside in a separate Room object in the project.

   **Example**: Assuming that the first television is in the Theater room, add two (2) rooms: Theater-right and Theater-left. Place a Television-right and the Television-left in each room.

2. Click **Connections**.

3. In Connections, ensure that all the Network, Control/AV, and Room connections are configured.

   **Example**: Make the following connections for the example system:
   - **Network**—At the Network tab, identify the Controller to the network.
   - **Control**—At the Control/AV tab, make a control connection to the Controller for every piece of AV equipment. These connections in the Composer Pro software should mirror the actual connections.
   - **AV**—At the Control/AV tab define the connections between the AV equipment by making the appropriate connections between device objects. These connections in the Composer Pro software should mirror the actual connections.

4. In the Agents pane, click **Add**.

5. On the dialog that appears, select **Video Wall** and click **OK**.

6. In the Agents pane, select the **Video Wall**.

7. In the Ultimate Sports Agents pane and in the Channel pane, select the **channels** you want available. Click **Add** to add them to the “Display these channels List.” This is similar to adding them to a “Favorite’s” list. The list you create is used for each monitor.
8. Using the three (3) panes at the bottom, use the pull-down menus to select the Location, Video Source, and Starting Channel for each monitor.

3.5.6.16 Example: Program Using the Wakeup Agent

Use the Control4® Composer Pro Agents and Programming views to program this agent. The Wakeup agent lets you set wakeup times, lighting, music, and so on.

Note: Wakeup times set in Composer Pro synchronize with the Navigators. Likewise, wakeup times changed on the Navigators will synchronize with Composer.

Example: At a user-specified time in the Navigators, start playing music from a CD in the Bedroom, and move the light progressively from 10 to 70 percent light level in 15 minutes. Thirty (30) minutes before wakeup starts, adjust the temperature in the room to 72 degrees. After 15 minutes of playing music, turn on the TV and broadcast the Local News.

3.5.6.16.1 Prerequisites

The following devices are added and identified (with a network address) in the project:

- Controller
- Digital Audio (ensure that you can play music in the project)
- Bedroom Dimmer
- Gas Fireplace

3.5.6.16.2 Procedure

To set up a Wakeup agent:

1. Start Composer and connect to a Director.
2. Click Connections.
3. Make sure the connections are correct. Example: From the Control & Audio Video Connections tab, ensure that the Gas Fireplace is connected to Relay Port 1.
4. Schedule a Wakeup time (see “Example: Program Using the Scheduler Agent”).
5. Click Agents.
7. Select Wakeup > OK.
9. In the Wakeups pane, click New.
10. On the dialog that appears, enter a name. Example: Bedroom Wakeup.
11. Click Create.
12. Enter **Wakeup Scene 1** information.

- **Media**—Click **Pick Media** (default). Use the drop-down menu to select **Albums**, and then click a particular album and song you want to play when the Wakeup starts, such as Norah Jones 'Sunrise.' Set the desired volume using the scrollbar or the drop-down menu.

- **Lights**—Use the scrollbar or enter the Light Level to 70; use the drop-down menu to set the **Ramp Rate** to 15 minutes.

- **Temperature**—Set the temperature to 72 degrees F to come on 30 minutes before wakeup starts.
13. Enter **Wakeup Scene 2** information.
14. **Scene 2**—Check **Wakeup Scene 2** and set the Start time to 15 minutes after *Wakeup Scene 1*. Set the desired volume for *Scene 2* using the scroll bar or drop-down menu.
   - **Media**—Click **Choose Media** and use the drop-down menu to select **Broadcast Video**. Then, select a local channel, such as **4-KTVX** and click **OK**. Select Volume at **70**.
   - **Lights**—**Uncheck** the box to make no changes for **Wakeup Scene 2**.
   - **Temperature**—**Uncheck** the box to make no changes for **Wakeup Scene 2**.

15. Click the **Programming** view.

   **Note**: Your scene saves automatically even when you leave the Agent view.

16. In the Device Events pane, scroll down to view the available agents.
17. Select the **Scheduler** agent and **Scheduled Event**.
   The agent event appears at the top of the Script pane.
In the Actions pane, scroll to the bottom to see the available agents.


19. In the Commands tab, do the following:
a. In the Wakeup Actions pane, select the **Wakeup** scene you want to use, such as **Bedroom Wakeup**.

b. In 'Location to play scene,' select the location to play the scene, such as **Bedroom**.

20. Drag the **green arrow** to the Script pane.
21. When you are finished, click **Execute** in the Script pane.

To add a device to the Wakeup scene:

1. In the **project tree** > Device Events pane include additional devices in your wakeup. Scroll to the bottom of the project tree to the devices, rooms and other information about the project.
2. Select the **Wakeup** agent again.
3. In Wakeup Events, select the **Bedroom Wakeup**. The Wakeup event appears at the top of the Script pane.
4. In the Device Actions pane, select the **device** to trigger actions when the Wakeup event occurs. For example, select **Fireplace**.
5. In the **Command** tab, select the **On** radio button. The **action** appears in the Actions pane.
6. Drag the **green arrow** to the Script pane.
7. Click **Execute** to execute the command.

**Bedroom Wakeup Example**

At a user-specified time in the Navigators:

- Thirty minutes prior to wakeup time, the temperature rises to 72 degrees.
- The album of choice starts playing at 6:45 AM.
- Lights should start ramping up to 70 percent light level by 7:00 AM.
- The fireplace turns on.
- In 15 minutes, Wakeup Scene 2 begins.
- The local news turns on at 7:00 AM.
- The Wakeup is complete.
Note: Users can schedule the wakeup time from their Navigators, such as Touch Screen, On-Screen, or Mini Touch Screen. See the product documentation or the Control4 System User Guide for more information about how to schedule the wakeup time from the Navigators.

Tip: Some homeowners may want a Wakeup agent executed Monday through Friday, but not on the weekends. To turn off Wakeup for weekends, turn it off as a programmable event not to execute on weekends.

3.5.7 Other Programming Tasks

3.5.7.1 Programming Using Find and Replace

The Control4® Composer Pro Find and Replace programming feature lets you find one device already programmed and replace it with another.

Example: You want Button 1 on your 6-Button Keypad to turn on all the Dimmers in your Control4 system. Currently, Button 1 is programmed to turn on all the Lights in your system. Use the Find and Replace programming option to replace the lights with Dimmers in your programming.

3.5.7.1.1 Procedure

To program using the Find and Replace feature:
1. Start Composer and connect to a Director.
2. Click Programming.
3. In the Script pane, right-click and select Find and Replace. A Find and Replace dialog appears.
4. Replace the programming device object with the one you want.
   Find what: **Theater > Theater Light**
   Replace with: **Theater > Theater Dimmer**.

5. Click **Replace**. The statement in the Script pane changes to the replacement script.
6. Repeat for each line in the Script pane.
   Find what: Bedroom > Bedroom Light
   Replace with: Bedroom > Bedroom Dimmer
   Find what: Front > Front Light
   Replace with: Front > Front Dimmer

   When you complete this process, the script reflects that you have changed all the lights in your Control4 system to Dimmers.

3.5.7.2 Programming Using Copy and Paste
   The Control4® Composer Pro copy and paste programming feature lets you copy the programming you configure from one device and paste it to another device. By creating the same command, loop, or conditional for a device, you can copy it for use in another programming script.

   Example: You want all of the lights in the Control4 system and the fireplace to turn on by pressing Button 1 on the 6-Button Keypad. When you press Button 4, you want to turn all the lights on in the system except in the Master Bedroom. In this example, you can copy the first set of actions into the second set and not include the Master Bedroom.
3.5.7.2.1 **Procedure**

To program the 6-button Keypad:

1. Start **Composer** and connect to a **Director**.
2. Click **System Design**.
3. Ensure that you have the following devices added and connected to the Control4 system:
   - Controller
   - Gas Fireplace
   - Master Bedroom Dimmer
   - 6-Button Keypad
4. Click **Programming**.
5. Select **6-Button Keypad** in the *project tree* of the Device Events pane.
6. In 6-Button Keypad Events, push **Button 1**, and select the **Press** radio button.
7. In the Device Actions pane, scroll down and select **Dimmer**.
8. In the Dimmer Actions pane, click the **Commands** tab, and click the **On** radio button.
9. Drag the **Dimmer Action green arrow** to the Script pane.
10. Repeat Steps 1 through 9 for all the lights in your system and your fireplace. This includes the **Light Switch** and Dimmer in the Theater, and the Dimmer and the Gas Fireplace in the Bedroom.
11. Move to the Script pane, and right-click. Select **Copy** from the options. This automatically copies all arrow statements in the pane.

12. Click **Button 4** in the 6-Button Keypad Events pane, and then select the **Press** radio button.
13. Right-click in the Script pane, and select **Paste**. The programming of the lights shows up in the Script pane for Button 4.
You have completed Copy and Paste Programming. Now you can edit the Button 4 Script as needed.

**Example:** You can remove the Bedroom Dimmer from Button 4 Script, so when you push Button 1 all the lights in the system come on; and when you push Button 4, all the lights come on except for the Dimmer in the Bedroom.

**Tip:** This feature is very useful when programming complex loops and conditionals.

3.5.7.3 **Programming Using IR Inputs with Third-Party Remotes**

Some popular programmable remote controls are available on the market, such as the Phillips Pronto, Harmony Remote, or MX3000 that consumers of home theater and home control systems enjoy. These and any other programmable remotes are now supported in the Control4® system.

3.5.7.4 **Guidelines**

1. **Published list of Control4 IR Input codes.** To use one of these programmable remote controls with the Control4 system, Control4 has a list of Control4 IR Input codes on the Control4 system. See the table, 'IR Input Values and Commands,' at the end of this section for a list of supported IR custom commands and their values. The Control4 IR Input codes are available online at http://www.control4.com/. From this list, you can copy and paste the codes for your programmable remote control.

2. **The Control4 system is based on rooms.** This comprehensive Control4 IR Input code list provides all currently supported device codes included in the Control4 system. The Control4 system’s Navigators are room based. For example, a Touch Screen is configured to change control of devices in a particular room. Other Control4 Navigators include System Remote Control, Wireless Touch Screen (10.5”), On-Screen Navigator (viewable on a television), etc. Each Navigator is configured to exist in the context of a room in a Composer Pro-created project. The Navigator’s codes are then sent to the Control4 system in the context of the room while using the same set of IR Input codes.

3. **Sets of commands for rooms 1 through 15.** The Control4 IR Input codes contain one complete set of command codes for every room (rooms 1 through 15 supported). You can program up to 15...
rooms. Each set of codes includes a mask code that associates the remote to a particular room. **Example:** You can program a remote for use in a Living Room using mask code 1. Then you assign Mask 1 to the Living Room. This lets you use the particular remote in the Living Room.

4. **Set of commands for global use.** A global mask is available (mask 0 or None) that overrides the mask code (1 through 15) in any room. **Example:** You can use a remote programmed with mask 0 in any room where remotes are programmed to one of the masks (1 through 15). Remotes programmed using masks 1 through 15 are only for use in the assigned room.

5. **Assign a mask number for each room.** When setting up the remote, assign the mask number for that room in the Room Properties. Access Room Properties in the System Design view by right-clicking a room, selecting the Miscellaneous tab, and in Multi-Room Shared IR Settings.

6. **IR receiver requirement for each room with a third-party remote control.** Place an IR receiver in the room where you plan to use the third-party remote. The **Controller** and the Home Theater Controller both have IR receiver windows built into the front panel. You can also purchase third-party IR receivers which attach to the four (4) IR Input ports on the back of the Controller. You can connect up to 15 IR Receivers into one (1) IR Import Controller port.

7. **Configure each IR receiver as an IR receiver for a specific room.** The room is assigned to an IR mask on the Properties page for that room which automatically assigns it to the device in the room that handles IR receiving, such as a Controller, Home Theater Controller, or third-party IR receiver.

8. **Various configurations and implementations supported.** The IR code sets allow various configurations. The Controller has four (4) ports on the back that can potentially support up to 15 rooms. This means that one (1) Controller can support 60 rooms from the back four (4) ports, and one (1) room from the front IR receiving window. The Home Theater Controller has one (1) front IR receiving window so it can only support one (1) room. If needed, you can stack the Controllers to support additional rooms as necessary.

### 3.5.7.5 Procedure

**To use Control4 IR Input codes for programming third-party remote control devices:**

1. Plan where remote controls will be used in the house or site. Each room is assigned a mask number. You can program the rooms using a different mask number for up to 15 rooms.

   **Example:**
   - Master Bedroom - Mask 0
   - Theater Room - Mask 1
   - Family Room - Mask 2
   - Bedroom 1 - Mask 3
   - Bedroom 2 - Mask 4
   - Bedroom 4 - Mask 5

2. Using the IR Input codes provided at [http://www.control4.com](http://www.control4.com) in an XML file, program the third-party remote by copying and pasting the codes. **Note:** The room mask is included in the individual codes in each set.

   **Example:**
   - Program Remote Controls using the codes associated with the mask:
     - Master Bedroom (Global Remote) - Mask 0
     - Theater Room (Remote 1) - Mask 1
     - Family Room (Remote 2) - Mask 2
     - Bedroom 1 (Remote 3) - Mask 3
3. In the Composer Pro project and the System Design view, select a room and click the Miscellaneous tab.

4. In Multi-Room Shared IR Settings, use the pull-down menu to select the IR Room Mask number (None through 15).

![Image of Composer Pro interface showing Miscellaneous tab and Multi-Room Shared IR Settings]

<table>
<thead>
<tr>
<th>Room Mask</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not Defined</td>
</tr>
<tr>
<td>1</td>
<td>PLAY</td>
</tr>
<tr>
<td>2</td>
<td>STOP</td>
</tr>
<tr>
<td>3</td>
<td>PAUSE</td>
</tr>
<tr>
<td>4</td>
<td>SKIP_FWD</td>
</tr>
<tr>
<td>5</td>
<td>SKIP_REV</td>
</tr>
<tr>
<td>6</td>
<td>SCAN_FWD</td>
</tr>
<tr>
<td>7</td>
<td>SCAN_REV</td>
</tr>
<tr>
<td>8</td>
<td>RECORD</td>
</tr>
<tr>
<td>9</td>
<td>Not Defined</td>
</tr>
<tr>
<td>10</td>
<td>NUMBER_0</td>
</tr>
<tr>
<td>11</td>
<td>NUMBER_1</td>
</tr>
<tr>
<td>12</td>
<td>NUMBER_2</td>
</tr>
<tr>
<td>13</td>
<td>NUMBER_3</td>
</tr>
<tr>
<td>14</td>
<td>NUMBER_4</td>
</tr>
<tr>
<td>15</td>
<td>NUMBER_5</td>
</tr>
<tr>
<td>16</td>
<td>NUMBER_6</td>
</tr>
<tr>
<td>17</td>
<td>NUMBER_7</td>
</tr>
<tr>
<td>18</td>
<td>NUMBER_8</td>
</tr>
<tr>
<td></td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>96</td>
</tr>
</tbody>
</table>

- HOUSE: 117
- PAGE_UP: 118
- PAGE_DOWN: 119
- INFO: 120
- RECALL: 122
- PVR: 123
- GUIDE: 124
- CONTROL4: 125
- CANCEL: 121
- NOT_DEFINED: 0
- PULSE_SUR_UP: 128
- TUNE_UP: 131
- TUNE_DOWN: 132
- SEARCH_UP: 133
- SEARCH_DOWN: 134
- PRESET_UP: 135
<table>
<thead>
<tr>
<th>Key</th>
<th>Definition</th>
<th>Code</th>
<th>Definition</th>
<th>Code</th>
<th>Definition</th>
<th>Code</th>
<th>Definition</th>
<th>Code</th>
<th>Definition</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>NUMBER_9</td>
<td>58</td>
<td>Not Defined</td>
<td>97</td>
<td>Not Defined</td>
<td>136</td>
<td>PRESET_DOWN</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Not Defined</td>
<td>59</td>
<td>Not Defined</td>
<td>98</td>
<td>Not Defined</td>
<td>137</td>
<td>MUTE_ON</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Not Defined</td>
<td>60</td>
<td>Not Defined</td>
<td>99</td>
<td>Not Defined</td>
<td>138</td>
<td>MUTE_OFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>STAR</td>
<td>61</td>
<td>Not Defined</td>
<td>100</td>
<td>Not Defined</td>
<td>139</td>
<td>MUTE_TOGGLE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>POUND</td>
<td>62</td>
<td>Not Defined</td>
<td>101</td>
<td>Not Defined</td>
<td>140</td>
<td>Not Defined</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>HYPHEN</td>
<td>63</td>
<td>Not Defined</td>
<td>102</td>
<td>ROOM_OFF</td>
<td>141</td>
<td>Not Defined</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>DASH</td>
<td>64</td>
<td>Not Defined</td>
<td>103</td>
<td>Not Defined</td>
<td>142</td>
<td>Not Defined</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>ON</td>
<td>65</td>
<td>Not Defined</td>
<td>104</td>
<td>CH_UP</td>
<td>143</td>
<td>BASS_UP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>OFF</td>
<td>66</td>
<td>Not Defined</td>
<td>105</td>
<td>CH_DOWN</td>
<td>144</td>
<td>BASS_DOWN</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Not Defined</td>
<td>67</td>
<td>Not Defined</td>
<td>106</td>
<td>VOL_UP</td>
<td>145</td>
<td>TREBLE_UP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Not Defined</td>
<td>68</td>
<td>Not Defined</td>
<td>107</td>
<td>VOL_DOWN</td>
<td>146</td>
<td>TREBLE_DOWN</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>PULSE_INPUT</td>
<td>69</td>
<td>Not Defined</td>
<td>108</td>
<td>MENU</td>
<td>147</td>
<td>BALANCE_UP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Not Defined</td>
<td>70</td>
<td>Not Defined</td>
<td>109</td>
<td>BACK</td>
<td>148</td>
<td>BALANCE_DOWN</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Not Defined</td>
<td>71</td>
<td>Not Defined</td>
<td>110</td>
<td>Not Defined</td>
<td>149</td>
<td>LOUDNESS_ON</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Not Defined</td>
<td>72</td>
<td>RADIO</td>
<td>111</td>
<td>ENTER</td>
<td>150</td>
<td>LOUDNESS_OFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Not Defined</td>
<td>73</td>
<td>MUSIC</td>
<td>112</td>
<td>TV_VIDEO</td>
<td>151</td>
<td>LOUDNESS_TOGGL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Not Defined</td>
<td>74</td>
<td>TV</td>
<td>113</td>
<td>UP</td>
<td>152</td>
<td>PULSE_ASPECT_RATIO</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Not Defined</td>
<td>75</td>
<td>VIDEOS</td>
<td>114</td>
<td>DOWN</td>
<td>153</td>
<td>PIP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Not Defined</td>
<td>76</td>
<td>PICTURES</td>
<td>115</td>
<td>LEFT</td>
<td>154</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Not Defined</td>
<td>77</td>
<td>LIGHTS</td>
<td>116</td>
<td>RIGHT</td>
<td>155</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4. Glossary

4Sight: An Internet service that provides a connection to the Home-Automation System any time and from any place worldwide.


action: An activity that occurs when an event prompts it to do so.

agent: In Control4 programming, agents provide the ability to perform complex programming by using functional modules. There are various types of agents; for example, Announcements, Email Notifications, Scheduler, Lighting Scenes, Wakeup, etc.

AV: Audio Video

Boolean: The computer logic used to determine if a statement is ‘True’ or ‘False.’

button-link binding: The LED colors used based on the device; the Installer can set these colors independently from the device to which the colors are bound.

CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4 products.

client: A software or hardware device that communicates to a server for feedback from the server via an application for the user.

Command: A ‘do’ statement; actions the Director communicates to a device.

Composer: The Control4 software used to design and define a Control4 Home-Automation System.

Composer Pro: Composer is used to set up and configure Control4 devices to communicate with each other in a Home-Automation System.

conditional: An ‘if’ statement that asks a true/false questions which are acted upon in Composer programming.

configuration worksheet: Used in Composer software training to design and configure a project in Composer.

connection: Binding or linking devices together in Composer so they can communicate with each other.

contact: Contacts are generally used to monitor the status of something (door, window, water sensor, etc.) and can be hooked up through a security panel or directly using a Control4 Controller or Contact/Relay Extender. Contacts connected to a Control4 Controller or Contact/Relay Extender can be configured either as NC (normally closed) or NO (normally open).

Control4 system: A Home-Automation System designed and developed by Control4.

Controller: The main device that makes Home Automation possible. There may be multiple Controllers within a Control4 system. The Controller that runs Director is referred to as the Primary Controller.

Cover Art: An illustration of the cover of a DVD or CD album that displays in the Graphical or On-Screen Navigators when playing music or watching videos.

CSV: comma-separated value. Can be used when adding media to a Control4 system.
device: A component that requires a device driver; code that is used to allow the Control4 system to work with that device.

device driver: Every device in the Control4 system needs a corresponding device driver to control the device.

DHCP: DHCP (Dynamic Host Configuration Protocol) - A protocol used between a network client and a DHCP server (usually a router or access point) that dynamically assigns IP addresses from a pre-defined list to clients on a network.

Director: Each Control4 Controller (such as a Home Controller HC-500) ships with pre-installed Director software (Linux based) embedded in the device. The Director communicates with Control4 products and third-party products to enable Home Automation and interaction of individual devices. Director runs the Control4 devices. Composer Pro is the software used to connect to and program a system Director that resides on a Controller.

DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-AV devices.

DVD: (Digital Versatile Disc) – A media format for video and data storage.

end point: The end point is the final point (device) on the defined path over which audio and/or video content is routed to a room. An example of this would be a TV or Receiver.

Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star network topology that allows multiple points to communicate to a single point. The Speaker Point® and Mini Touch Screens use Ethernet to communicate to the Control4 Controller.

event: An action; used to trigger Composer programming when programming Control4 devices.

file format: A format used by applications to store/read files.

FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in quality.

full duplex: The simultaneous transfer of data in both directions. For example, on a Touch Screen the caller can send out a call and the receiver on the other end of the call can answer via his or her Touch Screen and then respond.

gateway: (router)- Provides a means of communicating between two separate networks.

home network: A network installed in the customer’s home that provides an Ethernet or wireless connection so that Control4 devices can communicate with each other.

Home-Automation System: The Control4 system: a line of Home Automation products that communicate with each other over Ethernet, WiFi, or ZigBee for a total Home Automation experience.

Interviewer Wizard: An automated setup program in Composer that builds a project for Home Automation.

IR: A device controlled using a wireless remote control device. Commands are sent via pulses of infrared light to the device.

keypad managed: On a Keypad, the LED state is controlled by the buttons on the Keypad.
keypad unmanaged: On a Keypad, the LED state of the buttons is controlled through programming rather than from the Keypad buttons.

L

LCD: (Lighted Crystal Display) - A display used with some Control4 interfaces.

LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen.

Linux: An operating system used by several Control4 devices.

List Navigator: A System Remote Control device uses a Navigator that lists the options.

Live Connection: A term used in Composer Pro to indicate an actual connection to the network.

Loop: A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers are on…”

M

Media Manager: Media information is stored in the Media Manager database, which will permit users to view the media information from the Navigators.

MP3: A music format that makes streaming audio available.

Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc. Navigator is software that the customer interacts with using a Universal Remote Control, On-Screen Navigator, Touch Screen, or LCD Screen.

N

On-Screen Device: Allows you to select the controller (Media Controller or Home Theater Controller) in the room that controls the source for the on-screen display.

P

playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or any combination.

Power Over Ethernet (POE): A Control4 device that is Ethernet controlled.

programming: A machine-readable artificial language used to express computations that can be performed by a device.

project tree: A tree view in Composer where the project is layered by the larger branches (Home, Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

R

ramp rate: The rate that a Dimmer ramps up its voltage.

relay: An electrical switch that opens and closes. A relay is controlled by another electrical circuit.

remote access: The ability to access a device from a remote location.

Remote Director: Connects you to the home network while working in Composer from a remote location.

retrofit: The ability to set up a Home-Automation System in an existing structure or home. Compare this with new building construction.

RJ-45 jack: An eight-pin jack used to connect CAT5e network cables to devices through Ethernet signals.

router: See gateway. Functions similar to an AP but with additional functionality for controlling the network; for example, coordinating traffic between different networks.
serial-controlled device: Serial-controlled devices with an RS-232 interface and control protocol often have a higher level of controllability than IR-controlled devices. Examples of serial-controlled devices are projectors, multi-disc DVD changers, etc.

switch: An extension of a router that adds more Ethernet ports to support additional devices or clients on the local network.

system event: An action that causes another action; for example, if a projector turns on, it enables the other devices in the system that work with the projector.

system remote: System Remote Control

System Remote Control: A Control4 System Remote Control is a universal solution that replaces System Remote Control devices from other manufacturers, and includes programmable buttons. This System Remote Control can access on-screen (Graphical) Navigators.

Touch Screen: A Touch Screen is a Home-Automation System Navigator that controls the home's lighting, music, videos, and other devices on the Home-Automation System.

UI (user interface): The preferred term is Navigator. The Control4 interface used with Control4 devices to control Home Automation, such as Touch Screens or On-Screen Navigators.

universal remote: Universal remote control. A third-party remote control that can be programmed to replace other remotes in the home so that only one remote is needed, replacing all others. Control4 System Remote Control devices are a type of universal remote control.

USB: Universal Serial Bus) - A format used with USB sticks that plug in to a USB port on Control4 devices.

Virtual Connection: A term used in Composer Pro to indicate a connection outside the network.

Virtual Director: A connection to a virtual Controller only (a PC is the Director host rather than the Controller). Projects created or edited here are benign until the saved project is loaded onto a Controller.

WAP: Wireless Access Protocol. The protocol used to enable wireless access of Control4 devices.

WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices “connect” to each other by transmitting and receiving signals on a specific frequency of the radio band using a wireless access point. This technology uses the star network topology. WiFi uses high bandwidth 802.11.

wired network: Uses Ethernet Category 5 (CAT5) wiring to send and receive data between devices connected to a network.

wireless access point: A router extension with an antenna that communicates with WiFi devices and clients in the home. A wireless hub that connects to the wired network, and distributes the wireless signal.

Wireless Switch: Uses the ZigBee. UL listed dimmer. Single or multi-gang. Has an air gap to cut power.

WLAN: Wireless local area network.

WMA: (Windows Media Audio) – Audio data compression technology developed at Microsoft; an audio file format that competes with MP3.
Z

**ZigBee:** A wireless network that uses bi-directional wireless mesh network technology to transfer messages from one device to another. Unlike a star network topology where devices can only send messages to each other by sending them first to a single central device (which then delivers the message to the recipient device), a mesh network topology allows the devices to forward messages from one device to another, thereby extending the effective range of the network. Uses low bandwidth 802.15.4. 250 devices are allowed per controller but Control4 recommends 125.

**ZigBee Pro:** The 1.1 version of ZigBee that provides improvements in standardization by: allowing more interoperability with other Control4 devices, support for home automation profiles, and improves the scalability of multiple ZigBee access points.

**Zserver:** A ZigBee server that contains software which runs on a Control4 HC-class Controller.
5. Index

1.8.2 update, 129
10" Wall Mount Touch Screen, 15
10.5" Wireless Touch Screen V1, 15
2, 3, 6-Button Keypad
  change LED colors, 62
  configure, 54
  Properties, 55
3-way lights
  configure, 72
  configure 2-Button Keypad for, 72
  configure 3-Button Keypad for, 73
4-Zone Amp
  configure, 36
  Properties, 38
7" Portable Touch Screen
  configure, 95
  Properties, 96
7" Tabletop Touch Screen
  configure, 96
  Properties, 97
AAC, 14
Actions pane
  programming, 287
Advanced Device Configuration, Thermostat, 110
Advanced Properties
  Wireless Dimmer, Switch, 19
Agent
  Announcements, 330
  Custom Buttons, 333
  E-Mail Notification, 337
  Intercom, 339
  Lighting Scenes, 342
  Macro, 345
  Media Scenes, 347
  Rhapsody, 350
  Scheduler, 351
  Screen Saver, 353
  Timer, 354
  Variables, 357
  Video Wall, 357
  Wakeup, 359
Agents
  program, 329
AMG media lookup service, 16
Announcement agent, 329
Audio End Point, 236
Audio Matrix Switch
  configure, 32
Audio switch
  add, 275
Audio Switch
  configure, 34
Audio Volume, 236
Auxiliary Stage, Thermostat, 111
Auxiliary Stages, Thermostat, 112
AV devices
  configure, 32
AV products, 15
AV Switch
  configure, 34
Back up system, 127
Black & Decker lock
  configure, 113
  Properties, 115
  update firmware, 124
Bookmarks
  program, 301
Boolean variable, 308
Break command, 293, 296
Broadcast message, Intercom, 98
CBM Flash Disk
  and Photo Screen Saver, 117
CD
  add, 267
  edit, 278
CD information
  edit, 266
Celsius, 108
CFL Load
  Wireless Dimmer, 60
Change location, 164
Cold Start Level
  Wireless Dimmer, 60
Cold Start Time
  Wireless Dimmer, 60
Commands
  programming, 291
  using Delay, Stop, Break, 293
Composer Pro
  advanced sections, 7
  basic sections, 7
  basic tasks, 8
  check version, 127
  defined, 7
  purpose, 7
  update, 121

Copyright © 2010 Control4. All Rights Reserved.
Composer Views Method
example, 145
Conditional
program, 302
Configure 5” or 7” In-Wall Touch Screen, 97
Configure properties, 18
Connection
audio and video, 230
control, 230
IP Network, 230
network, 230
room, 230
verify, 230
verify network, 241
WiFi, 240
Connections
test, 247
update when location changes, 246
Contact Information, 2
Contact Relay Extender, 15
Container variables, 308
Control and AV Connection
define, 232
verify, 244
Control and AV Connections, 243
disconnect, 244
example, 163, 232
re-assign, 245
Control/AV connections
disconnect, 164
re-assign, 164
Control/AV tab, 66, 243
Control4 web site, 122
Controller
configure, 24
troubleshoot, 167
Controller Networking, 175, 178
Controller Performance
view, 177
Controller properties, 28
Controllers
configure multiple, 29
Cooling Cutoff Point, Thermostat, 111
Cooling system
configure, 104
Copyright, 2
CPU Usage, 177
Create script
programming, 289
Custom Buttons agent, 329
Custom variables, 308
Delay command, 293
Design project
example, 145
Device
cannot identify, 170
connect to the network, 239
Device control
test, 247
Device Control window
device examples, 248
Device driver
create, 196
create 2-way serial, 228
create TCP/IP controlled, 228
edit, 200
export for projects, 229
use new driver in project, 228
Device driver creation
overview, 198
Device driver wizard, 196
Device properties, 18
Device Properties
example, 18
Device, configure
guidelines, 22
Devices
add, 23, 123
change order in Navigator, 121
connect, 123
connecting, 229
disconnect, 123
hide, 120
install, 8
refresh, 123
troubleshoot, 168
view, 121
Dimmer
change LED colors, 60
configure, 56
Properties, 59
troubleshoot, 169
Director, 14
troubleshoot, 167
update, 121
Disc Changer
add media, 263
add media to, 262
auto-scan media, 264
media storage, 262
search media, 265
Disclaimer, 2
Discrete power control, 248
Dock for iPod
configure, 34
Document
new and updated sections, 16
Document scope, 7
Documentation
what's new, 14
Driver
assign inputs and outputs, 203
Driver creation
guidelines, 198
Driver database
updates, 128
Driver Wizard
IR-controlled drivers, 204
limitations, 200
using, 199
Drivers
troubleshoot, 169
DriverWorks SDK, 198
DVD
add, 267
eedit, 282
DVD information
eedit, 266
Easy Importer, 15
Easy Setup, 15
E-mail Notification agent, 329
Emergency Stage, Thermostat, 111
Events pane
programming, 286
External storage device
using, 272
Fahrenheit, 108
Favorites
program, 301
FLAC, 14
Flash Navigator, 12
Full duplex, Intercom, 98
Gas Fireplace Relay
configure, 99
Properties, 100
GNU, 2
Gracenote, 2
Gracenote media lookup service, 16
Hardware
no longer supported or partially supported, 15
Hardware connections
example, 132
Hardware supported, OS 2.0, 16
HC-1000
configure, 25
HC-200
configure, 25
HC-300
configure, 25
HC-500
configure, 25
Heat Stage, Thermostat, 111
Heating Cutoff Point, Thermostat, 111
Heating system
configure, 104
Home Controller HC-1000 V1, 15
Home Controller HC-1000 V3, 16
Home Controller HC-500, 15
Home Theater Controller, 15
HVAC
configure, 104
Identify button
System Remote Control SR-150, 78
Identify device, 161
Intercom, 97
Intercom agent, 339
Intercom license, 97
Intercom, user experience, 98
Interviewer Method
example, 130
Interviewer wizard
example, 130
IO Extender, 16
configure, 31
IP Camera
configure, 113
IP device
update, 124
iPod dock
configure, 34
Properties, 35
IR codes
guidelines for capturing, 204
verify in Driver Wizard, 200
IR driver
create, 197edit, 214
IR drivers
create, 204
iTunes, 16
Keypad
troubleshoot, 169
LCD Keypad, Ethernet
configure, 86
Properties, 88
LCD Keypad, Wireless
configure, 88
Properties, 90
LED colors
changing on Dimmer or Switch, 60
Legal Notice, 2
License
Intercom, 97
Lighting
configure, 53
Lighting Scenes agent, 329
List View properties, 17
Load Profile
Wireless Dimmer, 60
Locks
configure, 113
Logging, 176, 180
Loop, 296
Macro agent, 330
Make connections
example, 153
Max On Level
Wireless Dimmer, 60
Maximum Run Time, Thermostat, 112
Media
Auto-scan, 259
Controller, 260
Disc Changer, 259
edit, 278
Media Player, 259
radio station, 269
scan schedule, 258
set up, 254
storage, 257
television station, 270
test connection, 278
troubleshoot, 168
Media Controller, 15
Media Dashboard, 12
Media Database, 255
Media Lookup Service, 256
Media Management, 14, 255
Media Monkey, 16
Media Player
configure, 51
Properties, 52
scan videos, 52
set up videos, 269
Media Scenes agent, 329
Media supported, OS 2.0, 16
Memory Usage, 177
Mini Touch Screen V1 and V2, 15
Mini Touch Screen, Ethernet
configure, 91
Properties, 93
Mini Touch Screen, Wireless
configure, 93
Identify, 94
Properties, 95
Minimum On Level
Wireless Dimmer, 60
Minimum Run Time, Thermostat, 112
MP3, 16
MPEG, 2
Multi Channel Amp
configure, 38
Properties, 40
Multi Tuner
configure, 41
My Drivers list, 25
My Drivers tab
using, 23
Navigator
configure, 77
Flash, 12
set up Photo Screen Saver, 117
Navigators
troubleshoot, 169
Network storage
scan videos, 257
Network tab, 241
example, 162
Network Tools, 123, 241
troubleshoot, 169
example, 162
Number variable, 308
Online Database
search for drivers, 24
On-Screen Device, 236
OS 2.0 update, 130
Outlet Light object
Switch, 65
Photo Screen Saver
setup, 116
Playlist
create, 276
Pool Controller, 15
Power Control
Switch, 65
Power learning
Switch, 64
Power Learning, 67
Power Management, 201
change options, 203
troubleshoot, 169
editing options, 202
Power sensing, 67
example, 74
Wireless Outlet Switch, 64, 68
Programming
add a room to play music, 306
agents, 329
basics, 285
button to play music, 305
button to turn up volume, 306
commands, 291
Conditionals, 302
Copy and Paste, 366
Digital Audio, 305
elements of, 289
Find and Replace, 364
IR inputs, 368
rooms, 305
set default music volume, 307
the system, 284
variables, 308
Project properties, 17
Project tree
add devices, 24
Properties
configure, 18
Wireless 2, 3, 6-Button Keypad, 20
Wireless Dimmer, 18
Wireless Switch, 18
Properties pane, 17
Reboot Control4 system, 9
Reboot Controller, 9
Reboot Touch Screen, 7", 9
Related documents, 8
Relay, pulse type
configure pulse single relay, 102
Properties, 102
Relay, single contact
configure, 103
Properties, 103
Release 1.2.0, 192
Release 1.3.0, 191
Release 1.7.0, 187
Release 1.7.1, 187
Release 1.7.2, 186
Release 1.7.3, 186
Release 1.7.x, 183
Release 1.8.x, 183
Reset Controller, 11
Rhapsody agent, 330
Rhapsody playlist, 276
Room connection
types, 236
Room connections, 234
Room properties, 17
Room variables, 308
Scan media
from network, 273
new, 256
Scan songs, 254
Scheduler agent, 330
Screen Saver
change time, 119
program, 119
set up custom, 118
Screen Saver agent, 330
Script pane
programming, 287
SD Video Mode, 26
Search tab
using, 23
Security, 14
Security System, 236
Serial codes
for device drivers, 222
Serial device driver, 222
create, 225
Serial driver
create, 197
Software
no longer supported or partially supported, 15
Speaker Point
configure, 45
configure for WiFi, 48
network configuration, 194
Stage Cutoff Delay, Auxiliary, 112
Stage Delay, Auxiliary, 112
Stage Minimum Off Time, Thermostat, 111
Stop command, 293, 295
String variable, 308
Switch
change LED colors, 60
troubleshoot, 169
System configurations
examples, 236
System Diagnostics, 173
System Info, 176
System Information, 180
System Manager, 123
System Remote Control SR-150
configure, 77
program buttons, 80
Properties, 79
System Remote Control SR-250
change Watch/Listen sources, 86
change ZigBee channel, 83
Composer Pro User Guide

configure, 81
paging, 85
program buttons, 84
Properties, 82
System Remote Control V1 and V2, 15
Television driver
creating IR, 206
Temperature and Temperature Control, 236
Temperature Calibration, Thermostat, 111
Test Internet Connection, 175
Thermostat
heat/cool engage delta, 110
lock, unlock, 109
Remote Temperature Sensor, 109
set backlight, 110
set date and time, 110
setting advanced properties, 110
Thermostat driver, 112
Thermostat schedule, change, 108
Thermostat, set Vacation mode, 109
Third-party devices
configure, 22
Timer agent, 330
Touch Screen
5" or 7", 97
Troubleshooting, 165
guidelines, 165
Update Composer Pro, 121
Update Director, 121
Update Manager, 122
Update system
best practices, 127
general steps, 127
guidelines, 124
software and drivers, 128
update times, 125
Update time
per device, 125
Upgrade
troubleshooting, 170
USB drive
and Photo Screen Saver, 117
USB Install, 15
USB Restore, 15
USB WiFi adapter
HC-300, 27
Variable
handling, 311
room example, 308
room, variable options, 311
using Boolean, 312
using custom variable agent number, 319
using custom variable agent string, 322
Variables
use in programming, 308
Variables agent, 330
Version
updating to same firmware version, 123
Video Audio End Point, 236
Video End Point, 236
Video mode
set correctly, 28
Video scanning
from network, 257
Video switch
add, 275
Video Volume, 236
Video Wall agent, 330
Wakeup agent, 330
Web image
configure, 113
Web Navigator, 15
What's New?, 11
While statement, 296, 297
WiFi adapter
HC-300, 27
WiFi configuration, 194
WiFi connection
Controllers, 26
Windows Media Player, 16
Wireless Fireplace Switch
configure, 100
Properties, 101
Wireless Outlet Dimmer
configure, 71
Properties, 71
Wireless Outlet Switch
configure, 63
control AV device, 69
define connection, 66
Wireless Thermostat
program the schedule, 106
Properties, 108
setup, 104
ZAP, 26
ZigBee channel, 26
ZigBee device
update, 123
ZigBee Pro, 14
ZigBee Server, 26
e nsure it is running, 28